# Table of Contents

1. C Language .................................................................................................................. 1  
   1.1. Data Types .................................................................................................................. 1  
      1.1.1. Floating-point Types ........................................................................................... 3  
   1.2. Shift JIS Kanji Support ............................................................................................ 4  
   1.3. Using Assembly in the C Source: __asm() ................................................................. 5  
   1.4. Attributes .................................................................................................................. 10  
   1.5. Pragmas to Control the Compiler ............................................................................. 15  
   1.6. Predefined Preprocessor Macros .............................................................................. 18  
   1.7. Functions .................................................................................................................. 20  
      1.7.1. Calling Convention ............................................................................................ 20  
      1.7.2. Register Usage ................................................................................................. 22  
      1.7.3. Stack Usage .................................................................................................... 23  
      1.7.4. Variable Length Arrays .................................................................................... 24  
      1.7.5. Inlining Functions: inline ............................................................................... 24  
      1.7.6. Channel Functions ......................................................................................... 25  
      1.7.7. Intrinsic Functions ........................................................................................... 27  
   1.8. Section Naming ......................................................................................................... 33  
2. Assembly Language ....................................................................................................... 37  
   2.1. Assembly Syntax ....................................................................................................... 37  
   2.2. Assembler Significant Characters ............................................................................. 38  
   2.3. Operands of an Assembly Instruction ......................................................................... 39  
   2.4. Symbol Names ......................................................................................................... 39  
      2.4.1. Predefined Preprocessor Symbols ...................................................................... 40  
   2.5. Registers .................................................................................................................. 41  
   2.6. Assembly Expressions .............................................................................................. 41  
      2.6.1. Numeric Constants ........................................................................................... 42  
      2.6.2. Strings ............................................................................................................ 42  
      2.6.3. Expression Operators ...................................................................................... 43  
   2.7. Working with Sections .............................................................................................. 44  
   2.8. Built-in Assembly Functions ..................................................................................... 46  
   2.9. Assembler Directives and Controls .......................................................................... 51  
      2.9.1. Assembler Directives ..................................................................................... 52  
      2.9.2. Assembler Controls ....................................................................................... 93  
   2.10. Macro Operations .................................................................................................... 104  
      2.10.1. Defining a Macro ....................................................................................... 104  
      2.10.2. Calling a Macro ......................................................................................... 104  
      2.10.3. Using Operators for Macro Arguments ..................................................... 105  
   2.11. Generic Instructions ............................................................................................... 108  
3. Using the C Compiler .................................................................................................... 111  
   3.1. Compilation Process ............................................................................................... 111  
   3.2. Calling the C Compiler ............................................................................................ 112  
   3.3. How the Compiler Searches Include Files ............................................................... 114  
   3.4. Compiling for Debugging ....................................................................................... 115  
   3.5. Compiler Optimizations .......................................................................................... 116  
      3.5.1. Generic Optimizations (frontend) ........................................................................ 117  
      3.5.2. Core Specific Optimizations (backend) ............................................................ 118  
      3.5.3. Optimize for Code Size or Execution Speed .................................................. 119  
   3.6. Static Code Analysis ............................................................................................... 121
Chapter 1. C Language

This chapter describes the target specific features of the C language, including language extensions that are not standard in ISO-C. For example, pragmas are a way to control the compiler from within the C source.

The TASKING VX-toolset for MCS C compiler fully supports the ISO-C standard and adds extra possibilities to program the special functions of the target.

In addition to the standard C language, the compiler supports the following:

- attribute to specify alignment and absolute addresses
- intrinsic (built-in) functions that result in target specific assembly instructions
- pragmas to control the compiler from within the C source
- predefined macros
- the possibility to use assembly instructions in the C source
- keywords for inlining functions and channel functions
- libraries

All non-standard keywords have two leading underscores (___).

In this chapter the target specific characteristics of the C language are described, including the above mentioned extensions.

1.1. Data Types

The C compiler supports the ISO C99 defined data types. The characteristics of these types are shown in the following table.

The precision describes the number of bits that are used to express a value.

The size is the storage size in bits that a variable of a given C type consumes when it is stored in memory.

The alignment specifies how variables of the given C type are aligned in memory. A memory address is said to be \( n \)-bits aligned when the address is a multiple of \( n \) bits (where \( n \) is a power of 2). The values depend on the data transfer operations as defined by the MCS instruction set architecture.

<table>
<thead>
<tr>
<th>C Type</th>
<th>Precision</th>
<th>Size</th>
<th>Alignment</th>
<th>Limits</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Bool</td>
<td>1</td>
<td>24</td>
<td>32</td>
<td>0 or 1</td>
</tr>
<tr>
<td>signed char</td>
<td>24</td>
<td>24</td>
<td>32</td>
<td>([-2^{23}, 2^{23}-1])</td>
</tr>
<tr>
<td>unsigned char</td>
<td>24</td>
<td>24</td>
<td>32</td>
<td>([0, 2^{24}-1])</td>
</tr>
<tr>
<td>short</td>
<td>24</td>
<td>24</td>
<td>32</td>
<td>([-2^{23}, 2^{23}-1])</td>
</tr>
</tbody>
</table>
A byte is defined as the size of a `char`, so a byte contains 24 bits.

Data type `__aei_t` is a storage type to interface on the AEI Bus Master Interface. Arithmetic operations applied on this data type result in either 32-bit unsigned behavior or undefined behavior.

Data types that consist of multiple words are allocated with the least significant word at the lowest memory address (little-endian). The contents of the upper RDW-W bits of a memory location are undefined, except for objects of type `__aei_t`.

**Arrays**

Arrays are aligned according to the alignment of its element type.

**Structures and unions**

The alignment of structures and unions is equivalent with the most restrictive alignment of their members.

A structure or union is padded to the alignment of its most restrictive member.

**Bit-fields**

Individual bit-fields cannot exceed 24 bits in width. The allowed bit-field fundamental data types are `_Bool`, (un)signed `char`, (un)signed `short`, (un)signed `int` and `enum`. The maximum bit-field size is equal to that of the type’s size. For the bit-field types the same rules regarding to alignment and signed-ness apply as specified for the fundamental data types. Plain `int` bit-fields (without the `signed` or `unsigned` type modifier) are unsigned. In addition, the following rules apply:
• The first bit-field is stored at the least significant bits. Subsequent bit-fields will fill the higher significant bits.

• A bit-field of a particular type cannot cross a boundary as is specified by its maximum width. For example, a bit-field of type `short` cannot cross a 24-bit boundary.

• Bit-fields share a storage unit with other bit-field members if and only if there is sufficient space in the storage unit. Adjacent bit-fields are packed together with no padding in between, except as required for the special case of a zero-width bit-field.

• An unnamed bit-field creates a gap that has the size of the specified width.

• As a special case, an unnamed bit-field having width 0 (zero) prevents any further bit-fields from residing in the storage unit corresponding to the type of the zero-width bit-field (a zero-width bit-field, as specified by ISO C, forces alignment to a storage unit boundary, which for MCS is 32 bits).

Bit-fields are always allocated beginning with the next available bit in the structure or union. No alignment padding is inserted, except for the cases noted. In the following example therefore, padding will be inserted in bits [31:9] of the first 32 bits to complete a full 32-bit word in memory. The 17-bit bit-field `f17` will occupy positions [16:0] of the second word in memory. Padding will be inserted in bits [31:17] to complete a full word, and the structure will be 32-bit aligned.

```c
struct {
    int f1: 5;
    int f2: 4;
    // padding ...
    int f17: 17;
    // padding ...
};
```

### 1.1.1. Floating-point Types

The IEEE Std 754-2008 binary 32 format is used for C type `float` and the binary 64 format is used for C types `double` and `long double`.

The first word in the tables below is the most significant word. The last word in the tables is the least significant word.

#### float

<table>
<thead>
<tr>
<th>Bit number</th>
<th>31</th>
<th>0</th>
<th>31</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary encoding</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### double / long double

<table>
<thead>
<tr>
<th>Bit number</th>
<th>31</th>
<th>0</th>
<th>31</th>
<th>0</th>
<th>31</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary encoding</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
<td>----.-.-.0000.0000.0000.0000.eee.eee</td>
</tr>
</tbody>
</table>
1.2. Shift JIS Kanji Support

In order to allow for Japanese character support on non-Japanese systems (like PCs), you can use the Shift JIS Kanji Code standard. This standard combines two successive ASCII characters to represent one Kanji character. A valid Kanji combination is only possible within the following ranges:

- First (high) byte is in the range 0x81-0x9f or 0xe0-0xef.
- Second (low) byte is in the range 0x40-0x7e or 0x80-0xfc

Compiler option -Ak enables support for Shift JIS encoded Kanji multi-byte characters in strings and (wide) character constants. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash (\) as an escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Example:

```c
// Example usage of Shift JIS Kanji
// Do not switch off option -Ak
// At the position of the italic text you can
// put your Shift JIS Kanji code
int i;    // put Shift JIS Kanji here
char c1;
char c2;
unsigned int ui;
const char mes[]="put Shift JIS Kanji here";
const unsigned int ar[5]={'k','a','n','j','i'};
    // 5 Japanese array

void main(void)
{
    i=(int)c1;
    i++;    /* put Shift JIS Kanji here\ 
            continuous comment */
    c2=mes[9];
    ui=ar[0];
}
```
1.3. Using Assembly in the C Source: __asm()

With the keyword __asm() you can use assembly instructions in the C source and pass C variables as operands to the assembly code.

It is recommended to use constructs in C or use intrinsic functions instead of __asm(). Be aware that C modules that contain assembly are not portable and harder to compile in other environments.

The compiler does not interpret assembly blocks but passes the assembly code to the assembly source file; they are regarded as a black box. So, it is your responsibility to make sure that the assembly block is syntactically correct. Possible errors can only be detected by the assembler.

You need to tell the compiler exactly what happens in the inline assembly code because it uses that for code generation and optimization. The compiler needs to know exactly which registers are written and which registers are only read. For example, if the inline assembly writes to a register from which the compiler assumes that it is only read, the generated code after the inline assembly is based on the fact that the register still contains the same value as before the inline assembly. If that is not the case the results may be unexpected. Also, an inline assembly statement using multiple input parameters may be assigned the same register if the compiler finds that the input parameters contain the same value. As long as this register is only read this is not a problem.

General syntax of the __asm keyword

__asm( "instruction_template"
   [ : output_param_list
   [ : input_param_list
   [ : register_reserve_list]] )

- **instruction_template**: Assembly instructions that may contain parameters from the input list or output list in the form: %parm_nr[.regnum]
- **%parm_nr**: Parameter number in the range 0 .. 9.
- **output_param_list**: [[ "=[&]constraint_char"(C_expression)],...]
- **input_param_list**: [[ "constraint_char"(C_expression)],...]
- **&**: Says that an output operand is written to before the inputs are read, so this output must not be the same register as any input.
- **constraint_char**: Constraint character: the type of register to be used for the C_expression. See the table below.
- **C_expression**: Any C expression. For output parameters it must be an lvalue, that is, something that is legal to have on the left side of an assignment.
- **register_reserve_list**: [["register_name"],...]
- **register_name**: Name of the register you want to reserve. For example because this register gets clobbered by the assembly code. The compiler will not use this register for inputs or outputs. Note that reserving too many registers can make register allocation impossible.
Specifying registers for C variables

With a constraint character you specify the register type for a parameter.

You can reserve the registers that are used in the assembly instructions, either in the parameter lists or in the reserved register list (register_reserve_list). The compiler takes account of these lists, so no unnecessary register saves and restores are placed around the inline assembly instructions.

<table>
<thead>
<tr>
<th>Constraint character</th>
<th>Type</th>
<th>Operand</th>
<th>Remark</th>
</tr>
</thead>
<tbody>
<tr>
<td>r</td>
<td>general purpose register</td>
<td>r1 .. r6</td>
<td>Input and output constraint.</td>
</tr>
<tr>
<td>s</td>
<td>general purpose register and mirror</td>
<td>r1 .. r6, and rs0 .. rs7 when option --extended-registers is used</td>
<td>Input and output constraint.</td>
</tr>
<tr>
<td>number</td>
<td>type of operand it is associated with</td>
<td>same as %number</td>
<td>Input constraint only. The number must refer to an output parameter. Indicates that %number and number are the same register.</td>
</tr>
</tbody>
</table>

If an input parameter is modified by the inline assembly then this input parameter must also be added to the list of output parameters (see Example 6). If this is not the case, the resulting code may behave differently than expected since the compiler assumes that an input parameter is not being changed by the inline assembly.

Loops and conditional jumps

The compiler does not detect loops with multiple __asm() statements or (conditional) jumps across __asm() statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asm(), the whole loop must be contained in a single __asm() statement. The same counts for (conditional) jumps. As a rule of thumb, all references to a label in an __asm() statement must be in that same statement. You can use numeric labels for these purposes.

Example 1: no input or output

A simple example without input or output parameters. You can use any instruction or label. When it is required that a sequence of __asm() statements generates a contiguous sequence of instructions, then they can be best combined to a single __asm() statement. Compiler optimizations can insert instruction(s) in between __asm() statements. Use newline characters ‘\n’ to continue on a new line in a __asm() statement. For multi-line output, use tab characters ‘\t’ to indent instructions.

__asm ( "nop\n"     "\tnop" );
Example 2: using output parameters

Assign the result of inline assembly to a variable. A register is chosen for the parameter because of the constraint $s$; the compiler decides which register is best to use. The $%0$ in the instruction template is replaced with the name of the variable.

```c
int read_acb( void )
{
    int out;

    __asm( "MOV %0,acb"
           : "=s" (out) );

    return out;
}
```

Generated assembly code:

```
MOV   r2,acb  ; r2 is chosen as output register
```

Example 3: using input parameters

The preferred use is to use intrinsics, but for illustrating purposes the following example performs a write access on the bus master interface. A register is chosen for the parameter because of the constraint $r$; the compiler decides which register is best to use. The $%0$ in the instruction template is replaced with the name of this register. The compiler generates code to move the input variable to the input register. Because there are no output parameters, the output parameter list is empty. Only the colon has to be present.

```c
void writebm( int in )
{
    __asm( "BWR %0,#256"
            : "r" (in) );
}
int main(void)
{
    writebm(1234);
    return 1;
}
```

Generated assembly code:

```asm
.sdecl '.mcstext.example3.writebm'
.sect '.mcstext.example3.writebm'
.global writebm
.align  4
writebm: .type func
BWR   r2,#256
ret
    .sdecl '.mcstext.example3.main'
```
.sect '.mcstext.example3.main
.global main
.align 4
main: .type func
    movl r2,#1234
    call writebm
    movl r2,#1
    ret

Example 4: using input and output parameters

Assign one C variable to another variable. Registers are necessary for the input and output parameters (constraint s,%0 for out, %1 for in in the instruction template). The compiler generates code to move the input expression into the input register.

```c
int in=5;

int movvar( void )
{
    int out;

    __asm( "MOV %0,%1"
          : "=s" (out)
          : "s" (in) );
    return out;
}
```

Generated assembly code:

```assembly
movvar: .type func
    mrd r5,in
    MOV r2,r5
    ret
```

Example 5: reserving registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a function call, where the called function is allowed to do whatever it likes with some registers. If this is the case, you can list specific registers that get clobbered by an operation after the inputs.

Same as Example 4, but now register r5 is a reserved register. You can do this by adding a reserved register list (: "r5"). As you can see in the generated assembly code, register r5 is not used (the register used is r4).

```c
int in=5;

int movvar( void )
{
    int out;

    __asm( "MOV %0,%1"
          : "=s" (out)
          : "s" (in) );
    return out;
}
```
Example 6: use the same register for input and output

As input constraint you can use a number to refer to an output parameter. This tells the compiler that the same register can be used for the input and output parameter. When the input and output parameter are the same C expression, these will effectively be treated as if the input parameter is also used as output. In that case it is allowed to write to this register. For example:

```c
inline int foo(int par1, int par2)
{
  int retvalue;

  __asm(
    "SHL    %1,#2\n"
    "ADD    %2,%1\n"
    "MOV    %0,%2"
    : "=&s" (retvalue), "=s" (par1), "=s" (par2)
    : "1" (par1), "2" (par2)
  );
  return retvalue;
}

int result;

void func(void)
{
  result = foo(1000,1000);
}
```

In this example the "1" constraint for the input parameter `par1` refers to the output parameter `par1`, and similar for the "2" constraint and `par2`. In the inline assembly `%1 (par1)` and `%2 (par2)` are written. This is allowed because the compiler is aware of this.

This results in the following generated assembly code:

```assembly
movl  r5,#1000
mov   r4,r5
SHL   r5,#2
```
ADD   r4,r5
MOV   r3,r4
mwr   r3,result

However, when the inline assembly would have been as given below, the compiler would have assumed that %1 (par1) and %2 (par2) were read-only. Because of the inline keyword the compiler knows that par1 and par2 both contain 1000. Therefore the compiler can optimize and assign the same register to %1 and %2. This would have given an unexpected result.

```c
__asm(
    "SHL    %1,#2\n    "ADD    %2,%1\n    "MOV    %0,%2"
    : "=&s" (retvalue)
    : "s" (par1), "s" (par2)
);
```

Generated assembly code:

```assembly
movl  r5,#1000
SHL   r5,#2
ADD   r5,r5        ; same register, but is expected read-only
MOV   r4,r5
mwr   r4,result    ; contains unexpected result
```

### 1.4. Attributes

You can use the keyword `__attribute__` to specify special attributes on declarations of variables, functions, types, and fields.

Syntax:

```
__attribute__((name,...))
```

or:

```
__name__
```

The second syntax allows you to use attributes in header files without being concerned about a possible macro of the same name. This second syntax is only possible on attributes that do not already start with an underscore. For example, you may use `__noreturn__` instead of `__attribute__((noreturn))`.

**alias("symbol")**

You can use `__attribute__((alias("symbol")))` to specify that the function declaration appears in the object file as an alias for another symbol. For example:

```c
void __f() { /* function body */; }
void f() __attribute__((weak, alias("__f")));
declares 'f' to be a weak alias for '__f__'.

__align__(value)

You can use __attribute__((__align(n))) to change the alignment of objects of a size greater than or equal to four bytes. The alignment must be a power of two and larger than or equal to 4.

const

You can use __attribute__((const)) to specify that a function has no side effects and will not access global data. This can help the compiler to optimize code. See also attribute pure.

The following kinds of functions should not be declared __const__:

- A function with pointer arguments which examines the data pointed to.
- A function that calls a non-const function.

export

You can use __attribute__((export)) to specify that a variable/function has external linkage and should not be removed. During MIL linking, the compiler treats external definitions at file scope as if they were declared static. As a result, unused variables/functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be referenced from functions outside the current module. During MIL linking not all uses of a variable/function can be known to the compiler. For example when a variable is referenced in an assembly file or a (third-party) library. With the export attribute the compiler will not perform optimizations that affect the unknown code.

int i __attribute__((export)); /* 'i' has external linkage */

flatten

You can use __attribute__((flatten)) to force inlining of all function calls in a function, including nested function calls.

Unless inlining is impossible or disabled by __attribute__((noinline)) for one of the calls, the generated code for the function will not contain any function calls.

format(type, arg_string_index, arg_check_start)

You can use __attribute__((format(type, arg_string_index, arg_check_start))) to specify that functions take printf, scanf, strftime or strftime style arguments and that calls to these functions must be type-checked against the corresponding format string specification.

_type determines how the format string is interpreted, and should be printf, scanf, strftime or strftime.

_arg_string_index is a constant integral expression that specifies which argument in the declaration of the user function is the format string argument.
arg_check_start is a constant integral expression that specifies the first argument to check against the format string. If there are no arguments to check against the format string (that is, diagnostics should only be performed on the format string syntax and semantics), arg_check_start should have a value of 0. For strftime-style formats, arg_check_start must be 0.

Example:

```c
int foo(int i, const char * my_format, ...) __attribute__((format(printf, 2, 3)));
```

The format string is the second argument of the function `foo` and the arguments to check start with the third argument.

**leaf**

You can use `__attribute__((leaf))` to specify that a function is a leaf function. A leaf function is an external function that does not call a function in the current compilation unit, directly or indirectly. The attribute is intended for library functions to improve dataflow analysis. The attribute has no effect on functions defined within the current compilation unit.

**malloc**

You can use `__attribute__((malloc))` to improve optimization and error checking by telling the compiler that:

- The return value of a call to such a function points to a memory location or can be a null pointer.
- On return of such a call (before the return value is assigned to another variable in the caller), the memory location mentioned above can be referenced only through the function return value; e.g., if the pointer value is saved into another global variable in the call, the function is not qualified for the malloc attribute.
- The lifetime of the memory location returned by such a function is defined as the period of program execution between a) the point at which the call returns and b) the point at which the memory pointer is passed to the corresponding deallocation function. Within the lifetime of the memory object, no other calls to malloc routines should return the address of the same object or any address pointing into that object.

**noinline**

You can use `__attribute__((noinline))` to prevent a function from being considered for inlining. Same as keyword `__noinline` or `#pragma noinline`.

**always_inline**

With `__attribute__(((always_inline))` you force the compiler to inline the specified function, regardless of the optimization strategy of the compiler itself. Same as keyword `inline` or `#pragma inline`. 
**noreturn**

Some standard C function, such as abort and exit cannot return. The C compiler knows this automatically. You can use `__attribute__((noreturn))` to tell the compiler that a function never returns. For example:

```c
void fatal() __attribute__((noreturn));

void fatal( /* ... */ )
{
    /* Print error message */
    exit(1);
}
```

The function `fatal` cannot return. The compiler can optimize without regard to what would happen if `fatal` ever did return. This can produce slightly better code and it helps to avoid warnings of uninitialized variables.

**protect**

You can use `__attribute__((protect))` to exclude a variable/function from the duplicate/unreferenced section removal optimization in the linker. When you use this attribute, the compiler will add the "protect" section attribute to the symbol's section. Example:

```c
int i __attribute__((protect));
```

Note that the protect attribute will not prevent the compiler from removing an unused variable/function (see the used symbol attribute).

**pure**

You can use `__attribute__((pure))` to specify that a function has no side effects, although it may read global data. Such pure functions can be subject to common subexpression elimination and loop optimization. See also attribute `const`.

**section("section_name")**

You can use `__attribute__((section("name")))` to specify that a function must appear in the object file in a particular section. For example:

```c
extern void foobar(void) __attribute__((section("bar")));
```

puts the function `foobar` in the section named `bar`.

See also `#pragma section`.

**used**

You can use `__attribute__((used))` to prevent an unused symbol from being removed, by both the compiler and the linker. Example:
static const char copyright[] __attribute__((used)) = "Copyright 2015 Altium BV";

When there is no C code referring to the copyright variable, the compiler will normally remove it. The __attribute__((used)) symbol attribute prevents this. Because the linker should also not remove this symbol, __attribute__((used)) implies __attribute__((protect)).

**unused**

You can use __attribute__((unused)) to specify that a variable or function is possibly unused. The compiler will not issue warning messages about unused variables or functions.

**weak**

You can use __attribute__((weak)) to specify that the symbol resulting from the function declaration or variable must appear in the object file as a weak symbol, rather than a global one. This is primarily useful when you are writing library functions which can be overwritten in user code without causing duplicate name errors.

See also #pragma weak.
1.5. Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule compiler options. Put pragmas in your C source where you want them to take effect. Unless stated otherwise, a pragma is in effect from the point where it is included to the end of the compilation unit or until another pragma changes its status.

The syntax is:

```c
#pragma [label:]pragma-spec pragma-arguments [on | off | default | restore]
```
or:

```c
__Pragma( "[label:]pragma-spec pragma-arguments [on | off | default | restore]"
)
```

Some pragmas can accept the following special arguments:

- `on` switch the flag on (same as without argument)
- `off` switch the flag off
- `default` set the pragma to the initial value
- `restore` restore the previous value of the pragma

### Label pragmas

Some pragmas support a label prefix of the form "label:" between `#pragma` and the pragma name. Such a label prefix limits the effect of the pragma to the statement following a label with the specified name. The `restore` argument on a pragma with a label prefix has a special meaning: it removes the most recent definition of the pragma for that label.

You can see a label pragma as a kind of macro mechanism that inserts a pragma in front of the statement after the label, and that adds a corresponding `#pragma ... restore` after the statement.

Compared to regular pragmas, label pragmas offer the following advantages:

- The pragma text does not clutter the code, it can be defined anywhere before a function, or even in a header file. So, the pragma setting and the source code are uncoupled. When you use different header files, you can experiment with a different set of pragmas without altering the source code.

- The pragma has an implicit end: the end of the statement (can be a loop) or block. So, no need for pragma restore / endoptimize etc.

Example:

```c
#pragma lab1:optimize P

volatile int v;

void f( void )
{
  int i, a;
```
a = 42;

lab1: for( i=1; i<10; i++ )
{
   /* the entire for loop is part of the pragma optimize */
   a += i;
}

v = a;

**Supported pragmas**

The compiler recognizes the following pragmas, other pragmas are ignored. On the command line you can use `cmcs -h help=pragmas` to get a list of all supported pragmas. Pragmas marked with (*) support a label prefix.

**STDC FP_CONTRACT** [on | off | default | restore] (*)

This is a standard ISO C99 pragma. With this pragma you can control the +contract flag of C compiler option `--fp-model`.

**alias symbol=defined_symbol**

Define `symbol` as an alias for `defined_symbol`. It corresponds to a .ALIAS directive at assembly level. The `symbol` should not be defined elsewhere, and `defined_symbol` should be defined with static storage duration (not extern or automatic).

**boolean** [on | off | default | restore] (*)

This pragma is used to mark the macros "false" and "true" from the library header file `stdbool.h` as "essentially BOOLEAN", which is a concept from the MISRA C:2012 standard.

**extension isuffix** [on | off | default | restore] (*)

Enables a language extension to specify imaginary floating-point constants. With this extension, you can use an "i" suffix on a floating-point constant, to make the type _Imaginary.

float 0.5i

**extern symbol**

Normally, when you use the C keyword extern, the compiler generates an .EXTERN directive in the generated assembly source. However, if the compiler does not find any references to the extern symbol in the C module, it optimizes the assembly source by leaving the .EXTERN directive out.

With this pragma you can force an external reference (.EXTERN assembler directive), even when the `symbol` is not used in the module.
fp_negzero [on | off | default | restore] (*)
With this pragma you can control the +negzero flag of C compiler option --fp-model.

fp_nonan [on | off | default | restore] (*)
With this pragma you can control the +nonan flag of C compiler option --fp-model.

fp_rewrite [on | off | default | restore] (*)
With this pragma you can control the +rewrite flag of C compiler option --fp-model.

inline / noinline / smartinline [default | restore] (*)
See Section 1.7.5, Inlining Functions: inline.

inline_max_incr {value | default | restore} (*)
inline_max_size {value | default | restore} (*)
With these pragmas you can control the automatic function inlining optimization process of the compiler. It has effect only when you have enable the inlining optimization (C compiler option --optimize=+inline).
See C compiler options --inline-max-incr / --inline-max-size.

macro / nomacro [on | off | default | restore] (*)
Turns macro expansion on or off. By default, macro expansion is enabled.

message "message" ...
Print the message string(s) on standard output.

nomisrac [nr,...] [default | restore] (*)
Without arguments, this pragma disables MISRA C checking. Alternatively, you can specify a comma-separated list of MISRA C rules to disable.
See C compiler option --misrac and Section 3.6.2, C Code Checking: MISRA C.

optimize [flags] / endoptimize [default | restore] (*)
You can overrule the C compiler option --optimize for the code between the pragmas optimize and endoptimize. The pragma works the same as C compiler option --optimize.
See Section 3.5, Compiler Optimizations.
section [type=][format_string][,...] / endsection [default | restore] (*)

Rename sections by adding a format_string to all section names specified with .type, or restore default section naming. If you specify only a format_string (without a type), the suffix is added to all section names. See Section 1.8, Section Naming, C compiler option --rename-sections and assembler directive .SDECL for more information.

source / nosource [on | off | default | restore] (*)

With these pragmas you can choose which C source lines must be listed as comments in assembly output.

See C compiler option --source.

stdinc [on | off | default | restore] (*)

This pragma changes the behavior of the #include directive. When set, the C compiler options --include-directory and --no-stdinc are ignored.

tradeoff level [default | restore] (*)

Specify tradeoff between speed (0) and size (4). See C compiler option --tradeoff

warning [number,...] [default | restore] (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings will be suppressed.

weak symbol

Mark a symbol as "weak" (.WEAK assembler directive). The symbol must have external linkage, which means a global or external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of the object files. However, a weak reference will not cause the extraction of a module from a library to resolve the reference. When a weak external reference cannot be resolved, the null pointer is substituted.

A weak definition can be overruled by a normal global definition. The linker will not complain about the duplicate definition, and ignore the weak definition.

1.6. Predefined Preprocessor Macros

The TASKING C compiler supports the predefined macros as defined in the table below. The macros are useful to create conditional C code.
<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>BUILD</strong></td>
<td>Identifies the build number of the compiler, composed of decimal digits for the build number, three digits for the major branch number and three digits for the minor branch number. For example, if you use build 1.22.1 of the compiler, <strong>BUILD</strong> expands to 1022001. If there is no branch number, the branch digits expand to zero. For example, build 127 results in 127000000.</td>
</tr>
<tr>
<td><strong>CMCS</strong></td>
<td>Identifies the compiler. You can use this symbol to flag parts of the source which must be recognized by the TASKING cmcs compiler only. It expands to 1.</td>
</tr>
<tr>
<td><strong>CORE</strong></td>
<td>Expands to a string with the core name depending on the option --core=core. The dots '.' are removed from the core name. For example, if --core=mcs3.0 is specified, the symbol <strong>CORE</strong> expands to mcs30.</td>
</tr>
<tr>
<td><strong>CORE_core</strong></td>
<td>A symbol is defined depending on the option --core=core. The core is converted to uppercase and the dots '.' are removed. For example, if --core=mcs3.0 is specified, the symbol <strong>CORE_MCS30</strong> is defined. When no --core is supplied, the compiler defines <strong>CORE_MCS31</strong>.</td>
</tr>
<tr>
<td><strong>DATE</strong></td>
<td>Expands to the compilation date: “mmm dd yyyy”.</td>
</tr>
<tr>
<td><strong>DOUBLE_FP</strong></td>
<td>Expands to 1 if you used option --fp-model=-float, otherwise unrecognized as macro.</td>
</tr>
<tr>
<td><strong>FILE</strong></td>
<td>Expands to the current source file name.</td>
</tr>
<tr>
<td><strong>FPU</strong></td>
<td>Expands to 1 when the option --fp-model=+soft is not used. Otherwise unrecognized as a macro.</td>
</tr>
<tr>
<td><strong>HAS_FLOATS_BUILTIN</strong></td>
<td>Expands to 1.</td>
</tr>
<tr>
<td><strong>LINE</strong></td>
<td>Expands to the line number of the line where this macro is called.</td>
</tr>
<tr>
<td><strong>LITTLE_ENDIAN</strong></td>
<td>Expands to 1. The processor accesses data in little-endian.</td>
</tr>
<tr>
<td><strong>PROF_ENABLE</strong></td>
<td>Expands to 1 if profiling is enabled, otherwise expands to 0.</td>
</tr>
<tr>
<td><strong>REVISION</strong></td>
<td>Expands to the revision number of the compiler. Digits are represented as they are; characters (for prototypes, alphas, betas) are represented by -1. Examples: v1.0r1 -&gt; 1, v1.0rb -&gt; -1</td>
</tr>
<tr>
<td><strong>SINGLE_FP</strong></td>
<td>Expands to 1 if you used option --fp-model=+float (Treat ‘double’ as ‘float’), otherwise unrecognized as macro.</td>
</tr>
<tr>
<td><strong>STDC</strong></td>
<td>Identifies the level of ANSI standard. The macro expands to 1 if you set option --language (Control language extensions), otherwise expands to 0.</td>
</tr>
<tr>
<td><strong>STDC_HOSTED</strong></td>
<td>Always expands to 0, indicating the implementation is not a hosted implementation.</td>
</tr>
<tr>
<td><strong>STDC_VERSION</strong></td>
<td>Identifies the ISO-C version number. Expands to 199901L for ISO C99 or 199409L for ISO C90.</td>
</tr>
<tr>
<td><strong>TASKING</strong></td>
<td>Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING compiler is used.</td>
</tr>
</tbody>
</table>
### 1.7. Functions

#### 1.7.1. Calling Convention

**Parameter passing**

A lot of execution time of an application is spent transferring parameters between functions. The fastest parameter transport is via registers. Therefore, function parameters are first passed via registers. If no more registers are available for a parameter, the compiler pushes parameters on the stack.

Registers available for parameter passing are r2, r3, r4 and r5. The parameters are loaded sequentially into the parameter registers. For each parameter the next unused register (pair) is selected. If fewer (or no) registers are needed, the unneeded registers are not loaded and will contain undefined values on entry to the called function. Up to four arithmetic types or four pointers can be passed this way.

The following table specifies which registers are used to pass an object of a specific type to a function.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>__CHAR_MAX</td>
<td>Expands to UCHAR_MAX or SCHAR_MAX, depending upon the <code>option --uchar</code> (char defaults to unsigned).</td>
</tr>
<tr>
<td>__CHAR_MIN</td>
<td>Expands to 0 or SCHAR_MIN, depending upon the <code>option --uchar</code> (char defaults to unsigned).</td>
</tr>
<tr>
<td>__PTRDIFF_MAX</td>
<td>Expands to INT24_MAX.</td>
</tr>
<tr>
<td>__PTRDIFF_MIN</td>
<td>Expands to INT24_MIN.</td>
</tr>
<tr>
<td>__SIZE_MAX</td>
<td>Expands to UINT24_MAX.</td>
</tr>
<tr>
<td>__SIZE_MIN</td>
<td>Expands to 0.</td>
</tr>
<tr>
<td>__WCHAR_MAX</td>
<td>Expands to UINT24_MAX.</td>
</tr>
<tr>
<td>__WCHAR_MIN</td>
<td>Expands to 0.</td>
</tr>
</tbody>
</table>

Example

```c
#ifdef __CORE_MCS31__
/* this part is only compiled for core mcs3.1 */
...
#endif
```
<table>
<thead>
<tr>
<th>Type</th>
<th>Registers used for parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Bool</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>(unsigned) char</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>(unsigned) short</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>(unsigned) int</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>(unsigned) long</td>
<td>r2r3, r3r4 or r4r5</td>
</tr>
<tr>
<td>(unsigned) long long</td>
<td>r2r3r4 or r3r4r5</td>
</tr>
<tr>
<td>__int72_t</td>
<td>r2r3r4 or r3r4r5</td>
</tr>
<tr>
<td>__uint72_t</td>
<td>r2r3r4 or r3r4r5</td>
</tr>
<tr>
<td>float</td>
<td>r2r3, r3r4 or r4r5</td>
</tr>
<tr>
<td>(long) double</td>
<td>r2r3r4 or r3r4r5</td>
</tr>
<tr>
<td>pointer to function/data</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>struct / union (size 24-bits)</td>
<td>r2, r3, r4 or r5</td>
</tr>
<tr>
<td>struct / union (size 48-bits)</td>
<td>r2r3, r3r4 or r4r5</td>
</tr>
<tr>
<td>struct / union (size 72-bits)</td>
<td>r2r3r4 or r3r4r5</td>
</tr>
</tbody>
</table>

* Small struct/union types are passed in registers, except when any of the members has the __aei_t type.

Only when the parameters do not fit in the four registers provided for parameter passing, or when the object is an aggregate type that cannot be passed in registers, or has the __aei_t type, the caller allocates stack space for the parameters in its stack frame. It allocates only enough space to hold the parameters that do not fit into registers. The space that holds the parameters is called the argument passing area (APA).

Examples:

```c
void func1( int i, char * p, char c );  /* r2 r3 r4 */
void func2( int i1, double d, int i2 ); /* r2 r3r4r5 stack */
void func3( char c1, char c2, char c3[] ); /* r2 r3 r4 */
void func4( double d1, int i1, double d2, int i2 );
    /* r2r3r4 r5 stack stack */
```

**Variable argument lists**

Parameters that are passed to a function in the variable argument list are always passed in the argument passing area (APA), directly after the fixed parameters on the user stack, if any.

**Function return values**

The C compiler uses registers to store C function return values, depending on the function return types.

<table>
<thead>
<tr>
<th>Return type</th>
<th>Return register</th>
</tr>
</thead>
<tbody>
<tr>
<td>_Bool</td>
<td>r2</td>
</tr>
</tbody>
</table>
Return type | Return register
--- | ---
(unsigned) char | r2
(unsigned) short | r2
(unsigned) int | r2
(unsigned) long | r2r3
(unsigned) long long | r2r3r4
__int72_t | r2r3r4
__uint72_t | r2r3r4
float | r2r3
(long) double | r2r3r4
pointer to function/data | r2
struct / union *(size 24-bits) | r2
struct / union *(size 48-bits) | r2r3
struct / union *(size 72-bits) | r2r3r4

* Small struct/union types are returned through registers, except when any of the members has the __aei_t type.

Return values of an aggregate type that cannot be returned in registers or return values of the __aei_t type are returned in memory. When stack space is required, the caller allocates enough stack space to hold the return value and passes a pointer to the return value memory area to the called function in its first parameter register (r2). The called function stores the value to be returned at the memory location designated by the pointer in r2, and returns r2 again to the caller. The parameter allocation then continues as usual, with r2 being occupied. After the called function returns, the caller releases the stack space for the return value when necessary.

1.7.2. Register Usage

The C compiler uses the registers according to the convention given in the following table.

<table>
<thead>
<tr>
<th>Register</th>
<th>Class</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>r0</td>
<td>dedicated</td>
<td>user stack pointer</td>
</tr>
<tr>
<td>r1</td>
<td>callee saves</td>
<td>local variables</td>
</tr>
<tr>
<td>r2 .. r3</td>
<td>caller saves</td>
<td>parameter passing and return values</td>
</tr>
<tr>
<td>r4</td>
<td>caller saves</td>
<td>parameter passing and return values and used for mulu/muls instructions and for the remainder result of divu and divs instructions</td>
</tr>
<tr>
<td>r5</td>
<td>caller saves</td>
<td>parameter passing and used for mrdio/mwrio instructions</td>
</tr>
<tr>
<td>r6</td>
<td>callee saves</td>
<td>used for jmpi/jbsi/jbci/calli/ardi/awri/nardi/wurmx/wurcx instructions and local variables</td>
</tr>
<tr>
<td>r7</td>
<td>dedicated</td>
<td>system stack pointer</td>
</tr>
<tr>
<td>rs0 .. rs7</td>
<td>callee saves</td>
<td>[optional, not EABI compliant] local variables</td>
</tr>
<tr>
<td>Register</td>
<td>Class</td>
<td>Purpose</td>
</tr>
<tr>
<td>----------</td>
<td>---------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>mhb</td>
<td>scratch</td>
<td>intrinsic functions and the __aei_t type.</td>
</tr>
</tbody>
</table>

The registers are classified as follows:

**caller saves**  These registers are allowed to be changed by a function without saving the contents. Therefore, the calling function must save these registers when necessary prior to a function call.

**callee saves**  These registers belong to the calling function. These registers must be saved and restored by the called function, i.e. the caller expects them not to be changed after the function call.

**dedicated**  The dedicated registers have a specific purpose throughout the entire application and are always valid.

**scratch**  The scratch registers are never preserved.

### 1.7.3. Stack Usage

**User stack**

The user stack is used for parameter passing and the allocation of automatic and temporary storage. The user stack grows from higher addresses to lower addresses. The user stack pointer (r0) points to the bottom (low address) of the stack frame. The stack pointer alignment is 32-bit. The following figure outlines a stack frame on the user stack.

![Stack Diagram](image)

The register save area is used to store the callee-saves registers when necessary. The local variables area is used to store local variables, function return values and spilled registers. The argument passing...
area is only used to pass stack parameters to the called functions. After control has been passed to the called function, this area is called the parameter area.

**System stack**

The system stack is used to store the return address. The system stack grows from lower addresses to higher addresses. The system stack pointer (r7) points to the bottom (low address) of the stack frame. The stack pointer alignment is 32-bit. The following figure outlines a stack frame on the system stack.

![Stack Frame Diagram](image)

1.7.4. Variable Length Arrays

Variable length arrays (VLAs) are allocated on the heap using the `malloc()` and `free()` function calls from the C library.

1.7.5. Inlining Functions: `inline`

With the C compiler option `--optimize+=inline`, the C compiler automatically inlines small functions in order to reduce execution time (smart inlining). The compiler inserts the function body at the place the function is called. The C compiler decides which functions will be inlined. You can overrule this behavior with the two keywords `inline` (ISO-C) and `__noinline`.

With the `inline` keyword you force the compiler to inline the specified function, regardless of the optimization strategy of the compiler itself:

```c
inline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
```

If a function with the keyword `inline` is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because the compiler only inlines a function in the module that contains the function definition. When you need to call the inline function from several source modules, you must include the definition of the inline function in each module (for example using a header file).

With the `__noinline` keyword, you prevent a function from being inlined:
__noinline unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}

Using pragmas: inline, noinline, smartinline

Instead of the inline qualifier, you can also use #pragma inline and #pragma noinline to inline a function body:

#pragma inline
unsigned int abs(int val)
{
    unsigned int abs_val = val;
    if (val < 0) abs_val = -val;
    return abs_val;
}
#pragma noinline
void main( void )
{
    int i;
    i = abs(-1);
}

If a function has an inline/__noinline function qualifier, then this qualifier will overrule the current pragma setting.

With the #pragma noinline/#pragma smartinline you can temporarily disable the default behavior that the C compiler automatically inlines small functions when you turn on the C compiler option --optimize=+inline.

With the C compiler options --inline-max-incr and --inline-max-size you have more control over the automatic function inlining process of the compiler.

1.7.6. Channel Functions

To support the channels of an MCS, the TASKING C compiler for MCS supports an attribute and a function qualifier.

Defining a channel function: channel() attribute

With the function attribute __attribute__((channel(channel))) or with the function type qualifier __channel(channel) you can declare a function as a channel function.

void channel_x( void ) __attribute__((channel([channel])))
{
    ...
}
void __channel([channel]) channel_x( void )
{
...
}

A function qualified with this attribute is called at program startup and serves as the entry point of the code executed by the specified channel. The argument channel is an integral number in the range 0..7 and is bound to the corresponding MCS channel. A channel can have only one entry point. For each channel function an unconditional jump to the function is inserted at the corresponding entry in the channel vector table (register MCS[i]_CH[x]_PC). For example,

void channel_1( void ) __attribute__((channel(1)));

void channel_1( void ) /* inherit channel() attribute from prototype */
{
    return;
}

When the channel function returns the channel is disabled by clearing the EN flag in the STA register. A channel function does not save, nor restore any registers in its function prologue/epilogue.

The following rules apply:
• Only one channel function can be bound to a specific channel.
• Channel functions cannot return anything and must have a void argument type list.
• It is not possible to call a channel function directly from an application.

The C compiler will bind the channel function to the appropriate vector. For example:

    .global _vector_1
    _vector_1   .equ    channel_1

Function main() is called from the startup code and is executed by channel 0 by default. However, you can execute main() from an arbitrary channel by specifying the macro GTM_MCS_MAIN_CHANNEL to the linker. See Section 5.7.3, Preprocessor Macros in the Linker Script Files for more information. Function main() should not be qualified with the channel() attribute. If function main() returns then function exit() is called. The exit() function does not disable the channel but will loop forever.

Each function qualified with the channel() attribute initializes a private stack. The heap is shared between channels.

The __csr pointer qualifier

When you need to create a pointer to a channel function, it is advised to qualify the pointer with the __csr pointer qualifier. This prevents that a channel function is accidentally called directly from an application through a function pointer. When you omit the __csr pointer qualifier, the C compiler issues a warning. You can avoid this warning with an explicit type cast. The function attribute __attribute__((channel(channel))) automatically assigns the __csr pointer qualifier. When
you use the __csr pointer qualifier without the channel() function attribute, the MCS C compiler binds the channel function to channel 0 by adding __attribute__((channel(0))). Examples:

```c
extern void chn( void ) __attribute__((channel(1)));
extern void f( void );
void       (*fp_a)( void );
void       (*fp_b)( void );
void       (*fp_c)( void );
void __csr (*fp_chn_a)( void );
void __csr (*fp_chn_b)( void );

int main( void )
{
    fp_a     = f;        /* ok, non-channel function, non-channel pointer */
    fp_chn_a = chn;      /* ok, channel function, channel pointer */
    fp_b     = chn;      /* warning, channel function, non-channel pointer */
    fp_chn_b = f;        /* ok, non-channel function, channel pointer */
    fp_c     = fp_chn_a; /* warning, channel pointer assigned to non-channel pointer */

    chn();               /* error, cannot call a channel function */
    (*fp_chn_a)();       /* error, cannot call a channel function */
    return 0;
}
```

### 1.7.7. Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to use these instructions. Intrinsic functions are predefined functions that are recognized by the compiler. The compiler generates the most efficient assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than calling it as a function). This avoids parameter passing and register saving instructions which are normally necessary during function calls.

Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by hand, intrinsic functions use registers even more efficiently. At the same time your C source remains very readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with a double underscore character (__).

#### 1.7.7.1. Intrinsic Functions Used Internally by the C Compiler

**Allocate a Variable Length Array**

```c
void * volatile __alloc( __size_t size );
```

Allocate memory. Returns a pointer to space of size bytes on the heap. Memory allocated through this function is freed when the calling function returns. This function is used internally for variable length arrays, it is not to be used by end users.
Free a Variable Length Array

```c
void volatile __free( void * ptr );
```

Deallocation of the memory pointed to by `ptr` must point to memory previously allocated by a call to `__alloc()`.

**Variable argument lists**

```c
char * __dotdotdot__( void );
```

Variable argument '...' operator. Used in library function `va_start()`. Returns a pointer to the start of the variable argument list on the stack.

### 1.7.7.2. ARU Transfer

#### Blocking ARU read access

```c
__uint72_t __ard( unsigned int address, unsigned int * sta );
```

Perform a blocking read access to the ARU and transfer both W bit values received at the ARU port to the lower 48 bits of the 72-bit return register. The received ARU control bits are stored in the upper 24 bits of the 72-bit return register, the lower 5 bits contain the control bits, the remaining bits are undefined.

The CAT/SAT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

The result is the two W bit values from the ARD[I] instruction in the lower 48 bits and ARU control bits in the upper 24 bits. If the execution was not successful the value may be undefined.

#### Blocking ARU write access

```c
void __awr( unsigned int index, __uint72_t value, unsigned int * sta );
```

Perform a blocking write access to the ARU and transfer two W bit values and the ARU control bits to the ARU port using the value in parameter `value`. The ARU control bits are passed in the upper 24 bits of the 72-bit parameter register `value`, the lower 5 bits contain the control bits, the other bits are not used.

The CAT/SAT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

This function returns nothing.

#### Non-blocking ARU read access

```c
__uint72_t __nard( unsigned int address, unsigned int * sta );
```

Perform a non-blocking read access to the ARU and transfer both W bit values received at the ARU port to the lower 48 bits of the 72-bit return register. The received ARU control bits are stored in the upper 24 bits of the 72-bit return register, the lower 5 bits contains the control bits, the remaining bits are undefined.
The SAT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

The result is the two W bit values from the NARD[I] instruction in the lower 48 bits and ARU control bits in the upper 24 bits. If the execution was not successful the value may be undefined.

### 1.7.7.3. GTM Time Base Unit

The following intrinsics are used to access the GTM specific time base units (TBU).

**Read timestamp from TBU_{TSx}**

```c
unsigned int __get_tbu_ts( unsigned int register );
```

This function reads the timestamp from one of the Time Base Units. The value of `register` can only be 0, 1 or 2.

Returns the contents of the TBU_{TSx} register, where `x` must be 0, 1 or 2.

**Suspend task until a match of TBU_{TSx} occurs**

```c
void __wait_on_tbu( unsigned int register, unsigned int value, unsigned int mask, unsigned int * sta );
```

This function uses the WURM/WURMX instruction to suspend the MCS task until a match occurs on one of the TBU_{TSx} registers, where `x` must be 0, 1 or 2. The CWT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

For MCS v3.0 cores the `mask` parameter must be an integral constant between 0 and 65535 because this core does not support the WURMX instruction.

This function returns nothing.

### 1.7.7.4. Trigger Registers

**Set bits in STRG**

```c
void __set_trigger_bits( unsigned int value );
```

This function writes one or more bits in the STRG register. This results in setting those bits in the common trigger register.

This function returns nothing.

**Clear bits in CTRG**

```c
void __clear_trigger_bits( unsigned int value );
```

This function writes one or more bits in the CTRG register. This results in clearing those bits in the common trigger register.
This function returns nothing.

**Read bits from STRG**

```c
unsigned int __get_trigger_bits( void );
```

This function reads the STRG register and returns the contents.

**Read bits from CTRG**

```c
unsigned int __get_clear_trigger_bits( void );
```

This function reads the CTRG register and returns the contents.

**Suspend task until trigger bits of STRG occur**

```c
void __wait_on_trigger_bits( unsigned int value, unsigned int mask,
    unsigned int * sta );
```

This function uses the WURM/WURMX instruction to suspend the MCS task until trigger bits of STRG occur. The CWT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

For MCS v3.0 cores the `mask` parameter must be an integral constant between 0 and 65535 because this core does not support the WURMX instruction.

This function returns nothing.

**Suspend task until trigger bits of CTRG occur**

```c
void __wait_on_clear_trigger_bits( unsigned int bits );
```

This function uses the WURM/WURMX instruction to suspend the MCS task until trigger bits of CTRG occur. The CWT flag of the register STA is stored in the location pointed to by the `sta` parameter. The `sta` pointer can be NULL in which case the STA register is not stored.

For MCS v3.0 cores the `mask` parameter must be an integral constant between 0 and 65535 because this core does not support the WURMX instruction.

This function returns nothing.

### 1.7.7.5. Bus Master Addressing

**Read access at bus master interface**

```c
__aei_t __brd( unsigned int address );
```

Initiate a read access at the bus master interface using the specified address.

This function returns the 32-bit value that is read from the bus master interface.
Write access at bus master interface

void __bwr( unsigned int addr, __aei_t value );

Initiate a write access at the bus master interface using the specified address and transfer a 32-bit value to the bus. The 32 bits of the parameter value are transferred.

This function returns nothing.

1.7.7.6. Floating-Point

Extract sign bit from floating-point value

_Bool __signbit( double d );
_Bool __signbitf( float f );

Generate code to extract the sign bit from a floating-point value.

This function returns the sign bit of the floating-point argument.

Extract exponent from floating-point value

unsigned int __exp( double d );
unsigned int __expf( float f );

Generate code to extract the exponent from a floating-point value.

This function returns the exponent of the floating-point argument.

Extract mantissa from floating-point value

__uint72_t __mant( double d );
unsigned int __mantf( float f );

Generate code to extract the mantissa from a floating-point value.

This function returns the mantissa of the floating-point argument.

Extract exponent and mantissa from floating-point value

__uint72_t __expmant( double d );
unsigned long __expmantf( float f );

Generate code to extract the exponent and mantissa from a floating-point value. The exponent is the most significant part of the returned value. The __expmantf() function leaves a gap of 1 bit between the exponent and the mantissa. This bit, which used to contain the sign bit of the single precision floating-point value, is always cleared. 

This function returns the exponent and mantissa of the floating-point argument.
Construct floating-point value from sign, exponent and mantissa

\[
\text{double } \_\text{pack}( \_\text{Bool sign, unsigned int exp, } \_\text{uint72_t mant});
\]

\[
\text{float } \_\text{packf}( \_\text{Bool sign, unsigned int exp, unsigned int mant});
\]

Construct a floating-point value from the components sign, exponent and mantissa.

This function returns the constructed floating-point value.

Set exponent of floating-point value

\[
\text{double } \_\text{set_exp}( \text{double } d, \text{unsigned int } exp);
\]

\[
\text{float } \_\text{set_expf}( \text{float } f, \text{unsigned int } exp);
\]

Set the exponent of a floating-point value.

This function returns the updated floating-point value.

Set sign of floating-point value

\[
\text{double } \_\text{set_sign}( \text{double } d, \_\text{Bool sign});
\]

\[
\text{float } \_\text{set_signf}( \text{float } f, \_\text{Bool sign});
\]

Set the sign of floating-point value.

This function returns the updated floating-point value.

Copy sign of floating-point value

\[
\text{double } \_\text{copysign}( \text{double } dst, \text{double } src);
\]

\[
\text{float } \_\text{copysignf}( \text{float } dst, \text{float } src);
\]

Copy the sign of a source floating-point value to a destination floating-point value.

This function returns the updated floating-point value.

Create infinity value

\[
\text{double } \_\text{inf}( \text{void });
\]

\[
\text{float } \_\text{inff}( \text{void });
\]

Create a floating-point infinity value.

This function returns the floating-point infinity value.

Create NaN value

\[
\text{double } \_\text{nan}( \text{void });
\]

\[
\text{float } \_\text{nanf}( \text{void });
\]

Create a floating-point NaN value.

This function returns the floating-point NaN value.
1.7.7. Miscellaneous

Execute the NOP Instruction

```c
void volatile __nop( void );
```

Execute the NOP instruction.

This function returns nothing.

1.8. Section Naming

By default the compiler generates section names that start with a dot (‘.’) and a section name prefix, extended with the module name and the name of the symbol that is allocated in the section. Each component is separated by a dot (‘.’):

```
.prefix.module-name.symbol-name
```

You can rename sections with a pragma or with a command line option. The syntax is the same:

```
--rename-sections=[[prefix=[|all=]|format_string]],...
```

```
#pragma section [[prefix=[|all=]|format_string]],...
```

With the `prefix` argument you select which sections are renamed. When the prefix of a section matches, the section name will get the specified `format_string` as suffix.

You can specify the following section name prefixes:

<table>
<thead>
<tr>
<th>Section prefix</th>
<th>Description</th>
<th>Implicit section type</th>
</tr>
</thead>
<tbody>
<tr>
<td>mctest</td>
<td>program code</td>
<td>CODE</td>
</tr>
<tr>
<td>mcsdata</td>
<td>initialized data</td>
<td>DATA</td>
</tr>
<tr>
<td>mcsbss</td>
<td>uninitialized data (cleared)</td>
<td>DATA</td>
</tr>
</tbody>
</table>

When you omit the section prefix or use "all", all sections will be renamed.

With the `format_string` you specify the string that extends the ELF section name. The format string can contain characters and may contain the following format specifiers:

- `{attrib}`: Expands to the section attributes, separated by underscores. The cluster attribute, used when debug information is enabled, is not included.
- `{module}`: Expands to the basename of the module name.
- `{name}`: Expands to the object name, name of variable or function.

In format specifier expansions (for example, a module name with an extra dot), dots (‘.’) are replaced by dollars (‘$’).
When you omit the format string, a section will have a name that consist of a dot (\'.\') and the section prefix only.

Note that \#pragma section mcstext=code,,mcsdata=special will give all sections a name consisting of just the section prefix, except for mcsdata sections, which will be named ".mcsdata.special". The reason for this is that the double comma is interpreted as: --rename-sections or \#pragma section, without arguments:

\#pragma section mcstext=code,,mcsdata=special

is the same as:

\#pragma section mcstext=code
\#pragma section
\#pragma section mcsdata=special

With \#pragma endsection the naming convention of the previous level is restored, while with \#pragma section default the default section naming convention is restored. Nesting of pragma section/endsection pairs will save the status of the previous level.

**Example**

The following example (file test.c) sets a default naming scheme for all sections, and then specializes the names for some sections.

\#pragma section all=other.{name},mcsbss=region1.{name}
\#pragma section mcstext=task1.{name}

int var1; /* .mcsbss.region1.var1 */

\#pragma section mcsbss={module}
/* assign module name to .mcsbss sections */
int var2; /* .mcsbss.test */

void f1( void ) /* .mcstext.task1.f1 */
{
    return;
}

void f2( void ) /* .mcstext.task1.f2 */
{
    return;
}

\#pragma endsection /* pop last \#pragma section from stack */

int var3; /* .mcsbss.region1.var3 */
const int c = 3; /* .mcsdata.other.c */
int s1 = 5; /* .mcsdata.other.s1 */
This example generates the following code:

```c
.sdecl '.mcstext.task1.f1'
.sect '.mcstext.task1.f1'
.global f1
; Function f1
.align 4
f1: .type func
    ret
; End of function
    .size  f1, *-f1
; End of section

.sdecl '.mcstext.task1.f2'
.sect '.mcstext.task1.f2'
.global f2
; Function f2
.align 4
f2: .type func
    ret
; End of function
    .size  f2, *-f2
; End of section

.sdecl '.mcsbss.region1.var1'
.sect '.mcsbss.region1.var1'
.global var1
.align 4
.size  var1, 4
var1: .type object
    .space 1
; End of section

.sdecl '.mcsbss.test'
.sect '.mcsbss.test'
.global var2
.align 4
.size  var2, 4
var2: .type object
    .space 1
; End of section

.sdecl '.mcsbss.region1.var3'
.sect '.mcsbss.region1.var3'
.global var3
.align 4
.size  var3, 4
var3: .type object
    .space 1
; End of section
```
.sdecl '.mcsdata.other.c'
.sect '.mcsdata.other.c'
.global c
.align 4
.size c, 4
.c: .type object
.word 3
; End of section

.sdecl '.mcsdata.other.s1'
.sect '.mcsdata.other.s1'
.global s1
.align 4
.size s1, 4
.s1: .type object
.word 5
; End of section
Chapter 2. Assembly Language

This chapter describes the most important aspects of the TASKING assembly language for the Multi Channel Sequencer (MCS).

For a complete overview of the MCS v1 core, refer to the Generic Timer Module (GTM) chapter in the AURIX TC27x 32-Bit Single-Chip Microcontroller Target Specification [V3.0, 2011-12, Infineon].

2.1. Assembly Syntax

An assembly program consists of statements. A statement may optionally be followed by a comment. Any source statement can be extended to more lines by including the line continuation character (\) as the last character on the line. The length of a source statement (first line and continuation lines) is only limited by the amount of available memory.

Mnemonics, directives and other keywords are case insensitive. Labels, symbols, directive arguments, and literal strings are case sensitive.

The syntax of an assembly statement is:

[label[:]] [instruction | directive | macro_call] [; comment]

label

A label is a special symbol which is assigned the value and type of the current program location counter. A label can consist of letters, digits and underscore characters (_). The first character cannot be a digit. The label can also be a number. A label which is prefixed by whitespace (spaces or tabs) has to be followed by a colon (:). The size of an identifier is only limited by the amount of available memory.

number is a number ranging from 1 to 255. This type of label is called a numeric label or local label. To refer to a numeric label, you must put an n (next) or p (previous) immediately after the label. This is required because the same label number may be used repeatedly.

Examples:

LAB1:   ; This label is followed by a colon and ; can be prefixed by whitespace
LAB1   ; This label has to start at the beginning ; of a line
1: jmp lp  ; This is an endless loop ; using numeric labels
instruction

An instruction consists of a mnemonic and zero, one or more operands. It must not start in the first column.

Operands are described in Section 2.3, Operands of an Assembly Instruction. The instructions are described in the Target Specification Manual.

The instruction can also be a so-called ‘generic instruction’. Generic instructions are pseudo instructions (no instructions from the instruction set). Depending on the situation in which a generic instruction is used, the assembler replaces the generic instruction with appropriate real assembly instruction(s). For a complete list, see Section 2.11, Generic Instructions.

directive

With directives you can control the assembler from within the assembly source. Except for preprocessing directives, these must not start in the first column. Directives are described in Section 2.9, Assembler Directives and Controls.

macro_call

A call to a previously defined macro. It must not start in the first column. See Section 2.10, Macro Operations.

comment

Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.

Apart from the assembly statements as described above, you can put a so-called 'control line' in your assembly source file. These lines start with a $ in the first column and alter the default behavior of the assembler.

$control

For more information on controls see Section 2.9, Assembler Directives and Controls.

### 2.2. Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the extended characters from the ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression evaluation are described in Section 2.6.3, Expression Operators. Other special assembler characters are:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>;</td>
<td>Start of a comment</td>
</tr>
<tr>
<td>\</td>
<td>Line continuation character or macro operator: argument concatenation</td>
</tr>
<tr>
<td>?</td>
<td>Macro operator: return decimal value of a symbol</td>
</tr>
<tr>
<td>%</td>
<td>Macro operator: return hex value of a symbol</td>
</tr>
<tr>
<td>^</td>
<td>Macro operator: override local label</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter or quoted string .DEFINE expansion character</td>
</tr>
<tr>
<td>'</td>
<td>String constants delimiter</td>
</tr>
</tbody>
</table>
2.3. Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the following types:

<table>
<thead>
<tr>
<th>Operand</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>symbol</td>
<td>A symbolic name as described in Section 2.4, Symbol Names. Symbols can also occur in expressions.</td>
</tr>
<tr>
<td>register</td>
<td>Any valid register as listed in Section 2.5, Registers.</td>
</tr>
<tr>
<td>expression</td>
<td>Any valid expression as described in Section 2.6, Assembly Expressions.</td>
</tr>
<tr>
<td>address</td>
<td>A combination of expression, register and symbol.</td>
</tr>
</tbody>
</table>

Addressing modes

The MCS assembly language has several addressing modes. These addressing modes are used for indirect memory addressing or indirect ARU addressing. For details see the Generic Timer Module (GTM) chapter in the AURIX TC27x 32-Bit Single-Chip Microcontroller Target Specification [V3.0, 2011-12, Infineon].

2.4. Symbol Names

User-defined symbols

A user-defined symbol can consist of letters, digits, dots(.) and underscore characters(_). The first character cannot be a digit. The size of an identifier is only limited by the amount of available memory. The case of these characters is significant. You can define a symbol by means of a label declaration or an equate or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your assembly source to create conditional assembly. See Section 2.4.1, Predefined Preprocessor Symbols.
**Labels**

Symbols used for memory locations are referred to as labels. It is allowed to use reserved symbols as labels as long as the label is followed by a colon.

**Reserved symbols**

Symbol names and other identifiers beginning with a period (.) are reserved for the system (for example for directives or section names). Instructions and registers are also reserved. The case of these built-in symbols is insignificant.

**Examples**

Valid symbol names:

- `loop_1`
- `ENTRY`
- `a_B_c`
- `_aBC`

Invalid symbol names:

- `1_loop ; starts with a number`
- `r1 ; reserved register name`
- `.DEFINE ; reserved directive name`

**2.4.1. Predefined Preprocessor Symbols**

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are useful to create conditional assembly.

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>ASMCS</strong></td>
<td>Identifies the assembler. You can use this symbol to flag parts of the source which must be recognized by the <code>asmcs</code> assembler only. It expands to 1.</td>
</tr>
<tr>
<td><strong>BUILD</strong></td>
<td>Identifies the build number of the assembler, composed of decimal digits for the build number, three digits for the major branch number and three digits for the minor branch number. For example, if you use build 1.22.1 of the assembler, <strong>BUILD</strong> expands to 1022001. If there is no branch number, the branch digits expand to zero. For example, build 127 results in 12700000.</td>
</tr>
<tr>
<td><strong>REVISION</strong></td>
<td>Expands to the revision number of the assembler. Digits are represented as they are; characters (for prototypes, alphas, betas) are represented by -1. Examples: v1.0r1 -&gt; 1, v1.0rb -&gt; -1</td>
</tr>
<tr>
<td><strong>TASKING</strong></td>
<td>Identifies the assembler as a TASKING assembler. Expands to 1 if a TASKING assembler is used.</td>
</tr>
<tr>
<td><strong>VERSION</strong></td>
<td>Identifies the version number of the assembler. For example, if you use version 2.1r1 of the assembler, <strong>VERSION</strong> expands to 2001 (dot and revision number are omitted, minor version number in 3 digits).</td>
</tr>
</tbody>
</table>
Example

```
.if @defined('__ASMCS__')
  ; this part is only for the asmcs assembler
...
.endif
```

2.5. Registers

The following register names, either uppercase or lowercase, should not be used for user-defined symbol names in an assembly language source file:

R0 .. R7  (general purpose registers)
STA        (status register)
ACB        (ARU control bit register)
CTRG       (clear trigger bits register)
STRG       (set trigger bits register)
TBU_TS0    (TBU timestamp TS0 register)
TBU_TS1    (TBU timestamp TS1 register)
TBU_TS2    (TBU timestamp TS2 register)
MHB        (memory high byte register)

The extended register set is the same set of registers as above, plus:

RS0 .. RS7  (mirror of general purpose registers R0 .. R7)
DSTA        (DPLL status register)
GMI0        (GTM Module Interrupt 0 register)
GMI1        (GTM Module Interrupt 1 register)

The extended register set is disabled by default. Note that the extended registers use the next MCS channel. You can enable the extended register set with assembler option `--extended-registers`.

2.6. Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a value that is used as an operand of an assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer or floating-point values), and any combination of integers, floating-point numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where the result is unknown until all sections have been combined and located, are called relocatable or relative expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable expressions are emitted in the object file and evaluated by the linker. Relocatable expressions can only
contain integral functions; floating-point functions and numbers are not supported by the ELF/DWARF object format.

The assembler evaluates expressions with 64-bit precision in two's complement.

The syntax of an expression can be any of the following:

- numeric constant
- string
- symbol
- expression binary_operator expression
- unary_operator expression
- (expression)
- function call

All types of expressions are explained in separate sections.

### 2.6.1. Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes the number is a decimal number. Prefixes can be used in either lowercase or uppercase.

<table>
<thead>
<tr>
<th>Base</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary</td>
<td>A 0b or 0B prefix followed by binary digits (0,1).</td>
<td>0B1101</td>
</tr>
<tr>
<td>Hexadecimal</td>
<td>A 0x or 0X prefix followed by hexadecimal digits (0-9, A-F, a-f).</td>
<td>0X12FF</td>
</tr>
<tr>
<td>Decimal integer</td>
<td>Decimal digits (0-9).</td>
<td>12</td>
</tr>
</tbody>
</table>

### 2.6.2. Strings

ASCII characters, enclosed in single (') or double (") quotes constitute an ASCII string. Strings between double quotes allow symbol substitution by a .DEFINE directive, whereas strings between single quotes are always literal strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII value). Strings in expressions can have a size of up to 4 characters or less depending on the operand of an instruction or directive; any subsequent characters in the string are ignored. In this case the assembler issues a warning. Null strings have a value of 0.
Square brackets ([ ]) delimit a substring operation in the form:

\[ [\text{string, offset, length}] \]

_offset_ is the start position within string. _length_ is the length of the desired substring. Both values may not exceed the size of string.

**Examples**

'ABCD' ; (0x41424344)
''79' ; to enclose a quote double it
"A""BC" ; or to enclose a quote escape it
'AB'+1 ; (0x4143) string used in expression
'' ; null string
.word 'abcdef' ; (0x64636261) 'ef' are ignored
'' ; warning: string value truncated
'abc'++'de' ; you can concatenate
 ; two strings with the '++' operator.
 ; This results in 'abcde'
['TASKING',0,4] ; results in the substring 'TASK'

**2.6.3. Expression Operators**

The next table shows the assembler operators. They are ordered according to their precedence. Operators of the same precedence are evaluated left to right. Parenthetical expressions have the highest priority (innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.

Most assembler operators can be used with both integer and floating-point values. If one operand has an integer value and the other operand has a floating-point value, the integer is converted to a floating-point value before the operator is applied. The result is a floating-point value.

<table>
<thead>
<tr>
<th>Type</th>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>()</td>
<td>( )</td>
<td>parenthesis</td>
<td>Expressions enclosed by parenthesis are evaluated first.</td>
</tr>
<tr>
<td>Unary</td>
<td>+</td>
<td>plus</td>
<td>Returns the value of its operand.</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>minus</td>
<td>Returns the negative of its operand.</td>
</tr>
<tr>
<td></td>
<td>~</td>
<td>one's complement</td>
<td>Integer only. Returns the one's complement of its operand. It cannot be used with a floating-point operand.</td>
</tr>
<tr>
<td></td>
<td>!</td>
<td>logical negate</td>
<td>Returns 1 if the operands' value is 0; otherwise 0. For example, if <em>buf</em> is 0 then !<em>buf</em> is 1. If <em>buf</em> has a value of 1000 then !<em>buf</em> is 0.</td>
</tr>
<tr>
<td>Arithmetic</td>
<td>*</td>
<td>multiplication</td>
<td>Yields the product of its operands.</td>
</tr>
<tr>
<td></td>
<td>/</td>
<td>division</td>
<td>Yields the quotient of the division of the first operand by the second. For integer operands, the divide operation produces a truncated integer result.</td>
</tr>
<tr>
<td>Type</td>
<td>Operator</td>
<td>Name</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>----------</td>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Description</td>
<td>%</td>
<td>modulo</td>
<td>Integer only. This operator yields the remainder from the division of the first operand by the second.</td>
</tr>
<tr>
<td></td>
<td>+</td>
<td>addition</td>
<td>Yields the sum of its operands.</td>
</tr>
<tr>
<td></td>
<td>-</td>
<td>subtraction</td>
<td>Yields the difference of its operands.</td>
</tr>
<tr>
<td>Shift</td>
<td>&lt;&lt;</td>
<td>shift left</td>
<td>Integer only. Causes the left operand to be shifted to the left (and zero-filled) by the number of bits specified by the right operand.</td>
</tr>
<tr>
<td></td>
<td>&gt;&gt;</td>
<td>shift right</td>
<td>Integer only. Causes the left operand to be shifted to the right by the number of bits specified by the right operand. The sign bit will be extended.</td>
</tr>
<tr>
<td>Relational</td>
<td>&lt;</td>
<td>less than</td>
<td>Returns an integer 1 if the indicated condition is TRUE or an integer 0 if the indicated condition is FALSE.</td>
</tr>
<tr>
<td></td>
<td>&lt;=</td>
<td>less than or equal</td>
<td>For example, if D has a value of 3 and E has a value of 5, then the result of the expression D&lt;E is 1, and the result of the expression D&gt;E is 0.</td>
</tr>
<tr>
<td></td>
<td>&gt;</td>
<td>greater than</td>
<td></td>
</tr>
<tr>
<td></td>
<td>&gt;=</td>
<td>greater than or equal</td>
<td></td>
</tr>
<tr>
<td></td>
<td>==</td>
<td>equal</td>
<td>Use tests for equality involving floating-point values with caution, since rounding errors could cause unexpected results.</td>
</tr>
<tr>
<td></td>
<td>!=</td>
<td>not equal</td>
<td></td>
</tr>
<tr>
<td>Bit and</td>
<td>&amp;</td>
<td>AND</td>
<td>Integer only. Yields the bitwise AND function of its operand.</td>
</tr>
<tr>
<td>Bitwise</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OR</td>
</tr>
<tr>
<td></td>
<td>^</td>
<td>exclusive OR</td>
<td>Integer only. Yields the bitwise exclusive OR function of its operands.</td>
</tr>
<tr>
<td>Logical</td>
<td>&amp;&amp;</td>
<td>logical AND</td>
<td>Returns an integer 1 if both operands are non-zero; otherwise, it returns an integer 0.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The relational operators and logical operators are intended primarily for use with the conditional assembly .if directive, but can be used in any expression.

2.7. Working with Sections

Sections are absolute or relocatable blocks of contiguous memory that can contain code or data. Some sections contain code or data that your program declared and uses directly, while other sections are created by the linker and contain debug information or code or data to initialize your application. These sections can be named in such a way that different modules can implement different parts of these sections. These sections are located in memory by the linker (using the linker script language, LSL) so that concerns about memory placement are postponed until after the assembly process.
All instructions and directives which generate data or code must be within an active section. The assembler emits a warning if code or data starts without a section definition and activation. If you program in assembly you have to define sections yourself.

For more information about locating sections see Section 5.7.9, The Section Layout Definition: Locating Sections.

Section definition

Sections are defined with the .SDECL directive and have a name. A section may have attributes to instruct the linker to place it on a predefined starting address.

```
.SDECL "name"[, type][, attribute ]... [AT address]
```

The *name* specifies the name of the section. Section names that start with a dot '.' and a predefined section name prefix have a special meaning to the locating process. Optionally, you can extend the section names with a dot '.' and a user defined name. You can specify the following section name prefixes:

<table>
<thead>
<tr>
<th>Section prefix</th>
<th>Description</th>
<th>Implicit section type</th>
</tr>
</thead>
<tbody>
<tr>
<td>mctest</td>
<td>program code</td>
<td>CODE</td>
</tr>
<tr>
<td>mcsdata</td>
<td>initialized data</td>
<td>DATA</td>
</tr>
<tr>
<td>mcsbss</td>
<td>uninitialized data (cleared)</td>
<td>DATA</td>
</tr>
</tbody>
</table>

See the description of the .SDECL directive for a complete description of all possible attributes.

Section activation

Sections are defined once and are activated with the .SECT directive.

```
.SECT "name"
```

The linker will check between different modules and emits an error message if the section attributes do not match. The linker will also concatenate all matching section definitions into one section. So, all "code" sections will be linked into one big "code" chunk which will be located in one piece. A .SECT directive referring to an earlier defined section is called a *continuation*. Only the name can be specified.

Examples

```
.SDECL  ".mctest.code"
.SECT   ".mctest.code"
```

Defines and activates a relocatable section in CODE memory. Other parts of this section, with the same name, may be defined in the same module or any other module. Other modules should use the same .SDECL statement. When necessary, it is possible to give the section an absolute starting address.

```
.SDECL  ".mcsdata.abs", data at 0x100
.SECT   ".mcsdata.abs"
```

Defines and activates an absolute section named .mcsdata.abs starting at address 0x100.
2.8. Built-in Assembly Functions

The TASKING assembler has several built-in functions to support string comparison and macro testing. You can use functions as terms in any expression.

Syntax of an assembly function

@function_name([argument[,argument]...])

Functions start with the '@' character and have zero or more arguments, and are always followed by opening and closing parentheses. White space (a blank or tab) is not allowed between the function name and the opening parenthesis and between the (comma-separated) arguments.

The names of assembly functions are case insensitive.

Overview of mathematical functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@SGN(expr)</td>
<td>Returns the sign of an expression as -1, 0 or 1</td>
</tr>
</tbody>
</table>

Overview of conversion functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@RVB(expr[, exprN])</td>
<td>Reverse order of bits in field</td>
</tr>
</tbody>
</table>

Overview of string functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@CAT(str1, str2)</td>
<td>Concatenate str1 and str2</td>
</tr>
<tr>
<td>@LEN(string)</td>
<td>Length of string</td>
</tr>
<tr>
<td>@POS(str1, str2[, start])</td>
<td>Position of str2 in str1</td>
</tr>
<tr>
<td>@SCP(str1, str2)</td>
<td>Compare str1 with str2</td>
</tr>
<tr>
<td>@SUB(str, expr1, expr2)</td>
<td>Return substring</td>
</tr>
</tbody>
</table>

Overview of macro functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@ARG('symbol'</td>
<td>expr)</td>
</tr>
<tr>
<td>@CNT()</td>
<td>Return number of macro arguments</td>
</tr>
<tr>
<td>@MAC(symbol)</td>
<td>Test if macro is defined</td>
</tr>
<tr>
<td>@MXP()</td>
<td>Test if macro expansion is active</td>
</tr>
</tbody>
</table>
Overview of address calculation functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@LSB(expr)</td>
<td>Least significant 8 bits of the expression</td>
</tr>
<tr>
<td>@MSB(expr)</td>
<td>Most significant 8 bits of the expression</td>
</tr>
</tbody>
</table>

Overview of assembler mode functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>@BIGENDIAN()</td>
<td>Test if assembler generates code for big-endian mode</td>
</tr>
<tr>
<td>@DEF('symbol'</td>
<td>symbol)</td>
</tr>
<tr>
<td>@EXP(expr)</td>
<td>Expression check</td>
</tr>
<tr>
<td>@INT(expr)</td>
<td>Integer check</td>
</tr>
<tr>
<td>@LST()</td>
<td>LIST control flag value</td>
</tr>
</tbody>
</table>

Detailed Description of Built-in Assembly Functions

@ARG('symbol' | expression)

Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the name of a macro argument enclosed in single quotes) or with expression (the ordinal number of the argument in the macro formal argument list). If you use this function when macro expansion is not active, the assembler issues a warning.

Example:

```
.IF @ARG('TWIDDLE') ;is argument twiddle present?
.IF @ARG(1)         ;is first argument present?
```

@BIGENDIAN()

Returns 1 if the assembler generates code for big-endian mode, returns 0 if the assembler generates code for little-endian mode (this is the default).

@CAT(string1,string2)

Concatenates the two strings into one string. The two strings must be enclosed in single or double quotes.

Example:

```
.DEFNE ID "@CAT('TASK','ING')"  ;ID = 'TASKING'
```
@CNT()

Returns the number of macro arguments of the current macro expansion as an integer. If you use this function when macro expansion is not active, the assembler issues a warning.

Example:

ARGCOUNT .SET @CNT() ; reserve argument count

@DEF('symbol | symbol)

Returns 1 if symbol has been defined, 0 otherwise. symbol can be any symbol or label not associated with a .MACRO or .SDECL directive. If symbol is quoted, it is looked up as a .DEFINE symbol; if it is not quoted, it is looked up as an ordinary symbol or label.

Example:

.if @DEFINED('ANGLE') ;is symbol ANGLE defined?
.if @DEFINED(ANGLE) ;does label ANGLE exist?

@EXP(expression)

Returns 0 if the evaluation of expression would normally result in an error. Returns 1 if the expression can be evaluated correctly. With the @EXP function, you prevent the assembler from generating an error if the expression contains an error. No test is made by the assembler for warnings. The expression may be relative or absolute.

Example:

.if !@EXP(3/0) ;Do the IF on error
    ;assembler generates no error
.if !(3/0) ;assembler generates an error

@INT(expression)

Returns integer 1 if expression has an integer result; otherwise, it returns a 0. The expression may be relative or absolute.

Example:

.if @INT(TERM) ;Test if result is an integer

@LEN(string)

Returns the length of string as an integer.

Example:

SLEN .SET @LEN('string') ;SLEN = 6
@LSB(expression)

Returns the least significant 8 bits of the result of the expression. The result of the expression is calculated as 16 bit.

Example:

VAR1 .SET @LSB(0x34) ;VAR1 = 0x34
VAR2 .SET @LSB(0x1234) ;VAR2 = 0x34
VAR3 .SET @LSB(0x654321) ;VAR3 = 0x21

@LST()

Returns the value of the $LIST ON/OFF control flag as an integer. Whenever a $LIST ON control is encountered in the assembler source, the flag is incremented; when a $LIST OFF control is encountered, the flag is decremented.

Example:

.DUP @ABS(@LST()) ;list unconditionally

@MAC(symbol)

Returns integer 1 if symbol has been defined as a macro name, 0 otherwise.

Example:

.IF @MAC(DOMUL) ;does macro DOMUL exist?

@MSB(expression)

Returns the most significant 8 bits of the result of the expression. The result of the expression is calculated as 16 bit.

Example:

VAR1 .SET @MSB(0x34) ;VAR1 = 0x00
VAR2 .SET @MSB(0x1234) ;VAR2 = 0x12
VAR3 .SET @MSB(0x654321) ;VAR3 = 0x43

@MXP()

Returns integer 1 if the assembler is expanding a macro, 0 otherwise.

Example:

.IF @MXP() ;macro expansion active?
@POS(string1,string2[,start])

Returns the position of string2 in string1 as an integer. If string2 does not occur in string1, the last string position + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is started from the beginning of string1. Note that the first position in a string is position 0.

Example:

ID1 .EQU @POS('TASKING','ASK') ; ID1 = 1
ID2 .EQU @POS('ABCDABCD','B',2) ; ID2 = 5
ID3 .EQU @POS('TASKING','BUG') ; ID3 = 7

@RVB(expression1,expression2)

Reverse the order of bits in expression1 delimited by the number of bits in expression2. If expression2 is omitted the field is bounded by the target word size. Both expressions must be 16-bit integer values.

Example:

VAR1 .SET @RVB(0x200) ; reverse all bits, VAR1=0x40
VAR2 .SET @RVB(0xB02) ; reverse all bits, VAR2=0x40D0
VAR3 .SET @RVB(0xB02,2) ; reverse bits 0 and 1,
               ; VAR3=0xB01

@SCP(string1,string2)

Returns integer 1 if the two strings compare, 0 otherwise. The two strings must be separated by a comma.

Example:

.IF @SCP(STR,'MAIN') ; does STR equal 'MAIN'? 

@SGN(expression)

Returns the sign of expression as an integer: -1 if the argument is negative, 0 if zero, 1 if positive. The expression may be relative or absolute.

Example:

VAR1 .SET @SGN(-1.2e-92) ; VAR1 = -1
VAR2 .SET @SGN(0) ; VAR2 = 0
VAR3 .SET @SGN(28.382) ; VAR3 = 1

@SUB(string,expression1,expression2)

Returns the substring from string as a string. expression1 is the starting position within string, and expression2 is the length of the desired string. The assembler issues an error if either expression1 or expression2 exceeds the length of string. Note that the first position in a string is position 0.
Example:

```
.DEFINITE ID "@SUB('TASKING',3,4)" ;ID = 'KING'
```

### 2.9. Assembler Directives and Controls

An assembler directive is simply a message to the assembler. Assembler directives are not translated into machine instructions. There are three main groups of assembler directives.

- Assembler directives that tell the assembler how to go about translating instructions into machine code. This is the most typical form of assembly directives. Typically they tell the assembler where to put a program in memory, what space to allocate for variables, and allow you to initialize memory with data. When the assembly source is assembled, a location counter in the assembler keeps track of where the code and data is to go in memory.

  The following directives fall under this group:
  
  - Assembly control directives
  - Symbol definition and section directives
  - Data definition / Storage allocation directives
  - High Level Language (HLL) directives

- Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor how to manipulate your assembly code before it is actually being assembled. You can use these directives to write macros and to write conditional source code. Parts of the code that do not match the condition, will not be assembled at all.

  Some directives act as assembler options and most of them indeed do have an equivalent assembler (command line) option. The advantage of using a directive is that with such a directive you can overrule the assembler option for a particular part of the code. Directives of this kind are called **controls**. A typical example is to tell the assembler with an option to generate a list file while with the controls `$LIST ON` and `$LIST OFF` you overrule this option for a part of the code that you do not want to appear in the list file. Controls always appear on a separate line and start with a `$` sign in the first column.

  The following controls are available:
  
  - Assembly listing controls
  - Miscellaneous controls

Each assembler directive or control has its own syntax. You can use assembler directives and controls in the assembly code as pseudo instructions.

Some assembler directives can be preceded with a label. If you do not precede an assembler directive with a label, you must use white space instead (spaces or tabs). The assembler recognizes both uppercase and lowercase for directives.
### 2.9.1. Assembler Directives

#### Overview of assembly control directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.COMMENT</td>
<td>Start comment lines. You cannot use this directive in .IF/.ELSE/.ENDIF constructs and .MACRO/.DUP definitions.</td>
</tr>
<tr>
<td>.END</td>
<td>Indicates the end of an assembly module</td>
</tr>
<tr>
<td>.FAIL</td>
<td>Programmer generated error message</td>
</tr>
<tr>
<td>.INCLUDE</td>
<td>Include file</td>
</tr>
<tr>
<td>.MESSAGE</td>
<td>Programmer generated message</td>
</tr>
<tr>
<td>.WARNING</td>
<td>Programmer generated warning message</td>
</tr>
</tbody>
</table>

#### Overview of symbol definition and section directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ALIAS</td>
<td>Create an alias for a symbol</td>
</tr>
<tr>
<td>.EQU</td>
<td>Set permanent value to a symbol</td>
</tr>
<tr>
<td>.EXTERN</td>
<td>Import global section symbol</td>
</tr>
<tr>
<td>.GLOBAL</td>
<td>Declare global section symbol</td>
</tr>
<tr>
<td>.LOCAL</td>
<td>Declare local section symbol</td>
</tr>
<tr>
<td>.ORG</td>
<td>Initialize memory space and location counters to create a nameless section</td>
</tr>
<tr>
<td>.SDECL</td>
<td>Declare a section with name, type and attributes</td>
</tr>
<tr>
<td>.SECT</td>
<td>Activate a declared section</td>
</tr>
<tr>
<td>.SET</td>
<td>Set temporary value to a symbol</td>
</tr>
<tr>
<td>.SIZE</td>
<td>Set size of symbol in the ELF symbol table</td>
</tr>
<tr>
<td>.TYPE</td>
<td>Set symbol type in the ELF symbol table</td>
</tr>
<tr>
<td>.WEAK</td>
<td>Mark a symbol as 'weak'</td>
</tr>
</tbody>
</table>

#### Overview of data definition / storage allocation directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.ALIGN</td>
<td>Align location counter</td>
</tr>
<tr>
<td>.ASCII, .ASCIIZ</td>
<td>Define ASCII string without / with ending NULL byte</td>
</tr>
<tr>
<td>.SPACE</td>
<td>Define storage (32 bits)</td>
</tr>
<tr>
<td>.WORD</td>
<td>Define word (32 bits)</td>
</tr>
</tbody>
</table>
# Overview of macro preprocessor directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DEFINE</td>
<td>Define substitution string</td>
</tr>
<tr>
<td>.DUP, .ENDM</td>
<td>Duplicate sequence of source lines</td>
</tr>
<tr>
<td>.DUPA, .ENDM</td>
<td>Duplicate sequence with arguments</td>
</tr>
<tr>
<td>.DUPC, .ENDM</td>
<td>Duplicate sequence with characters</td>
</tr>
<tr>
<td>.DUPF, .ENDM</td>
<td>Duplicate sequence in loop</td>
</tr>
<tr>
<td>.IF, .ELIF, .ELSE</td>
<td>Conditional assembly directive</td>
</tr>
<tr>
<td>.ENDIF</td>
<td>End of conditional assembly directive</td>
</tr>
<tr>
<td>.EXITM</td>
<td>Exit macro</td>
</tr>
<tr>
<td>.MACRO, .ENDM</td>
<td>Define macro</td>
</tr>
<tr>
<td>.PMACRO</td>
<td>Undefine (purge) macro</td>
</tr>
<tr>
<td>.UNDEF</td>
<td>Undefine .DEFINE symbol</td>
</tr>
</tbody>
</table>

# Overview of HLL directives

<table>
<thead>
<tr>
<th>Directive</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.CALLS</td>
<td>Pass call tree information and/or stack usage information</td>
</tr>
<tr>
<td>.COMPILER_INVOCATION</td>
<td>Pass C compiler invocation</td>
</tr>
<tr>
<td>.COMPILER_NAME</td>
<td>Pass C compiler name</td>
</tr>
<tr>
<td>.COMPILER_VERSION</td>
<td>Pass C compiler version header</td>
</tr>
<tr>
<td>.MISRAC</td>
<td>Pass MISRA C information</td>
</tr>
</tbody>
</table>
.ALIAS

Syntax

alias-name .ALIAS symbol-name

Description

With the .ALIAS directive you can create an alias of a symbol. The C compiler generates this directive when you use the #pragma alias.

Example

_exit .ALIAS _Exit
.ALIGN

Syntax

.ALIGN expression

Description

With the .ALIGN directive you instruct the assembler to align the location counter. By default the assembler aligns on four bytes.

When the assembler encounters the .ALIGN directive, it advances the location counter to an address that is aligned as specified by expression and places the next instruction or directive on that address. The alignment is in minimal addressable units (MAUs). The assembler fills the 'gap' with NOP instructions for code sections or with zeros for data sections. If the location counter is already aligned on the specified alignment, it remains unchanged. The location of absolute sections will not be changed.

The expression must be a power of two: 4, 8, 16, ... If you specify another value, the assembler changes the alignment to the next higher power of two and issues a warning.

The assembler aligns sections automatically to the largest alignment value occurring in that section.

A label is not allowed before this directive.

Example

.sdecl '.mcstext.code',code
.sect '.mcstext.code'
.ALIGN 16 ; the assembler aligns instruction ; this instruction at 16 MAUs and ; fills the 'gap' with NOP instructions.

.sdecl '.mcstext.code',code
.sect '.mcstext.code'
.ALIGN 12 ; WRONG: not a power of two, the instruction ; assembler aligns this instruction at ; 16 MAUs and issues a warning.
.ASCII, .ASCIIZ

Syntax

[label:] .ASCII  string[,string]...

[label:] .ASCIIZ string[,string]...

Description

With the .ASCII or .ASCIIZ directive the assembler allocates and initializes memory for each string argument. The last word will be padded with 0x00. Use commas to separate multiple strings.

There is only a difference between .ASCII and .ASCIIZ when the string has a size that is a multiple of four characters. In that case the .ASCIIZ directive adds a word with all zeros. The "z" in .ASCIIZ stands for "zero"

Example

STRING:  .ASCII  "Hello world"  ; = 0x48656C6C
         ;   0x6F20776F
         ;   0x726C6400
STRINGZ: .ASCIIZ "Hello world"  ; = 0x48656C6C
          ;   0x6F20776F
          ;   0x726C6400
STR4:    .ASCII  "Four"          ; = 0x466F7572
STR8:    .ASCIIZ "Four"          ; = 0x466F7572
         ;   0x00000000

Related Information

.SPACE (Define Storage)
.CALLS

Syntax

.CALLS 'caller','callee'

or

.CALLS 'caller','','stack_usage[, ...]

Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information to build a call graph. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the stack usage of the function itself. The value specified is the stack usage in bytes at the time of the call including the return address. A function can use multiple stacks.

This information is used by the linker to compute the used stack within the application. The information is found in the generated linker map file within the Memory Usage.

This directive is generated by the C compiler. Normally you will not use it in hand-coded assembly.

A label is not allowed before this directive.

Example

.CALLS 'main','nfunc'

Indicates that the function main calls the function nfunc.

.CALLS 'main','','8

The function main uses 8 bytes on the stack.
.COMMENT

Syntax

.COMMENT  delimiter
.
.
delimiter

Description

With the .COMMENT directive you can define one or more lines as comments. The first non-blank character after the .COMMENT directive is the comment delimiter. The two delimiters are used to define the comment text. The line containing the second comment delimiter will be considered the last line of the comment. The comment text can include any printable characters and the comment text will be produced in the source listing as it appears in the source file.

A label is not allowed before this directive.

Example

.COMMENT  + This is a one line comment +
.COMMENT  * This is a multiple line comment. Any number of lines can be placed between the two delimiters.
.*
The C compiler generates information about itself and the invocation at the start of the assembly source. This way you can always see how the assembly source file was generated. When you assemble the source file, this information will appear in .note sections in the object file.

A label is not allowed before these directives.

Example

```
.COMPILER_VERSION "TASKING VX-toolset for MCS: C compiler vx.yrz Build 999"
.COMPILER_INVOCATION "cmcs test.c"
.COMPILER_NAME "cmcs"
```

.DEFINE

Syntax

.DEFINEd symbol  string

Description

With the .DEFINE directive you define a substitution string that you can use on all following source lines. The assembler searches all succeeding lines for an occurrence of symbol, and replaces it with string. If the symbol occurs in a double quoted string it is also replaced. Strings between single quotes are not expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist of letters, digits and underscore characters (_), and the first character cannot be a digit.

Macros represent a special case. .DEFINE directive translations will be applied to the macro definition as it is encountered. When the macro is expanded, any active .DEFINE directive translations will again be applied.

The assembler issues a warning if you redefine an existing symbol.

A label is not allowed before this directive.

Example

Suppose you defined the symbol LEN with the substitution string "32":

.DEFINED LEN "32"

Then you can use the symbol LEN for example as follows:

.SPACE LEN
.WESTERN "The length is: LEN"

The assembler preprocessor replaces LEN with "32" and assembles the following lines:

.SPACE 32
.WESTERN "The length is: 32"

Related Information

.UNDEF (Undefine a .DEFINE symbol)

.MACRO, .ENDM (Define a macro)
.DUP, .ENDM

Syntax

[label:] .DUP expression
....
. ENDM

Description

With the .DUP/.ENM directive you can duplicate a sequence of assembly source lines. With expression you specify the number of duplications. If the expression evaluates to a number less than or equal to 0, the sequence of lines will not be included in the assembler output. The expression result must be an absolute integer and cannot contain any forward references (symbols that have not already been defined). The .DUP directive may be nested to any level.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In this example the loop is repeated three times. Effectively, the preprocessor repeats the source lines (.WORD 10) three times, then the assembler assembles the result:

.DUP 3
.WORD 10  ; assembly source lines
.ENDM

Related Information

.DUPA, .ENDM (Duplicate sequence with arguments)
.DUPC, .ENDM (Duplicate sequence with characters)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.DUPA, .ENDM

Syntax

[label:] .DUPA formal_arg, argument[,argument]...
    ....
    .ENDM

Description

With the .DUPA/.ENDM directive you can repeat a block of source statements for each argument. For each repetition, every occurrence of the formal_arg parameter within the block is replaced with each succeeding argument string. If an argument includes an embedded blank or other assembler-significant character, it must be enclosed with single quotes.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

    .DUPA VALUE, 12,, 32, 34
    .WORD VALUE
    .ENDM

This is expanded as follows:

    .WORD 12
    .WORD VALUE ; results in a warning
    .WORD 32
    .WORD 34

The second statement results in a warning of the assembler that the local symbol VALUE is not defined in this module and is made external.

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DUPC, .ENDM (Duplicate sequence with characters)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.DUPC, .ENDM

Syntax

[label:] .DUPC formal_arg,string
    ...
    .ENDM

Description

With the .DUPC/.ENDM directive you can repeat a block of source statements for each character within string. For each character in the string, the formal_arg parameter within the block is replaced with that character. If the string is empty, then the block is skipped.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

    .DUPC  VALUE,'123'
    .WORD  VALUE
    .ENDM

This is expanded as follows:

    .WORD  1
    .WORD  2
    .WORD  3

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DUPA, .ENDM (Duplicate sequence with arguments)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.DUPF, .ENDM

Syntax

[label:] .DUPF formal_arg, [start], end[, increment]
....
 .ENDM

Description

With the .DUPF/.ENDM directive you can repeat a block of source statements \((end - start) + 1 / increment\) times. \(start\) is the starting value for the loop index; \(end\) represents the final value. \(increment\) is the increment for the loop index; it defaults to 1 if omitted (as does the \(start\) value). The \(formal\_arg\) parameter holds the loop index value and may be used within the body of instructions.

If you specify \(label\), it gets the value of the location counter at the start of the directive processing.

Example

Consider the following source input statements,

```
.DUPF NUM, 0, 7
.WORD NUM
.ENDM
```

This is expanded as follows:

```
.WORD 0
.WORD 1
.WORD 2
.WORD 3
.WORD 4
.WORD 5
.WORD 6
.WORD 7
```
Related Information

.DUP, .ENDM (Duplicate sequence of source lines)

.DUPA, .ENDM (Duplicate sequence with arguments)

.DUPC, .ENDM (Duplicate sequence with characters)

.MACRO, .ENDM (Define a macro)
.END

Syntax

.END

Description

With the optional .END directive you tell the assembler that the end of the module is reached. If the assembler finds assembly source lines beyond the .END directive, it ignores those lines and issues a warning.

You cannot use the .END directive in a macro expansion.

The assembler does not allow a label with this directive.

Example

; source lines
.END ; End of assembly module

Related Information

-
.EQU

Syntax

symbol .EQU expression

Description

With the .EQU directive you assign the value of expression to symbol permanently. The expression can be relocatable or absolute and forward references are allowed. Once defined, you cannot redefine the symbol. With the .GLOBAL directive you can declare the symbol global.

Example

To assign the value 0x400 permanently to the symbol MYSYMBOL:

MYSYMBOL .EQU 0x4000

You cannot redefine the symbol MYSYMBOL after this.

Related Information

.SET (Set temporary value to a symbol)
.EXITM

Syntax

.EXITM

Description

With the .EXITM directive the assembler will immediately terminate a macro expansion. It is useful when you use it with the conditional assembly directive .IF to terminate macro expansion when, for example, error conditions are detected.

A label is not allowed before this directive.

Example

CALC .MACRO XVAL, YVAL
 .IF XVAL<0
   .FAIL 'Macro parameter value out of range'
   .EXITM ;; Exit macro
 .ENDIF
 .
 .
 .
 .ENDM

Related Information

.DUP, .ENDM (Duplicate sequence of source lines)
.DUPA, .ENDM (Duplicate sequence with arguments)
.DUPC, .ENDM (Duplicate sequence with characters)
.DUPF, .ENDM (Duplicate sequence in loop)
.MACRO, .ENDM (Define a macro)
.EXTERN

Syntax

.EXTERN symbol[,symbol]...

Description

With the .EXTERN directive you define an external symbol. It means that the specified symbol is referenced in the current module, but is not defined within the current module. This symbol must either have been defined outside of any module or declared as globally accessible within another module with the .GLOBAL directive.

If you do not use the .EXTERN directive and the symbol is not defined within the current module, the assembler issues a warning and inserts the .EXTERN directive.

A label is not allowed with this directive.

Example

.EXTERN AA,CC,DD ; defined elsewhere
.sdecl ".mcstext"
.sect  ".mcstext"

movl R3,AA  ; AA is used here

Related Information

.GLOBAL (Declare global section symbol)

.LOCAL (Declare local section symbol)
.FAIL

Syntax

```plaintext
.FAIL {str|exp},{{str|exp}}...
```

Description

With the .FAIL directive you tell the assembler to print an error message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated error. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The total error count will be incremented as with any other error. The .FAIL directive is for example useful in combination with conditional assembly for exceptional condition checking. The assembly process proceeds normally after the error has been printed.

With this directive the assembler exits with exit code 1 (an error).

A label is not allowed with this directive.

Example

```plaintext
.FAIL 'Parameter out of range'
```

This results in the error:

E143: ["filename" line] Parameter out of range

Related Information

.MESSAGE (Programmer generated message)

.WARNING (Programmer generated warning)
.GLOBAL

Syntax

.GLOBAL symbol[,symbol]...

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default behavior with assembler option --symbol-scope=global.

With the .GLOBAL directive you declare one of more symbols as global. It means that the specified symbols are defined within the current section or module, and that those definitions should be accessible by all modules.

To access a symbol, defined with .GLOBAL, from another module, use the .EXTERN directive.

Only program labels and symbols defined with .EQU can be made global.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

.sdecl  '.mcsdata.data'
.sect   '.mcsdata.data'
.GLOBAL  LOOPA ; LOOPA will be globally accessible by other modules
LOOPA .EQU 1 ; definition of symbol LOOPA

Related Information

.EXTERN (Import global section symbol)

.LOCAL (Declare local section symbol)
.IF, .ELIF, .ELSE, .ENDIF

Syntax

```assembly
.IF  expression
.
.
[.ELIF  expression] ; the .ELIF directive is optional
.
.
[.ELSE] ; the .ELSE directive is optional
.
.
.ENDIF
```

Description

With the .IF/.ENDIF directives you can create a part of conditional assembly code. The assembler assembles only the code that matches a specified condition.

The expression must evaluate to an absolute integer and cannot contain forward references. If expression evaluates to zero, the IF-condition is considered FALSE, any non-zero result of expression is considered as TRUE.

If the optional .ELSE and/or .ELIF directives are not present, then the source statements following the .IF directive and up to the next .ENDIF directive will be included as part of the source file being assembled only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between the .IF and the .ENDIF directives were never encountered.

If the .ELSE directive is present and expression has a nonzero result, then the statements between the .IF and .ELSE directives will be assembled, and the statement between the .ELSE and .ENDIF directives will be skipped. Alternatively, if expression has a value of zero, then the statements between the .IF and .ELSE directives will be skipped, and the statements between the .ELSE and .ENDIF directives will be assembled.

You can nest .IF directives to any level. The .ELSE and .ELIF directive always refer to the nearest previous .IF directive.

A label is not allowed with this directive.

Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and for the final version. Within the assembly source you define this code conditionally as follows:

```assembly
.IF   TEST
    ... ; code for the test version
.ELIF DEMO
    ... ; code for the demo version
.ELSE
```
Before assembling the file you can set the values of the symbols TEST and DEMO in the assembly source before the .IF directive is reached. For example, to assemble the demo version:

TEST .SET 0
DEMO .SET 1

You can also define the symbols on the command line with the assembler option --define (-D):

asmcs --define=DEMO --define=TEST=0 test.asm
.INCLUDE

Syntax

.INCLUDE "filename" | <filename>

Description

With the .INCLUDE directive you include another file at the exact location where the .INCLUDE occurs. This happens before the resulting file is assembled. The .INCLUDE directive works similarly to the #include statement in C. The source from the include file is assembled as if it followed the point of the .INCLUDE directive. When the end of the included file is reached, assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the operating system (forward/backward slashes) and can contain a directory specification.

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified or just a filename, the order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.
   The current directory is not searched if you use the <filename> syntax.
2. The path that is specified with the assembler option --include-directory.
3. The path that is specified in the environment variable ASMCSINC when the product was installed.
4. The default include directory in the installation directory.

The assembler does not allow a label with this directive.

Example

.INCLUDE 'storage\mem.asm' ; include file
.INCLUDE <data.asm>      ; Do not look in
                         ; current directory
.LOCAL

Syntax

.LOCAL symbol[,]...  

Description

All symbols or labels defined in the current section or module are local to the module by default. You can change this default behavior with assembler option --symbol-scope=global.

With the .LOCAL directive you declare one of more symbols as local. It means that the specified symbols are explicitly local to the module in which you define them.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.

The assembler does not allow a label with this directive.

Example

.SDECL  ".mcsdata.data",DATA
.SECT  ".mcsdata.data"
.LOCAL  LOOPA  ; LOOPA is local to this section

LOOPA .WORD   0x100   ; assigns the value 0x100 to LOOPA

Related Information

.EXTERN (Import global section symbol)

.GLOBAL (Declare global section symbol)
.MACRO, .ENDM

Syntax

macro_name .MACRO [argument[,argument]...]
... macro_definition_statements ...
. ENDM

Description

With the .MACRO directive you define a macro. Macros provide a shorthand method for handling a repeated pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the pattern would repeat.

The definition of a macro consists of three parts:

• Header, which assigns a name to the macro and defines the arguments (.MACRO directive).

• Body, which contains the code or instructions to be inserted when the macro is called.

• Terminator, which indicates the end of the macro definition (.ENDM directive).

The arguments are symbolic names that the macro processor replaces with the literal arguments when the macro is expanded (called). Each formal argument must follow the same rules as symbol names: the name can consist of letters, digits and underscore characters (_). The first character cannot be a digit. Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is expanded.

You can use the following operators in macro definition statements:

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>Macro argument concatenation</td>
<td>Concatenates a macro argument with adjacent alphanumeric characters.</td>
</tr>
<tr>
<td>?</td>
<td>Return decimal value of symbol</td>
<td>Substitutes the ?symbol sequence with a character string that represents the decimal value of the symbol.</td>
</tr>
<tr>
<td>%</td>
<td>Return hex value of symbol</td>
<td>Substitutes the %symbol sequence with a character string that represents the hexadecimal value of the symbol.</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter</td>
<td>Allows the use of macro arguments as literal strings.</td>
</tr>
<tr>
<td>^</td>
<td>Macro local label override</td>
<td>Prevents name mangling on labels in macros.</td>
</tr>
</tbody>
</table>

Example

The macro definition:
The macro call:

```
.SDECL "\mcstext\code", code
.SECT "\mcstext\code"
CONST24 r5,0x123456
```

The macro expands as follows:

```
movl r5,0x123456
```

**Related Information**

Section 2.10, *Macro Operations*

- `.DUP`, `.ENDM` (Duplicate sequence of source lines)
- `.DUPA`, `.ENDM` (Duplicate sequence with arguments)
- `.DUPC`, `.ENDM` (Duplicate sequence with characters)
- `.DUPF`, `.ENDM` (Duplicate sequence in loop)
- `.PMACRO` (Undefine macro)
- `.DEFINE` (Define a substitution string)
.MESSAGE

Syntax

_MESSAGE \{str|exp\},\{str|exp\}...

Description

With the .MESSAGE directive you tell the assembler to print a message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated message. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The error and warning counts will not be affected. The .MESSAGE directive is for example useful in combination with conditional assembly to indicate which part is assembled. The assembling process proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler.

A label is not allowed with this directive.

Example

.DEFINE LONG "SHORT"
.MESSAGE 'This is a LONG string'
.MESSAGE "This is a LONG string"

Within single quotes, the defined symbol LONG is not expanded. Within double quotes the symbol LONG is expanded so the actual message is printed as:

This is a LONG string
This is a SHORT string

Related Information

.FAIL (Programmer generated error)

.WARNING (Programmer generated warning)
.MISRAC

Syntax

.MISRAC string

Description

The C compiler can generate the .MISRAC directive to pass the compiler’s MISRA C settings to the object file. The linker performs checks on these settings and can generate a report. It is not recommended to use this directive in hand-coded assembly.

Example

.MISRAC 'MISRA-C:2004,64,e2,0b,e,e11,27,6,ef83,e1,
    ef,66,cb75,af1,eff,e7,e7f,8d,63,87ff7,6ff3,4'

Related Information

Section 3.6.2, C Code Checking: MISRA C

C compiler option --misrac
予定

\textbf{.ORG}

\textbf{Syntax}

\texttt{.ORG \[abs-loc\][,sect_type][,attribute]...}

\textbf{Description}

With the \texttt{.ORG} directive you can specify an absolute location (\textit{abs_loc}) in memory of a section. This is the same as a \texttt{.SDECL/.SECT} without a section name.

This directive uses the following arguments:

\begin{tabular}{|l|p{10cm}|}
\hline
\textit{abs-loc} & Initial value to assign to the run-time location counter. \textit{abs-loc} must be an absolute expression. If \textit{abs-loc} is not specified, then the value is zero. \\
\hline
\textit{sect_type} & An optional section type: code or data \\
\hline
\textit{attribute} & An optional section attribute: init, noread, noclear, max, rom, group(\textit{string}), cluster(\textit{string}), protect \\
\hline
\end{tabular}

For more information about the section types and attributes see the \texttt{assembler directive .SDECL}.

The section type and attributes are case insensitive. A label is not allowed with this directive.

\textbf{Example}

\begin{verbatim}
; define a section at location 100 decimal
   .org   100

; define a relocatable nameless section
   .org

; define a relocatable data section
   .org   ,data

; define a data section at 0x8000
   .org   0x8000,data
\end{verbatim}

\textbf{Related Information}

\texttt{.SDECL} (Declare section name and attributes)

\texttt{.SECT} (Activate a declared section)
.PMACRO

Syntax

  .PMACRO symbol[,symbol]...

Description

With the .PMACRO directive you tell the assembler to undefine the specified macro, so that later uses of the symbol will not be expanded.

The assembler does not allow a label with this directive.

Example

  .PMACRO MAC1,MAC2

This statement causes the macros named MAC1 and MAC2 to be undefined.

Related Information

  .MACRO, .ENDM (Define a macro)
.SDECL

Syntax

.SDECL "name"[,type][,attribute]... [AT address]

Description

With the .SDECL directive you can define a section with a name (between single or double quotes), type and optional attributes. Before any code or data can be placed in a section, you must use the .SECT directive to activate the section.

The name specifies the name of the section. Section names that start with a dot '.' and a predefined section name prefix have a special meaning to the locating process. Optionally, you can extend the section names with a dot '.' and a user defined name. You can specify the following section name prefixes:

<table>
<thead>
<tr>
<th>Section prefix</th>
<th>Description</th>
<th>Implicit section type</th>
</tr>
</thead>
<tbody>
<tr>
<td>mcstext</td>
<td>program code</td>
<td>CODE</td>
</tr>
<tr>
<td>mcsdata</td>
<td>initialized data</td>
<td>DATA</td>
</tr>
<tr>
<td>mcsbss</td>
<td>uninitialized data (cleared)</td>
<td>DATA</td>
</tr>
</tbody>
</table>

The type operand specifies the section’s type and must be one of:

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>CODE</td>
<td>Code section.</td>
</tr>
<tr>
<td>DATA</td>
<td>Data section.</td>
</tr>
<tr>
<td>DEBUG</td>
<td>Debug section.</td>
</tr>
</tbody>
</table>

When you use a section prefix, the section type is optional.

The section type and attributes are case insensitive.

The defined attributes are:

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Allowed on type</th>
</tr>
</thead>
<tbody>
<tr>
<td>AT address</td>
<td>Locate the section at the given address.</td>
<td>CODE, DATA</td>
</tr>
<tr>
<td>CLEAR</td>
<td>Sections are zeroed at startup.</td>
<td>DATA</td>
</tr>
<tr>
<td>CLUSTER('name')</td>
<td>Cluster code sections with companion debug sections. Used by the linker during removal of unreferenced sections. The name must be unique for this module (not for the application).</td>
<td>CODE, DATA, DEBUG</td>
</tr>
<tr>
<td>CONCAT</td>
<td>Concatenate sections. Used by the linker to merge sections with the same name.</td>
<td>DATA</td>
</tr>
<tr>
<td>INIT</td>
<td>Defines that the section contains initialization data, which is copied from ROM to RAM at program startup.</td>
<td>CODE, DATA</td>
</tr>
</tbody>
</table>
### Attribute Description

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Description</th>
<th>Allowed on type</th>
</tr>
</thead>
<tbody>
<tr>
<td>NOCLEAR</td>
<td>Sections are not zeroed at startup. This is a default attribute for data sections. This attribute is only useful with BSS sections, which are cleared at startup by default.</td>
<td>DATA</td>
</tr>
<tr>
<td>NOREAD</td>
<td>Defines that the section can be executed from but not read.</td>
<td>CODE</td>
</tr>
<tr>
<td>PROTECT</td>
<td>Tells the linker to exclude a section from unreferenced section removal and duplicate section removal.</td>
<td>CODE, DATA</td>
</tr>
<tr>
<td>ROM</td>
<td>Section contains data to be placed in ROM. This ROM area is not executable.</td>
<td>CODE, DATA</td>
</tr>
</tbody>
</table>

### Section names

The *name* of a section can have a special meaning for locating sections. The name of code sections should always start with "`.mcstext`". The name of data sections should always start with "`.mcsdata`".

#### Example

```assembly
.sdecl  `.mcstext.mycode"           ; declare mcscode section  
.sect   `.mcstext.mycode"           ; activate section

.sdecl  `.mcsdata.mydata"           ; declare mcsdata section  
.sect   `.mcsdata.mydata"           ; activate section

.sdecl  `.mcsdata.abssec", data at 0x100 
.sect   `.mcsdata.abssec"           ; absolute section
```

### Related Information

`.SECT` *(Activate a declared section)*
.SECT

Syntax

.SECT "name"

Description

With the .SECT directive you activate a previously declared section with the name name. Before you can activate a section, you must define the section with the .SDECL directive. You can activate a section as many times as you need.

Example

.sdecl ".mcsdata.mydata" ; declare mcsdata section
.sect  ".mcsdata.mydata"  ; activate section

Related Information

.SDECL (Declare section name and attributes)
.SET

Syntax

symbol .SET expression

.SET symbol expression

Description

With the .SET directive you assign the value of expression to symbol temporarily. If a symbol was defined with the .SET directive, you can redefine that symbol in another part of the assembly source, using the .SET directive again. Symbols that you define with the .SET directive are always local: you cannot define the symbol global with the .GLOBAL directive.

The .SET directive is useful in establishing temporary or reusable counters within macros. expression must be absolute and forward references are allowed.

Example

COUNT .SET 0 ; Initialize count. Later on you can
; assign other values to the symbol

Related Information

.EQU (Set permanent value to a symbol)
.SIZE

Syntax

.SIZE  symbol,expression

Description

With the .SIZE directive you set the size of the specified symbol to the value represented by expression.

The .SIZE directive may occur anywhere in the source file unless the specified symbol is a function. In this case, the .SIZE directive must occur after the function has been defined.

Example

_MCS_str:  .type  object  ; object _MCS_str
          .size  _MCS_str,16  ; size of object
          .word  80
          .word  67
          .word  80
          .word  0

Related Information

.TYPE (Set symbol type)
**.SPACE**

**Syntax**

[label:] .SPACE expression

**Description**

The .SPACE directive reserves a block in memory. The reserved block of memory is not initialized to any value.

If you specify the optional label, it gets the value of the location counter at the start of the directive processing.

The expression specifies the number of words to be reserved, and how much the location counter will advance. The expression must evaluate to an integer greater than zero and cannot contain any forward references (symbols that have not yet been defined).

If you specify label, it gets the value of the location counter at the start of the directive processing.

**Example**

To reserve 12 words (not initialized) of memory in a RAM data section:

```
.sdecl "mcsdata.data"
.sect "mcsdata.data"
uninit .SPACE 12 ; Sample buffer
```

**Related Information**

.WORD (Define a constant word)
**.TYPE**

**Syntax**

```c
symbol .TYPE typeid
```

**Description**

With the `.TYPE` directive you set a `symbol`'s type to the specified value in the ELF symbol table. Valid symbol types are:

- **FUNC** The symbol is associated with a function or other executable code.
- **OBJECT** The symbol is associated with an object such as a variable, an array, or a structure.
- **FILE** The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type **FUNC**. Labels in data sections have the default type **OBJECT**.

**Example**

```c
_MCS_Afunc: .type func
```

**Related Information**

- **.SIZE** (Set symbol size)
.UNDEF

Syntax

.UNDEF symbol

Description

With the .UNDEF directive you can undefine a substitution string that was previously defined with the .DEFINE directive. The substitution string associated with symbol is released, and symbol will no longer represent a valid .DEFINE substitution or macro.

The assembler issues a warning if you redefine an existing symbol.

The assembler does not allow a label with this directive.

Example

The following example undefines the LEN substitution string that was previously defined with the .DEFINE directive:

.UNDEF LEN

Related Information

.DEFINE (Define a substitution string)
.WARNING

Syntax

.WARNING {str|exp}[,{str|exp}]...

Description

With the .WARNING directive you tell the assembler to print a warning message to stderr during the assembling process.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening white space, can be specified to describe the nature of the generated warning. If you use expressions, the assembler outputs the result. The assembler outputs a space between each argument.

The total warning count will be incremented as with any other warning. The .WARNING directive is for example useful in combination with conditional assembly to indicate which part is assembled. The assembling process proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler, unless you use the assembler option --warnings-as-errors. In that case the assembler exits with exit code 1 (an error).

A label is not allowed with this directive.

Example

.WARNING 'Parameter out of range'

This results in the warning:

W144: ["filename" line] Parameter out of range

Related Information

.FAIL (Programmer generated error)

.MESSAGE (Programmer generated message)
.WEAK

Syntax

```
.WEAK symbol[,symbol]...
```

Description

With the .WEAK directive you mark one or more symbols as 'weak'. The symbol can be defined in the same module with the .GLOBAL directive or the .EXTERN directive. If the symbol does not already exist, it will be created.

A 'weak' external reference is resolved by the linker when a global (or weak) definition is found in one of the object files. However, a weak reference will not cause the extraction of a module from a library to resolve the reference.

You can overrule a weak definition with a .GLOBAL definition in another module. The linker will not complain about the duplicate definition, and ignore the weak definition.

Only program labels and symbols defined with .EQU can be made weak.

Example

```
LOOPA .EQU 1          ; definition of symbol LOOPA
   .GLOBAL LOOPA     ; LOOPA will be globally accessible by other modules
   .WEAK LOOPA      ; mark symbol LOOPA as weak
```

Related Information

- .EXTERN (Import global section symbol)
- .GLOBAL (Declare global section symbol)
**.WORD**

**Syntax**

[label:] .WORD argument[,argument]...

**Description**

With the .WORD directive the assembler allocates and initializes one word (32 bits) of memory for each argument.

If you specify the optional label, it gets the value of the location counter at the start of the directive processing.

An argument can be a single- or multiple-character string constant, an expression or empty.

Multiple arguments are stored in sets of four bytes. One or more arguments can be null (indicated by two adjacent commas), in which case the corresponding byte location will be filled with zeros.

The value of the arguments must be in range with the size of the directive; floating-point numbers are not allowed. If the evaluated argument is too large to be represented in a word, the assembler issues a warning and truncates the value.

**String constants**

Single-character strings are stored in the most significant byte of a word, where the lower seven bits in that byte represent the ASCII value of the character, for example:

```
.WORD 'R'        ; = 0x52000000
```

Multiple-character strings are stored in consecutive byte addresses, as shown below. The standard C language escape characters like `\n` are permitted.

```
.WORD  'ABCD'         ; = 0x44434241
```

**Related Information**

.SPCE (Define Storage)
2.9.2. Assembler Controls

Controls start with a $ as the first character on the line. Unknown controls are ignored after a warning is issued.

Overview of assembler listing controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$LIST ON/OFF</td>
<td>Print / do not print source lines to list file</td>
</tr>
<tr>
<td>$PAGE</td>
<td>Generate form feed in list file</td>
</tr>
<tr>
<td>$PAGE settings</td>
<td>Define page layout for assembly list file</td>
</tr>
<tr>
<td>$PRCTL</td>
<td>Send control string to printer</td>
</tr>
<tr>
<td>$STITLE</td>
<td>Set program subtitle in header of assembly list file</td>
</tr>
<tr>
<td>$TITLE</td>
<td>Set program title in header of assembly list file</td>
</tr>
</tbody>
</table>

Overview of miscellaneous assembler controls

<table>
<thead>
<tr>
<th>Control</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$CASE ON/OFF</td>
<td>Case sensitive user names ON/OFF</td>
</tr>
<tr>
<td>$DEBUG ON/OFF</td>
<td>Generation of symbolic debug ON/OFF</td>
</tr>
<tr>
<td>$IDENT LOCAL/GLOBAL</td>
<td>Assembler treats labels by default as local or global</td>
</tr>
<tr>
<td>$OBJECT</td>
<td>Alternative name for the generated object file</td>
</tr>
<tr>
<td>$WARNING OFF [num]</td>
<td>Suppress all or some warnings</td>
</tr>
</tbody>
</table>
$CASE

Syntax

$CASE  ON
$CASE  OFF

Default

$CASE  ON

Description

With the $CASE  ON and $CASE  OFF controls you specify whether the assembler operates in case sensitive mode or not. By default the assembler operates in case sensitive mode. This means that all user-defined symbols and labels are treated case sensitive, so LAB and Lab are distinct.

Note that the instruction mnemonics, register names, directives and controls are always treated case insensitive.

Example

; begin of source
$CASE OFF ; assembler in case insensitive mode

Related Information

Assembler option --case-insensitive
$DEBUG

Syntax

$DEBUG ON
$DEBUG OFF

Default

$DEBUG OFF

Description

With the $DEBUG ON and $DEBUG OFF controls you turn the generation of debug information on or off. ($DEBUG ON is similar to the assembler option --debug-info=+asm,+local (-gal)).

Example

;begin of source
$DEBUG ON ; generate local symbols debug information

Related Information

Assembler option --debug-info
$IDENT

Syntax

$IDENT LOCAL
$IDENT GLOBAL

Default

$IDENT LOCAL

Description

With the controls $IDENT LOCAL and $IDENT GLOBAL you tell the assembler how to treat symbols that you have not specified explicitly as local or global with the assembler directives .LOCAL or .GLOBAL.

By default the assembler treats all symbols as local symbols unless you have defined them to be global explicitly.

Example

;begin of source
$IDENT GLOBAL  ; assembly labels are global by default

Related Information

Assembler directive .GLOBAL
Assembler directive .LOCAL
Assembler option --symbol-scope
$LIST ON/OFF

Syntax

$LIST ON
$LIST OFF

Default

$LIST ON

Description

If you generate a list file with the assembler option --list-file, you can use the $LIST ON and $LIST OFF controls to specify which source lines the assembler must write to the list file. Without the assembler option --list-file these controls have no effect. The controls take effect starting at the next line.

The $LIST ON control actually increments a counter that is checked for a positive value and is symmetrical with respect to the $LIST OFF control. Note the following sequence:

; Counter value currently 1
$LIST ON         ; Counter value = 2
$LIST ON         ; Counter value = 3
$LIST OFF        ; Counter value = 2
$LIST OFF        ; Counter value = 1

The listing still would not be disabled until another $LIST OFF control was issued.

Example

.SDECL ".mcstext.code",code
.SECT ".mcstext.code"
... ; source line in list file
$LIST OFF
... ; source line not in list file
$LIST ON
... ; source line also in list file

Related Information

Assembler option --list-file

Assembler function @LST()
$OBJECT

Syntax

$OBJECT "file"
$OBJECT OFF

Default

$OBJECT

Description

With the $OBJECT control you can specify an alternative name for the generated object file. With the $OBJECT OFF control, the assembler does not generate an object file at all.

Example

;Begin of source
$object "x1.o" ; generate object file x1.o

Related Information

Assembler option --output
$PAGE

Syntax

$PAGE \{pagewidth[,pagelength[,blankleft[,blanktop[,blankbtm]]]]\}

Default

$PAGE 132, 72, 0, 0, 0

Description

If you generate a list file with the assembler option --list-file, you can use the $PAGE control to format the generated list file.

The arguments may be any positive absolute integer expression, and must be separated by commas.

<table>
<thead>
<tr>
<th>Argument</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>pagewidth</td>
<td>Number of columns per line. The default is 132, the minimum is 40.</td>
</tr>
<tr>
<td>pagelength</td>
<td>Total number of lines per page. The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page breaks.</td>
</tr>
<tr>
<td>blankleft</td>
<td>Number of blank columns at the left of the page. The default is 0, the minimum is 0, and the maximum must maintain the relationship: blankleft &lt; pagewidth.</td>
</tr>
<tr>
<td>blanktop</td>
<td>Number of blank lines at the top of the page. The default is 0, the minimum is 0 and the maximum must be a value so that (blanktop + blankbtm) &lt;= (pagelength - 10).</td>
</tr>
<tr>
<td>blankbtm</td>
<td>Number of blank lines at the bottom of the page. The default is 0, the minimum is 0 and the maximum must be a value so that (blanktop + blankbtm) &lt;= (pagelength - 10).</td>
</tr>
</tbody>
</table>

If you use the $PAGE control without arguments, it causes a 'formfeed': the next source line is printed on the next page in the list file. The $PAGE control itself is not printed.

Example

$PAGE               ; formfeed, the next source line is printed
                   ; on the next page in the list file.

$PAGE 96            ; set page width to 96. Note that you can
                   ; omit the last four arguments.

$PAGE ,,,3,3        ; use 3 line top/bottom margins.

Related Information

Assembler option --list-file
$PRCTL

Syntax

$PRCTL exp|string[,exp|string]...

Description

If you generate a list file with the assembler option --list-file, you can use the $PRCTL control to send control strings to the printer.

The $PRCTL control simply concatenates its arguments and sends them to the listing file (the control line itself is not printed unless there is an error).

You can specify the following arguments:

expr    A byte expression which may be used to encode non-printing control characters, such as ESC.
string  An assembler string, which may be of arbitrary length, up to the maximum assembler-defined limits.

The $PRCTL control can appear anywhere in the source file; the assembler sends out the control string at the corresponding place in the listing file.

If a $PRCTL control is the last line in the last input file to be processed, the assembler insures that all error summaries, symbol tables, and cross-references have been printed before sending out the control string. In this manner, you can use a $PRCTL control to restore a printer to a previous mode after printing is done.

Similarly, if the $PRCTL control appears as the first line in the first input file, the assembler sends out the control string before page headings or titles.

Example

$PRCTL $1B,'E' ; Reset HP LaserJet printer

Related Information

Assembler option --list-file
$STITLE

Syntax

$STITLE "string"

Default

$STITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the $STITLE control to specify the program subtitle which is printed at the top of all succeeding pages in the assembler list file below the title.

The specified subtitle is valid until the assembler encounters a new $STITLE control. By default, the subtitle is empty.

The $STITLE control itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.

Example

$TITLE 'This is the title'
$STITLE 'This is the subtitle'

Related Information

Assembler option --list-file

Assembler control $TITLE
$TITLE

Syntax

$TITLE "string"

Default

$TITLE ""

Description

If you generate a list file with the assembler option --list-file, you can use the $TITLE control to specify the program title which is printed at the top of each page in the assembler list file.

The specified title is valid until the assembler encounters a new $TITLE control. By default, the title is empty.

The $TITLE control itself will not be printed in the source listing.

If the page width is too small for the title to fit in the header, it will be truncated.

Example

$TITLE 'This is the title'

Related Information

Assembler option --list-file

Assembler control $STITLE
$WARNING OFF

Syntax

$WARNING OFF [number]

Default

All warnings are reported.

Description

This control allows you to disable all or individual warnings. The number argument must be a valid warning message number.

Example

$WARNING OFF ; all warning messages are suppressed

$WARNING OFF 135 ; suppress warning message 135

Related Information

Assembler option --no-warnings
2.10. Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro at the points in the program where the pattern would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject to conditional assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line source statements. 'In-line' means that all replacements act as if they are on the same line as the macro call. The generated statements may contain substitutable arguments. The statements produced by a macro can be any processor instruction, almost any assembler directive, or any previously-defined macro. Source statements resulting from a macro call are subject to the same conditions and restrictions as any other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

2.10.1. Defining a Macro

The first step in using a macro is to define it.

The definition of a macro consists of three parts:

- **Header**, which assigns a name to the macro and defines the arguments (.MACRO directive).
- **Body**, which contains the code or instructions to be inserted when the macro is called.
- **Terminator**, which indicates the end of the macro definition (.ENDM directive).

A macro definition takes the following form:

```assembly
macro_name .MACRO [argument[,argument]...]
    ...
    macro_definition_statements
    ...
    .ENDM
```

For more information on the definition see the description of the .MACRO directive.

The .DUP, .DUPA, .DUPC, and .DUPF directives are specialized macro forms to repeat a block of source statements. You can think of them as a simultaneous definition and call of an unnamed macro. The source statements between the .DUP, .DUPA, .DUPC, and .DUPF directives and the .ENDM directive follow the same rules as macro definitions.

2.10.2. Calling a Macro

To invoke a macro, construct a source statement with the following format:

```assembly
[label] macro_name [argument[,argument]...] [; comment]
```

where,
An optional label that corresponds to the value of the location counter at the start of the macro expansion.

The name of the macro. This may not start in the first column.

One or more optional, substitutable arguments. Multiple arguments must be separated by commas.

An optional comment.

The following applies to macro arguments:

- Each argument must correspond one-to-one with the formal arguments of the macro definition. If the macro call does not contain the same number of arguments as the macro definition, the assembler issues a warning.

- If an argument has an embedded comma or space, you must surround the argument by single quotes (').

- You can declare a macro call argument as null in three ways:
  - enter delimiting commas in succession with no intervening spaces
    ```plaintext
    macroname ARG1,,ARG3 ; the second argument is a null argument
    ```
  - terminate the argument list with a comma, the arguments that normally would follow, are now considered null
    ```plaintext
    macroname ARG1, ; the second and all following arguments are null
    ```
  - declare the argument as a null string

- No character is substituted in the generated statements that reference a null argument.

### 2.10.3. Using Operators for Macro Arguments

The assembler recognizes certain text operators within macro definitions which allow text substitution of arguments during macro expansion. You can use these operators for text concatenation, numeric conversion, and string handling.

<table>
<thead>
<tr>
<th>Operator</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>\</td>
<td>Macro argument concatenation</td>
<td>Concatenates a macro argument with adjacent alphanumeric characters.</td>
</tr>
<tr>
<td>?</td>
<td>Return decimal value of symbol</td>
<td>Substitutes the <code>?symbol</code> sequence with a character string that represents the decimal value of the symbol.</td>
</tr>
<tr>
<td>%</td>
<td>Return hex value of symbol</td>
<td>Substitutes the <code>%symbol</code> sequence with a character string that represents the hexadecimal value of the symbol.</td>
</tr>
<tr>
<td>&quot;</td>
<td>Macro string delimiter</td>
<td>Allows the use of macro arguments as literal strings.</td>
</tr>
<tr>
<td>^</td>
<td>Macro local label override</td>
<td>Prevents name mangling on labels in macros.</td>
</tr>
</tbody>
</table>
Example: Argument Concatenation Operator - \\

Consider the following macro definition:

```
MAC_A .MACRO reg,val
  movl r\reg,val
 .ENDM
```

The macro is called as follows:

```
MAC_A 0,1
```

The macro expands as follows:

```
movl r0,1
```

The macro preprocessor substitutes the character '0' for the argument `reg`, and the character '1' for the argument `val`. The concatenation operator (`\`) indicates to the macro preprocessor that the substitution characters for the arguments are to be concatenated with the character 'r'.

Without the `\` operator the macro would expand as:

```
movl rreg,1
```

which results in an assembler error (invalid operand).

Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the value of the macro call arguments.

Consider the following source code that calls the macro `MAC_A` after the argument `AVAL` has been set to 1.

```
AVAL .SET 1
  MAC_A 0,AVAL
```

If you want to replace the argument `val` with the value of `AVAL` rather than with the literal string 'AVAL', you can use the `?` operator and modify the macro as follows:

```
MAC_A .MACRO reg,val
  movl r\reg,?val
 .ENDM
```

Example: Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the hexadecimal value of a symbol.

Consider the following macro definition:
The macro is called after NUM has been set to 10:

```
NUM .SET 10
GEN_LAB HEX, NUM, NOP
```

The macro expands as follows:

```
HEXA NOP
```

The %VAL argument is replaced by the character 'A' which represents the hexadecimal value 10 of the argument VAL.

**Example: Argument String Operator - "**

To generate a literal string, enclosed by single quotes ('), you must use the argument string operator (")) in the macro definition.

Consider the following macro definition:

```
STR_MAC .MACRO STRING
.WORD "STRING"
.ENDM
```

The macro is called as follows:

```
STR_MAC ABCD
```

The macro expands as follows:

```
.WORD 'ABCD'
```

Within double quotes .DEFINE directive definitions can be expanded. Take care when using constructions with single quotes and double quotes to avoid inappropriate expansions. Since .DEFINE expansion occurs before macro substitution, any .DEFINE symbols are replaced first within a macro argument string:

```
.DEFIN E LONG 'short'
STR_MAC .MACRO STRING
.MESSAGE 'This is a LONG STRING'
.MESSAGE "This is a LONG STRING"
.ENDM
```

If the macro is called as follows:

```
STR_MAC sentence
```

it expands as:

```
.MESSAGE 'This is a LONG STRING'
.MESSAGE 'This is a short sentence'
```
Macro Local Label Override Operator - ^

If you use labels in macros, the assembler normally generates another unique name for the labels (such as LAB__M_L000001).

The macro ^-operator prevents name mangling on macro local labels.

Consider the following macro definition:

```assembly
STA_Z .EQU 5

INIT .MACRO ARG, CNT
    MOV R5,0x1
    ^LAB:
        .WORD ARG
        ADD R5,0x1
        ATUL R5,CNT
        JBC STA,STA_Z,^LAB
    .ENDM
```

The macro is called as follows:

```assembly
INIT 2,4
```

The macro expands as:

```assembly
MOV R5,0x1
LAB:
    .WORD 2
    ADD R5,0x1
    ATUL R5,4
    JBC STA,STA_Z,LAB
```

If you would have omitted the ^ operator, the macro preprocessor would choose another name for LAB because the label already exists. The macro would expand like:

```assembly
MOV R5,0x1
LAB__M_L000001:
    .WORD 2
    ADD R5,0x1
    ATUL R5,4
    JBC STA,STA_Z,LAB__M_L000001
```

2.11. Generic Instructions

The assembler supports so-called 'generic instructions'. Generic instructions are pseudo instructions (no instructions from the instruction set). Depending on the situation in which a generic instruction is used, the assembler replaces the generic instruction with appropriate real assembly instruction(s).

If you select the MCS v1.0 core, the assembler supports the generic instructions MWRL and MWRIL that are replaced by MWR24 and MWRI24, so that code for newer cores can be built for the MCS v1.0 core.
If you select any other core than MCS v1.0, the assembler supports the generic instructions MWR24 and MWRI24 that are replaced by MWRL and MWRIL, so that code for the MCS v1.0 core can be built for newer cores.

**MWRL generic**

Convert MWRL to MWR24 on MCS v1.0.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>MWRL A,C</td>
<td>MWR24 A,C</td>
</tr>
</tbody>
</table>

**MWRI24 generic**

Convert MWRI24 to MWRL on MCS v2.0 and later.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>MWRI24 A,B</td>
<td>MWR24 A,B</td>
</tr>
</tbody>
</table>

**MWR24 generic**

Convert MWR24 to MWRL on MCS v2.0 and later.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>MWR24 A,C</td>
<td>MWRL A,C</td>
</tr>
</tbody>
</table>

**MWRIL generic**

Convert MWRIL to MWRI24 on MCS v1.0.

<table>
<thead>
<tr>
<th>Instruction</th>
<th>Replacement</th>
</tr>
</thead>
<tbody>
<tr>
<td>MWRIL A,B</td>
<td>MWRI24 A,B</td>
</tr>
</tbody>
</table>
Chapter 3. Using the C Compiler

This chapter describes the compilation process and explains how to call the C compiler.

The TASKING VX-toolset for MCS under Eclipse can use the internal builder (default) or the TASKING makefile generator (external builder) to build your entire embedded project, from C source till the final ELF/DWARF object file which serves as input for the debugger.

Although in Eclipse you cannot run the C compiler separately from the other tools, this section discusses the options that you can specify for the C compiler.

On the command line it is possible to call the C compiler separately from the other tools. However, it is recommended to use the control program for command line invocations of the toolset (see Section 6.1, Control Program). With the control program it is possible to call the entire toolset with only one command line.

The C compiler takes the following files for input and output:

This chapter first describes the compilation process which consists of a frontend and a backend part. Next it is described how to call the C compiler and how to use its options. An extensive list of all options and their descriptions is included in Section 8.1, C Compiler Options. Finally, a few important basic tasks are described, such as including the C startup code and performing various optimizations.

3.1. Compilation Process

During the compilation of a C program, the C compiler runs through a number of phases that are divided into two parts: frontend and backend.

The backend part is not called for each C statement, but starts after a complete C module or set of modules has been processed by the frontend (in memory). This allows better optimization.

The C compiler requires only one pass over the input file which results in relative fast compilation.

Frontend phases

1. The preprocessor phase:

   The preprocessor includes files and substitutes macros by C source. It uses only string manipulations on the C source. The syntax for the preprocessor is independent of the C syntax but is also described in the ISO/IEC 9899:1999(E) standard.
2. The scanner phase:

   The scanner converts the preprocessor output to a stream of tokens.

3. The parser phase:

   The tokens are fed to a parser for the C grammar. The parser performs a syntactic and semantic analysis of the program, and generates an intermediate representation of the program. This code is called MIL (Medium level Intermediate Language).

4. The frontend optimization phase:

   Target processor independent optimizations are performed by transforming the intermediate code.

**Backend phases**

1. Instruction selector phase:

   This phase reads the MIL input and translates it into Low level Intermediate Language (LIL). The LIL objects correspond to a processor instruction, with an opcode, operands and information used within the C compiler.

2. Peephole optimizer/instruction scheduler/software pipelining phase:

   This phase replaces instruction sequences by equivalent but faster and/or shorter sequences, rearranges instructions and deletes unnecessary instructions.

3. Register allocator phase:

   This phase chooses a physical register to use for each virtual register.

4. The backend optimization phase:

   Performs target processor independent and dependent optimizations which operate on the Low level Intermediate Language.

5. The code generation/formatter phase:

   This phase reads through the LIL operations to generate assembly language output.

### 3.2. Calling the C Compiler

The TASKING VX-toolset for MCS under Eclipse can use the internal builder (default) or the TASKING makefile generator (external builder) to build your entire project. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.
Building a project under Eclipse

You have several ways of building your project:

- **Build Selected File(s)**. This compiles and assembles the selected file(s) without calling the linker.
  1. In the C/C++ Projects view, select the files you want to compile.
  2. Right-click in the C/C++ Projects view and select Build Selected File(s).

- **Build Individual Project**.
  To build individual projects incrementally, select Project » Build project.

- **Rebuild Project**. This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.
  1. Select Project » Clean...
  2. Enable the option Start a build immediately and click OK.

- **Build Automatically**. This performs a build of all projects whenever any project file is saved, such as your makefile.

  This way of building is not recommended for C/C++ development, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

See also Chapter 9, Influencing the Build Time.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them once. Based on the target processor, the compiler includes a special function register file. This is a regular include file which enables you to use virtual registers that are located in memory.

You can specify the target processor when you create a new project with the New C/C++ Project wizard (File » New » TASKING MCS C Project), but you can always change the processor in the project properties dialog.

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

   In the right pane the Processor page appears.

3. From the Processor selection list, select a processor.
To access the C compiler options

1. From the **Project** menu, select **Properties for**
   
   The Properties dialog appears.

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   In the right pane the Settings appear.

3. On the Tool Settings tab, select **C Compiler**.

4. Select the sub-entries and set the options in the various pages.

   Note that the C compiler options are used to create an object file from a C file. The options you enter in the Assembler page are not only used for hand-coded assembly files, but also for intermediate assembly files.

   You can find a detailed description of all C compiler options in Section 8.1, **C Compiler Options**.

Invocation syntax on the command line (Windows Command Prompt):

```bash
cmcs [option]... [file]... 
```

3.3. How the Compiler Searches Include Files

When you use include files (with the `#include` statement), you can specify their location in several ways. The compiler searches the specified locations in the following order:

1. If the `#include` statement contains an absolute pathname, the compiler looks for this file. If no path or a relative path is specified, the compiler looks in the same directory as the source file. This is only possible for include files that are enclosed in "".
   
   This first step is not done for include files enclosed in <>.

2. When the compiler did not find the include file, it looks in the directories that are specified in the **C Compiler » Include Paths** page in the **C/C++ Build » Settings » Tool Settings** tab of the Project Properties dialog (equivalent to the `-I` command line option).

3. When the compiler did not find the include file (because it is not in the specified include directory or because no directory is specified), it looks in the path(s) specified in the environment variable `CMCSINC`.

4. When the compiler still did not find the include file, it finally tries the default include directory relative to the installation directory (unless you specified `option --no-stdinc`).
Example

Suppose that the C source file `test.c` contains the following lines:

```c
#include <stdio.h>
#include "myinc.h"
```

You can call the compiler as follows:

`cmcs -Imyinclude test.c`

First the compiler looks for the file `stdio.h` in the directory `myinclude` relative to the current directory. If it was not found, the compiler searches in the environment variable `CMCSINC` and then in the default include directory.

The compiler now looks for the file `myinc.h`, in the directory where `test.c` is located. If the file is not there the compiler searches in the directory `myinclude`. If it was still not found, the compiler searches in the environment variable `CMCSINC` and then in the default include directory.

3.4. Compiling for Debugging

Compiling your files is the first step to get your application ready to run on a target. However, during development of your application you first may want to debug your application.

To create an object file that can be used for debugging, you must instruct the compiler to include symbolic debug information in the source file.

To include symbolic debug information

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **C Compiler » Debugging**.

4. Select **Default** in the **Generate symbolic debug information** box.

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain debug information is optimized away. Therefore, if you encounter strange behavior during debugging it might be necessary to reduce the optimization level, so that the source code is still suitable for debugging. For more information on optimization see **Section 3.5, Compiler Optimizations.**
Invocation syntax on the command line (Windows Command Prompt)

The invocation syntax on the command line is:

```
cmcs -g file.c
```

### 3.5. Compiler Optimizations

The compiler has a number of optimizations which you can enable or disable.

1. From the Project menu, select Properties for
   
   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.
   
   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Optimization.

4. Select an optimization level in the Optimization level box.
   
   or:

   In the Optimization level box select Custom optimization and enable the optimizations you want on the Custom optimization page.

#### Optimization levels

The TASKING C compiler offers four optimization levels and a custom level, at each level a specific set of optimizations is enabled.

- **Level 0 - No optimization**: No optimizations are performed. The compiler tries to achieve a 1-to-1 resemblance between source code and produced code. Expressions are evaluated in the order written in the source code, associative and commutative properties are not used.

- **Level 1 - Optimize**: Enables optimizations that do not affect the debug-ability of the source code. Use this level when you encounter problems during debugging your source code with optimization level 2.

- **Level 2 - Optimize more (default)**: Enables more optimizations to reduce the memory footprint and/or execution time. This is the default optimization level.

- **Level 3 - Optimize most**: This is the highest optimization level. Use this level when your program/hardware has become too slow to meet your real-time requirements.

- **Custom optimization**: you can enable/disable specific optimizations on the Custom optimization page.
Optimization pragmas

If you specify a certain optimization, all code in the module is subject to that optimization. Within the C source file you can overrule the C compiler options for optimizations with #pragma optimize flag and #pragma endoptimize. Nesting is allowed:

```c
#pragma optimize e    /* Enable expression
...   simplification */
...  C source ...
...#pragma optimize c    /* Enable common expression
...   elimination. Expression
...  C source ...   simplification still enabled */
...#pragma endoptimize   /* Disable common expression
...   elimination */
#pragma endoptimize    /* Disable expression
...   simplification */
```

The compiler optimizes the code between the pragma pair as specified.

You can enable or disable the optimizations described in the following subsection. The command line option for each optimization is given in brackets.

### 3.5.1. Generic Optimizations (frontend)

**Common subexpression elimination (CSE) (option -Oc/-OC)**

The compiler detects repeated use of the same (sub-)expression. Such a "common" expression is replaced by a variable that is initialized with the value of the expression to avoid recomputation. This method is called common subexpression elimination (CSE).

**Expression simplification (option -Oe/-OE)**

Multiplication by 0 or 1 and additions or subtractions of 0 are removed. Such useless expressions may be introduced by macros or by the compiler itself (for example, array subscripting).

**Constant propagation (option -Op/-OP)**

A variable with a known value is replaced by that value.

**Automatic function inlining (option -Oi/-OI)**

Small functions that are not too often called, are inlined. This reduces execution time at the cost of code size.

**Control flow simplification (option -Of/-OF)**

A number of techniques to simplify the flow of the program by removing unnecessary code and reducing the number of jumps. For example:
Switch optimization: A number of optimizations of a switch statement are performed, such as removing redundant case labels or even removing an entire switch.

Jump chaining: A (conditional) jump to a label which is immediately followed by an unconditional jump may be replaced by a jump to the destination label of the second jump. This optimization speeds up execution.

Conditional jump reversal: A conditional jump over an unconditional jump is transformed into one conditional jump with the jump condition reversed. This reduces both the code size and the execution time.

Dead code elimination: Code that is never reached, is removed. The compiler generates a warning messages because this may indicate a coding error.

Subscript strength reduction (option -Os/-OS)

An array or pointer subscripted with a loop iterator variable (or a simple linear function of the iterator variable), is replaced by the dereference of a pointer that is updated whenever the iterator is updated.

Loop transformations (option -Ol/-OL)

Transform a loop with the entry point at the bottom, to a loop with the entry point at the top. This enables constant propagation in the initial loop test and code motion of loop invariant code by the CSE optimization.

Forward store (option -Oo/-OO)

A temporary variable is used to cache multiple assignments (stores) to the same non-automatic variable.

3.5.2. Core Specific Optimizations (backend)

Coalescer (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV instruction) by smart use of registers. This optimizes both speed and code size.

Interprocedural register optimization (option -Ob/-OB)

Register allocation is improved by taking note of register usage in functions called by a given function.

Peephole optimizations (option -Oy/-OY)

The generated assembly code is improved by replacing instruction sequences by equivalent but faster and/or shorter sequences, or by deleting unnecessary instructions.

Generic assembly optimizations (option -Og/-OG)

A set of optimizations on the generated assembly code that increase speed and decrease code size, similar to peephole optimizations applied within and across basic blocks. The set includes but is not limited to:

- removal of unused code
• removal of superfluous code
• loop optimizations
• flow optimizations

### 3.5.3. Optimize for Code Size or Execution Speed

You can tell the compiler to focus on execution speed or code size during optimizations. You can do this by specifying a size/speed trade-off level from 0 (speed) to 4 (size). This trade-off does not turn optimization phases on or off. Instead, its level is a weight factor that is used in the different optimization phases to influence the heuristics. The higher the level, the more the compiler focusses on code size optimization. To choose a trade-off value read the description below about which optimizations are affected and the impact of the different trade-off values.

Note that the trade-off settings are directions and there is no guarantee that these are followed. The compiler may decide to generate different code if it assessed that this would improve the result.

**Optimization hint:** Optimizing for size has a speed penalty and vice versa. The advice is to optimize for size by default and only optimize those areas for speed that are critical for the application with respect to speed. Using the tradeoff options `-t0`, `-t1` and `-t2` globally for the application is not recommended.

To specify the size/speed trade-off optimization level:

1. From the **Project** menu, select **Properties for**
   
   The Properties dialog appears.

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   In the right pane the Settings appear.

3. On the Tool Settings tab, select **C Compiler » Optimization**.

4. Select a trade-off level in the **Trade-off between speed and size** box.

See also **C compiler option --tradeoff (-t)**

### Instruction Selection

Trade-off levels 0, 1 and 2: the compiler selects the instructions with the smallest number of cycles.

Trade-off levels 3 and 4: the compiler selects the instructions with the smallest number of bytes.

### Loop Optimization

For a top-loop, the loop is entered at the top of the loop. A bottom-loop is entered at the bottom. Every loop has a test and a jump at the bottom of the loop, otherwise it is not possible to create a loop. Some top-loops also have a conditional jump before the loop. This is only necessary when the number of loop
iterations is unknown. The number of iterations might be zero, in this case the conditional jump jumps
over the loop.

Bottom loops always have an unconditional jump to the loop test at the bottom of the loop.

<table>
<thead>
<tr>
<th>Trade-off value</th>
<th>Try to rewrite top-loops to bottom-loops</th>
<th>Optimize loops for size/speed</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>no</td>
<td>speed</td>
</tr>
<tr>
<td>1</td>
<td>yes</td>
<td>speed</td>
</tr>
<tr>
<td>2</td>
<td>yes</td>
<td>speed</td>
</tr>
<tr>
<td>3</td>
<td>yes</td>
<td>size</td>
</tr>
<tr>
<td>4</td>
<td>yes</td>
<td>size</td>
</tr>
</tbody>
</table>

Example:

```c
int a;

void i( int l, int m )
{
    int i;

    for ( i = m; i < l; i++ )
    {
        a++;
    }
    return;
}
```

Coded as a bottom loop (compiled with \texttt{--tradeoff=4}) is:

```
  mrd r5,a
  jmp .L2      ;; unconditional jump to loop test at bottom
.L3:
  addl r5,#1
  addl r3,#1
.L2:                      ;; loop entry point
  ats r3,r2
  jbs sta,#4,.L3
  mwr r5,a
```

Coded as a top loop (compiled with \texttt{--tradeoff=0}) is:

```
  mrd r5,a
  ats r3,r2      ;; test for at least one loop iteration
  jbc sta,#4,.L2 ;; can be omitted when number of iterations is known
.L3:              ;; loop entry point
  addl r5,#1
  addl r3,#1
```
Automatic Function Inlining

You can enable automatic function inlining with the option \texttt{--optimize=+inline} (-\texttt{O1}) or by using \texttt{#pragma optimize +inline}. This option is also part of the -\texttt{O3} predefined option set.

When automatic inlining is enabled, you can use the options \texttt{--inline-max-incr} and \texttt{--inline-max-size} (or their corresponding pragmas \texttt{inline_max_incr} / \texttt{inline_max_size}) to control automatic inlining. By default their values are set to -1. This means that the compiler will select a value depending upon the selected trade-off level. The defaults are:

<table>
<thead>
<tr>
<th>Trade-off value</th>
<th>inline-max-incr</th>
<th>inline-max-size</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>100</td>
<td>50</td>
</tr>
<tr>
<td>1</td>
<td>50</td>
<td>25</td>
</tr>
<tr>
<td>2</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>3</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>4</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

For example with trade-off value 1, the compiler inlines all functions that are smaller or equal to 25 internal compiler units. After that the compiler tries to inline even more functions as long as the function will not grow more than 50%.

When these options/pragmas are set to a value >= 0, the specified value is used instead of the values from the table above.

Static functions that are called only once, are always inlined, independent of the values chosen for inline-max-incr and inline-max-size.

3.6. Static Code Analysis

Static code analysis (SCA) is a relatively new feature in compilers. Various approaches and algorithms exist to perform SCA, each having specific pros and cons.

SCA Implementation Design Philosophy

SCA is implemented in the TASKING compiler based on the following design criteria:

- An SCA phase does not take up an excessive amount of execution time. Therefore, the SCA can be performed during a normal edit-compile-debug cycle.
- SCA is implemented in the compiler front-end. Therefore, no new makefiles or work procedures have to be developed to perform SCA.
The number of emitted false positives is kept to a minimum. A false positive is a message that indicates that a correct code fragment contains a violation of a rule/recommendation. A number of warnings is issued in two variants, one variant when it is guaranteed that the rule is violated when the code is executed, and the other variant when the rules is potentially violated, as indicated by a preceding warning message.

For example see the following code fragment:

```c
extern int some_condition(int);
void f(void)
{
    char buf[10];
    int i;

    for (i = 0; i <= 10; i++)
    {
        if (some_condition(i))
        {
            buf[i] = 0; /* subscript may be out of bounds */
        }
    }
}
```

As you can see in this example, if \(i=10\) the array \(buf[]\) might be accessed beyond its upper boundary, depending on the result of \(\text{some\_condition}(i)\). If the compiler cannot determine the result of this function at run-time, the compiler issues the warning "subscript is possibly out of bounds" preceding the CERT warning "ARR35: do not allow loops to iterate beyond the end of an array". If the compiler can determine the result, or if the \(if\) statement is omitted, the compiler can guarantee that the "subscript is out of bounds".

The SCA implementation has real practical value in embedded system development. There are no real objective criteria to measure this claim. Therefore, the TASKING compilers support well known standards for safety critical software development such as the MISRA guidelines for creating software for safety critical automotive systems and secure "CERT C Secure Coding Standard" released by CERT. CERT is founded by the US government and studies internet and networked systems security vulnerabilities, and develops information to improve security.

**Effect of optimization level on SCA results**

The SCA implementation in the TASKING compilers has the following limitations:

- Some violations of rules will only be detected when a particular optimization is enabled, because they rely on the analysis done for that optimization, or on the transformations performed by that optimization. In particular, the constant propagation and the CSE/PRE optimizations are required for some checks. It is preferred that you enable these optimizations. These optimizations are enabled with the default setting of the optimization level (-O2).

- Some checks require cross-module inspections and violations will only be detected when multiple source files are compiled and linked together by the compiler in a single invocation.
3.6.1. C Code Checking: CERT C

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C programming language. The goal of these rules and recommendations is to eliminate insecure coding practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure coding standard will lead to higher-quality systems that are robust and more resistant to attack.

For details about the standard, see the CERT C Secure Coding Standard web site. For general information about CERT secure coding, see www.cert.org/secure-coding.

Versions of the CERT C standard

Version 1.0 of the CERT C Secure Coding Standard is available as a book by Robert C. Seacord [Addison-Wesley]. Whereas the web site is a wiki and reflects the latest information, the book serves as a fixed point of reference for the development of compliant applications and source code analysis tools.

The rules and recommendations supported by the TASKING compiler reflect the version of the CERT web site as of June 1 2009.

The following rules/recommendations implemented by the TASKING compiler, are not part of the book: PRE11-C, FLP35-C, FLP36-C, MSC32-C

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler, see Chapter 15, CERT C Secure Coding Standard.

Priority and Levels of CERT C

Each CERT C rule and recommendation has an assigned priority. Three values are assigned for each rule on a scale of 1 to 3 for

- severity - how serious are the consequences of the rule being ignored
  1. low (denial-of-service attack, abnormal termination)
  2. medium (data integrity violation, unintentional information disclosure)
  3. high (run arbitrary code)

- likelihood - how likely is it that a flaw introduced by ignoring the rule could lead to an exploitable vulnerability
  1. unlikely
  2. probable
  3. likely

- remediation cost - how expensive is it to comply with the rule
  1. high (manual detection and correction)
  2. medium (automatic detection and manual correction)
3. low (automatic detection and correction)

The three values are then multiplied together for each rule. This product provides a measure that can be used in prioritizing the application of the rules. These products range from 1 to 27. Rules and recommendations with a priority in the range of 1-4 are level 3 rules (low severity, unlikely, expensive to repair flaws), 6-9 are level 2 (medium severity, probable, medium cost to repair flaws), and 12-27 are level 1 (high severity, likely, inexpensive to repair flaws).

The TASKING compiler checks most of the level 1 and some of the level 2 CERT C recommendations/rules.

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler, see Chapter 15, CERT C Secure Coding Standard.

To apply CERT C code checking to your application

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » CERT C Secure Coding.

4. Make a selection from the CERT C secure code checking list.

5. If you selected Custom, expand the Custom CERT C entry and enable one or more individual recommendations/rules.

On the command line you can use the option --cert.

    cmcs --cert=\{all | name [-name],\}...

With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all supported checks in the preprocessor category.

3.6.2. C Code Checking: MISRA C

The C programming language is a standard for high level language programming in embedded systems, yet it is considered somewhat unsuitable for programming safety-related applications. Through enhanced code checking and strict enforcement of best practice programming rules, TASKING MISRA C code checking helps you to produce more robust code.

MISRA C specifies a subset of the C programming language which is intended to be suitable for embedded automotive systems. It consists of a set of rules, defined in MISRA-C:2004, Guidelines for the Use of the C Language in Critical Systems (Motor Industry Research Association (MIRA), 2004).

The compiler also supports MISRA C:1998, the first version of MISRA C and MISRA C: 2012, the latest version of MISRA C. You can select the version with the following C compiler option:
In your C source files you can check against the MISRA C version used. For example:

```c
#if __MISRAC_VERSION__ == 1998
    ...
#elif __MISRAC_VERSION__ == 2004
    ...
#elif __MISRAC_VERSION__ == 2012
    ...
#endif
```

For a complete overview of all MISRA C rules, see Chapter 16, *MISRA C Rules*.

**Implementation issues**

The MISRA C implementation in the compiler supports nearly all rules. Only a few rules are not supported because they address documentation, run-time behavior, or other issues that cannot be checked by static source code inspection, or because they require an application-wide overview.

During compilation of the code, violations of the enabled MISRA C rules are indicated with error messages and the build process is halted.

MISRA C rules are divided in mandatory rules, required rules and advisory rules. If rules are violated, errors are generated causing the compiler to stop. With the following options warnings, instead of errors, are generated:

```c
--misrac-mandatory-warnings
--misrac-required-warnings
--misrac-advisory-warnings
```

Note that not all MISRA C violations will be reported when other errors are detected in the input source. For instance, when there is a syntax error, all semantic checks will be skipped, including some of the MISRA C checks. Also note that some checks cannot be performed when the optimizations are switched off.

**Quality Assurance report**

To ensure compliance to the MISRA C rules throughout the entire project, the TASKING linker can generate a MISRA C Quality Assurance report. This report lists the various modules in the project with the respective MISRA C settings at the time of compilation. You can use this in your company’s quality assurance system to provide proof that company rules for best practice programming have been applied in the particular project.

**To apply MISRA C code checking to your application**

1. From the **Project** menu, select **Properties for**
2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » MISRA C.


5. In the MISRA C checking box select a MISRA C configuration. Select a predefined configuration for conformance with the required rules in the MISRA C guidelines.

6. (Optional) In the Custom 1998, Custom 2004 or Custom 2012 entry, specify the individual rules.

   cmcs --misrac= {all | number [-number],...}

### 3.7. C Compiler Error Messages

The C compiler reports the following types of error messages in the Problems view of Eclipse.

**F (Fatal errors)**

After a fatal error the compiler immediately aborts compilation.

**E (Errors)**

Errors are reported, but the compiler continues compilation. No output files are produced unless you have set the C compiler option --keep-output-files (the resulting output file may be incomplete).

**W (Warnings)**

Warning messages do not result into an erroneous assembly output file. They are meant to draw your attention to assumptions of the compiler for a situation which may not be correct. You can control warnings in the C/C++ Build » Settings » Tool Settings » C Compiler » Diagnostics page of the Project » Properties for menu (C compiler option --no-warnings).

**I (Information)**

Information messages are always preceded by an error message. Information messages give extra information about the error.

**S (System errors)**

System errors occur when internal consistency checks fail and should never occur. When you still receive the system error message

   S9##: internal consistency check failed - please report
please report the error number and as many details as possible about the context in which the error occurred.

**Display detailed information on diagnostics**

1. From the **Window** menu, select **Show View » Other » TASKING » Problems**.
   
   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.
   
   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.
   
   *A dialog box appears with additional information.*

On the command line you can use the **C compiler option -- diag** to see an explanation of a diagnostic message:

```
cmcs --diag=[format:]{all | number,...}
```
Chapter 4. Using the Assembler

This chapter describes the assembly process and explains how to call the assembler.

The assembler converts hand-written or compiler-generated assembly language programs into machine language, resulting in object files in the ELF/DWARF object format.

The assembler takes the following files for input and output:

- assembly file (.s or .asm)
- source file (.c)
- list file (.lst)
- error messages (.err)

The following information is described:

- The assembly process.
- How to call the assembler and how to use its options. An extensive list of all options and their descriptions is included in Section 8.2, Assembler Options.
- The assembler optimizations.
- How to generate a list file.
- Types of assembler messages.

4.1. Assembly Process

The assembler generates relocatable output files with the extension .o. These files serve as input for the linker.

Phases of the assembly process

- Parsing of the source file: preprocessing of assembler directives and checking of the syntax of instructions
- Instruction grouping and reordering
- Optimization (generic instructions)
- Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See Section 2.10, Macro Operations for more information.
4.2. Calling the Assembler

The TASKING VX-toolset for MCS under Eclipse can use the internal builder (default) or the TASKING makefile generator (external builder) to build your entire project. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

• Build Selected File(s) ( ). This assembles the selected file(s) without calling the linker.

  1. In the C/C++ Projects view, select the files you want to assemble.
  2. Right-click in the C/C++ Projects view and select Build Selected File(s).

• Build Individual Project ( ).

  To build individual projects incrementally, select Project » Build project.

• Rebuild Project ( ). This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.

  1. Select Project » Clean...
  2. Enable the option Start a build immediately and click OK.

• Build Automatically. This performs a build of all projects whenever any project file is saved, such as your makefile.

  This way of building is not recommended, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them once.

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Processor.

   In the right pane the Processor page appears.

3. From the Processor selection list, select a processor.
To access the assembler options

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Assembler**.

4. Select the sub-entries and set the options in the various pages.

   Note that the options you enter in the Assembler page are not only used for hand-coded assembly files, but also for the assembly files generated by the compiler.

You can find a detailed description of all assembler options in Section 8.2, *Assembler Options*.

**Invocation syntax on the command line (Windows Command Prompt):**

```
asmcs [ [option]... [file]... ]...
```

The input file must be an assembly source file (.asm, .mcs or .src).

### 4.3. How the Assembler Searches Include Files

When you use include files (with the **.INCLUDE** directive), you can specify their location in several ways. The assembler searches the specified locations in the following order:

1. If the **.INCLUDE** directive contains an absolute path name, the assembler looks for this file. If no path or a relative path is specified, the assembler looks in the same directory as the source file.

2. When the assembler did not find the include file, it looks in the directories that are specified in the **Assembler » Include Paths** page in the **C/C++ Build » Settings » Tool Settings** tab of the Project Properties dialog (equivalent to the **-I** command line option).

3. When the assembler did not find the include file (because it is not in the specified include directory or because no directory is specified), it looks in the path(s) specified in the environment variable **ASMCSINC**.

4. When the assembler still did not find the include file, it finally tries the default include directory relative to the installation directory.

**Example**

Suppose that the assembly source file `test.asm` contains the following lines:

```
.INCLUDE 'myinc.inc'
```
You can call the assembler as follows:

```
asmcs ~Imyinclude test.asm
```

First the assembler looks for the file `myinc.asm`, in the directory where `test.asm` is located. If the file is not there the assembler searches in the directory `myinclude`. If it was still not found, the assembler searches in the environment variable `ASMCSINC` and then in the default `include` directory.

### 4.4. Assembler Optimizations

The assembler can perform various optimizations that you can enable or disable.

1. From the **Project** menu, select **Properties for**
   
   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Assembler » Optimization**.

4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each optimization is given in brackets.

#### Allow generic instructions (option -Og/-OG)

When this option is enabled, you can use generic instructions in your assembly source. The assembler tries to replace instructions by faster or smaller instructions.

By default this option is enabled. Because shorter instructions may influence the number of cycles, you may want to disable this option when you have written timed code. In that case the assembler encodes all instructions as they are.

### 4.5. Generating a List File

The list file is an additional output file that contains information about the generated code. You can customize the amount and form of information.

If the assembler generates errors or warnings, these are reported in the list file just below the source line that caused the error or warning.

**To generate a list file**

1. From the **Project** menu, select **Properties for**
   
   *The Properties dialog appears.*
2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Assembler » List File**.

4. Enable the option **Generate list file**.

5. (Optional) Enable the options to include that information in the list file.

**Example on the command line (Windows Command Prompt)**

The following command generates the list file *test.lst*:

```
asmcs -l test.asm
```

See Section 11.1, *Assembler List File Format*, for an explanation of the format of the list file.

### 4.6. Assembler Error Messages

The assembler reports the following types of error messages in the Problems view of Eclipse.

**F (Fatal errors)**

After a fatal error the assembler immediately aborts the assembly process.

**E (Errors)**

Errors are reported, but the assembler continues assembling. No output files are produced unless you have set the **assembler option **--keep-output-files** (the resulting output file may be incomplete).

**W (Warnings)**

Warning messages do not result into an erroneous assembly output file. They are meant to draw your attention to assumptions of the assembler for a situation which may not be correct. You can control warnings in the **C/C++ Build » Settings » Tool Settings » Assembler » Diagnostics** page of the **Project » Properties for** menu (assembler option **--no-warnings**).

**Display detailed information on diagnostics**

1. From the **Window menu**, select **Show View » Other » TASKING » Problems**.

   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.

   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.
A dialog box appears with additional information.

On the command line you can use the assembler option `--diag` to see an explanation of a diagnostic message:

```
asmcs --diag=[format:] {all | number,...}
```
Chapter 5. Using the Linker

This chapter describes the linking process, how to call the linker and how to control the linker with a script file.

The TASKING linker is a combined linker/locator. The linker phase combines relocatable object files (.o files, generated by the assembler), and libraries into a single relocatable linker object file (.out). The locator phase assigns absolute addresses to the linker object file and creates an absolute object file which you can load into a target processor. From this point the term linker is used for the combined linker/locator.

The linker can simultaneously link and locate all programs for all cores available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard processor with some external memory that executes one task. A complex target board may contain multiple standard processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute a different program, and external memory may be shared by multiple cores.

The linker takes the following files for input and output:

```
relocatable object files .o
relocatable linker object file .out
relocatable object library .a
linker script file .lsl
linker map file .map
error messages .elm
memory definition file .mdf
Intel Hex absolute object file .hex
ELF/DWARF absolute object file .elf
Motorola S-record absolute object file .sce
```

This chapter first describes the linking process. Then it describes how to call the linker and how to use its options. An extensive list of all options and their descriptions is included in Section 8.3, Linker Options.

To control the link process, you can write a script for the linker. This chapter shortly describes the purpose and basic principles of the Linker Script Language (LSL) on the basis of an example. A complete description of the LSL is included in Linker Script Language.

5.1. Linking Process

The linker combines and transforms relocatable object files (.o) into a single absolute object file. This process consists of two phases: the linking phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files and libraries into a single relocatable object file. In the second phase, the linker assigns absolute addresses to the object file so it can actually be loaded into a target.
### Terms used in the linking process

<table>
<thead>
<tr>
<th>Term</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Absolute object file</td>
<td>Object code in which addresses have fixed absolute values, ready to load into a target.</td>
</tr>
<tr>
<td>Address</td>
<td>A specification of a location in an address space.</td>
</tr>
<tr>
<td>Address space</td>
<td>The set of possible addresses. A core can support multiple spaces, for example in a Harvard architecture the addresses that identify the location of an instruction refer to code space, whereas addresses that identify the location of a data object refer to a data space.</td>
</tr>
<tr>
<td>Architecture</td>
<td>A description of the characteristics of a core that are of interest for the linker. This encompasses the address space(s) and the internal bus structure. Given this information the linker can convert logical addresses into physical addresses.</td>
</tr>
<tr>
<td>Copy table</td>
<td>A section created by the linker. This section contains data that specifies how the startup code initializes the data and BSS sections. For each section the copy table contains the following fields:</td>
</tr>
<tr>
<td></td>
<td>• action: defines whether a section is copied or zeroed</td>
</tr>
<tr>
<td></td>
<td>• destination: defines the section's address in RAM</td>
</tr>
<tr>
<td></td>
<td>• source: defines the sections address in ROM, zero for BSS sections</td>
</tr>
<tr>
<td></td>
<td>• length: defines the size of the section in MAUs of the destination space</td>
</tr>
<tr>
<td>Core</td>
<td>An instance of an architecture.</td>
</tr>
<tr>
<td>Derivative</td>
<td>The design of a processor. A description of one or more cores including internal memory and any number of buses.</td>
</tr>
<tr>
<td>Library</td>
<td>Collection of relocatable object files. Usually each object file in a library contains one symbol definition (for example, a function).</td>
</tr>
<tr>
<td>Logical address</td>
<td>An address as encoded in an instruction word, an address generated by a core (CPU).</td>
</tr>
<tr>
<td>LSL file</td>
<td>The set of linker script files that are passed to the linker.</td>
</tr>
<tr>
<td>MAU</td>
<td>Minimum Addressable Unit. For a given processor the number of bits between an address and the next address. This is not necessarily a byte or a word.</td>
</tr>
<tr>
<td>Object code</td>
<td>The binary machine language representation of the assembly source.</td>
</tr>
<tr>
<td>Physical address</td>
<td>An address generated by the memory system.</td>
</tr>
<tr>
<td>Processor</td>
<td>An instance of a derivative. Usually implemented as a (custom) chip, but can also be implemented in an FPGA, in which case the derivative can be designed by the developer.</td>
</tr>
<tr>
<td>Relocatable object file</td>
<td>Object code in which addresses are represented by symbols and thus relocatable.</td>
</tr>
<tr>
<td>Relocation</td>
<td>The process of assigning absolute addresses.</td>
</tr>
</tbody>
</table>
### 5.1.1. Phase 1: Linking

The linker takes one or more relocatable object files and/or libraries as input. A relocatable object file, as generated by the assembler, contains the following information:

- **Header information**: Overall information about the file, such as the code size, name of the source file it was assembled from, and creation date.

- **Object code**: Binary code and data, divided into various named sections. Sections are contiguous chunks of code that have to be placed in specific parts of the memory. The program addresses start at zero for each section in the object file.

- **Symbols**: Some symbols are exported - defined within the file for use in other files. Other symbols are imported - used in the file but not defined (external symbols). Generally these symbols are names of routines or names of data objects.

- **Relocation information**: A list of places with symbolic references that the linker has to replace with actual addresses. When in the code an external symbol (a symbol defined in another file or in a library) is referenced, the assembler does not know the symbol's size and address. Instead, the assembler generates a call to a preliminary relocatable address (usually 0000), while stating the symbol name.

- **Debug information**: Other information about the object code that is used by a debugger. The assembler optionally generates this information and can consist of line numbers, local symbols and descriptions of data structures.

The linker resolves the external references between the supplied relocatable object files and/or libraries and combines the files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files and libraries. If the linker encounters an unresolved symbol, it remembers its name and continues scanning. The symbol may be defined elsewhere in the same file, or in one of the other files or libraries that you specified to the linker. If the symbol is defined in a library, the linker extracts the object file with the symbol definition from the library. This way the linker collects all definitions and references of all of the symbols.

Next, the linker combines sections with the same section name and attributes into single sections. The linker also substitutes (external) symbol references by (relocatable) numerical addresses where possible.
At the end of the linking phase, the linker either writes the results to a file (a single relocatable object file) or keeps the results in memory for further processing during the locating phase.

The resulting file of the linking phase is a single relocatable object file (.out). If this file contains unresolved references, you can link this file with other relocatable object files (.o) or libraries (.a) to resolve the remaining unresolved references.

With the linker command line option --link-only, you can tell the linker to only perform this linking phase and skip the locating phase. The linker complains if any unresolved references are left.

5.1.2. Phase 2: Locating

In the locating phase, the linker assigns absolute addresses to the object code, placing each section in a specific part of the target memory. The linker also replaces references to symbols by the actual address of those symbols. The resulting file is an absolute object file which you can actually load into a target memory. Optionally, when the resulting file should be loaded into a ROM device the linker creates a so-called copy table section which is used by the startup code to initialize the data and BSS sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to modify this code according to certain rules or relocation expressions to reflect the new addresses. These relocation expressions are stored in the relocatable object file. Consider the following snippet of x86 code that moves the contents of variable a to variable b via the eax register:

A1 3412 0000 mov a,%eax   \(a\) defined at 0x1234, byte reversed
A3 0000 0000 mov %eax,b   \(b\) is imported so the instruction refers to 0x0000 since its location is unknown

Now assume that the linker links this code so that the section in which a is located is relocated by 0x10000 bytes, and b turns out to be at 0x9A12. The linker modifies the code to be:

A1 3412 0100 mov a,%eax   \(0x10000\) added to the address
A3 129A 0000 mov %eax,b   \(0x9A12\) patched in for b

These adjustments affect instructions, but keep in mind that any pointers in the data part of a relocatable object file have to be modified as well.

Output formats

The linker can produce its output in different file formats. The default ELF/DWARF format (.elf) contains an image of the executable code and data, and can contain additional debug information. The Intel-Hex format (.hex) and Motorola S-record format (.sre) only contain an image of the executable code and data. You can specify a format with the options --output (-o) and --chip-output (-c).

Controlling the linker

Via a so-called linker script file you can gain complete control over the linker. The script language is called the Linker Script Language (LSL). Using LSL you can define:

- The memory installed in the embedded target system:
To assign locations to code and data sections, the linker must know what memory devices are actually installed in the embedded target system. For each physical memory device the linker must know its start-address, its size, and whether the memory is read-write accessible (RAM) or read-only accessible (ROM).

• How and where code and data should be placed in the physical memory:

Embedded systems can have complex memory systems. If for example on-chip and off-chip memory devices are available, the code and data located in internal memory is typically accessed faster and with dissipating less power. To improve the performance of an application, specific code and data sections should be located in on-chip memory. By writing your own LSL file, you gain full control over the locating process.

• The underlying hardware architecture of the target processor.

To perform its task the linker must have a model of the underlying hardware architecture of the processor you are using. For example the linker must know how to translate an address used within the object file (a logical address) into an offset in a particular memory device (a physical address). In most linkers this model is hard coded in the executable and can not be modified. For the TASKING linker this hardware model is described in the linker script file. This solution is chosen to support configurable cores that are used in system-on-chip designs.

When you want to write your own linker script file, you can use the standard linker script files with architecture descriptions delivered with the product.

See also Section 5.7, Controlling the Linker with a Script.

5.2. Calling the Linker

In Eclipse you can set options specific for the linker. After you have built your project, the output files are available in a subdirectory of your project directory, depending on the active configuration you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

• Build Individual Project (.).

To build individual projects incrementally, select Project » Build project.

• Rebuild Project (.). This builds every file in the project whether or not a file has been modified since the last build. A rebuild is a clean followed by a build.

   1. Select Project » Clean...

   2. Enable the option Start a build immediately and click OK.
• Build Automatically. This performs a build of all projects whenever any project file is saved, such as your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically and ensure there is a check mark beside the Build Automatically menu item. In order for this option to work, you must also enable option Build on resource save (Auto build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

To access the linker options

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker.

4. Select the sub-entries and set the options in the various pages.

You can find a detailed description of all linker options in Section 8.3, Linker Options.

Invocation syntax on the command line (Windows Command Prompt):

```
lmcs [ [option]... [file]... ]...
```

When you are linking multiple files, either relocatable object files (.o) or libraries (.a), it is important to specify the files in the right order. This is explained in Section 5.3, Linking with Libraries.

You can find a detailed description of all linker options in Section 8.3, Linker Options.

Example:

```
lmcs -dtc27x.1sl test.o
```

This links and locates the file test.o and generates the file test.elf.

5.3. Linking with Libraries

There are two kinds of libraries: system libraries and user libraries.

System library

System libraries are stored in the directory:

```
<installation path>\lib\mcs30\[be|le] (MCS v3.0 libraries)
<installation path>\lib\mcs31\[be|le] (MCS v3.1 libraries)
```

The libraries are available in big-endian (be) or little-endian (le) variants.
An overview of the system libraries is given in the table in Chapter 10, Libraries.

Sources for the libraries are present in the directories `lib\src, lib\src.*` in the form of an executable. If you run the executable it will extract the sources in the corresponding directory.

**To link the default C (system) libraries**

1. From the **Project** menu, select **Properties for**
   
   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Linker » Libraries**.

4. Enable the option **Link default libraries**.

When you want to link system libraries from the command line, you must specify this with the option `--library` (`-l`). For example, to specify the system library `libc.a`, type:

```
lmcs --library=c test.o
```

**User library**

You can create your own libraries. Section 6.3, Archiver describes how you can use the archiver to create your own library with object modules.

**To link user libraries**

1. From the **Project** menu, select **Properties for**
   
   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Linker » Libraries**.

4. Add your libraries to the **Libraries** box.

When you want to link user libraries from the command line, you must specify their filenames on the command line:

```
lmcs start.o mylib.a
```

If the library resides in a sub-directory, specify that directory with the library name:

```
lmcs start.o mylibs\mylib.a
```

If you do not specify a directory, the linker searches the library in the current directory only.
Library order

The order in which libraries appear on the command line is important. By default the linker processes object files and libraries in the order in which they appear at the command line. Therefore, when you use a weak symbol construction, like `printf`, in an object file or your own library, you must position this object/library before the C library.

With the option `--first-library-first` you can tell the linker to scan the libraries from left to right, and extract symbols from the first library where the linker finds it. This can be useful when you want to use newer versions of a library routine:

```
lmcs --first-library-first a.a test.o b.a
```

If the file `test.o` calls a function which is both present in `a.a` and `b.a`, normally the function in `b.a` would be extracted. With this option the linker first tries to extract the symbol from the first library `a.a`.

Note that routines in `b.a` that call other routines that are present in both `a.a` and `b.a` are now also resolved from `a.a`.

5.3.1. How the Linker Searches Libraries

System libraries

You can specify the location of system libraries in several ways. The linker searches the specified locations in the following order:

1. The linker first looks in the Library search path that are specified in the Linker » Libraries page in the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to the option `--library-directory (-L)`). If you specify the `-L` option without a pathname, the linker stops searching after this step.

2. When the linker did not find the library (because it is not in the specified library directory or because no directory is specified), it looks in the path(s) specified in the environment variable `LIBMCS`.

3. When the linker did not find the library, it tries the default `lib` directory relative to the installation directory (or a processor specific sub-directory).

User library

If you use your own library, the linker searches the library in the current directory only.

5.3.2. How the Linker Extracts Objects from Libraries

A library built with the TASKING archiver `armcs` always contains an index part at the beginning of the library. The linker scans this index while searching for unresolved externals. However, to keep the index as small as possible, only the defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the corresponding object file is extracted from the library and is processed. After processing the object file, the remaining library index is searched. If after a complete search of the library unresolved externals are introduced, the library index will be scanned again. After all files and libraries are processed, and there are still unresolved externals
and you did not specify the linker option --no-rescan, all libraries are rescanned again. This way you do not have to worry about the library order on the command line and the order of the object files in the libraries. However, this rescanning does not work for 'weak symbols'. If you use a weak symbol construction, like printf, in an object file or your own library, you must position this object/library before the C library.

The option --verbose (-v) shows how libraries have been searched and which objects have been extracted.

Resolving symbols

If you are linking from libraries, only the objects that contain symbols to which you refer, are extracted from the library. This implies that if you invoke the linker like:

```
lmcs mylib.a
```

nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches through mylib.a.

It is possible to force a symbol as external (unresolved symbol) with the option --extern (-e):

```
lmcs --extern=main mylib.a
```

In this case the linker searches for the symbol main in the library and (if found) extracts the object that contains main.

If this module contains new unresolved symbols, the linker looks again in mylib.a. This process repeats until no new unresolved symbols are found.

5.4. Incremental Linking

With the TASKING linker it is possible to link incrementally. Incremental linking means that you link some, but not all .o modules to a relocatable object file .out. In this case the linker does not perform the locating phase. With the second invocation, you specify both new .o files as the .out file you had created with the first invocation.

Incremental linking is only possible on the command line.

```
lmcs --incremental test1.o -otest.out
```

This links the file test1.o and generates the file test.out. This file is used again and linked together with test2.o to create the file test.elf (the default name if no output filename is given in the default ELF/DWARF 2 format).

With incremental linking it is normal to have unresolved references in the output file until all .o files are linked and the final .out or .elf file has been reached. The option --incremental (-r) for incremental linking also suppresses warnings and errors because of unresolved symbols.
5.5. Importing Binary Files

With the TASKING linker it is possible to add a binary file to your absolute output file. In an embedded application you usually do not have a file system where you can get your data from. With the linker option `--import-object` you can add raw data to your application. This makes it possible for example to display images on a device or play audio. The linker puts the raw data from the binary file in a section. The section is aligned on a 4-byte boundary. The section name is derived from the filename, in which dots are replaced by an underscore. So, when importing a file called `my.mp3`, a section with the name `my_mp3` is created. In your application you can refer to the created section by using linker labels.

For example:

```assembly
.extern __lc_ub_my_mp3; /* linker labels */
.extern __lc_ue_my_mp3;
```

If you want to use the export functionality of Eclipse, the binary file has to be part of your project.

5.6. Linker Optimizations

During the linking and locating phase, the linker looks for opportunities to optimize the object code. Both code size and execution speed can be optimized.

To enable or disable optimizations

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.

   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select **Linker » Optimization**.

4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each optimization is given in brackets.

**Delete unreferenced sections (option -Oc/-OC)**

This optimization removes unused sections from the resulting object file.

**First fit decreasing (option -Ol/-OL)**

When the physical memory is fragmented or when address spaces are nested it may be possible that a given application cannot be located although the size of the available physical memory is larger than the
sum of the section sizes. Enable the first-fit-decreasing optimization when this occurs and re-link your application.

The linker’s default behavior is to place sections in the order that is specified in the LSL file (that is, working from low to high memory addresses or vice versa). This also applies to sections within an unrestricted group. If a memory range is partially filled and a section must be located that is larger than the remainder of this range, then the section and all subsequent sections are placed in a next memory range. As a result of this gaps occur at the end of a memory range.

When the first-fit-decreasing optimization is enabled the linker will first place the largest sections in the smallest memory ranges that can contain the section. Small sections are located last and can likely fit in the remaining gaps.

**Compress copy table (option -Ot/-OT)**

The startup code initializes the application’s data areas. The information about which memory addresses should be zeroed and which memory ranges should be copied from ROM to RAM is stored in the copy table.

When this optimization is enabled the linker will try to locate sections in such a way that the copy table is as small as possible thereby reducing the application’s ROM image.

**Delete duplicate code (option -Ox/-OX)**

**Delete duplicate constant data (option -Oy/-OY)**

These two optimizations remove code and constant data that is defined more than once, from the resulting object file.

### 5.7. Controlling the Linker with a Script

With the options on the command line you can control the linker’s behavior to a certain degree. From Eclipse it is also possible to determine where your sections will be located, how much memory is available, which sorts of memory are available, and so on. Eclipse passes these locating directions to the linker via a script file. If you want even more control over the locating process you can supply your own script.

The language for the script is called the **Linker Script Language**, or shortly LSL. You can specify the script file to the linker, which reads it and locates your application exactly as defined in the script. If you do not specify your own script file, the linker always reads a standard script file which is supplied with the toolset.

### 5.7.1. Purpose of the Linker Script Language

The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target’s core architecture. This definition is supplied with the toolset.

2. It provides the linker with a specification of the memory attached to the target processor.
3. It provides the linker with information on how your application should be located in memory. This gives you, for example, the possibility to create overlaying sections.

The linker accepts multiple LSL files. You can use the specifications of the core architectures that Altium has supplied in the include.lsl directory. Do not change these files.

If you use a different memory layout than described in the LSL file supplied for the target core, you must specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your LSL file that contains the memory specification to the linker. Next you may want to specify how sections should be located and overlaid. You can do this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard C preprocessor keywords, such as #include and #define, because the linker sends the script file first to the C preprocessor before it starts interpreting the script.

The complete LSL syntax is described in Chapter 13, Linker Script Language (LSL).

5.7.2. Eclipse and LSL

In Eclipse you can specify the size of the stack and heap; the physical memory attached to the processor; identify that particular address ranges are reserved; and specify which sections are located where in memory. Eclipse translates your input into an LSL file that is stored in the project directory under the name project_name.lsl and passes this file to the linker. If you want to learn more about LSL you can inspect the generated file project_name.lsl.

Because an MCS project is part of a TriCore project you only need to specify an LSL file to the TriCore project.

To add a generated Linker Script File to your project

1. From the File menu, select File » New » TASKING TriCore C/C++ Project.

   The New C/C++ Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the following dialog appears.
3. Enable the option **Add linker script file to the project** and click **Finish**.

*Eclipse creates your project and the file "project_name.lsl" in the project directory.*

If you do not add the linker script file here, you can always add it later with **File » New » Linker Script File (LSL)**

**To change the Linker Script File in Eclipse**

There are two ways of changing the LSL file in Eclipse.

- You can change the LSL file directly in an editor.
  
  1. Double-click on the file *project_name.lsl*.

     *The project LSL file opens in the editor area.*
2. You can edit the LSL file directly in the `project_name`.lsl editor.  
   
   A * appears in front of the name of the LSL file to indicate that the file has changes.

3. Click 📊 or select **File » Save** to save the changes.

- You can also make changes to the property pages Memory (Memory/Reserved/MCS Macros) and Stack/Heap.

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Memory** or **Stack/Heap**.

   *In the right pane the corresponding property page appears.*

3. Make changes to memory and/or stack/heap and click **OK**.

   *The project LSL file is updated automatically according to the changes you make in the pages.*

You can quickly navigate through the LSL file by using the Outline view (**Window » Show View » Outline**).
5.7.3. Preprocessor Macros in the Linker Script Files

The linker script files contain several predefined preprocessor macros. If for some reason you need to change a default value, you can use Eclipse or the linker option \texttt{--define} to define a new value, or add this option via the control program to the linker.

For example, to set the user stack size for channel 0 from the command line to 48, enter:

\texttt{ccmcs -Wl--define=GTM\_MCS\_USER\_STACK\_0=48 test.o}

With option \texttt{-Wl} the control program passes the macro definition to the linker.

The following macros are available in the linker script files.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTM_CPU_ENDIANNESS</td>
<td>Identifies the endianness (big or little) of the main processing cores of the CPU based on the option \texttt{--endianness}.</td>
</tr>
<tr>
<td>GTM_MCFG_CTRL</td>
<td>Identifies the value of the MCFG_CTRL register that determines the GTM memory configuration. The default is 0x00000000, which is no swap and no borrow.</td>
</tr>
<tr>
<td>GTM_MCS_COPYTABLE_SPACE</td>
<td>Identifies the LSL address space (on the CPU) that holds the copy table used to initialize GTM MCS memory.</td>
</tr>
<tr>
<td>GTM_MCS_HEAP</td>
<td>Identifies the size of the heap. The default is 256 octets.</td>
</tr>
<tr>
<td>GTM_MCS_MAIN_CHANNEL</td>
<td>It is possible to execute the \texttt{main()} function on an arbitrary channel. You can set this macro to the channel number in the range [0 .. 7]. If this macro is not defined, the \texttt{main()} function will be executed on channel 0.</td>
</tr>
<tr>
<td>GTM_MCS_NO_START_ADDRESS</td>
<td>If defined, no start address (__START) will specified in the LSL file.</td>
</tr>
<tr>
<td>GTM_MCS_RAM0_SIZE</td>
<td>Identifies the size of a large MCS memory block in octets (default: 0x1000).</td>
</tr>
<tr>
<td>GTM_MCS_STACKS_BALLOONING</td>
<td>By default all MCS stacks have a fixed size. When this macro is defined, stacks will be &quot;ballooning&quot;. This means that after locating all sections, the largest remaining gap in the space is used completely for the stack.</td>
</tr>
<tr>
<td>GTM_MCS_SYSTEM_STACK_channel</td>
<td>Identifies the size of the system stack for the specified channel. \texttt{channel} is a number in the range [0 .. 7]. By default, all MCS stacks are 32 octets.</td>
</tr>
<tr>
<td>GTM_MCS_USER_STACK_channel</td>
<td>Identifies the size of the user stack for the specified channel. \texttt{channel} is a number in the range [0 .. 7]. By default, all MCS stacks are 32 octets.</td>
</tr>
<tr>
<td>MCS_RAM1_EN_ADDR_MSB</td>
<td>If defined as 1, the second memory block of each MCS is half the size of the first memory block. If this macro is undefined, the second memory block of each MCS is the same size as the first memory block.</td>
</tr>
<tr>
<td>MCS00_0RAM __MC_S07_0RAM</td>
<td>Identifies the offset of the memory for core MCS00 .. MCS07 from the GTM base address.</td>
</tr>
</tbody>
</table>
5.7.4. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an *architecture definition* describes how the linker should convert logical addresses into physical addresses for a given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this conversion. In this context a physical address is an offset on a given internal or external bus. Additionally the architecture definition contains information about items such as the user stack and the system stack.

This specification is normally written by Altium. Altium supplies LSL files in the *include.lsl* directory.

The architecture definition of the LSL file should not be changed by you unless you also modify the core’s hardware architecture. If the LSL file describes a multi-core system an architecture definition must be available for each different type of core.

The linker uses the architecture name in the LSL file to identify the target. For example, the default library search path can be different for each core architecture.

The derivative definition

The *derivative definition* describes the configuration of the internal (on-chip) bus and memory system. Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems apart from one or more cores. The design of such a chip is called a *derivative*.

When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the linker automatically instantiates only a single core for an unused architecture.

Altium supplies LSL files for each derivative (*derivative.lsl*). When you use a derivative that is not (yet) supported by the TASKING tools, you may have to write a derivative definition.

The processor definition

The *processor definition* describes an instance of a derivative. A processor definition is only needed in a multi-processor embedded system. It allows you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker automatically creates a processor named 'A' of derivative 'A'. This is why for single-processor applications it is enough to specify the derivative in the LSL file.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory and on-chip buses. In the context of a board specification the memory and bus definitions are used to

---

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>GTM_REDEFINE_ON_CHIP_ITEMS</td>
<td>If defined as 1, no memories are defined in the GTM.</td>
</tr>
</tbody>
</table>
define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical
address into an offset into an on-chip or off-chip memory device.

**The board specification**

The processor definition and memory and bus definitions together form a board specification. LSL provides
language constructs to easily describe single-core and heterogeneous or homogeneous multi-core
systems. The board specification describes all characteristics of your target board's system buses, memory
devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided
in the board specification the linker can for each core:

- convert a logical address to an offset within a memory device
- locate sections in physical memory
- maintain an overall view of the used and free physical memory within the whole system while locating

**The section layout definition (optional)**

The optional section layout definition enables you to exactly control where input sections are located.
Features are provided such as: the ability to place sections at a given address, to place sections in a
given order, and to overlay code and/or data sections.

**Example: Skeleton of a Linker Script File**

A linker script file that defines a derivative "X" based on the TC1V1.6.X and MCS architecture, its external
memory and how sections are located in memory, may have the following skeleton:

```plaintext
architecture TC1V1.6.X
{
    // Specification of the TC1V1.6.X core architecture.
    // Written by Altium.
}

architecture MCS
{
    // Specification of the MCS core architecture.
    // Written by Altium.
}

derivative X  // derivative name is arbitrary
{
    // Specification of the derivative.
    // Written by Altium.
    core tc0    // always specify the core(s)
    {
        architecture = TC1V1.6.X;
        // ...
    }

core tcl     // always specify the core(s)
```

Using the Linker
{  
    architecture = TC1V1.6.X;
    // ...
}

core tc2       // always specify the core(s)
{  
    architecture = TC1V1.6.X;
    // ...
}

core mcs00     // always specify the core(s)
{  
    architecture = MCS;
    // ...
}

core mcs01     // always specify the core(s)
{  
    architecture = MCS;
    // ...
}

core vtc       // virtual core
{  
    architecture = TC1V1.6.X;
    import tc0;
    import tc1;
    import tc2;
}

bus sri       // internal bus
{  
    // maps to bus "fpi_bus" in real "tc0", "tc1", ... cores
    // and virtual core "vtc"
}

    // internal memory
}

processor mpe       // multi-core processor name
{  
    derivative = X;
}

memory ext_name
{
    // external memory definition
}
section_layout : vtc:linear  // section layout
{
    // section placement statements

    // sections are located in address space 'linear'
    // of virtual core 'vtc'
}

See for example the file tc27x.lsl and gtm10_04.lsl in the directory include.lsl for an actual implementation.

**Overview of LSL files delivered by Altium**

Altium supplies the following LSL files in the directory include.lsl.

<table>
<thead>
<tr>
<th>LSL file</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>tc_arch.lsl</td>
<td>Defines the base architecture (TC) for all generic TriCore cores. It includes the files inttab.lsl and traptab.lsl.</td>
</tr>
<tr>
<td>tc_mc_arch.lsl</td>
<td>Defines the base architecture (TC) for all multi-core TriCore cores.</td>
</tr>
<tr>
<td>mcs_arch.lsl</td>
<td>Defines the base architectures (MCS, MCS2.0, MCS3.0, MCS3.1) for all MCS cores.</td>
</tr>
<tr>
<td>inttab.lsl</td>
<td>Defines the interrupt vector table. It is included in the file tc_arch.lsl.</td>
</tr>
<tr>
<td>inttab{0</td>
<td>1</td>
</tr>
<tr>
<td>traptab.lsl</td>
<td>Defines the trap vector table. It is included in the file tc_arch.lsl.</td>
</tr>
<tr>
<td>traptab{0</td>
<td>1</td>
</tr>
<tr>
<td>tc1v1_3.lsl</td>
<td>Extends the base architecture for cores TC1V1.3, TC1V1.3.1, TC1V1.6,TC1V1.6.X or TC1V1.6.2. It includes the file tc_arch.lsl or tc_mc_arch.lsl.</td>
</tr>
<tr>
<td>tc1v1_3_1.lsl</td>
<td></td>
</tr>
<tr>
<td>tc1v1_6.lsl</td>
<td></td>
</tr>
<tr>
<td>tc1v1_6_x.lsl</td>
<td></td>
</tr>
<tr>
<td>tc1v1_6_2.lsl</td>
<td></td>
</tr>
<tr>
<td>derivative.lsl</td>
<td>Defines the derivative and defines a single processor (spe) or a multi-core processor (mpe). Contains a memory definition and section layout.</td>
</tr>
<tr>
<td>userdef13.lsl</td>
<td>Defines a user defined derivative for cores TC1V1.3, TC1V1.3.1, TC1V1.6, TC1V1.6.X or TC1V1.6.2 and defines a single processor for TC1V1.3,</td>
</tr>
<tr>
<td>userdef131.lsl</td>
<td>TC1V1.3.1 and TC1V1.6, and a multi-core processor for TC1V1.6.X and TC1V1.6.2.</td>
</tr>
<tr>
<td>userdef16.lsl</td>
<td></td>
</tr>
<tr>
<td>userdef16x.lsl</td>
<td></td>
</tr>
<tr>
<td>userdef162.lsl</td>
<td></td>
</tr>
<tr>
<td>template.lsl</td>
<td>This file is used by Eclipse as a template for the project LSL file. It includes the file derivative.lsl based on your CPU selection. The CPU is specified by the <strong>CPU</strong> macro.</td>
</tr>
</tbody>
</table>
**LSL file** | **Description**
---|---
default.lsl | Contains a default memory definition and section layout based on the tc1796b derivative. This file is used on a command line invocation of the tools, when no CPU is selected (no option `--cpu`). It includes the file `extmem.lsl`.

extmem.lsl | Template file with a specification of the external memory attached to the target processor.

When you select to add a linker script file when you create a project in Eclipse, Eclipse makes a copy of the file `template.lsl` and names it "`project_name.lsl`". On the command line, the linker uses the file `default.lsl`, unless you specify another file with the linker option `--lsl-file (-d)`.

### 5.7.5. The Architecture Definition

Although you will probably not need to write an architecture definition (unless you are building your own processor core) it helps to understand the Linker Script Language and how the definitions are interrelated.

Within an *architecture definition* the characteristics of a target processor core that are important for the linking process are defined. These include:

- space definitions: the logical address spaces and their properties
- bus definitions: the I/O buses of the core architecture
- mappings: the address translations between logical address spaces, the connections between logical address spaces and buses and the address translations between buses

### Address spaces

A logical address space is a memory range for which the core has a separate way to encode an address into instructions. Most microcontrollers and DSPs support multiple address spaces. For example, separate spaces for code and data. Normally, the size of an address space is $2^N$, with $N$ the number of bits used to encode the addresses.

The relation of an address space with another address space can be one of the following:

- one space is a subset of the other. These are often used for "small" absolute or relative addressing.
- the addresses in the two address spaces represent different locations so they do not overlap. This means the core must have separate sets of address lines for the address spaces. For example, in Harvard architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units (MAU), alignment restrictions, and page sizes. All address spaces have a number that identifies the logical space (id).

The following table lists the different address spaces for the architecture TC as defined in `tc_mc_arch.lsl`.

<table>
<thead>
<tr>
<th>Space</th>
<th>Id</th>
<th>MAU</th>
<th>Description</th>
<th>ELF sections</th>
</tr>
</thead>
<tbody>
<tr>
<td>linear</td>
<td>1</td>
<td>1</td>
<td>Linear address space.</td>
<td>.text, .bss, .data, .rodata, table, istack, ustack</td>
</tr>
</tbody>
</table>
The MCS, which is part of TriCore v1.6.x and v1.6.2 derivatives, such as TC27x, has one address space for architecture MCS as defined in mcs_arch.lsl

<table>
<thead>
<tr>
<th>Space</th>
<th>Id</th>
<th>MAU</th>
<th>Description</th>
<th>ELF sections</th>
</tr>
</thead>
<tbody>
<tr>
<td>abs24</td>
<td>2</td>
<td>8</td>
<td>Absolute 24-bit addressable space</td>
<td></td>
</tr>
<tr>
<td>abs18</td>
<td>3</td>
<td>8</td>
<td>Absolute 18-bit addressable space</td>
<td>.zdata, .zbss</td>
</tr>
<tr>
<td>csa</td>
<td>4</td>
<td>8</td>
<td>Context Save Area</td>
<td>csa.*</td>
</tr>
</tbody>
</table>

### The TriCore architecture in LSL notation

The best way to write the architecture definition, is to start with a drawing. The following figure shows a part of the TriCore architecture TC as defined in tc_mc_arch.lsl:

```
    space linear
    {
        id = 1;
        mau = 8;

        map (src_offset=0x00000000, dest_offset=0x00000000, size=4G, dest=bus:fpi_bus);
    }

    space abs18
    {
        id = 3;
        mau = 8;

        map (src_offset=0x00000000, dest_offset=0x00000000, size=16k, dest=space:linear);
        map (src_offset=0x10000000, dest_offset=0x10000000, size=16k, dest=space:linear);
        map (src_offset=0x20000000, dest_offset=0x20000000, size=16k, dest=space:linear);
    }
```
The keyword `map` corresponds with the arrows in the drawing. You can map:

- address space \( \Rightarrow \) address space
- address space \( \Rightarrow \) bus
- memory \( \Rightarrow \) bus (not shown in the drawing)
- bus \( \Rightarrow \) bus (not shown in the drawing)

Next the internal bus, named `fpi_bus` must be defined in LSL:

```plaintext
bus fpi_bus
{
    mau = 8;
    width = 32;  // there are 32 data lines on the bus
}
```

This completes the LSL code in the architecture definition. Note that all code above goes into the architecture definition, thus between:

```plaintext
architecture TC1V1.6.X
{
    // All code above goes here.
}
```

### 5.7.6. The Derivative Definition

Although you will probably not need to write a derivative definition (unless you are using multiple cores that both access the same memory device) it helps to understand the Linker Script Language and how the definitions are interrelated.

A *derivative* is the design of a processor, as implemented on a chip (or FPGA). It comprises one or more cores and on-chip memory. The derivative definition includes:

- core definition: an instance of a core architecture
- bus definition: the I/O buses of the core architecture
- memory definitions: internal (or on-chip) memory

**Core**

Each derivative must have at least one core and each core must have a specification of its core architecture. This core architecture must be defined somewhere in the LSL file(s).

```plaintext
core mcs00
{
```
architecture = MCS;
copytable_space = vtc:linear; // use copytable from core vtc
}

In a multi-core environment you can combine multiple cores with the same architecture into a single link task. This is done by importing one or more cores into a root core. The imported cores share a single symbol namespace. The address spaces in each imported core must have a unique ID in the link task. For each imported core is specified that the space IDs of the imported core start at a specific offset. If writable sections for a core must be initialized by using the copy table of a different core, this is specified by a copytable_space. The following example is part of tc27x.lsl delivered with the product.

core tc0 // core 0
{
    architecture = TC1V1.6.X;
    space_id_offset = 100; // add 100 to all space IDs in
    // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core tc1 // core 1
{
    architecture = TC1V1.6.X;
    space_id_offset = 200; // add 200 to all space IDs in
    // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core tc2 // core 2
{
    architecture = TC1V1.6.X;
    space_id_offset = 300; // add 300 to all space IDs in
    // the architecture definition
    copytable_space = vtc:linear; // use copytable from core vtc
}
core vtc
{
    architecture = TC1V1.6.X;
    import tc0; // add all address spaces of tc0 for linking
    import tc1; // add all address spaces of tc1 for linking
    import tc2; // add all address spaces of tc2 for linking
}

**Bus**

Each derivative can contain a bus definition for connecting external memory. In this example, the bus fpi_bus maps to the bus fpi_bus defined in the architecture definition of core tc:

bus fpi_bus
{
    mau = 8;
    width = 32;
map (dest=bus:tc:fpi_bus, dest_offset=0, size=4G);

**Memory**

External memory is usually described in a separate memory definition, but you can specify on-chip memory for a derivative. For example:

```lsl
memory dspr0
{
    mau = 8;
    size = 128k;
    type = ram;
    map (dest=bus:tc0:fpi_bus, dest_offset=0xd0000000, size=128k, priority=8);
    map (dest=bus:sri, dest_offset=0xd8000000, size=128k);
}
```

This completes the LSL code in the derivative definition. Note that all code above goes into the derivative definition, thus between:

```lsl
derivative X    // name of derivative
{
    // All code above goes here
}
```

### 5.7.7. The Processor Definition

The processor definition is only needed when you write an LSL file for a multi-processor embedded system. The processor definition explicitly instantiates a derivative, allowing multiple processors of the same type.

```lsl
processor name
{
    derivative = derivative_name;
}
```

If no processor definition is available that instantiates a derivative, a processor is created with the same name as the derivative.

*Altium defines a “multi processor environment” (mpe) in each derivative.lsl file. For example:*

```lsl
processor mpe
{
    derivative = tc27x;
}
```
5.7.8. The Memory Definition

Once the core architecture is defined in LSL, you may want to extend the processor with external (or off-chip) memory. You need to specify the location and size of the physical external memory devices in the target system.

The principle is the same as defining the core's architecture but now you need to fill the memory definition:

```
memory name
{
    // memory definitions
}
```

Suppose your embedded system has 16 kB of external ROM, named `code_rom` and 2 kB of external NVRAM, named `my_nvsram`. Both memories are connected to the bus `fpi_bus`. In LSL this looks like:

```
memory code_rom
{
    mau = 8;
    size = 16k;
    type = rom;
    map( dest=bus:mpe:fpi_bus, dest_offset=0xa0000000, size=16k );
}

memory my_nvsram
{
    mau = 8;
    size = 2k;
    type = nvram;
    map( dest=bus:mpe:fpi_bus, dest_offset=0xc0000000, size=2k );
}
```

If you use a different memory layout than described in the LSL file supplied for the target core, you can specify this in Eclipse or you can specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your LSL file that contains the memory specification to the linker.

**To add memory using Eclipse**

1. From the **Project** menu, select **Properties for**

   *The Properties dialog appears.*
2. In the left pane, expand C/C++ Build and select Memory.
   
   In the right pane the Memory page appears.

3. Open the Memory tab and click on the Add... button.
   
   The Add new memory dialog appears.

4. Enter the memory name, type and size.

5. Click on the Add... button.
   
   The Add new mapping dialog appears.

6. You have to specify at least one mapping. Enter the mapping name (optional), address, size and destination and click OK.
   
   The new mapping is added to the list of mappings.

7. Click OK.
   
   The new memory is added to the list of memories (user memory).

8. Click OK to close the Properties dialog.
   
   The updated settings are stored in the project LSL file.

If you make changes to the on-chip memory as defined in the architecture LSL file, the memory is copied to your project LSL file and the line `#define __REDEFINE_ON_CHIP_ITEMS` is added. If you remove all the on-chip memory from your project LSL file, also make sure you remove this define.

5.7.9. The Section Layout Definition: Locating Sections

Once you have defined the internal core architecture and optional memory, you can actually define where your application must be located in the physical memory.

Sections have a name, an indication (section type) in which address space it should be located and attributes like writable or read-only.

In the section layout definition you can exactly define how input sections are placed in address spaces, relative to each other, and what their absolute run-time and load-time addresses will be.

Section placement

Suppose we want to save sections in non-volatile (battery back-upped) memory. This is the memory `my_nvsram` from the example in Section 5.7.8, The Memory Definition.

To control the locating of sections, you need to write one or more section definitions in the LSL file. At least one for each address space where you want to change the default behavior of the linker. In our example, we need to locate sections in the address space `data`:

```
section_layout :mcs00:mcs
{
```
To locate sections, you must create a group in which you select sections from your program. For our example, we need to define one group, which contains the section .mcsdata.non_volatile. All other sections are located using the defaults specified in the architecture definition. Section .mcsdata.non_volatile should be placed in non-volatile ram. To achieve this, the run address refers to our non-volatile memory called my_nvsram.

```plaintext
section_layout :vtc:linear
{
  // Section placement statements
}

group ( ordered, run_addr = mem:my_nvsram )
{
  select ".mcsdata.non_volatile";
}
```

This completes the LSL file for the sample architecture and sample program. You can now invoke the linker with this file and the sample program to obtain an application that works for this architecture.

For a complete description of the Linker Script Language, refer to Chapter 13, *Linker Script Language (LSL)*.

### 5.7.9.1. Locating Code and Data Sections in Separate Pages

When code and data are in the same memory page, this will have a negative effect on the run-time speed. To have the best performance, code must end up in mp0 and data in mp1.

The following example shows how to do this in LSL. Note that for "code in mp0, data in mp0", the directions need to be reversed. Only a `section_layout` with high_to_low is needed since low_to_high is the default.

```plaintext
section_layout :mcs00:mcs (direction=high_to_low)
{
  group (contiguous)
  {
    select ".mcstext";
    select ".mcstext.*";
  }
}

section_layout :mcs00:mcs (direction=low_to_high)
{
  group (contiguous)
  {
    select ".mcsdata";
    select ".mcsdata.*";
  }
}
```
5.8. Linker Labels

The linker creates labels that you can use to refer to from within the application software. Some of these labels are real labels at the beginning or the end of a section. Other labels have a second function, these labels are used to address generated data in the locating phase. The data is only generated if the label is used.

Linker labels are labels starting with `_lc_`. The linker assigns addresses to the following labels when they are referenced:

<table>
<thead>
<tr>
<th>Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>_lc_ub_name</code></td>
<td>Begin of section name. Also used to mark the begin of the stack or heap or copy table.</td>
</tr>
<tr>
<td><code>_lc_b_name</code></td>
<td>Begin of group name. This label appears in the output file even if no reference to the label exists in the input file.</td>
</tr>
<tr>
<td><code>_lc_ue_name</code></td>
<td>End of section name. Also used to mark the end of the stack or heap.</td>
</tr>
<tr>
<td><code>_lc_e_name</code></td>
<td>End of group name. This label appears in the output file even if no reference to the label exists in the input file.</td>
</tr>
<tr>
<td><code>_lc_gb_name</code></td>
<td></td>
</tr>
<tr>
<td><code>_lc_ge_name</code></td>
<td></td>
</tr>
</tbody>
</table>

The linker only allocates space for the stack and/or heap when a reference to either of the section labels exists in one of the input object files.

If there is no LSL file in your project, select File » New » Linker Script File (LSL), add the lines that define the symbol. Add the LSL file to the linker options (Tool Options » Linker » Script File » Linker script file (.lsl)).

When the MCS linked project (.out) is linked with a TriCore project, then the TriCore LSL file also needs this addition.

5.9. Generating a Map File

The map file is an additional output file that contains information about the location of sections and symbols. You can customize the type of information that should be included in the map file.

To generate a map file

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Map File.
4. Enable the option **Generate XML map file format (.mapxml) for map file viewer**.

5. (Optional) Enable the option **Generate map file (.map)**.

6. (Optional) Enable the options to include that information in the map file.

**Example on the command line (Windows Command Prompt)**

The following command generates the map file `test.map`:

```shell
lmcs --map-file test.o
```

With this command the map file `test.map` is created.

See Section 11.2, **Linker Map File Format**, for an explanation of the format of the map file.

### 5.10. Linker Error Messages

The linker reports the following types of error messages in the Problems view of Eclipse.

**F (Fatal errors)**

After a fatal error the linker immediately aborts the link/locate process.

**E (Errors)**

Errors are reported, but the linker continues linking and locating. No output files are produced unless you have set the **linker option --keep-output-files**.

**W (Warnings)**

Warning messages do not result into an erroneous output file. They are meant to draw your attention to assumptions of the linker for a situation which may not be correct. You can control warnings in the **C/C++ Build » Settings » Tool Settings » Linker » Diagnostics** page of the **Project » Properties for** menu (linker option **--no-warnings**).

**I (Information)**

Verbose information messages do not indicate an error but tell something about a process or the state of the linker. To see verbose information, use the **linker option --verbose**.

**S (System errors)**

System errors occur when internal consistency checks fail and should never occur. When you still receive the system error message

```
S6##: message
```

please report the error number and as many details as possible about the context in which the error occurred.

**Display detailed information on diagnostics**

1. From the **Window** menu, select **Show View » Other » TASKING » Problems**.

   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.

   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.

   *A dialog box appears with additional information.*

On the command line you can use the **linker option --diag** to see an explanation of a diagnostic message:

```
lmcs --diag=[format:]all | number,...
```
Chapter 6. Using the Utilities

The TASKING VX-toolset for MCS comes with a number of utilities:

ccmcs  A control program. The control program invokes all tools in the toolset and lets you quickly generate an absolute object file from assembly source input files. Eclipse uses the control program to call the assembler and linker.

amk  The make utility which is used in Eclipse. It supports parallelism which utilizes the multiple cores found on modern host hardware.

armcs  An archiver. With this utility you create and maintain library files with relocatable object modules (.o) generated by the assembler.

hldumpmcs  A high level language (HLL) object dumper. With this utility you can dump information about an absolute object file (.elf). Key features are a disassembler with HLL source intermixing and HLL symbol display and a HLL symbol listing of static and global symbols.

cnvba2ta.pl  A Perl script to convert Bosch MCS assembly to TASKING assembly for MCS.

6.1. Control Program

The control program is a tool that invokes all tools in the toolset for you. It provides a quick and easy way to generate the final absolute object file out of your C sources without the need to invoke the compiler, assembler and linker manually.

Eclipse uses the control program to call the C compiler, assembler and linker, but you can call the control program from the command line. The invocation syntax is:

```
ccmcs [ [option]... [file]... ]...
```

Recognized input files

- Files with a `.c` suffix are interpreted as C source programs and are passed to the compiler.
- Files with a `.asm` suffix are interpreted as hand-written assembly source files which have to be passed to the assembler.
- Files with a `.src` suffix are interpreted as compiled assembly source files. They are directly passed to the assembler.
- Files with a `.a` suffix are interpreted as library files and are passed to the linker.
- Files with a `.o` suffix are interpreted as object files and are passed to the linker.
- Files with a `.out` suffix are interpreted as linked object files and are passed to the locating phase of the linker. The linker accepts only one `.out` file in the invocation.
- Files with a `.lsl` suffix are interpreted as linker script files and are passed to the linker.
Options

The control program accepts several command line options. If you specify an unknown option to the control program, the control program looks if it is an option for a specific tool. If so, it passes the option directly to the tool. However, it is recommended to use the control program options `--pass-*` (`-Wc`, `-Wa`, `-WI`) to pass arguments directly to tools.

For a complete list and description of all control program options, see Section 8.4, Control Program Options.

Example with verbose output

```
ccmcs --verbose --cpu=tc27x test.asm
```

The control program calls all tools in the toolset and generates the absolute object file `test.elf`. With option `--verbose (-v)` you can see how the control program calls the tools:

```
+ "path\asmcs" -D__CPU__=tc27x -D__CPU__=tc27x -o cc3248b.o test.asm
+ "path\lmcs" -o test.elf -dtc27x.lsl --non-romable
  --user-provided-initialization-code -DCSA=0
  --core=mpe:mcs00 --map-file cc3248b.o
```

The control program produces unique filenames for intermediate steps in the build process (such as `cc5966a.src` and `cc5966b.o` in the example above) which are removed afterwards, unless you specify command line option `--keep-temporary-files (-t)`.

Example with argument passing to a tool

```
ccmcs --pass-assembler=-ga test.asm
```

The option `-ga` is directly passed to the assembler.
6.2. Make Utility amk

amk is a make utility that you can use to maintain, update, and reconstruct groups of programs. amk features parallelism which utilizes the multiple cores found on modern host hardware, hardening for path names with embedded white space and it has an (internal) interface to provide progress information for updating a progress bar. It does not use an external command shell (/bin/sh, cmd.exe) but executes commands directly.

The primary purpose of any make utility is to speed up the edit-build-test cycle. To avoid having to build everything from scratch even when only one source file changes, it is necessary to describe dependencies between source files and output files and the commands needed for updating the output files. This is done in a so called "makefile".

6.2.1. Makefile Rules

A makefile dependency rule is a single line of the form:

[target ...] : [prerequisite ...]

where target and prerequisite are path names to files. Example:

test.o : test.c

This states that target test.o depends on prerequisite test.c. So, whenever the latter is modified the first must be updated. Dependencies accumulate: prerequisites and targets can be mentioned in multiple dependency rules (circular dependencies are not allowed however). The command(s) for updating a target when any of its prerequisites have been modified must be specified with leading white space after any of the dependency rule(s) for the target in question. Example:

test.o :
   ccmcs test.c   # leading white space

Command rules may contain dependencies too. Combining the above for example yields:

test.o : test.c
   ccmcs test.c

White space around the colon is not required. When a path name contains special characters such as ‘:’, ‘#’ (start of comment), ‘=’ (macro assignment) or any white space, then the path name must be enclosed in single or double quotes. Quoted strings can contain anything except the quote character itself and a newline. Two strings without white space in between are interpreted as one, so it is possible to embed single and double quotes themselves by switching the quote character.

When a target does not exist, its modification time is assumed to be very old. So, amk will try to make it. When a prerequisite does not exist possibly after having tried to make it, it is assumed to be very new. So, the update commands for the current target will be executed in that case. amk will only try to make targets which are specified on the command line. The default target is the first target in the makefile which does not start with a dot.
Static pattern rules

Static pattern rules are rules which specify multiple targets and construct the prerequisite names for each target based on the target name.

[target ...] : target-pattern : [prerequisite-patterns ...]

The target specifies the targets the rules applies to. The target-pattern and prerequisite-patterns specify how to compute the prerequisites of each target. Each target is matched against the target-pattern to extract a part of the target name, called the stem. This stem is substituted into each of the prerequisite-patterns to make the prerequisite names (one from each prerequisite-pattern).

Each pattern normally contains the character '%' just once. When the target-pattern matches a target, the '%' can match any part of the target name; this part is called the stem. The rest of the pattern must match exactly. For example, the target foo.o matches the pattern '%.o', with 'foo' as the stem. The targets foo.c and foo.elf do not match that pattern.

The prerequisite names for each target are made by substituting the stem for the '%' in each prerequisite pattern.

Example:

objects = test.o filter.o

all: $(objects)

$(objects): %.o: %.c
    ccmcs -c $< -o $@
    echo the stem is $*

Here '$< ' is the automatic variable that holds the name of the prerequisite, '$@ ' is the automatic variable that holds the name of the target and '$* ' is the stem that matches the pattern. Internally this translates to the following two rules:

test.o: test.c
    ccmcs -c test.c -o test.o
    echo the stem is test

filter.o: filter.c
    ccmcs -c filter.c -o filter.o
    echo the stem is filter

Each target specified must match the target pattern; a warning is issued for each target that does not.

Special targets

There are a number of special targets. Their names begin with a period.

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DEFAULT</td>
<td>If you call the make utility with a target that has no definition in the makefile, this target is built.</td>
</tr>
</tbody>
</table>
### Target Description

<table>
<thead>
<tr>
<th>Target</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>.DONE</td>
<td>When the make utility has finished building the specified targets, it continues with the rules following this target.</td>
</tr>
<tr>
<td>.INIT</td>
<td>The rules following this target are executed before any other targets are built.</td>
</tr>
</tbody>
</table>
| .PHONY | The prerequisites of this target are considered to be phony targets. A phony target is a target that is not really the name of a file. The rules following a phony target are executed unconditionally, regardless of whether a file with that name exists or what its last-modification time is. For example:  

```bash
.PHONY: clean  
clean:  
  rm *.o
```

With `amk clean`, the command is executed regardless of whether there is a file named `clean`.

---

### 6.2.2. Makefile Directives

Directives inside makefiles are executed while reading the makefile. When a line starts with the word "include" or "-include" then the remaining arguments on that line are considered filenames whose contents are to be inserted at the current line. "-include" will silently skip files which are not present. You can include several files. Include files may be nested.

Example:

```bash
include makefile2 makefile3
```

White spaces (tabs or spaces) in front of the directive are allowed.

### 6.2.3. Macro Definitions

A *macro* is a symbol name that is replaced with its definition before the makefile is executed. Although the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention. When a line does not start with white space and contains the assignment operator '=' or ':=' then the line is interpreted as a macro definition. White space around the assignment operator and white space at the end of the line is discarded. Single character macro evaluation happens by prefixing the name with `$`. To evaluate macros with names longer than one character put the name between parentheses `{}` or curly braces `{}`. Macro names may contain anything, even white space or other macro evaluations.

Example:

```bash
DINNER = $(FOOD) and $(BEVERAGE)  
FOOD = pizza  
BEVERAGE = sparkling water  
FOOD += with cheese
```
With the `+=` operator you can add a string to an existing macro. An extra space is inserted before the added string automatically.

Macros are evaluated recursively. Whenever `$(DINNER)` or `${DINNER}` is mentioned after the above, it will be replaced by the text "pizza with cheese and sparkling water". The left hand side in a macro definition is evaluated before the definition takes place. Right hand side evaluation depends on the assignment operator:

- `=`: Evaluate the macro at the moment it is used.
- `:=`: Evaluate the replacement text before defining the macro.

Subsequent `+=` assignments will inherit the evaluation behavior from the previous assignment. If there is none, then `+=` is the same as `=`. The default value for any macro is taken from the environment. Macro definitions inside the makefile overrule environment variables. Macro definitions on the `amk` command line will be evaluated first and overrule definitions inside the makefile.
Predefined macros

<table>
<thead>
<tr>
<th>Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>$</td>
<td>This macro translates to a dollar sign. Thus you can use &quot;$$&quot; in the makefile to represent a single &quot;$&quot;.</td>
</tr>
<tr>
<td>@</td>
<td>The name of the current target. When a rule has multiple targets, then it is the name of the target that caused the rule commands to be run.</td>
</tr>
<tr>
<td>*</td>
<td>The basename (or stem) of the current target. The stem is either provided via a static pattern rule or is calculated by removing all characters found after and including the last dot in the current target name. If the target name is 'test.c' then the stem is 'test' (if the target was not created via a static pattern rule).</td>
</tr>
<tr>
<td>&lt;</td>
<td>The name of the first prerequisite.</td>
</tr>
<tr>
<td>MAKE</td>
<td>The amk path name (quoted if necessary). Optionally followed by the options -n and -s.</td>
</tr>
<tr>
<td>ORIGIN</td>
<td>The name of the directory where amk is installed (quoted if necessary).</td>
</tr>
<tr>
<td>SUBDIR</td>
<td>The argument of option -G. If you have nested makes with -G options, the paths are combined. This macro is defined in the environment (i.e. default macro value).</td>
</tr>
</tbody>
</table>

The @, * and < macros may be suffixed by 'D' to specify the directory component or by 'F' to specify the filename component. \$(@D) evaluates to the directory name holding the file \$(@F). \$(@D)/\$(@F) is equivalent to \$@. Note that on MS-Windows most programs accept forward slashes, even for UNC path names.

The result of the predefined macros @, * and < and 'D' and 'F' variants is not quoted, so it may be necessary to put quotes around it.

Note that stem calculation can cause unexpected values. For example:

```
$@
/home/.wine/test
/home/test/.project
/..file
```

```
$*
/home/
/home/test/
/.
```

Macro string substitution

When the macro name in an evaluation is followed by a colon and equal sign as in

\$ (MACRO:string1=string2)

then amk will replace string1 at the end of every word in \$ (MACRO) by string2 during evaluation. When \$ (MACRO) contains quoted path names, the quote character must be mentioned in both the original string and the replacement string¹. For example:

\$ (MACRO:.o"=.d")

¹Internally, amk tokenizes the evaluated text, but performs substitution on the original input text to preserve compatibility here with existing make implementations and POSIX.
6.2.4. Makefile Functions

A function not only expands but also performs a certain operation. The following functions are available:

$(filter pattern ..., item ...)

The filter function filters a list of items using a pattern. It returns items that do match any of the pattern words, removing any items that do not match. The patterns are written using '%',

```
>${filter %.c %.h, test.c test.h test.o readme.txt .project output.c}
```

results in:

```
test.c test.h output.c
```

$(filter-out pattern ..., item ...)

The filter-out function returns all items that do not match any of the pattern words, removing the items that do match one or more. This is the exact opposite of the filter function.

```
>${filter-out %.c %.h, test.c test.h test.o readme.txt .project output.c}
```

results in:

```
test.o readme.txt .project
```

$(foreach var-name, item ..., action)

The foreach function runs through a list of items and performs the same action for each item. The var-name is the name of the macro which gets dynamically filled with an item while iterating through the item list. In the action you can refer to this macro. For example:

```
>${foreach T, test filter output, ${T}.c ${T}.h}
```

results in:

```
test.c test.h filter.c filter.h output.c output.h
```

6.2.5. Conditional Processing

Lines containing ifdef, ifndef, else or endif are used for conditional processing of the makefile. They are used in the following way:

```
ifdef macro-name
if-lines
else
else-lines
endif
```

The if-lines and else-lines may contain any number of lines or text of any kind, even other ifdef, ifndef, else and endif lines, or no lines at all. The else line may be omitted, along with the else-lines following it. White spaces (tabs or spaces) in front of preprocessing directives are allowed.
First the macro-name after the ifdef command is checked for definition. If the macro is defined then the if-lines are interpreted and the else-lines are discarded (if present). Otherwise the if-lines are discarded; and if there is an else line, the else-lines are interpreted; but if there is no else line, then no lines are interpreted.

When you use the ifndef line instead of ifdef, the macro is tested for not being defined. These conditional lines can be nested to any level.

You can also add tests based on strings. With ifeq the result is true if the two strings match, with ifneq the result is true if the two strings do not match. They are used in the following way:

```plaintext
ifeq(string1,string2)
if-lines
else
else-lines
endif
```

### 6.2.6. Makefile Parsing

`amk` reads and interprets a makefile in the following order:

1. When the last character on a line is a backslash (`\`) (i.e. without trailing white space) then that line and the next line will be concatenated, removing the backslash and newline.

2. The unquoted `#` character indicates start of comment and may be placed anywhere on a line. It will be removed in this phase.

   ```plaintext
   # this comment line is continued\ 
on the next line
   ```

3. Trailing white space is removed.

4. When a line starts with white space and it is not followed by a directive or preprocessing directive, then it is interpreted as a command for updating a target.

5. Otherwise, when a line contains the unquoted text `=` or `+=` or `:=` operator, then it will be interpreted as a macro definition.

6. Otherwise, all macros on the line are evaluated before considering the next steps.

7. When the resulting line contains an unquoted `:` the line is interpreted as a dependency rule.

8. When the first token on the line is "include" or "-include" (which by now must start on the first column of the line), `amk` will execute the directive.

9. Otherwise, the line must be empty.

Macros in commands for updating a target are evaluated right before the actual execution takes place (or would take place when you use the `-n` option).
6.2.7. Makefile Command Processing

A line with leading white space (tabs or spaces) without a (preprocessing) directive is considered as a command for updating a target. When you use the option -j or -J, amk will execute the commands for updating different targets in parallel. In that case standard input will not be available and standard output and error output will be merged and displayed on standard output only after the commands have finished for a target.

You can precede a command by one or more of the following characters:

@ Do not show the command. By default, commands are shown prior to their output.
-
Continue upon error. This means that amk ignores a non-zero exit code of the command.
+
Execute the command, even when you use option -n (dry run).
| Execute the command on the foreground with standard input, standard output and error output available.

Built-in commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>true</td>
<td>This command does nothing. Arguments are ignored.</td>
</tr>
<tr>
<td>false</td>
<td>This command does nothing, except failing with exit code 1. Arguments are ignored.</td>
</tr>
<tr>
<td>echo arg...</td>
<td>Display a line of text.</td>
</tr>
<tr>
<td>exit code</td>
<td>Exit with defined code. Depending on the program arguments and/or the extra rule options <code>-t</code> this will cause amk to exit with the provided code. Please note that <code>exit 0</code> has currently no result.</td>
</tr>
<tr>
<td>argfile file arg...</td>
<td>Create an argument file suitable for the <code>--option-file (-f)</code> option of all the other tools. The first <code>argfile</code> argument is the name of the file to be created. Subsequent arguments specify the contents. An existing argument file is not modified unless necessary. So, the argument file itself can be used to create a dependency to options of the command for updating a target.</td>
</tr>
<tr>
<td>rm [option]... file...</td>
<td>Remove the specified file(s). The following options are available:</td>
</tr>
<tr>
<td>-r, --recursive</td>
<td>Remove directories and their contents recursively.</td>
</tr>
<tr>
<td>-f, --force</td>
<td>Force deletion. Ignore non-existent files, never prompt.</td>
</tr>
<tr>
<td>-i, --interactive</td>
<td>Interactive. Prompt before every removal.</td>
</tr>
<tr>
<td>-v, --verbose</td>
<td>Verbose mode. Explain what is being done.</td>
</tr>
<tr>
<td>-m file</td>
<td>Read options from file.</td>
</tr>
<tr>
<td>-?, --help</td>
<td>Show usage.</td>
</tr>
</tbody>
</table>
6.2.8. Calling the amk Make Utility

The invocation syntax of amk is:

```
amk [option]... [target]... [macro=def]...
```

For example:

```
amk test.elf
```

- **target**: You can specify any target that is defined in the makefile. A target can also be one of the intermediate files specified in the makefile.

- **macro=def**: Macro definition. This definition remains fixed for the amk invocation. It overrides any regular definitions for the specified macro within the makefiles and from the environment. It is not inherited by subordinate amk’s

- **option**: For a complete list and description of all amk make utility options, see Section 8.5, Parallel Make Utility Options.

**Exit status**

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an exit status of 0.
6.3. Archiver

The archiver `armcs` is a program to build and maintain your own library files. A library file is a file with extension `.a` and contains one or more object files (.o) that may be used by the linker.

The archiver has five main functions:

- Deleting an object module from the library
- Moving an object module to another position in the library file
- Replacing an object module in the library or add a new object module
- Showing a table of contents of the library file
- Extracting an object module from the library

The archiver takes the following files for input and output:

\[
\begin{align*}
\text{archiver} & \rightarrow \text{relocatable object file} \\
\text{relocatable object library} & \rightarrow \text{assembler} \\
\text{assembler} & \rightarrow \text{linker}
\end{align*}
\]

The linker optionally includes object modules from a library if that module resolves an external symbol definition in one of the modules that are read before.

6.3.1. Calling the Archiver

You can create a library in Eclipse, which calls the archiver or you can call the archiver on the command line.

To create a library in Eclipse

Instead of creating an MCS absolute ELF file, you can choose to create a library. You do this when you create a new project with the New C Project wizard.

1. From the File menu, select New » TASKING MCS C Project.

   *The New C Project wizard appears.*

2. Enter a project name.

3. In the Project type box, select TASKING MCS Library and click Next >.

4. Follow the rest of the wizard and click Finish.

5. Add the files to your project.
6. Build the project as usual. For example, select **Project » Build Project**.

*Eclipse builds the library. Instead of calling the linker, Eclipse now calls the archiver.*

**Command line invocation**

You can call the archiver from the command line. The invocation syntax is:

```
armcs key_option [sub_option...] library [object_file]
```

- **key_option** With a key option you specify the main task which the archiver should perform. You must **always** specify a key option.

- **sub_option** Sub-options specify into more detail how the archiver should perform the task that is specified with the key option. It is not obligatory to specify sub-options.

- **library** The name of the library file on which the archiver performs the specified action. You must always specify a library name, except for the options `-?` and `-V`. When the library is not in the current directory, specify the complete path (either absolute or relative) to the library.

- **object_file** The name of an object file. You must always specify an object file name when you add, extract, replace or remove an object file from the library.

**Options of the archiver utility**

The following archiver options are available:

<table>
<thead>
<tr>
<th>Description</th>
<th>Option</th>
<th>Sub-option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main functions (key options)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace or add an object module</td>
<td><code>-r</code></td>
<td><code>-a -b -c -u -v</code></td>
</tr>
<tr>
<td>Extract an object module from the library</td>
<td><code>-x</code></td>
<td><code>-v</code></td>
</tr>
<tr>
<td>Delete object module from library</td>
<td><code>-d</code></td>
<td><code>-v</code></td>
</tr>
<tr>
<td>Move object module to another position</td>
<td><code>-m</code></td>
<td><code>-a -b -v</code></td>
</tr>
<tr>
<td>Print a table of contents of the library</td>
<td><code>-t</code></td>
<td><code>-s0 -s1</code></td>
</tr>
<tr>
<td>Print object module to standard output</td>
<td><code>-p</code></td>
<td></td>
</tr>
<tr>
<td><strong>Sub-options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules after existing module name</td>
<td><code>-a name</code></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules before existing module name</td>
<td><code>-b name</code></td>
<td></td>
</tr>
<tr>
<td>Create library without notification if library does not exist</td>
<td><code>-c</code></td>
<td></td>
</tr>
<tr>
<td>Preserve last-modified date from the library</td>
<td><code>-o</code></td>
<td></td>
</tr>
<tr>
<td>Print symbols in library modules</td>
<td>`-s{0</td>
<td>1}`</td>
</tr>
<tr>
<td>Replace only newer modules</td>
<td><code>-u</code></td>
<td></td>
</tr>
<tr>
<td>Verbos</td>
<td><code>-v</code></td>
<td></td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
For a complete list and description of all archiver options, see Section 8.6, Archiver Options.

6.3.2. Archiver Examples

Create a new library

If you add modules to a library that does not yet exist, the library is created. To create a new library with the name `mylib.a` and add the object modules `cstart.o` and `calc.o` to it:

```
armcs -r mylib.a cstart.o calc.o
```

Add a new module to an existing library

If you add a new module to an existing library, the module is added at the end of the module. (If the module already exists in the library, it is replaced.)

```
armcs -r mylib.a mod3.o
```

Print a list of object modules in the library

To inspect the contents of the library:

```
armcs -t mylib.a
```

The library has the following contents:

```
cstart.o
calc.o
mod3.o
```

Move an object module to another position

To move `mod3.o` to the beginning of the library, position it just before `cstart.o`:

```
armcs -mb cstart.o mylib.a mod3.o
```

Delete an object module from the library

To delete the object module `cstart.o` from the library `mylib.a`:

```
armcs -d mylib.a cstart.o
```
Extract all modules from the library

Extract all modules from the library `mylib.a`:

```
armcs -x mylib.a
```
6.4. HLL Object Dumper

The high level language (HLL) dumper hldumpmcs is a program to dump information about an absolute object file (.elf). Key features are a disassembler with HLL source intermixing and HLL symbol display and a HLL symbol listing of static and global symbols.

6.4.1. Invocation

Command line invocation

You can call the HLL dumper from the command line. The invocation syntax is:

```
hldumpmcs [option]... file...
```

The input file must be an ELF file with or without DWARF debug info (.elf).

The HLL dumper can process multiple input files. Files and options can be intermixed on the command line. Options apply to all supplied files. If multiple files are supplied, the disassembly of each file is preceded by a header to indicate which file is dumped. For example:

```
========== file.elf ==========
```

For a complete list and description of all options, see Section 8.7, HLL Object Dumper Options. With `hldumpmcs --help` you will see the options on stdout.

6.4.2. HLL Dump Output Format

The HLL dumper produces output in text format by default, but you can also specify the XML output format with `--output-type=xml`. The XML output is mainly for use in the Eclipse editor. The output is printed on stdout, unless you specify an output file with `--output=filename`.

The parts of the output are dumped in the following order:

1. Module list
2. Section list
3. Call graph using the DWARF debug info
4. Section dump (disassembly)
5. HLL symbol table
6. Assembly level symbol table
7. Note sections

With the option `--dump-format=flag` you can control which parts are shown. By default, all parts are shown, except for the call graph.
Example

Suppose we have a simple "Hello World" program in a file called `hello.c`. We call the control program as follows:

```bash
cmcs -g -t hello.c
```

Option `-g` tells to include DWARF debug information. Option `-t` tells to keep the intermediate files. This command results (among other files) in the file `hello.elf` (the absolute object file).

We can dump information about the ELF file with the following command:

```bash
hldumpmcs -F3 hello.elf
```

Option `-F3` enables all parts. A possible output could be (just a fraction of the actual output is shown):

```
---------- Module list ----------
Name    Full path
hello.c hello.c

---------- Section list ----------
Address  Size   Align Type    Name
000003f4     28     4 text    .mcstext.hello.main
000002b8     24     4 data    .mcsdata.hello.$1$str
00000300      4     4 data    .mcsdata.hello.world
000002d0     48     4 data    .mcsdata.hello.$2$str

---------- Call graph using the DWARF debug info ----------
```

```
+- 0x000003f4 main
  |    +-- 0x0000099c printf
  |         +-- 0x00000478 _doprint
  |          |    +-- 0x00000898 _io_putchar
  |          |          |    +-- 0x00000968 fputc
  |          |          |          |    +-- 0x00000698 _flsbuf
  |          |          |          |    +-- 0x00000878 _host_write
  |          |          |          |    +-- 0x0000042c _dbg_trap
  |          |          |          |    +-- 0x00000558 _fflush
  |          |          |          |    +-- 0x00000878 _host_write *
```

Using the Utilities
--- Section dump ---

.sdecl '.vector.0', CODE AT 0x0
.sect '.vector.0'
00000000 14 04 00 e0    jmp     __START

.sdecl '.mcsdata.hello.$1$str', DATA AT 0x2b8
.sect '.mcsdata.hello.$1$str'
.word 00000077,0000006f,00000072,0000006c; w...o...r...l...
.word 00000064,00000000                  ; d.......

.sdecl '.mcsdata.hello.$2$str', DATA AT 0x2d0
.sect '.mcsdata.hello.$2$str'
.word 00000048,00000065,0000006c,0000006c; H...e...l...l...
.word 0000006f,0000002c,00000020,00000025; o...,... ...%...
.word 00000073,00000021,0000000a,00000000; s...!.......... 

.sdecl '.mcsdata.hello.world', DATA AT 0x300
.sect '.mcsdata.hello.world'
world .word 000002b8                           ; .... 

.sdecl '.mcstext.hello.main', CODE AT 0x3f4
.sect '.mcstext.hello.main'
000003f4 04 00 00 30 main:  subl    r0,0x00000004
000003f8 00 03 01 a5         mrd     r5,0x00000300
000003fc 00 00 04 a5         mwri    r5,r0,0
00000400 d0 02 00 12         movl    r2,0x000002d0
00000404 9c 09 03 e0         call    printf
00000408 04 00 00 20         addl    r0,0x00000004
0000040c 00 00 04 e0         ret

.sdecl 'user_stack_0', DATA AT 0x9d8
.sect 'user_stack_0'
.space 80

.sdecl 'system_stack_0', DATA AT 0xa28
.sect 'system_stack_0'
 lc_ub_system_stack_0:
.space 36

---------- HLL symbol table ----------
### Module list

This part lists all modules (C files) found in the object file(s). It lists the filename and the complete path name at the time the module was built.

### Section list

This part lists all sections found in the object file(s).

<table>
<thead>
<tr>
<th>Address</th>
<th>Size</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000020</td>
<td>24</td>
<td>struct</td>
<td>_dbg_request [dbg.c]</td>
</tr>
<tr>
<td>00000038</td>
<td>320</td>
<td>static char</td>
<td>stdin_buf[80] [iob.c]</td>
</tr>
<tr>
<td>00000178</td>
<td>320</td>
<td>static char</td>
<td>stdout_buf[80] [iob.c]</td>
</tr>
<tr>
<td>00000300</td>
<td>4</td>
<td>char</td>
<td>* world [hello.c]</td>
</tr>
<tr>
<td>00000304</td>
<td>240</td>
<td>struct _iobuf</td>
<td>_iob[10] [iob.c]</td>
</tr>
<tr>
<td>000003f4</td>
<td>28</td>
<td>void</td>
<td>main()</td>
</tr>
</tbody>
</table>

---------- Assembly level symbol table ----------

<table>
<thead>
<tr>
<th>Address</th>
<th>Size</th>
<th>Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000000</td>
<td></td>
<td>system_stack_0</td>
<td></td>
</tr>
<tr>
<td>00000000</td>
<td></td>
<td>user_stack_0</td>
<td></td>
</tr>
<tr>
<td>00000020</td>
<td>24</td>
<td>data</td>
<td>_dbg_request</td>
</tr>
<tr>
<td>00000300</td>
<td>4</td>
<td>data</td>
<td>world</td>
</tr>
<tr>
<td>00000304</td>
<td>240</td>
<td>data</td>
<td>_iob</td>
</tr>
<tr>
<td>000003f4</td>
<td>28</td>
<td>code</td>
<td>main</td>
</tr>
<tr>
<td>00000410</td>
<td>4</td>
<td>code</td>
<td>_Exit</td>
</tr>
<tr>
<td>00000414</td>
<td>24</td>
<td>code</td>
<td>__START</td>
</tr>
</tbody>
</table>

---------- .note sections ----------

Section .note, section 35:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Desc</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000000</td>
<td>ALTIUM ASSEMBLER NAME</td>
<td>Altium</td>
<td>asmcs</td>
</tr>
</tbody>
</table>

With option --sections=name[,name]... you can specify a list of sections that should be dumped.
Call graph

The linker can generate a call graph in the linker map file. However, if you only have an ELF file and you need to test it, you can use the option `--dump-format=+callgraph`. You can then step through the call graph to identify the flow for debugging purposes. Some notes about the call graph:

- The call graph starts with the default entry point of the application.
- Recursive calls are marked with 'R'.
- Inline functions are marked with 'I'.
- A function is analyzed only once. When a function is called again, it is not analyzed again and this is marked with '*'.
- By default the DWARF debug information is used to generate the call graph. When no DWARF information is available the ELF information is used. Inline functions can only be detected and dumped when DWARF information is available.
- With option `--call-graph-elf-mode` you can force the call graph to use ELF symbols even when DWARF information is available. This can be useful when you want to dump information from an assembly function.
- With option `--call-graph-root=function` you can specify the address or function name where to start the call graph (default: `main()`).

Section dump

This part contains the disassembly. It consists of the following columns:

- address column: Contains the address of the instruction or directive that is shown in the disassembly. If the section is relocatable the section start address is assumed to be 0. The address is represented in hexadecimal and has a fixed width. The address is padded with zeros. No 0x prefix is displayed. For example, on a 32-bit architecture, the address 0x32 is displayed as 00000032.
- encoding column: Shows the hexadecimal encoding of the instruction (code sections) or it shows the hexadecimal representation of data (data sections). The encoding column has a maximum width of eight digits, i.e. it can represent a 32-bit hexadecimal value. The encoding is padded to the size of the data or instruction. For example, a 16-bit instruction only shows four hexadecimal digits. The encoding is aligned left and padded with spaces to fill the eight digits.
- label column: Displays the label depending on the option `--symbols=[hll|asm|none]`. The default is `asm`, meaning that the low level (ELF) symbols are used. With `hll`, HLL (DWARF) symbols are used. With `none`, no symbols will be included in the disassembly.
disassembly column | For code sections the instructions are disassembled. Operands are replaced with labels, depending on the option --symbols=[hll|asm|none].

The contents of data sections are represented by directives. A new directive will be generated for each symbol. ELF labels in the section are used to determine the start of a directive. ROM sections are represented with .word directives. RAM sections are represented with .space directives. This can be either the size specified in the ELF symbol, or the size up to the next label.

With option --hex, no directives will be generated for ROM data sections and no disassembly dump will be done for code sections. Instead a hex dump is done with the following format:

```
AAAAAAAA AA H0 H1 H2 H3 H4 H5 H6 H7 H8 H9 HA HB HC HD HE HF RRRRRRRRRRRRRRRRR
```

where,

A = Address (8 digits, 32-bit)
Hx = Hex contents, one byte (16 bytes max)
R = ASCII representation (16 characters max)

For example:

```
section 7 (.mcsdata.hello.$2$str):
000002d0 48 00 00 00 65 00 00 00 6c 00 00 00 6c 00 00 00 H...e...l...l...
000002e0 6f 00 00 00 2c 00 00 00 20 00 00 00 25 00 00 00 o...,... ...%...
000002f0 73 00 00 00 21 00 00 00 0a 00 00 00 00 00 00 00 s...!............
```

With option --hex, RAM sections will be represented with only a start address and a size indicator:

```
AAAAAAAA Space: 24 bytes
```

With option --disassembly-intermix you can intermix the disassembly with HLL source code.

**HLL symbol table**

This part contains a symbol listing based on the HLL (DWARF) symbols found in the object file(s). The symbols are sorted on address.

<table>
<thead>
<tr>
<th>Address</th>
<th>The start address of the symbol. Hexadecimal, 8 digits, 32-bit.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>The size of the symbol from the DWARF info in bytes.</td>
</tr>
<tr>
<td>HLL Type</td>
<td>The HLL symbol type.</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the HLL symbol.</td>
</tr>
</tbody>
</table>

HLL arrays are indicated by adding the size in square brackets to the symbol name. For example:

```
00000038 320 static char stdin_buf[80] [_iob.c]
```
With option --expand-symbols=+basic-types HLL struct and union symbols are listed including all fields. Array members are expanded in one array member per line regardless of the HLL type. For example:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000038</td>
<td>320 static char</td>
<td>stdin_buf[80]</td>
<td></td>
<td>[_iob.c]</td>
</tr>
<tr>
<td>00000038</td>
<td>4 char</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000003c</td>
<td>4 char</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000040</td>
<td>4 char</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000174</td>
<td>4 char</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

HLL struct and union symbols are listed by default without fields. For example:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000020</td>
<td>24 struct</td>
<td>_dbg_request</td>
<td></td>
<td>[dbg.c]</td>
</tr>
</tbody>
</table>

With option --expand-symbols all struct, union and array fields are included as well. For the fields the types and names are indented with two spaces. For example:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000020</td>
<td>24 struct</td>
<td>_dbg_request</td>
<td></td>
<td>[dbg.c]</td>
</tr>
<tr>
<td>00000020</td>
<td>4 int</td>
<td>_errno</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000024</td>
<td>4 enum</td>
<td>nr</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000028</td>
<td>16 union</td>
<td>u</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000028</td>
<td>4 struct</td>
<td>exit</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000028</td>
<td>4 int</td>
<td>status</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000028</td>
<td>8 struct</td>
<td>open</td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000028</td>
<td>4 const char</td>
<td>* pathname</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000002c</td>
<td>4 unsigned int</td>
<td>flags</td>
<td></td>
<td></td>
</tr>
<tr>
<td>...</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Functions are displayed with the full function prototype. Size is the size of the function. HLL Type is the return type of the function. For example:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000099c</td>
<td>60 int</td>
<td>printf</td>
<td></td>
<td>(const char * restrict format, ...)</td>
</tr>
</tbody>
</table>

The local and static symbols get an identification between square brackets. The filename is printed and if a function scope is known the function name is printed between the square brackets as well. If multiple files with the same name exist, the unique part of the path is added. For example:

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000200</td>
<td>4 int</td>
<td>count</td>
<td></td>
<td>[file.c, somefunc()]</td>
</tr>
<tr>
<td>00000204</td>
<td>4 int</td>
<td>count</td>
<td></td>
<td>[x\a.c]</td>
</tr>
<tr>
<td>00000208</td>
<td>4 int</td>
<td>count</td>
<td></td>
<td>[y\a.c, foo()]</td>
</tr>
</tbody>
</table>

Global symbols do not get information in square brackets.

**Assembly level symbol table**

This part contains a symbol listing based on the assembly level (ELF) symbols found in the object file(s). The symbols are sorted on address.

<table>
<thead>
<tr>
<th>Address</th>
<th>Type</th>
<th>Name</th>
<th>Size</th>
<th>Description</th>
</tr>
</thead>
</table>

**Address** The start address of the symbol. Hexadecimal, 8 digits, 32-bit.

**Size** The size of the symbol from the ELF info in bytes. If this field is empty, the size is zero.
Type Code or Data, depending on the section the symbol belongs to. If this field is empty, the symbol does not belong to a section.

Name The name of the ELF symbol.

6.5. Bosch MCS Assembly to TASKING Assembly Converter

The Perl script **cnvba2ta.pl** is a converter to convert Bosch MCS assembly files to TASKING VX-toolset for MCS assembly files. You need to have Perl installed on your system.

**Command line invocation**

You can call the converter from the command line by using Perl. The invocation syntax is:

```bash
perl cnvba2ta.pl input_file > output_file
```

Without output redirection the output is sent to **stdout**. The converted file includes **mcs_defines.inc**.

For example:

```bash
perl cnvba2ta.pl bosch_mcs.mcs > tsk_mcs.asm
```
Chapter 7. Using the Debugger

This chapter describes the debugger and how you can run and debug a C or C++ application. This chapter only describes the TASKING specific parts.

7.1. Reading the Eclipse Documentation

Before you start with this chapter, it is recommended to read the Eclipse documentation first. It provides general information about the debugging process. This chapter guides you through a number of examples using the TASKING debugger with simulation as target.

You can find the Eclipse documentation as follows:

1. Start Eclipse.
2. From the Help menu, select Help Contents.
   
   The help screen overlays the Eclipse Workbench.
3. In the left pane, select C/C++ Development User Guide.
4. Open the Getting Started entry and select Debugging projects.
   
   This Eclipse tutorial provides an overview of the debugging process. Be aware that the Eclipse example does not use the TASKING tools and TASKING debugger.

7.2. Creating a Customized Debug Configuration

Before you can debug a project, you need a Debug launch configuration. Such a configuration, identified by a name, contains all information about the debug project: which debugger is used, which project is used, which binary debug file is used, which perspective is used, ... and so forth.

If you want to debug on a target board, you have to create a custom debug configuration for your target board, otherwise you have to create a debug launch configuration for the TASKING simulator.

To debug a project, you need at least one opened and active project in your workbench. In this chapter, it is assumed that the myproject is opened and active in your workbench.

Create or customize your debug configuration

To create or change a debug configuration follow the steps below.

1. From the Debug menu, select Debug Configurations...
   
   The Debug Configurations dialog appears.
2. Select TASKING C/C++ Debugger and click the New launch configuration button.
to add a new configuration.
Or: In the left pane, select the configuration you want to change, for example, **TASKING C/C++ Debugger » myproject.simulator**.

3. In the **Name** field enter the name of the configuration. By default, this is the name of the project, but you can give your configuration any name you want to distinguish it from the project name. For example enter **myproject.simulator** to identify the simulator debug configuration.

4. On the **Target** tab, select the **MCS Simulator** or any of the target boards.

The dialog shows several tabs.

**Target tab**

On the **Target** tab you can select on which target the application should be debugged. An application can run on an external evaluation board, or on a simulator using your own PC. On this tab you can also select the connection settings (DAS, RS-232, TCP/IP). The information in this tab is based on the Debug Target Configuration (DTC) files as explained in Chapter 14, *Debug Target Configuration Files*.

**Initialization tab**

On the **Initialization** tab enable one or more of the following options:
• **Initial download of program**

  If enabled, the target application is downloaded onto the target. If disabled, only the debug information in the file is loaded, which may be useful when the application has already been downloaded (or flashed) earlier. If downloading fails, the debugger will shut down.

• **Verify download of program**

  If enabled, the debugger verifies whether the code and data has been downloaded successfully. This takes some extra time but may be useful if the connection to the target is unreliable.

• **Program flash when downloading**

  If enabled, also flash devices are programmed (if necessary). Flash programming will not work when you use a simulator.

• **Reset target**

  If enabled, the target is immediately reset after downloading has completed.

• **Goto main**

  If enabled, only the C startup code is processed when the debugger is launched. The application stops executing when it reaches the first C instruction in the function `main()`. Usually you enable this option in combination with the option **Reset Target**.

• **Break on exit**

  If enabled, the target halts automatically when the `exit()` function is called.

• **Reduce target state polling**
If you have set a breakpoint, the debugger checks the status of the target every number of seconds to find out if the breakpoint is hit. In this field you can change the polling frequency.

- **Monitor file (Flash settings)**
  Filename of the monitor, usually an Intel Hex or S-Record file.

- **Sector buffer size (Flash settings)**
  Specifies the buffer size for buffering a flash sector.

- **Workspace address (Flash settings)**
  The address of the workspace of the flash programming monitor.

**Project tab**

On the **Project** tab, you can set the properties for the debug configuration such as a name for the project and the application binary file which are used when you choose this configuration.

- In the **Project** field, you can choose the project for which you want to make a debug configuration. Because the project `myproject` is the active project, this project is filled in automatically. Click the Browse... button to select a different project. Only the *opened* projects in your workbench are listed.

- In the **C/C++ Application** field, you can choose the binary file to debug. The file `myproject.elf` is automatically selected from the active project.

**Arguments tab**

If your application's `main()` function takes arguments, you can pass them in this tab. Arguments are conventionally passed in the `argv[]` array. Because this array is allocated in target memory, make sure you have allocated sufficient memory space for it.
Source tab

On the Source tab, you can add additional source code locations in which the debugger should search for debug data.

- Usually, the default source code location is correct.

Miscellaneous tab

On the Miscellaneous tab you can specify several file locations.
• **Debugger location**

The location of the debugger itself. This should not be changed.

• **FSS root directory**

The initial directory used by file system simulation (FSS) calls. See the description of the FSS view.

• **ORTI file and KSM module**

If you wish to use the debugger's special facilities for kernel-aware debugging, specify the name of a Kernel Debug Interface (KDI) compatible KSM module (shared library) in the appropriate edit box. See also the description of the RTOS view.

• **GDI log file and Debug instrument log file**

You can use the options GDI log file and Debug instrument log file (if applicable) to control the generation of internal log files. These are primarily intended for use by or at the request of Altium support personnel.

• **Cache target access**

Except when using a simulator, the debugger's performance is generally strongly dependent on the throughput and latency of the connection to the target. Depending on the situation, enabling this option may result in a noticeable improvement, as the debugger will then avoid re-reading registers and memory while the target remains halted. However, be aware that this may cause the debugger to show the wrong data if tasks with a higher priority or external sources can influence the halted target's state.

• **Launch in background**

When this option is disabled you will see a progress bar when the debugger starts. If you do not want to see the progress bar and want that the debugger launches in the background you can enable this option.
• **Use linker/locator memory map file (.mdf) for memory map**

You can use this option to find errors in your application that cause access to non-existent memory or cause an attempt to write to read-only memory. When building your project, the linker/locator creates a memory description file (.mdf) file which describes the memory regions of the target you selected in your project properties. The debugger uses this file to initialize the debugging target.

This option is only useful in combination with a simulator as debug target. The debugger may fail to start if you use this option in combination with other debugging targets than a simulator.

### 7.3. Troubleshooting

If the debugger does not launch properly, this is likely due to mistakes in the settings of the execution environment or to an improper connection between the host computer and the execution environment. Always read the notes for your particular execution environment.

Some common problems you may check for, are:

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wrong device name in the launch configuration</td>
<td>Make sure the specified device name is correct.</td>
</tr>
<tr>
<td>Invalid baud rate</td>
<td>Specify baud rate that matches the baud rate the execution environment is configured to expect.</td>
</tr>
<tr>
<td>No power to the execution environment</td>
<td>Make sure the execution environment or attached probe is powered.</td>
</tr>
<tr>
<td>Wrong type of RS–232 cable</td>
<td>Make sure you are using the correct type of RS-232 cable.</td>
</tr>
<tr>
<td>Cable connected to the wrong port on the execution environment or host.</td>
<td>Some target machines and hosts have several ports. Make sure you connect the cable to the correct port.</td>
</tr>
<tr>
<td>Conflict between communication ports.</td>
<td>A device driver or background application may use the same communications port on the host system as the debugger. Disable any service that uses the same port-number or choose a different port-number if possible.</td>
</tr>
<tr>
<td>Port already in use by another user.</td>
<td>The port may already be in use by another user on some UNIX hosts, or being allocated by a login process. Some target machines and hosts have several ports. Make sure you connect the cable to the correct port.</td>
</tr>
</tbody>
</table>

### 7.4. TASKING Debug Perspective

After you have launched the debugger, you are either asked if the TASKING Debug perspective should be opened or it is opened automatically. The Debug perspective consists of several views.

To open views in the Debug perspective:

1. Make sure the Debug perspective is opened
2. From the **Window** menu, select **Show View** »

3. Select a view from the menu or choose **Other...** for more views.

By default, the Debug perspective is opened with the following views:

![Debug View](image)

### 7.4.1. Debug View

The Debug view shows the target information in a tree hierarchy shown below with a sample of the possible icons:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Session item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Launch" /></td>
<td>Launch instance</td>
<td>Launch configuration name and launch type</td>
</tr>
<tr>
<td><img src="image" alt="Debugger" /></td>
<td>Debugger instance</td>
<td>Debugger name and state</td>
</tr>
<tr>
<td><img src="image" alt="Thread" /></td>
<td>Thread instance</td>
<td>Thread number and state</td>
</tr>
<tr>
<td><img src="image" alt="Stack" /></td>
<td>Stack frame instance</td>
<td>Stack frame number, function, file name, and file line number</td>
</tr>
</tbody>
</table>
Stack display

During debugging (running) the actual stack is displayed as it increases or decreases during program execution. By default, all views present information that is related to the current stack item (variables, memory, source code etc.). To obtain the information from other stack items, click on the item you want.

The Debug view displays stack frames as child elements. It displays the reason for the suspension beside the thread, (such as end of stepping range, breakpoint hit, and signal received). When a program exits, the exit code is displayed.

The Debug view contains numerous functions for controlling the individual stepping of your programs and controlling the debug session. You can perform actions such as terminating the session and stopping the program. All functions are available from the right-click menu, though commonly used functions are also available from the toolbar.

Controlling debug sessions

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🗑️</td>
<td>Remove all</td>
<td>Removes all terminated launches.</td>
</tr>
<tr>
<td>🔃</td>
<td>Reset target system</td>
<td>Resets the target system and restarts the application.</td>
</tr>
<tr>
<td>🔃</td>
<td>Restart</td>
<td>Restarts the application. The target system is <em>not</em> reset.</td>
</tr>
<tr>
<td>🔄</td>
<td>Resume</td>
<td>Resumes the application after it was suspended (manually, breakpoint, signal).</td>
</tr>
<tr>
<td>⏰</td>
<td>Suspend</td>
<td>Suspends the application (pause). Use the Resume button to continue.</td>
</tr>
<tr>
<td>⏳</td>
<td>Relaunch</td>
<td>Right-click menu. Restarts the selected debug session when it was terminated. If the debug session is still running, a new debug session is launched.</td>
</tr>
<tr>
<td>🔄</td>
<td>Reload current application</td>
<td>Reloads the current application without restarting the debug session. The application does restart of course.</td>
</tr>
<tr>
<td>🔴</td>
<td>Terminate</td>
<td>Ends the selected debug session and/or process. Use Relaunch to restart this debug session, or start another debug session.</td>
</tr>
<tr>
<td>🔴</td>
<td>Terminate all</td>
<td>Right-click menu. As terminate. Ends all debug sessions.</td>
</tr>
<tr>
<td>🔴</td>
<td>Terminate and remove</td>
<td>Right-click menu. Ends the debug session and removes it from the Debug view.</td>
</tr>
<tr>
<td>🔴</td>
<td>Terminate and Relaunch</td>
<td>Right-click menu. Ends the debug session and relaunches it. This is the same as choosing Terminate and then Relaunch.</td>
</tr>
<tr>
<td>🔴</td>
<td>Disconnect</td>
<td>Detaches the debugger from the selected process (useful for debugging attached processes).</td>
</tr>
</tbody>
</table>
### Stepping through the application

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Step into" /></td>
<td>Step into</td>
<td>Steps to the next source line or instruction.</td>
</tr>
<tr>
<td><img src="image" alt="Step over" /></td>
<td>Step over</td>
<td>Steps over a called function. The function is executed and the application</td>
</tr>
<tr>
<td><img src="image" alt="Step return" /></td>
<td>Step return</td>
<td>Suspends at the next instruction after the call.</td>
</tr>
<tr>
<td><img src="image" alt="Instruction stepping" /></td>
<td>Instruction stepping</td>
<td>Toggle. If enabled, the stepping functions are performed on instruction level</td>
</tr>
<tr>
<td><img src="image" alt="Interrupt aware stepping" /></td>
<td>Interrupt aware stepping</td>
<td>Toggle. If enabled, the stepping functions do not step into an interrupt when</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Copy Stack" /></td>
<td>Copy Stack</td>
<td>Right-click menu. Copies the stack as text to the windows clipboard. You</td>
</tr>
<tr>
<td><img src="image" alt="Edit project" /></td>
<td>Edit project...</td>
<td>Right-click menu. Opens the debug configuration dialog to let you edit the</td>
</tr>
<tr>
<td><img src="image" alt="Edit Source Lookup" /></td>
<td>Edit Source Lookup...</td>
<td>Right-click menu. Opens the Edit Source Lookup Path window to let you edit</td>
</tr>
</tbody>
</table>

### 7.4.2. Breakpoints View

You can add, disable and remove breakpoints by clicking in the marker bar (left margin) of the Editor view. This is explained in the Getting Started manual.

**Description**

The Breakpoints view shows a list of breakpoints that are currently set. The button bar in the Breakpoints view gives access to several common functions. The right-most button opens the Breakpoints menu.

**Types of breakpoints**

To access the breakpoints dialog, add a breakpoint as follows:

1. Click the **Add TASKING Breakpoint** button.

   *The Breakpoints dialog appears.*

Each tab lets you set a breakpoint of a special type. You can set the following types of breakpoints:

- **File breakpoint**
The target halts when it reaches the specified line of the specified source file. Note that it is possible that a source line corresponds to multiple addresses, for example when a header file has been included into two different source files or when inlining has occurred. If so, the breakpoint will be associated with all those addresses.

- **Function**

  The target halts when it reaches the first line of the specified function. If no source file has been specified and there are multiple functions with the given name, the target halts on all of those. Note that function breakpoints generally will not work on inlined instances of a function.

- **Address**

  The target halts when it reaches the specified instruction address.

- **Stack**

  The target halts when it reaches the specified stack level.

- **Data**

  The target halts when the given variable or memory location (specified in terms of an absolute address) is read or written to, as specified.

- **Instruction**

  The target halts when the given number of instructions has been executed.

- **Cycle**

  The target halts when the given number of clock cycles has elapsed.

- **Timer**

  The target halts when the given amount of time elapsed.

In addition to the type of the breakpoint, you can specify the condition that must be met to halt the program.

In the **Condition** field, type a condition. The condition is an expression which evaluates to 'true' (non-zero) or 'false' (zero). The program only halts on the breakpoint if the condition evaluates to 'true'.

In the **Ignore count** field, you can specify the number of times the breakpoint is ignored before the program halts. For example, if you want the program to halt only in the fifth iteration of a while-loop, type '4': the first four iterations are ignored.

### 7.4.3. File System Simulation (FSS) View

**Description**

The File System Simulation (FSS) view is automatically opened when the target requests FSS input or generates FSS output. The virtual terminal that the FSS view represents, follows the VT100 standard. If you right-click in the view area of the FSS view, a menu is presented which gives access to some self-explanatory functions.
VT100 characteristics

The **queens** example demonstrates some of the VT100 features. (You can find the **queens** example in the `<MCS installation path>\examples` directory from where you can import it into your workspace.)

Per debugging session, you can have more than one FSS view, each of which is associated with a positive integer. By default, the view "FSS #1" is associated with the standard streams `stdin`, `stdout`, `stderr` and `stdaux`. Other views can be accessed by opening a file named "terminal window <number>", as shown in the example below.

```c
FILE * f3 = fopen("terminal window 3", "rw");
fprintf(f3, "Hello, window 3.\n");
fclose(f3);
```

You can set the initial working directory of the target application in the Debug configuration dialog (see also Section 7.2, Creating a Customized Debug Configuration):

1. On the **Debugger** tab, select the **Miscellaneous** sub-tab.
2. In the **FSS root directory** field, specify the FSS root directory.

The FSS implementation is designed to work without user intervention. Nevertheless, there are some aspects that you need to be aware of.

First, the interaction between the C library code (in the files `dbg*.c` and `dbg*.h`; see Section 10.1.4, `dbg.h`) and the debugger takes place via a breakpoint, which incidentally is not shown in the Breakpoints view. Depending on the situation this may be a hardware breakpoint, which may be in short supply.

Secondly, proper operation requires certain code in the C library to have debug information. This debug information should normally be present but might get lost when this information is stripped later in the development process.

### 7.4.4. Disassembly View

The Disassembly view shows target memory disassembled into instructions and / or data. If possible, the associated C / C++ source code is shown as well. The **Address** field shows the address of the current selected line of code.

To view the contents of a specific memory location, type the address in the **Address** field. If the address is invalid, the field turns red.

### 7.4.5. Expressions View

The Expressions view allows you to evaluate and watch regular C expressions.

To add an expression:

Click **OK** to add the expression.

1. Right-click in the Expressions View and select **Add Watch Expression**.

   *The Add Watch Expression dialog appears.*
2. Enter an expression you want to watch during debugging, for example, the variable name "i"

If you have added one or more expressions to watch, the right-click menu provides options to **Remove** and **Edit** or **Enable** and **Disable** added expressions.

- You can access target registers directly using `#NAME`. For example "arr[#R0 << 3]" or "#TIMER3 = m++". If a register is memory-mapped, you can also take its address, for example, "&ADCIN".

- Expressions may contain target function calls like for example "g1 + invert(&g2)". Be aware that this will not work if the compiler has optimized the code in such a way that the original function code does not actually exist anymore. This may be the case, for example, as a result of inlining. Also, be aware that the function and its callees use the same stack(s) as your application, which may cause problems if there is too little stack space. Finally, any breakpoints present affect the invoked code in the normal way.

### 7.4.6. Memory View

Use the Memory view to inspect and change process memory. The Memory view supports the same addressing as the C and C++ languages. You can address memory using expressions such as:

- 0x0847d3c
- (&y) + 1024
- *ptr

**Monitors**

To monitor process memory, you need to add a **monitor**:

1. In the Debug view, select a debug session. Selecting a thread or stack frame automatically selects the associated session.

2. Click the **Add Memory Monitor** button in the Memory Monitors pane.

   *The Monitor Memory dialog appears.*

3. Type the address or expression that specifies the memory section you want to monitor and click **OK**.

   *The monitor appears in the monitor list and the Memory Renderings pane displays the contents of memory locations beginning at the specified address.*

To remove a monitor:

1. In the Monitors pane, right-click on a monitor.

2. From the popup menu, select **Remove Memory Monitor**.
Renderings

You can inspect the memory in so-called renderings. A rendering specifies how the output is displayed: hexadecimal, ASCII, signed integer, unsigned integer or traditional. You can add or remove renderings per monitor. Though you cannot change a rendering, you can add or remove them:

1. Click the New Renderings... tab in the Memory Renderings pane.

   The Add Memory Rendering dialog appears.

2. Select the rendering you want (Traditional, Hex, ASCII, Signed Integer, Unsigned Integer or Hex Integer) and click Add Rendering(s).

To remove a rendering:

1. Right-click on a memory address in the rendering.

2. From the popup menu, select Remove Rendering.

Changing memory contents

In a rendering you can change the memory contents. Simply type a new value.

Warning: Changing process memory can cause a program to crash.

The right-click popup menu gives some more options for changing the memory contents or to change the layout of the memory representation.

7.4.7. Compare Application View

You can use the Compare Application view to check if the downloaded application matches the application in memory. Differences may occur, for example, if you changed memory addresses in the Memory view.

• To check for differences, click the Compare button.

7.4.8. Heap View

With the Heap view you can inspect the status of the heap memory. This can be illustrated with the following example:

```c
string = (char *) malloc(100);
strcpy ( string, "abcdefgh" );
free (string);
```

If you step through these lines during debugging, the Heap view shows the situation after each line has been executed. Before any of these lines has been executed, there is no memory allocated and the Heap view is empty.

• After the first line the Heap view shows that memory is occupied, the description tells where the block starts, how large it is (100 MAUs) and what its content is (0x0, 0x0, ...).
• After the second line, "abcdefgh" has been copied to the allocated block of memory. The description field of the Heap view again shows the actual contents of the memory block (0x61, 0x62, ...).

• The third line frees the memory. The Heap view is empty again because after this line no memory is allocated anymore.

7.4.9. Logging View

Use the Logging view to control the generation of internal log files. This view is intended mainly for use by or at the request of Altium support personnel.

7.4.10. RTOS View

The debugger has special support for debugging real-time operating systems (RTOSs). This support is implemented in an RTOS-specific shared library called a kernel support module (KSM) or RTOS-aware debugging module (RADM). You have to create your own Run Time Interface (ORTI) and specify this file on the Miscellaneous tab while configuring a customized debug configuration (see also Section 7.2, Creating a Customized Debug Configuration):

1. From the Debug menu, select Debug Configurations...
   
   The Debug Configurations dialog appears.

2. In the left pane, select the configuration you want to change, for example, TASKING C/C++ Debugger » myproject.simulator.
   
   Or: click the New launch configuration button ( ) to add a new configuration.

3. Open the Miscellaneous tab

4. In the ORTI file field, specify the name of your own ORTI file.

5. In the KSM module field, specify the name of a KSM shared library file suitable for RTOS kernels.

The debugger supports ORTI specifications v2.0 and v2.1.

7.4.11. Registers View

In the Registers view you can examine the value of registers while stepping through your application. The registers are organized in a number of register groups, which together contain all known registers. You can select a group to see which registers it contains. This view has a number of features:

• While you step through the application, the registers involved in the step turn yellow. If you scroll in the view or switch groups, some registers may appear on a lighter yellow background, indicating that the debugger does not know whether the registers have changed because the debugger did not read the registers before the step began.
• You can change each register's value.

• You can search for a specific register: right-click on a register and from the popup menu select **Find Register**... Enter a group or register name filter, click the register you want to see and click **OK**. The register of your interest will be shown in the view.

### 7.4.12. Trace View

If tracing is enabled, the Trace view shows the code was most recently executed. For example, while you step through the application, the Trace view shows the executed code of each step. To enable tracing:

• Right-click in the Trace view and select **Trace**.

  *A check mark appears when tracing is enabled.*

The view has three tabs, **Source**, **Instruction** and **Raw**, each of which represents the trace in a different way. However, not all target environments will support all three of these. The view is updated automatically each time the target halts.
Chapter 8. Tool Options

This chapter provides a detailed description of the options for the C compiler, assembler, linker, control program, make utility, archiver and the HLL object dumper.

Tool options in Eclipse (Menu entry)

For each tool option that you can set from within Eclipse, a **Menu entry** description is available. In Eclipse you can customize the tools and tool options in the following dialog:

1. From the **Project** menu, select **Properties**
   
   *The Properties dialog appears.*

2. In the left pane, expand **C/C++ Build** and select **Settings**.
   
   *In the right pane the Settings appear.*

3. Open the **Tool Settings** tab.

   *You can set all tool options here.*

Unless stated otherwise, all **Menu entry** descriptions expect that you have this Tool Settings tab open.

The following tables give an overview of all tool options on the Tool Settings tab in Eclipse with hyperlinks to the corresponding command line options (if available).

### Global Options

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use global 'product directory' preference</td>
<td>Directory where the TASKING toolset is installed</td>
</tr>
<tr>
<td>Treat warnings as errors</td>
<td>Control program option <strong>--warnings-as-errors</strong></td>
</tr>
<tr>
<td>Keep temporary files</td>
<td>Control program option <strong>--keep-temporary-files (-t)</strong></td>
</tr>
<tr>
<td>Verbose mode of control program</td>
<td>Control program option <strong>--verbose (-v)</strong></td>
</tr>
</tbody>
</table>

### C Compiler

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Preprocessing</strong></td>
<td></td>
</tr>
<tr>
<td>Store preprocessor output in <code>&lt;file&gt;.pre</code></td>
<td>Control program option <strong>--preprocess (-E) / --no-preprocessing-only</strong></td>
</tr>
<tr>
<td><strong>Eclipse option</strong></td>
<td><strong>Description or option</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>--------------------------</td>
</tr>
<tr>
<td>Keep comments in preprocessor output</td>
<td>Control program option  --preprocess=+comments</td>
</tr>
<tr>
<td>Keep #line info in preprocessor output</td>
<td>Control program option  --preprocess=-noline</td>
</tr>
<tr>
<td>Defined symbols</td>
<td>C compiler option --define</td>
</tr>
<tr>
<td>Pre-include files</td>
<td>C compiler option --include-file</td>
</tr>
<tr>
<td>Include Paths</td>
<td>C compiler option --include-directory</td>
</tr>
<tr>
<td>Language</td>
<td>C compiler option --include-directory</td>
</tr>
<tr>
<td>Comply to C standard</td>
<td>C compiler option --iso</td>
</tr>
<tr>
<td>Allow GNU C extensions</td>
<td>C compiler option --language=+gcc</td>
</tr>
<tr>
<td>Allow // comments in ISO C90 mode</td>
<td>C compiler option --language=+comments</td>
</tr>
<tr>
<td>Check assignment of string literal to non-const string pointer</td>
<td>C compiler option --language=-strings</td>
</tr>
<tr>
<td>Treat 'char' variables as unsigned</td>
<td>C compiler option --uchar</td>
</tr>
<tr>
<td>Treat 'int' bit-fields as signed</td>
<td>C compiler option --signed-bitfields</td>
</tr>
<tr>
<td>Allow optimization across volatile access</td>
<td>C compiler option --language=volatile</td>
</tr>
<tr>
<td>Allow Shift JIS Kanji in strings</td>
<td>C compiler option --language=+kanji</td>
</tr>
<tr>
<td>Floating-Point</td>
<td>Control program option  --fp-model</td>
</tr>
<tr>
<td>Allocation</td>
<td>C compiler option --rename-sections</td>
</tr>
<tr>
<td>Rename sections</td>
<td>C compiler option --rename-sections</td>
</tr>
<tr>
<td>Optimization</td>
<td>C compiler option --optimize</td>
</tr>
<tr>
<td>Optimization level</td>
<td>C compiler option --optimize</td>
</tr>
<tr>
<td>Trade-off between speed and size</td>
<td>C compiler option --tradeoff</td>
</tr>
<tr>
<td>Always inline function calls</td>
<td>C compiler option --inline</td>
</tr>
<tr>
<td>Maximum size increment when inlining (in %)</td>
<td>C compiler option --inline-max-incr</td>
</tr>
<tr>
<td>Maximum size for functions to always inline</td>
<td>C compiler option --inline-max-size</td>
</tr>
<tr>
<td>Custom Optimization</td>
<td>C compiler option --optimize</td>
</tr>
<tr>
<td>Debugging</td>
<td>C compiler option --debug-info</td>
</tr>
<tr>
<td>MISRA C</td>
<td>C compiler option --misrac</td>
</tr>
<tr>
<td>MISRA C checking</td>
<td>C compiler option --misrac</td>
</tr>
<tr>
<td>MISRA C version</td>
<td>C compiler option --misrac-version</td>
</tr>
<tr>
<td>Warnings instead of errors for mandatory rules</td>
<td>C compiler option --misrac-mandatory-warnings</td>
</tr>
</tbody>
</table>
## Tool Options

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warnings instead of errors for required rules</td>
<td>C compiler option --misra-c-required-warnings</td>
</tr>
<tr>
<td>Warnings instead of errors for advisory rules</td>
<td>C compiler option --misra-c-advisory-warnings</td>
</tr>
<tr>
<td>Custom 1998 / Custom 2004 / Custom 2012</td>
<td>C compiler option --misrac</td>
</tr>
<tr>
<td>Custom CERT C</td>
<td>C compiler option --cert</td>
</tr>
</tbody>
</table>

### Diagnostics

<table>
<thead>
<tr>
<th>Description or option</th>
<th>C compiler option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Suppress C compiler warnings</td>
<td>--no-warnings=num</td>
</tr>
<tr>
<td>Suppress all warnings</td>
<td>--no-warnings</td>
</tr>
</tbody>
</table>

### Miscellaneous

<table>
<thead>
<tr>
<th>Description or option</th>
<th>C compiler option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Merge C source code with generated assembly</td>
<td>--source</td>
</tr>
<tr>
<td>Additional options</td>
<td>C compiler options, Control program options</td>
</tr>
</tbody>
</table>

## Assembler

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preprocessing</td>
<td></td>
</tr>
<tr>
<td>Defined symbols</td>
<td>Assembler option --define</td>
</tr>
<tr>
<td>Pre-include files</td>
<td>Assembler option --include-file</td>
</tr>
<tr>
<td>Include Paths</td>
<td></td>
</tr>
<tr>
<td>Include paths</td>
<td>Assembler option --include-directory</td>
</tr>
<tr>
<td>Symbols</td>
<td></td>
</tr>
<tr>
<td>Generate symbolic debug</td>
<td>Assembler option --debug-info</td>
</tr>
<tr>
<td>Case insensitive identifiers</td>
<td>Assembler option --case-insensitive</td>
</tr>
<tr>
<td>Emit local EQU symbols</td>
<td>Assembler option --emit-locals=+equ</td>
</tr>
<tr>
<td>Emit local non-EQU symbols</td>
<td>Assembler option --emit-locals=+symbols</td>
</tr>
<tr>
<td>Set default symbol scope to global</td>
<td>Assembler option --symbol-scope</td>
</tr>
<tr>
<td>Optimization</td>
<td></td>
</tr>
<tr>
<td>Optimize generic instructions</td>
<td>Assembler option --optimize=+generics</td>
</tr>
<tr>
<td>List File</td>
<td></td>
</tr>
<tr>
<td>Generate list file</td>
<td>Control program option --list-files</td>
</tr>
<tr>
<td>List ...</td>
<td>Assembler option --list-format</td>
</tr>
<tr>
<td>List section summary</td>
<td>Assembler option --section-info=+list</td>
</tr>
<tr>
<td>Diagnostics</td>
<td></td>
</tr>
<tr>
<td>Suppress warnings</td>
<td>Assembler option --no-warnings=num</td>
</tr>
<tr>
<td>Suppress all warnings</td>
<td>Assembler option --no-warnings</td>
</tr>
<tr>
<td>Eclipse option</td>
<td>Description or option</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Display section summary</td>
<td>Assembler option (--section-info=+console)</td>
</tr>
<tr>
<td>Maximum number of emitted errors</td>
<td>Assembler option (--error-limit)</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>Additional options</td>
<td>Assembler options</td>
</tr>
</tbody>
</table>

**Linker**

<table>
<thead>
<tr>
<th>Eclipse option</th>
<th>Description or option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Libraries</strong></td>
<td></td>
</tr>
<tr>
<td>Rescan libraries to solve unresolved externals</td>
<td>Linker option (--no-rescan)</td>
</tr>
<tr>
<td>Libraries</td>
<td>The libraries are added as files on the command line.</td>
</tr>
<tr>
<td>Library search path</td>
<td>Linker option (--library-directory)</td>
</tr>
<tr>
<td><strong>Data Objects</strong></td>
<td></td>
</tr>
<tr>
<td>Data objects</td>
<td>Linker option (--import-object)</td>
</tr>
<tr>
<td><strong>Script File</strong></td>
<td></td>
</tr>
<tr>
<td>Defined symbols</td>
<td>Linker option (--define)</td>
</tr>
<tr>
<td>Linker script file (.lsl)</td>
<td>Linker option (--ltl-file)</td>
</tr>
<tr>
<td><strong>Optimization</strong></td>
<td></td>
</tr>
<tr>
<td>Delete unreferenced sections</td>
<td>Linker option (--optimize=c)</td>
</tr>
<tr>
<td>Use a 'first-fit decreasing' algorithm</td>
<td>Linker option (--optimize=l)</td>
</tr>
<tr>
<td>Compress copy table</td>
<td>Linker option (--optimize=t)</td>
</tr>
<tr>
<td>Delete duplicate code</td>
<td>Linker option (--optimize=x)</td>
</tr>
<tr>
<td>Delete duplicate data</td>
<td>Linker option (--optimize=y)</td>
</tr>
<tr>
<td><strong>Map File</strong></td>
<td></td>
</tr>
<tr>
<td>Generate map file (.map)</td>
<td>Control program option (--no-map-file)</td>
</tr>
<tr>
<td>Generate XML map file format (.mapxml) for map file viewer</td>
<td>Linker option (--map-file=file.mapxml:XML)</td>
</tr>
<tr>
<td>Include ...</td>
<td>Linker option (--map-file-format)</td>
</tr>
<tr>
<td><strong>Diagnostics</strong></td>
<td></td>
</tr>
<tr>
<td>Suppress warnings</td>
<td>Linker option (--no-warnings=num)</td>
</tr>
<tr>
<td>Suppress all warnings</td>
<td>Linker option (--no-warnings)</td>
</tr>
<tr>
<td>Maximum number of emitted errors</td>
<td>Linker option (--error-limit)</td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
</tr>
<tr>
<td>Strip symbolic debug information</td>
<td>Linker option (--strip-debug)</td>
</tr>
<tr>
<td>Link case insensitive</td>
<td>Linker option (--case-insensitive)</td>
</tr>
<tr>
<td>Eclipse option</td>
<td>Description or option</td>
</tr>
<tr>
<td>----------------------------------------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td>Do not use standard copy table for initialization</td>
<td>Linker option</td>
</tr>
<tr>
<td></td>
<td>--user-provided-initialization-code</td>
</tr>
<tr>
<td>Additional options</td>
<td>Linker options</td>
</tr>
</tbody>
</table>
8.1. C Compiler Options

This section lists all C compiler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on the command line. Eclipse invokes the compiler via the control program. Therefore, it uses the syntax of the control program to pass options and files to the C compiler. If there is no equivalent option in Eclipse, you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for
   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.
   In the right pane the Settings appear.

3. On the Tool Settings tab, select C Compiler » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

   Because Eclipse uses the control program, you have to precede the option with -Wc to pass the option via the control program directly to the C compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For example, the option -n sends output to stdout instead of a file and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--). You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

   cmcs -Oac test.c
   cmcs --optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
C compiler option: --cert

Menu entry
1. Select C Compiler » CERT C Secure Coding.
2. Make a selection from the CERT C secure code checking list.
3. If you selected Custom, expand the Custom CERT C entry and enable one or more individual recommendations/rules.

Command line syntax
--cert={all | name[-name],...}

Default format: all

Description
With this option you can enable one or more checks for CERT C Secure Coding Standard recommendations/rules. When you omit the argument, all checks are enabled. name is the name of a CERT recommendation/rule, consisting of three letters and two digits. Specify only the three-letter mnemonic to select a whole category. For the list of names you can use, see Chapter 15, CERT C Secure Coding Standard.

On the command line you can use --diag=cert to see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all supported preprocessor checks.

Example
To enable the check for CERT rule STR30-C, enter:

cmcs --cert=str30 test.c

Related information
Chapter 15, CERT C Secure Coding Standard
C compiler option --diag (Explanation of diagnostic messages)
C compiler option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.

This option is available on the command line only.

Related information

Assembler option --check (Check syntax)
C compiler option: --core

Menu entry
1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor or select User defined ....

Command line syntax

--core=core

You can specify the following core arguments:

- mcs3.0: MCS v3.0 core
- mcs3.1: MCS v3.1 core

Default: mcs3.1

Description

With this option you specify the core architecture for a target processor for which you create your application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor you selected. When the default core (mcs3.1) is used, the macro __CORE_MCS31__ is defined in the C source file.

With --core=mcs3.0, the compiler can generate MCS v3.0 instructions in the assembly file. The macro __CORE_MCS30__ is defined in the C source file.

With --core=mcs3.1, the compiler can generate MCS v3.1 instructions in the assembly file. The macro __CORE_MCS31__ is defined in the C source file.

Example

Select an MCS v3.0 core:

```
cmcs --core=mcs3.0 test.c
```

Related information

Control program option --cpu (Select processor)
C compiler option: --debug-info (-g)

Menu entry
1. Select C Compiler » Debugging.
2. To generate symbolic debug information, select Default, Small set or Full. To disable the generation of debug information, select None.

Command line syntax

--debug-info [=suboption]

-g [suboption]

You can set the following suboptions:

<table>
<thead>
<tr>
<th>Suboption</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>small</td>
<td>1 / c</td>
</tr>
<tr>
<td>default</td>
<td>2 / d</td>
</tr>
<tr>
<td>all</td>
<td>3 / a</td>
</tr>
</tbody>
</table>

Emit small set of debug information.
Emit default symbolic debug information.
Emit full symbolic debug information.

Default: --debug-info (same as --debug-info=default)

Description
With this option you tell the compiler to add directives to the output file for including symbolic information. This facilitates high level debugging but increases the size of the resulting assembler file (and thus the size of the object file). For the final application, compile your C files without debug information.

The DWARF debug format allows for a flexible approach as to how much symbolic information is included, as long as the structure is valid. Adding all possible DWARF data for a program is not practical. The amount of DWARF information per compilation unit can be huge. And for large projects, with many object modules the link time can grow unacceptably long. That is why the compiler has several debug information levels. In general terms one can say, the higher the level the more DWARF information is produced.

The DWARF data in an object module is not only used for debugging. The toolset can also do "type checking" of the whole application. In that case the linker will use the DWARF information of all object modules to determine if every use of a symbol is done with the same type. In other words, if the application is built with type checking enabled then the compiler will add DWARF information too.

Small set of debug information
With this suboption only DWARF call frame information and type information are generated. This enables you to inspect parameters of nested functions. The type information improves debugging. You can perform a stack trace, but stepping is not possible because debug information on function bodies is not generated. You can use this suboption, for example, to compact libraries.
Default debug information

This provides all debug information you need to debug your application. It meets the debugging requirements in most cases without resulting in oversized assembler/object files.

Full debug information

With this suboption extra debug information is generated about unused typedefs and DWARF "lookup table sections". Under normal circumstances this extra debug information is not needed to debug the program. Information about unused typedefs concerns all typedefs, even the ones that are not used for any variable in the program. (Possibly, these unused typedefs are listed in the standard include files.) With this suboption, the resulting assembler/object file will increase significantly.

In the following table you see in more detail what DWARF information is included for the debug option levels.

<table>
<thead>
<tr>
<th>Feature</th>
<th>-g1</th>
<th>-g2</th>
<th>-g3</th>
<th>type check</th>
<th>Remarks</th>
</tr>
</thead>
<tbody>
<tr>
<td>basic info</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>info such as symbol name and type</td>
</tr>
<tr>
<td>call frame</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>this is information for a debugger to compute a stack trace when a program has stopped at a breakpoint</td>
</tr>
<tr>
<td>symbol lifetime</td>
<td></td>
<td>+</td>
<td></td>
<td></td>
<td>this is information about where symbols live (e.g. on stack at offset so and so, when the program counter is in this range)</td>
</tr>
<tr>
<td>line number info</td>
<td></td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>file name, line number, column number</td>
</tr>
<tr>
<td>&quot;lookup tables&quot;</td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>DWARF sections ... this is an optimization for the DWARF data, it is not essential</td>
</tr>
<tr>
<td>unused typedefs</td>
<td></td>
<td></td>
<td></td>
<td>+</td>
<td>in the C code of the program there can be (many) typedefs that are not used for any variable. Sometimes this can cause enormous expansion of the DWARF data and thus it is only included in -g3.</td>
</tr>
</tbody>
</table>

Related information
C compiler option: --define (-D)

Menu entry

1. Select C Compiler » Preprocessing.

   *The Defined symbols box shows the symbols that are currently defined.*

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, you can use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional C source as shown in the example below.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

```c
void main( void )
{
    #if DEMO
        demo_func();     /* compile for the demo program */
    #else
        real_func();     /* compile for the real program */
    #endif
}
```
You can now use a macro definition to set the DEMO flag:

```cmcs --define=DEMO test.c
cmcs --define=DEMO=1 test.c```

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new option.

```cmcs --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c```

**Related information**

C compiler option **--undefine** (Remove preprocessor macro)

C compiler option **--option-file** (Specify an option file)
C compiler option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension .d (one for every input file).

Command line syntax

--dep-file[=file]

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option --preprocess=+make, the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension .d (one for every input file). When you specify a filename, all dependencies will be combined in the specified file.

Example

```
cmcs --dep-file=test.dep test.c
```

The compiler compiles the file test.c, which results in the output file test.src, and generates dependency lines in the file test.dep.

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
C compiler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
   
   The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
   
   A popup menu appears.

3. Select Detailed Diagnostics Info.
   
   A dialog box appears with additional information.

Command line syntax

```
--diag=[format:]\{all | msg[-msg],\ldots
```

You can set the following output formats:

- html: HTML output.
- text: ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. The compiler does not compile any files. You can specify the following formats: html, rtf or text (default). To create a file with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given (except for the CERT checks). If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

With --diag=cert you can see a list of the available CERT checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all supported preprocessor checks.

Example

To display an explanation of message number 282, enter:

```
cmcs --diag=282
```

This results in the following message and explanation:
E282: unterminated comment

Make sure that every comment starting with /* has a matching */. Nested comments are not possible.

To write an explanation of all errors and warnings in HTML format to file cerrors.html, use redirection and enter:

cmcs --diag=html:all > cerrors.html

Related information

Section 3.7, C Compiler Error Messages

C compiler option --cert (Enable individual CERT checks)
C compiler option: --error-file

Menu entry

- 

Command line syntax

--error-file [=file]

Description

With this option the compiler redirects error messages to a file. If you do not specify a filename, the error file will be named after the output file with extension .err.

Example

To write errors to errors.err instead of stderr, enter:

cmcs --error-file=errors.err test.c

Related information

-
C compiler option: --extended-registers

Menu entry
1. Select C Compiler » Code Generation.
2. Enable the option Use extended register set.

Command line syntax
--extended-registers

Description
The extended register set extends the registers of the current MCS channel with the registers of the next MCS channel. These registers are RS0..RS7, DSTAT, GMI0 and GMI1. By default the extended register set is disabled. You can use this option to enable the extended register set.

Related information
C compiler option: --fp-model

Menu entry
1. Select C Compiler » Floating-Point.
2. Make a selection from the Floating-point model list.
3. If you selected Custom, enable one or more individual options.

Command line syntax
--fp-model=flags

You can set the following flags:

+/-contract c/C allow expression contraction
+/-float f/F treat 'double' as 'float'
+/-fastlib l/L allow less precise library functions
+/-nonan n/N allow optimizations to ignore NaN/Inf
+/-rewrite r/R allow expression rewriting
+/-trap t/T support trapping on exceptions
+/-negzero z/Z ignore sign of -0.0

0 alias for --fp-model=CFLNRtZ (strict)
1 alias for --fp-model=cFLNRTZ (precise)
2 alias for --fp-model=cFlnrTz (fast double)
3 alias for --fp-model=cflnrTz (fast single)

Default: --fp-model=cFlnrTz

Description

With this option you select the floating-point execution model.

With --fp-model=+contract you allow the compiler to contract multiple float operations into a single operation, with different rounding results. A possible example is fused multiply-add. With --fp-model=-contract, the fused multiply-and-accumulate (FMA) operations are not generated. FMA operations are not supported by the IEEE-754 standard. The result of FMA operations is only rounded once at the end of the FMA.

With --fp-model=+float you tell the compiler to treat variables and constants of type double as float. Because the float type takes less space, execution speed increases and code size decreases, both at the cost of less precision. Make sure you specify the corresponding libraries to the linker.
With `--fp-model=+fastlib` you allow the compiler to select faster but less accurate library functions for certain floating-point operations. With `--fp-model=-fastlib` more precise library functions are used and the compiler defines the macro `__PRECISE_LIB_FP__`, which is used in `math.h`.

With `--fp-model=+nonan` you allow the compiler to ignore NaN or Inf input values. An example is to replace multiply by zero with zero.

With `--fp-model=+rewrite` you allow the compiler to rewrite expressions by reassociating. This might result in rounding differences and possibly different exceptions. An example is to rewrite \((a^c)+(b^c)\) as \((a+b)^c\).

With `--fp-model=+trap` operations trap on floating-point exceptions. The floating-point instructions, as implemented in the FPU, need to be handled in a special way if floating-point trapping behavior is expected from the generated code. Make sure you specify the corresponding trapping floating-point library to the linker.

With `--fp-model=+negzero` you allow the compiler to ignore the sign of -0.0 values. An example is to replace \((a-a)\) by zero.

**Related information**

Pragmas `STDC FP_CONTRACT`, `fp_negzero`, `fp_nonan` and `fp_rewrite` in Section 1.5, Pragmas to Control the Compiler.
C compiler option: --global-type-checking

Menu entry

1. Select C Compiler » Diagnostics.
2. Enable the option Perform global type checking on C code.

Command line syntax

--global-type-checking

Description

The C compiler already performs type checking within each module. Use this option when you want the linker to perform type checking between modules.

Related information

-
C compiler option: --help (-?)

Menu entry
-

Command line syntax

--help [=item]
-?

You can specify the following arguments:

intrinsics   i   Show the list of intrinsic functions
options      o   Show extended option descriptions
pragmas      p   Show the list of supported pragmas
typedefs     t   Show the list of predefined typedefs

Description

Displays an overview of all command line options. With an argument you can specify which extended information is shown.

Example

The following invocations all display a list of the available command line options:

cmcs -?
cmcs --help
cmcs

The following invocation displays a list of the available pragmas:

cmcs --help=pragmas

Related information
-

**C compiler option: --include-directory (-I)**

**Menu entry**

1. Select C Compiler » Include Paths.

   *The Include paths box shows the directories that are added to the search path for include files.*

2. To define a new directory for the search path, click on the **Add** button in the **Include paths** box.

3. Type or select a path.

   Use the **Edit** and **Delete** button to change a path or to remove a path from the list.

**Command line syntax**

```
--include-directory=path,...

-I path,...
```

**Description**

With this option you can specify the path where your include files are located. A relative path will be relative to the current directory,

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source (only for #include files that are enclosed in "")

2. The path that is specified with this option.

3. The path that is specified in the environment variable CMCSINC when the product was installed.

4. The default directory $(PRODDIR)\include (unless you specified option --no-stdinc).

**Example**

Suppose that the C source file test.c contains the following lines:

```c
#include <stdio.h>
#include "myinc.h"
```

You can call the compiler as follows:

```
cmcs --include-directory=myinclude test.c
```

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the compiler searches in the environment variable and then in the default include directory.
The compiler now looks for the file `myinc.h` in the directory where `test.c` is located. If the file is not there the compiler searches in the directory `myinclude`. If it was still not found, the compiler searches in the environment variable and then in the default include directory.

**Related information**

C compiler option `--include-file` (Include file at the start of a compilation)

C compiler option `--no-stdinc` (Skip standard include files directory)
C compiler option: --include-file (-H)

Menu entry
1. Select C Compiler » Preprocessing.
   
   The Pre-include files box shows the files that are currently included before the compilation starts.
2. To define a new file, click on the Add button in the Pre-include files box.
3. Type the full path and file name or select a file.

   Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

--include-file=file,...

-H file,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other includes. This is the same as specifying #include "file" at the beginning of each of your C sources.

Example

    cmcs --include-file=stdio.h test1.c test2.c

The file stdio.h is included at the beginning of both test1.c and test2.c.

Related information

    C compiler option --include-directory (Add directory to include file search path)
C compiler option: --inline

Menu entry
1. Select C Compiler » Optimization.
2. Enable the option Always inline function calls.

Command line syntax
--inline

Description
With this option you instruct the compiler to inline calls to functions without the __noinline function qualifier whenever possible. This option has the same effect as a #pragma inline at the start of the source file.

Example
To always inline function calls:

cmcs --inline test.c

Related information
Section 1.7.5, Inlining Functions: inline
C compiler option: --inline-max-incr / --inline-max-size

Menu entry
1. Select C Compiler » Optimization.
2. In the Maximum size increment when inlining field, enter a value (default -1).
3. In the Maximum size for functions to always inline field, enter a value (default -1).

Command line syntax

```
--inline-max-incr=percentage (default: -1)
--inline-max-size=threshold (default: -1)
```

Description

With these options you can control the automatic function inlining optimization process of the compiler. These options only have effect when you have enabled the inlining optimization (option `--optimize=+inline` or `Optimize most`).

Regardless of the optimization process, the compiler always inlines all functions that have the function qualifier `inline`.

With the option `--inline-max-size` you can specify the maximum size of functions that the compiler inlines as part of the optimization process. The compiler always inlines all functions that are smaller than the specified threshold. The threshold is measured in compiler internal units and the compiler uses this measure to decide which functions are small enough to inline. The default threshold is -1, which means that the threshold depends on the option `--tradeoff`.

After the compiler has inlined all functions that have the function qualifier `inline` and all functions that are smaller than the specified threshold, the compiler looks whether it can inline more functions without increasing the code size too much. With the option `--inline-max-incr` you can specify how much the code size is allowed to increase. The default value is -1, which means that the value depends on the option `--tradeoff`.

Example

```
cmcs --optimize=+inline --inline-max-incr=40 --inline-max-size=15 test.c
```

The compiler first inlines all functions with the function qualifier `inline` and all functions that are smaller than the specified threshold of 15. If the code size has still not increased with 40%, the compiler decides which other functions it can inline.

Related information

C compiler option `--optimize=+inline` (Optimization: automatic function inlining)
Section 1.7.5, Inlining Functions: inline
Section 3.5.3, Optimize for Code Size or Execution Speed
C compiler option: --iso (-c)

Menu entry
1. Select C Compiler » Language.
2. From the Comply to C standard list, select ISO C99 or ISO C90.

Command line syntax

```
--iso=(90|99)
-c (90|99)
```

Default: --iso=99

Description
With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99 refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

Example
To select the ISO C90 standard on the command line:
```
cmcs --iso=90 test.c
```

Related information
C compiler option --language (Language extensions)
C compiler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the .src file when errors occur during compilation.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during compilation, the resulting .src file may be incomplete or incorrect. With this option you keep the generated output file (.src) when an error occurs.

By default the compiler removes the generated output file (.src) when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or incorrect.

Example

cmcs --keep-output-files test.c

When an error occurs during compilation, the generated output file test.src will not be removed.

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)
C compiler option: --language (-A)

Menu entry
1. Select C Compiler » Language.
2. Enable or disable one or more of the following options:
   - Allow GNU C extensions
   - Allow // comments in ISO C90 mode
   - Check assignment of string literal to non-const string pointer
   - Allow optimization across volatile access
   - Allow Shift JIS Kanji in strings

Command line syntax

```bash
--language=[flags]
-A[flags]
```

You can set the following flags:

```plaintext
+/-gcc            g/G    enable a number of gcc extensions
+/-kanji         k/K    support for Shift JIS Kanji in strings
+/-comments      p/P    // comments in ISO C90 mode
+/-volatile      v/V    don't optimize across volatile access
+/-strings       x/X    relaxed const check for string literals
```

Default: `--AGKpVx`

Default (without flags): `--AGKPVX`

Description
With this option you control the language extensions the compiler can accept. By default the MCS compiler allows all language extensions, except for gcc extensions.

The option `--language` (-A) without flags disables all language extensions.

GNU C extensions
The `--language=+gcc` (-Ag) option enables the following gcc language extensions:

- The identifier `__FUNCTION__` expands to the current function name.
- Alternative syntax for variadic macros.
• Alternative syntax for designated initializers.
• Allow zero sized arrays.
• Allow empty struct/union.
• Allow unnamed struct/union fields.
• Allow empty initializer list.
• Allow initialization of static objects by compound literals.
• The middle operand of a ? : operator may be omitted.
• Allow a compound statement inside braces as expression.
• Allow arithmetic on void pointers and function pointers.
• Allow a range of values after a single case label.
• Additional preprocessor directive #warning.
• Allow comma operator, conditional operator and cast as lvalue.
• An inline function without "static" or "extern" will be global.
• An "extern inline" function will not be compiled on its own.
• An __attribute__ directly following a struct/union definition relates to that tag instead of to the objects in the declaration.

For a more complete description of these extensions, you can refer to the UNIX gcc info pages (info gcc).

Shift JIS Kanji support

With --language=+kanji (-Ak) you tell the compiler to support Shift JIS encoded Kanji multi-byte characters in strings, (wide) character constants and // comments. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash as an escape character. Shift JIS in /*...*/ comments is supported regardless of this option. Note that Shift JIS also includes Katakana and Hiragana.

Comments in ISO C90 mode

With --language=+comments (-Ap) you tell the compiler to allow C++ style comments (/\/) in ISO C90 mode (option --iso=90). In ISO C99 mode this style of comments is always accepted.

Check assignment of string literal to non-const string pointer

With --language=+strings (-Ax) you disable warnings about discarded const qualifiers when a string literal is assigned to a non-const pointer.

    char *p;
    void main( void ) { p = "hello"; }
Example

cmcs --language=-comments,+strings --iso=90 test.c
cmcs -APx -c90 test.c

The compiler compiles in ISO C90 mode, accepts assignments of a constant string to a non-constant string pointer and does not allow C++ style comments.

Optimization across volatile access

With the --language=+volatile (-Av) option, the compiler will block optimizations when reading or writing a volatile object, by executing all memory and register accesses before the access of the volatile object. The volatile access acts as a memory barrier. With this option you can prevent for example that code below the volatile object is optimized away to somewhere above the volatile object.

Example:

extern unsigned int variable;
extern volatile unsigned int access;

void TestFunc(unsigned int flag)
{
    access = 0;
    variable |= flag;
    if (variable == 3)
    {
        variable = 0;
    }
    variable |= 0x8000;
    access = 1;
}

Result with --language=volatile (default):

TestFunc: .type func
    subl r5,#8
    mwri r4,r5
    mwri r6,r5,#4
    sub r6,r6
    mw r6,access ; <= Volatile access
    mrd r6,variable
    or r6,r0
    atul r6,#3
    jbc sta,#5,.L2
    sub r6,r6
.L2:
    orl r6,#32768
    movl r4,#1
    mw r4,access ; <= Volatile access
    mw r6,variable ; <= Moved across volatile access
    mr di r6,r5,#4
Result with `--language=+volatile`:

```asm
TestFunc: .type func
    subl r5,#4
    mwri r6,r5
    sub r6,r6
    mwr r6,access ; == Volatile access
    mrd r6,variable
    or r6,r0
    atul r6,#3
    jbc sta,#5,.L2
    sub r6,r6
    .L2:
        orl r6,#32768
        mwr r6,variable ; == Not moved
        movl r6,#1
        mwr r6,access ; == Volatile access
        mrdi r6,r5
        addl r5,#4
    ret
```

Note that the volatile behavior of the compiler with option `--language=-volatile` or `--language=+volatile` is ISO C compliant in both cases.

**Related information**

C compiler option `--iso` (ISO C standard)

Section 1.2, *Shift JIS Kanji Support*
C compiler option: --make-target

Menu entry

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension .o.

Example

cmcs --preprocess=+make --make-target=mytarget.o test.c

The compiler generates dependency lines with the default target name mytarget.o instead of test.o.

Related information

C compiler option --preprocess=+make (Generate dependencies for make)

C compiler option --dep-file (Generate dependencies in a file)
C compiler option: --misrac

Menu entry

1. Select C Compiler » MISRA C.
2. Make a selection from the MISRA C checking list.
3. If you selected Custom, expand the Custom 1998, Custom 2004 or Custom 2012 entry and enable one or more individual rules.

Command line syntax

--misrac={all | nr[-nr]},...

Description

With this option you specify to the compiler which MISRA C rules must be checked. With the option --misrac=all the compiler checks for all supported MISRA C rules.

Example

cmcs --misrac=9-13 test.c

The compiler generates an error for each MISRA C rule 9, 10, 11, 12 or 13 violation in file test.c.

Related information

Section 3.6.2, C Code Checking: MISRA C
C compiler option --misrac-mandatory-warnings
C compiler option --misrac-advisory-warnings
C compiler option --misrac-required-warnings
Linker option --misrac-report
C compiler option: --misrac-advisory-warnings / --misrac-required-warnings / --misrac-mandatory-warnings

Menu entry
1. Select C Compiler » MISRA C.
2. Make a selection from the MISRA C checking list.
3. Enable one or more of the options:
   - Warnings instead of errors for mandatory rules
   - Warnings instead of errors for required rules
   - Warnings instead of errors for advisory rules.

Command line syntax
--misrac-advisory-warnings
--misrac-required-warnings
--misrac-mandatory-warnings

Description
Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence, no output file is generated. With this option, the compiler generates a warning instead of an error.

Related information
Section 3.6.2, C Code Checking: MISRA C
C compiler option --misrac
Linker option --misrac-report
C compiler option: --misrac-version

Menu entry

1. Select C Compiler » MISRA C.

Command line syntax


Default: 2004

Description

MISRA C rules exist in three versions: MISRA C:1998, MISRA C:2004 and MISRA C:2012. By default, the C source is checked against the MISRA C:2004 rules. With this option you can select which version to use.

Related information

Section 3.6.2, C Code Checking: MISRA C

C compiler option --misrac
C compiler option: --no-stdinc

Menu entry
1. Select C Compiler » Miscellaneous.
2. Add the option --no-stdinc to the Additional options field.

Command line syntax
--no-stdinc

Description
With this option you tell the compiler not to look in the default include directory relative to the installation directory, when searching for include files. This way the compiler only searches in the include file search paths you specified.

Related information
C compiler option --include-directory (Add directory to include file search path)
Section 3.3, How the Compiler Searches Include Files
C compiler option: --no-warnings (-w)

Menu entry

1. Select C Compiler » Diagnostics.
   The Suppress C compiler warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress warnings box.
3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for example 537, 538). Or you can use the Add button multiple times.
4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number[-number],...]
-w[number[-number],...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.
• If you specify this option but without numbers, all warnings are suppressed.
• If you specify this option with a number or a range, only the specified warnings are suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 537 and 538, enter:

cmcs test.c --no-warnings=537,538

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)
Pragma warning
C compiler option: --optimize (-O)

Menu entry
1. Select C Compiler » Optimization.
2. Select an optimization level in the Optimization level box.

Command line syntax

--optimize[=flags]

-flags

You can set the following flags:

-/-coalesce a/A Coalescer: remove unnecessary moves
-/-ipro b/B Interprocedural register optimizations
-/-cse c/C Common subexpression elimination
-/-expression e/E Expression simplification
-/-flow f/F Control flow simplification
-/-glo g/G Generic assembly code optimizations
-/-inline i/I Automatic function inlining
-/-loop l/L Loop transformations
-/-forward o/O Forward store
-/-propagate p/P Constant propagation
-/-subscript s/S Subscript strength reduction
-/-peephole y/Y Peephole optimizations

Use the following options for predefined sets of flags:

--optimize=0 -O0 No optimization
Alias for -OaBCEFGILOPSY

No optimizations are performed except for the coalescer (to allow better debug information). The compiler tries to achieve an optimal resemblance between source code and produced code. Expressions are evaluated in the same order as written in the source code, associative and commutative properties are not used.

--optimize=1 -O1 Optimize
Alias for -OabcefgILOPSy

Enables optimizations that do not affect the debug ability of the source code. Use this level when you encounter problems during debugging your source code with optimization level 2.
--optimize=2  -O2  Optimize more (default)  
Alias for -OabcefgIlopsy

Enables more optimizations to reduce code size and/or execution time. This is the default optimization level.

--optimize=3  -O3  Optimize most  
Alias for -OabcefgIlopsy

This is the highest optimization level. Use this level to decrease execution time to meet your real-time requirements.

Default: --optimize=2

Description

With this option you can control the level of optimization. If you do not use this option, the default optimization level is Optimize more (option --optimize=2 or --optimize).

When you use this option to specify a set of optimizations, you can overrule these settings in your C source file with #pragma optimize flag/#pragma endoptimize.

In addition to the option --optimize, you can specify the option --tradeoff (-t). With this option you specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

Example

The following invocations are equivalent and result all in the default optimization set:

cmcs test.c

```
cmcs --optimize=2 test.c
cmcs -O2 test.c

cmcs --optimize test.c
cmcs -O test.c

cmcs -OabcefgIlopsy test.c
cmcs --optimize=+coalesce,+ipro,+cse,+expression,+flow,+glo,-inline,+loop,+forward,+propagate,+subscript,+peephole test.c
```

Related information

C compiler option --tradeoff (Trade off between speed and size)

Pragma optimize/endoptimize

Section 3.5, Compiler Optimizations
C compiler option: --option-file (-f)

Menu entry

1. Select C Compiler » Miscellaneous.
2. Add the option --option-file to the Additional options field.

   Be aware that the options in the option file are added to the C compiler options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

   --option-file=file,...
   -f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

   • Multiple arguments on one line in the option file are allowed.

   • To include whitespace in an argument, surround the argument with single or double quotes.

   • If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

         "This has a single quote ' embedded"

         'This has a double quote " embedded'

         'This has a double quote " and a single quote '" embedded"

   • When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

         "This is a continuation \ line"

         -> "This is a continuation line"
• It is possible to nest command line files up to 25 levels.

**Example**

Suppose the file `myoptions` contains the following lines:

```
--debug-info
--define=DEMO=1
test.c
```

Specify the option file to the compiler:

```
ccms --option-file=myoptions
```

This is equivalent to the following command line:

```
ccms --debug-info --define=DEMO=1 test.c
```

**Related information**
C compiler option: --output (-o)

Menu entry
Eclipse names the output file always after the C source file.

Command line syntax

--output=file
-o file

Description
With this option you can specify another filename for the output file of the compiler. Without this option the basename of the C source file is used with extension .src.

Example
To create the file output.src instead of test.src, enter:

cmcs --output=output.src test.c

Related information
-
C compiler option: --preprocess (-E)

Menu entry
1. Select C Compiler » Preprocessing.
2. Enable the option Store preprocessor output in <file>.pre.
3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax
--preprocess [=flags]
-E[flags]

You can set the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-comments</td>
<td>keep comments</td>
</tr>
<tr>
<td>+/-includes</td>
<td>generate a list of included source files</td>
</tr>
<tr>
<td>+/-list</td>
<td>generate a list of macro definitions</td>
</tr>
<tr>
<td>+/-make</td>
<td>generate dependencies for make</td>
</tr>
<tr>
<td>+/-noline</td>
<td>strip #line source position information</td>
</tr>
</tbody>
</table>

Default: --ECILMP

Description
With this option you tell the compiler to preprocess the C source. Under Eclipse the compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file to compile). Eclipse also compiles the C source.

On the command line, the compiler sends the preprocessed file to stdout. To capture the information in a file, specify an output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.

With --preprocess=+make the compiler will generate dependency lines that can be used in a Makefile. The preprocessor output is discarded. The default target name is the basename of the input file, with the extension .o. With the option --make-target you can specify a target name which overrules the default target name.
With \texttt{--preprocess=+noline} you tell the preprocessor to strip the \texttt{#line} source position information (lines starting with \texttt{#line}). These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines out, the output is easier to read.

\textbf{Example}

```bash
cmcs --preprocess=+comments,-make,-noline test.c --output=test.pre
```

The compiler preprocesses the file \texttt{test.c} and sends the output to the file \texttt{test.pre}. Comments are included but no dependencies are generated and the line source position information is not stripped from the output file.

\textbf{Related information}

- \texttt{C} compiler option \texttt{--dep-file} (Generate dependencies in a file)
- \texttt{C} compiler option \texttt{--make-target} (Specify target name for \texttt{-Em} output)
C compiler option: --rename-sections (-R)

Menu entry

1. Select **C Compiler » Allocation**

   The Rename sections box shows the sections that are currently renamed.

2. To rename a section, click on the **Add** button in the **Rename sections** box.

3. Type the rename rule in the format `type=format or format` (for example, `mcsdata={module}.{attrib}`)

   Use the **Edit** and **Delete** button to change a section renaming or to remove an entry from the list.

Command line syntax

`--rename-sections=[type]=format_string],...`

`-R[[type]=format_string],...`

Default section name: `.type.(module).{name}`

Description

By default the compiler extends the standard ELF section names with the module name and the name of the symbol that is allocated in the section. You can use this option to create your own unique section names to ease selection in linker script files for locating.

With the `type` argument you select which sections are renamed. When the type of a section matches, the section name will get the specified `format_string` as suffix.

You can specify the following section types:

<table>
<thead>
<tr>
<th>Section type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>mcsctext</td>
<td>program code</td>
</tr>
<tr>
<td>mcsdata</td>
<td>initialized data</td>
</tr>
<tr>
<td>mcsbss</td>
<td>uninitialized data (cleared)</td>
</tr>
<tr>
<td>all</td>
<td>all sections</td>
</tr>
</tbody>
</table>

When you omit the type or use type "all", all sections will be renamed.

With the `format_string` you specify the string that extends the ELF section name. The format string can contain characters and may contain the following format specifiers:

- `{attrib}` Expands to the section attributes, separated by underscores. The cluster attribute, used when debug information is enabled, is not included.
- `{module}` Expands to the basename of the module name.
Expands to the object name, name of variable or function.

In format specifier expansions (for example, a module name with an extra dot), dots (\`) are replaced by dollars ($).

When you omit the format_string, only the section type will be used as the section name.

Example

To rename sections of type mcsdata to .mcsdata.mydata.\texttt{variable\_name}:

\texttt{cmcs --rename-sections=mcsdata=mydata.\{name\} test.c}

To generate the section name \texttt{.type.NEW} instead of the default section name \texttt{.type.module\_name.symbol\_name}, enter:

\texttt{cmcs -RNEW test.c}

To generate the section name \texttt{section\_type\_prefix} instead of the default section name \texttt{section\_type\_prefix.module\_name.symbol\_name}, enter:

\texttt{cmcs -R test.c}

Related information

Section 1.8, Section Naming
C compiler option: --signed-bitfields

Menu entry

1. Select C Compiler » Language.
2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int or unsigned int. By default an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the compiler to treat int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int bit-field as unsigned.

Related information

Section 1.1, Data Types
C compiler option: --source (-s)

Menu entry
1. Select C Compiler » Miscellaneous.
2. Enable the option Merge C source code with generated assembly.

Command line syntax

--source

-s

Description
With this option you tell the compiler to merge C source code with generated assembly code in the output file. The C source lines are included as comments.

Related information
Pragmas source/nosource
C compiler option: --stdout (-n)

Menu entry
-

Command line syntax
--stdout
-n

Description
With this option you tell the compiler to send the output to stdout (usually your screen). No files are created. This option is for example useful to quickly inspect the output or to redirect the output to other tools.

Related information
-
C compiler option: --tradeoff (-t)

Menu entry
1. Select C Compiler » Optimization.
2. Select a trade-off level in the Trade-off between speed and size box.

Command line syntax

```
--tradeoff={0|1|2|3|4}
-t {0|1|2|3|4}
```

Default: --tradeoff=4

Description

If the compiler uses certain optimizations (option --optimize), you can use this option to specify whether the used optimizations should optimize for more speed (regardless of code size) or for smaller code size (regardless of speed).

By default the compiler optimizes for code size (--tradeoff=4).

If you have not specified the option --optimize, the compiler uses the default Optimize more optimization. In this case it is still useful to specify a trade-off level.

With option --tradeoff=3 or --tradeoff=4 the loop alignment optimization is switched off.

Example

To set the trade-off level for the used optimizations:

```
cmcs --tradeoff=2 test.c
```

The compiler uses the default Optimize more optimization level and balances speed and size while optimizing.

Related information

C compiler option --optimize (Specify optimization level)

Section 3.5.3, Optimize for Code Size or Execution Speed
C compiler option: --uchar (-u)

Menu entry

1. Select C Compiler » Language.
2. Enable the option Treat 'char' variables as unsigned.

Command line syntax

--uchar
-u

Description

By default char is the same as specifying signed char. With this option char is the same as unsigned char.

Related information

Section 1.1, Data Types
C compiler option: --undefine (-U)

Menu entry

1. Select C Compiler » Preprocessing

   The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete button.

Command line syntax

--undefine=macro_name
-Umacro_name

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

__FILE__  current source filename
__LINE__  current source line number (int type)
__TIME__  hh:mm:ss
__DATE__  Mmm dd yyyy
__STDC__  level of ANSI standard

Example

To undefine the predefined macro __TASKING__:

    cmcs --undefine=__TASKING__ test.c

Related information

C compiler option --define (Define preprocessor macro)

Section 1.6, Predefined Preprocessor Macros
C compiler option: --verbose (-v)

Menu entry

Command line syntax

--verbose
-v

Description

With this option you put the compiler in verbose mode. With this option the C compiler can generate additional informational diagnostics when available. For example, when code is generated to circumvent functional problems in the processor.

Related information
C compiler option: --version (-V)

Menu entry
-

Command line syntax

--version
-v

Description

Display version information. The compiler ignores all other options or input files.

Example

cmcs --version

The compiler does not compile any files but displays the following version information:

TASKING VX-toolset for MCS: C compiler   vx.yrz Build nnn
Copyright 2014-year Altium BV            SN-00000000

Related information
-
C compiler option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax
--warnings-as-errors[=number[-number],...]

Description
If the compiler encounters an error, it stops compiling. When you use this option without arguments, you tell the compiler to treat all warnings not suppressed by option --no-warnings (or #pragma warning) as errors. This means that the exit status of the compiler will be non-zero after one or more compiler warnings. As a consequence, the compiler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers or ranges. In this case, this option takes precedence over option --no-warnings (and #pragma warning).

Related information
C compiler option --no-warnings (Suppress some or all warnings)
Pragma warning
8.2. Assembler Options

This section lists all assembler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on the command line. Eclipse invokes the assembler via the control program. Therefore, it uses the syntax of the control program to pass options and files to the assembler. If there is no equivalent option in Eclipse, you can specify a command line option in Eclipse as follows:

1. From the **Project** menu, select **Properties for**
   - *The Properties dialog appears.*
2. In the left pane, expand **C/C++ Build** and select **Settings**.
   - *In the right pane the Settings appear.*
3. On the Tool Settings tab, select **Assembler » Miscellaneous**.
4. In the **Additional options** field, enter one or more command line options.
   - *Because Eclipse uses the control program, Eclipse automatically precedes the option with **-Wa** to pass the option via the control program directly to the assembler.*

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For example, the option **-V** displays version header information and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (-- ) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +*longflag*. To switch a flag off, use an uppercase letter or a -*longflag*. Separate *longflags* with commas. The following two invocations are equivalent:

```
asmcs -l -LeM test.src
asmcs --list-file --list-format=+symbol,-macro test.src
```

When you do not specify an option, a default value may become active.
**Assembler option: --case-insensitive (-c)**

**Menu entry**
1. Select **Assembler » Symbols**.
2. Enable the option **Case insensitive identifiers**.

**Command line syntax**

```
--case-insensitive
-c
```

Default: case sensitive

**Description**

With this option you tell the assembler not to distinguish between uppercase and lowercase characters. By default the assembler considers uppercase and lowercase characters as different characters.

**Example**

When assembling case insensitive, the label `LabelName` is the same label as `labelname`.

```
asmcs --case-insensitive test.asm
```

**Related information**

Assembler control `$CASE`
Assembler option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application.

The assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information
Assembler option: --core

Menu entry
1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor.

Command line syntax

--core=core

You can specify the following core arguments:

- mcs1.0: MCS v1.0
- mcs2.0: MCS v2.0
- mcs3.0: MCS v3.0
- mcs3.1: MCS v3.1

Default: mcs1.0

Description

With this option you specify the core architecture for a target processor for which you create your application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor you selected. The define __CORE__ expands to the core argument without the dot. When the default core (mcs1.0) is used, the define __CORE_MCS10__ is set to 1.

With --core=mcs2.0, you can use MCS v2.0 instructions in the assembly code. The define __CORE_MCS20__ is set to 1.

With --core=mcs3.0, you can use MCS v3.0 instructions in the assembly code. The define __CORE_MCS30__ is set to 1.

With --core=mcs3.1, you can use MCS v3.1 instructions in the assembly code. The define __CORE_MCS31__ is set to 1.

Example

To allow the use of MCS v3.1 instructions in the assembly code, enter:

asmcs --core=mcs3.1 test.src

Related information

Control program option --cpu (Select processor)
Assembler option: --debug-info (-g)

Menu entry
1. Select Assembler » Symbols.
2. Select an option from the Generate symbolic debug list.

Command line syntax
--debug-info [=flags]
-g [flags]

You can set the following flags:

```
+-asm       a/A  Assembly source line information
+-local     I/L  Assembler local symbols debug information
```

Default: --debug-info=-asm,-local
Default (without flags): --debug-info=+asm,+local

Description
With this option you tell the assembler which kind of debug information to emit in the object file.

With --debug-info=+asm the assembler generates assembly source line information.

With --debug-info=+local the assembler generates local symbols debug information.

By default the assembler does not generate any debug information.

Related information
Assembler control $DEBUG
Assembler option: --define (-D)

Menu entry

1. Select Assembler » Preprocessing.

   The Defined symbols box right-below shows the symbols that are currently defined.

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, demo=1)

Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the assembler preprocessor. If you only specify a macro name (no macro definition), the macro expands as ‘1’.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful in combination with conditional assembly as shown in the example below.

This option has the same effect as defining symbols via the .DEFINE, .SET, and .EQU directives (similar to #define in the C language). With the .MACRO directive you can define more complex macros.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

Consider the following assembly program with conditional code to assemble a demo program and a real program:
You can now use a macro definition to set the DEMO flag:

```
asmcs --define=DEMO test.asm
asmcs --define=DEMO=1 test.asm
```

Note that both invocations have the same effect.

**Related information**

*Assembler option* `--option-file` *(Specify an option file)*
Assembler option: --dep-file

Menu entry

Command line syntax

```
--dep-file [=file]
```

Description

With this option you tell the assembler to generate dependency lines that can be used in a Makefile. The dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension `.d`. When you specify a filename, all dependencies will be combined in the specified file.

Example

```
asmcs --dep-file=test.dep test.asm
```

The assembler assembles the file `test.asm`, which results in the output file `test.o`, and generates dependency lines in the file `test.dep`.

Related information

Assembler option --make-target (Specify target name for --dep-file output)
Assembler option: --diag

Menu entry
1. From the Window menu, select Show View » Other » TASKING » Problems.
   
   The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
   
   A popup menu appears.

3. Select Detailed Diagnostics Info.
   
   A dialog box appears with additional information.

Command line syntax

```
--diag=[format:]{all | nr,...}
```

You can set the following output formats:

- **html**: HTML output.
- **rtf**: Rich Text Format.
- **text**: ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: **html**, **rtf** or **text** (default). To create a file with the descriptions, you must redirect the output.

With the suboption **all**, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 244, enter:

```
asmcs --diag=244
```

This results in the following message and explanation:

```
W244: additional input files will be ignored
```

The assembler supports only a single input file. All other input files are ignored.
To write an explanation of all errors and warnings in HTML format to file `aserrors.html`, use redirection and enter:

```bash
asmcs --diag=html:all > aserrors.html
```

**Related information**

Section 4.6, *Assembler Error Messages*
Assembler option: --emit-locals

Menu entry
1. Select Assembler » Symbols.
2. Enable or disable one or both of the following options:
   • Emit local EQU symbols
   • Emit local non-EQU symbols

Command line syntax

--emit-locals[=flag,...]

You can set the following flags:

+/-equ$s  e/E  emit local EQU symbols
+/-symbol$s  s/S  emit local non-EQU symbols

Default: --emit-locals=ES

Default (without flags): --emit-locals=+symbols

Description

With the option --emit-locals=+equ$s the assembler also emits local EQU symbols to the object file. Normally, only global symbols and non-EQU local symbols are emitted. Having local symbols in the object file can be useful for debugging.

Related information

Assembler directive .EQU
Assembler option: --endianness

Menu entry
1. Select Global Options.
2. Specify the Endianness: Little-endian mode or Big-endian mode.

Command line syntax
--endianness=endianness
-B
--big-endian

You can specify the following endianness:

<table>
<thead>
<tr>
<th>big</th>
<th>b</th>
<th>Big endian</th>
</tr>
</thead>
<tbody>
<tr>
<td>little</td>
<td>l</td>
<td>Little endian (default)</td>
</tr>
</tbody>
</table>

Description
By default, the assembler generates object files with instructions and data in little-endian format (least significant byte of a word at lowest byte address). With --endianness=big the assembler generates object files in big-endian format (most significant byte of a word at lowest byte address). -B is an alias for option --endianness=big.

The endianness is reflected in the list file.

Assembly code can check the setting of this option by means of the built-in assembly function @BIGENDIAN().

Related information
Assembly function @BIGENDIAN()
Assembler option: --error-file

Menu entry

Command line syntax

--error-file [=file]

Description

With this option the assembler redirects error messages to a file. If you do not specify a filename, the error file will be named after the output file with extension .ers.

Example

To write errors to errors.ers instead of stderr, enter:

asmcs --error-file=errors.ers test.asm

Related information

Section 4.6, Assembler Error Messages
Assembler option: --error-limit

Menu entry
1. Select Assembler » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description
With this option you tell the assembler to only emit the specified maximum number of errors. When 0 (null) is specified, the assembler emits all errors. Without this option the maximum number of errors is 42.

Related information
Section 4.6, Assembler Error Messages
Assembler option: --extended-registers

Menu entry

1. Select C Compiler » Code Generation.
2. Enable the option Use extended register set.

Command line syntax

--extended-registers

Description

The extended register set extends the registers of the current MCS channel with the registers of the next MCS channel. These registers are RS0..RS7, DSTAT, GMI0 and GMI1. By default the extended register set is disabled. With this option you can enable the extended register set.

Related information

-
Assembler option: --help (-?)

Menu entry
-

Command line syntax

--help[=item]
-

You can specify the following arguments:

  options  Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

asmcs -?
asmcs --help
asmcs

To see a detailed description of the available options, enter:

asmcs --help=options

Related information
-

Assembler option: --include-directory (-I)

Menu entry
1. Select Assembler » Include Paths.
   
   *The Include paths box shows the directories that are added to the search path for include files.*

2. To define a new directory for the search path, click on the Add button in the Include paths box.

3. Type or select a path.

   Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

```
--include-directory=path,...
-I path,...
```

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current directory.

The order in which the assembler searches for include files is:

1. The pathname in the assembly file and the directory of the assembly source.

2. The path that is specified with this option.

3. The path that is specified in the environment variable ASMCSINC when the product was installed.

4. The default directory $(PRODDIR)\include.

Example

Suppose that the assembly source file test.asm contains the following lines:

```
.INCLUDE 'myinc.inc'
```

You can call the assembler as follows:

```
asmcs --include-directory=c:\proj\include test.asm
```

First the assembler looks for the file myinc.inc in the directory where test.asm is located. If it does not find the file, it looks in the directory c:\proj\include (this option). If the file is still not found, the assembler searches in the environment variable and then in the default include directory.
Related information

Assembler option --include-file (Include file at the start of the input file)
Assembler option: --include-file (-H)

Menu entry

1. Select Assembler » Preprocessing.
   
   The Pre-include files box shows the files that are currently included before the assembling starts.

2. To define a new file, click on the Add button in the Pre-include files box.

3. Type the full path and file name or select a file.

   Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax

--include-file=file,...

-Hfile,...

Description

With this option (set at project level) you include one extra file at the beginning of the assembly source file. The specified include file is included before all other includes. This is the same as specifying .INCLUDE 'file' at the beginning of your assembly source.

Example

asmcs --include-file=myinc.inc test.asm

The file myinc.inc is included at the beginning of test.asm before it is assembled.

Related information

Assembler option --include-directory (Add directory to include file search path)
Assembler option: --kanji

Menu entry

1. Select Assembler » Miscellaneous.
2. Enable the option Allow Shift JIS Kanji in strings.

Command line syntax

--kanji

Description

With this option you tell the assembler to support Shift JIS encoded Kanji multi-byte characters in strings. Without this option, encodings with 0x5c as the second byte conflict with the use of the backslash as an escape character. Shift JIS in comments is supported regardless of this option.

Note that Shift JIS also includes Katakana and Hiragana.

Related information

-
Assembler option: --keep-output-files (-k)

Menu entry
Eclipse *always* removes the object file when errors occur during assembling.

Command line syntax

```
--keep-output-files
-k
```

Description
If an error occurs during assembling, the resulting object file (.o) may be incomplete or incorrect. With this option you keep the generated object file when an error occurs.

By default the assembler removes the generated object file when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated object. For example when you know that a particular error does not result in a corrupt object file.

Related information
Assembler option *--warnings-as-errors* (Treat warnings as errors)
Assembler option: --list-file (-l)

Menu entry
1. Select Assembler » List File.
2. Enable the option Generate list file.
3. Enable or disable the types of information to be included.

Command line syntax

```
--list-file=[file]
-l[file]
```
Default: no list file is generated

Description

With this option you tell the assembler to generate a list file. A list file shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional file you can specify an alternative name for the list file. By default, the name of the list file is the basename of the output file with the extension .lst.

Related information

Assembler option --list-format (Format list file)
Assembler option: --list-format (-L)

Menu entry

1. Select Assembler » List File.
2. Enable the option Generate list file.
3. Enable or disable the types of information to be included.

Command line syntax

--list-format=flag,...

-L flags

You can set the following flags:

+/-section       d/D  List section directives (.SDECL, .SECT)
+/-symbol        e/E  List symbol definition directives
+/-macro         m/M  List macro definitions
+/-empty-line    n/N  List empty source lines and comment lines (newline)
+/-conditional   p/P  List conditional assembly
+/-equate        q/Q  List equate and set directives (.EQU, .SET)
+/-relocations   r/R  List relocations characters ('r')
+/-equate-values v/V  List equate and set values
+/-wrap-lines    w/W  Wrap source lines
+/-macro-expansion x/X  List macro expansions
+/-cycle-count   y/Y  List cycle counts
+/-define-expansion z/Z  List define expansions

Use the following options for predefined sets of flags:

--list-format=0   -L0  All options disabled
                   Alias for --list-format=DEMNPQRVWXYZ
--list-format=1   -L1  All options enabled
                   Alias for --list-format=demnpqrvwxyz

Default: --list-format=dEMnPqrVwXyZ

Description

With this option you specify which information you want to include in the list file.

On the command line you must use this option in combination with the option --list-file (-l).
**Related information**

Assembler option **--list-file** (Generate list file)

Assembler option **--section-info=list** (Display section information in list file)
Assembler option: --make-target

Menu entry

Command line syntax

`--make-target=name`

Description

With this option you can overrule the default target name in the make dependencies generated by the option `--dep-file`. The default target name is the basename of the input file, with extension `.o`.

Example

```
asmcs --dep-file --make-target=../mytarget.o test.asm
```

The assembler generates dependency lines with the default target name `../mytarget.o` instead of `test.o`.

Related information

Assembler option `--dep-file` (Generate dependencies in a file)
Assembler option: --no-warnings (-w)

Menu entry

1. Select Assembler » Diagnostics.

The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example 201, 202). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings [=number,...]

-w [number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 201 and 202, enter:

asmcs test.asm --no-warnings=201,202

Related information

Assembler option --warnings-as-errors (Treat warnings as errors)
Assembler option: --optimize (-O)

Menu entry

1. Select Assembler » Optimization.
2. Enable the option Optimize generic instructions.

Command line syntax

```
--optimize=flag,...
-O flags
```

You can set the following flags:

```
+/-generics          g/G   Allow generic instructions
```

Default: `--optimize=g`

Description

With this option you can control the level of optimization. For details about each optimization see Section 4.4, Assembler Optimizations.

Related information

Section 4.4, Assembler Optimizations
Assembler option: --option-file (-f)

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the assembler options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax

--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the assembler.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

Option files can also be generated on the fly, for example by the make utility. You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

"This has a single quote ' embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote '" embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \\ line"

     --> "This is a continuation line"
• It is possible to nest command line files up to 25 levels.

**Example**

Suppose the file `myoptions` contains the following lines:

```
--debug=+asm,-local
test.asm
```

Specify the option file to the assembler:

```
asmcs --option-file=myoptions
```

This is equivalent to the following command line:

```
asmcs --debug=+asm,-local test.asm
```

**Related information**

-
Assembler option: --output (-o)

Menu entry
Eclipse names the output file always after the input file.

Command line syntax

`--output=file`
`-o file`

Description
With this option you can specify another filename for the output file of the assembler. Without this option, the basename of the assembly source file is used with extension `.o`.

Example
To create the file `relobj.o` instead of `asm.o`, enter:

`asmcs --output=relobj.o asm.asm`

Related information
-
Assembler option: --page-length

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --page-length to the Additional options field.

Command line syntax

```
--page-length=number
```

Default: 72

Description
If you generate a list file with the assembler option --list-file, this option sets the number of lines in a page in the list file. The default is 72, the minimum is 10. As a special case, a page length of 0 turns off page breaks.

Related information

Assembler option --list-file (Generate list file)

Assembler control $PAGE
Assembler option: --page-width

Menu entry
1. Select Assembler » Miscellaneous.
2. Add the option --page-width to the Additional options field.

Command line syntax

--page-width=number

Default: 132

Description
If you generate a list file with the assembler option --list-file, this option sets the number of columns per line on a page in the list file. The default is 132, the minimum is 40.

Related information
Assembler option --list-file (Generate list file)
Assembler control $PAGE
Assembler option: --preprocess (-E)

Menu entry
-

Command line syntax

--preprocess

-E

Description

With this option the assembler will only preprocess the assembly source file. The assembler sends the preprocessed file to stdout.

Related information
-


Assembler option: --preprocessor-type (-m)

Menu entry

Command line syntax

```
--preprocessor-type=type
-m type
```

You can set the following preprocessor types:

<table>
<thead>
<tr>
<th>none</th>
<th>n</th>
<th>No preprocessor</th>
</tr>
</thead>
<tbody>
<tr>
<td>tasking</td>
<td>t</td>
<td>TASKING preprocessor</td>
</tr>
</tbody>
</table>

Default: `--preprocessor-type=tasking`

Description

With this option you select the preprocessor that the assembler will use. By default, the assembler uses the TASKING preprocessor.

When the assembly source file does not contain any preprocessor symbols, you can specify to the assembler not to use a preprocessor.

Related information

-
Assembler option: --section-info (-t)

Menu entry

1. Select Assembler » List File.
2. Enable the option Generate list file.
3. Enable the option List section summary.

and/or

1. Select Assembler » Diagnostics.
2. Enable the option Display section summary.

Command line syntax

```
--section-info [=flag,...]
-t [flags]
```

You can set the following flags:

```
+/-console c/C  Display section summary on console
+/-list l/L    List section summary in list file
```

Default: --section-info=CL

Default (without flags): --section-info=cl

Description

With this option you tell the assembler to display section information. For each section its memory space, size, total cycle counts and name is listed on stdout and/or in the list file.

The cycle count consists of two parts: the total accumulated count for the section and the total accumulated count for all repeated instructions. In the case of nested loops it is possible that the total supersedes the section total.

Example

To writes the section information to the list file and also display the section information on stdout, enter:

```
asmcs --list-file --section-info asm.asm
```

Related information

Assembler option --list-file (Generate list file)
Assembler option: --symbol-scope (-i)

Menu entry

1. Select Assembler » Symbols.
2. Enable or disable the option Set default symbol scope to global.

Command line syntax

--symbol-scope=scope

-iscpe

You can set the following scope:

<table>
<thead>
<tr>
<th>global</th>
<th>g</th>
<th>Default symbol scope is global</th>
</tr>
</thead>
<tbody>
<tr>
<td>local</td>
<td>l</td>
<td>Default symbol scope is local</td>
</tr>
</tbody>
</table>

Default: --symbol-scope=local

Description

With this option you tell the assembler how to treat symbols that you have not specified explicitly as global or local. By default the assembler treats all symbols as local symbols unless you have defined them explicitly as global.

Related information

Assembler directive .GLOBAL

Assembler directive .LOCAL

Assembler control $IDENT
Assembler option: --version (-V)

Menu entry
-

Command line syntax
--version
-v

Description
Display version information. The assembler ignores all other options or input files.

Related information
-
**Assembler option: --warnings-as-errors**

**Menu entry**

1. Select **Global Options**.
2. Enable the option **Treat warnings as errors**.

**Command line syntax**

```plaintext
--warnings-as-errors[=number, ...]
```

**Description**

If the assembler encounters an error, it stops assembling. When you use this option without arguments, you tell the assembler to treat all warnings as errors. This means that the exit status of the assembler will be non-zero after one or more assembler warnings. As a consequence, the assembler now also stops after encountering a warning.

You can limit this option to specific warnings by specifying a comma-separated list of warning numbers.

**Related information**

Assembler option **--no-warnings** (Suppress some or all warnings)
8.3. Linker Options

This section lists all linker options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the linker via the control program. Therefore, it uses the syntax of the
control program to pass options and files to the linker. If there is no equivalent option in Eclipse, you can
specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Miscellaneous.

4. In the Additional options field, enter one or more command line options.

   Because Eclipse uses the control program, Eclipse automatically precedes the option with -Wl to
   pass the option via the control program directly to the linker.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option --keep-output-files keeps files after an error occurred. When you specify this option
in Eclipse, it will have no effect because Eclipse always removes the output file after an error had occurred.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

    lmcs -mfkl test.o
    lmcs --map-file-format=+files,+link,+locate test.o

When you do not specify an option, a default value may become active.
Linker option: --case-insensitive

Menu entry

1. Select **Linker » Miscellaneous**.
2. Enable the option **Link case insensitive**.

Command line syntax

```
--case-insensitive
```

Default: case sensitive

**Description**

With this option you tell the linker not to distinguish between uppercase and lowercase characters in symbols. By default the linker considers uppercase and lowercase characters as different characters.

When you have written your own assembly code and specified to assemble it case insensitive, you must also link the `.o` file case insensitive.

**Related information**

Assembler option **--case-insensitive**
Linker option: --chip-output (-c)

Menu entry

1. Select Linker » Output Format.
2. Enable the option Generate Intel Hex format file and/or Generate S-records file.
3. Enable the option Create file for each memory chip.
4. Optionally, specify the Size of addresses.

   *Eclipse always uses the project name as the basename for the output file.*

Command line syntax

```
--chip-output=[basename]:format[:addr_size],...
-c[basename]:format[:addr_size],...
```

You can specify the following formats:

- **IHEX**  
  Intel Hex

- **SREC**  
  Motorola S-records

The `addr_size` specifies the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

Description

With this option you specify the Intel Hex or Motorola S-record output format for loading into a PROM-programmer. The linker generates a file for each ROM memory defined in the LSL file, where sections are located:

```
memory memname
{  type=rom;  }
```

The name of the file is the name of the Eclipse project or, on the command line, the name of the memory device that was emitted with extension `.hex` or `.sre`. Optionally, you can specify a `basename` which prepends the generated file name.

The linker always outputs a debugging file in ELF/DWARF format and optionally an absolute object file in Intel Hex-format and/or Motorola S-record format.

Example

To generate Intel Hex output files for each defined memory, enter the following on the command line:

```
lmcs --chip-output=myfile:IHEX test1.o
```
In this case, this generates the file `myfile_memname.hex`.

**Related information**

Linker option `--output` (Output file)
Linker option: --core (-C)

Menu entry
1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor or select User defined ....
3. From the Multi-core configuration list, select an MCS core.

Command line syntax
--core=MCS-core
-CMCS-core

You can specify the following MCS cores (depending on the chosen processor):

- mpe:mcs00  MCS core 0
- mpe:mcs01  MCS core 1
- mpe:mcs02  MCS core 2
- mpe:mcs03  MCS core 3

Default: mpe:mcs00

Description
With this option you specify the core for the target processor for which you create your application.

In a multi-task setting, use this option to tell the linker to use a specific core for a specific task. Only one task can be assigned to a certain core. Assigning multiple tasks to a single core requires some form of kernel functionality.

The core is specified as mpe:mcs{0123}. For example, the file tc27x.lsl in the include.lsl directory, contains a description of derivative tc27x and the supported MCS cores. mpe is the multi-processor environment as specified in the LSL file.

Example
To link objects for the MCS core mpe:mcs01, enter:

```
lcms -o test.elf -dtc27x.lsl --non-romable
   --user-provided-initialization-code -D__LINKONLY__
   -DCSA=0 --core=mpe:mcs01 --map-file test.o
```

Related information
Control program option --lsl-core (Specify LSL core)
Linker option: --define (-D)

Menu entry
1. Select Linker » Script File.
   
   The Defined symbols box shows the symbols that are currently defined.
   
2. To define a new symbol, click on the Add button in the Defined symbols box.
3. Type the symbol definition (for example, demo=1)

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

--define=macro_name[=macro_definition]

-Dmacro_name[=macro_definition]

Description

With this option you can define a macro and specify it to the linker LSL file preprocessor. If you only specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like; just use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the linker with the option --option-file (-f) file.

The definition can be tested by the preprocessor with #if, #ifdef and #ifndef, for conditional locating.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

To define the RESET vector, which is used in the linker script file tc27x.lsl, enter:

lmcs test.o -otest.elf --lsl-file=tc27x.lsl --define=RESET=0xa0000020

Related information

Linker option --option-file (Specify an option file)
**Linker option: --diag**

**Menu entry**

1. From the **Window** menu, select **Show View » Other » TASKING » Problems**.
   
   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.
   
   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.
   
   *A dialog box appears with additional information.*

**Command line syntax**

```
--diag=[format:]{all | nr,...}
```

You can set the following output formats:

- **html**: HTML output.
- **rtf**: Rich Text Format.
- **text**: ASCII text.

Default format: text

**Description**

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: **html**, **rtf** or **text** (default). To create a file with the descriptions, you must redirect the output.

With the suboption **all**, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

With this option the linker does not link/locate any files.

**Example**

To display an explanation of message number 106, enter:

```
lmcs --diag=106
```

This results in the following message and explanation:

```
E106: unresolved external: <message>
```

The linker could not resolve all external symbols.
This is an error when the incremental linking option is disabled. The <message> indicates the symbol that is unresolved.

To write an explanation of all errors and warnings in HTML format to file lkerrors.html, use redirection and enter:

```
lmcs --diag=html:all > lkerrors.html
```

**Related information**

Section 5.10, *Linker Error Messages*
Linker option: --endianness

Menu entry

1. Select Global Options.
2. Specify the Endianness: Little-endian mode or Big-endian mode.

Command line syntax

--endianness=endianness

-B
--big-endian

You can specify the following endianness:

<table>
<thead>
<tr>
<th>big</th>
<th>b</th>
<th>Big endian</th>
</tr>
</thead>
<tbody>
<tr>
<td>little</td>
<td>l</td>
<td>Little endian (default)</td>
</tr>
</tbody>
</table>

Description

By default, the linker links objects in little-endian mode. With --endianness=big you tell the linker to link the input files in big-endian mode. The endianness used must be valid for the architecture you are linking for. Depending on the endianness used, the linker links different libraries. -B is an alias for option --endianness=big.

Related information

-
Linker option: --error-file

Menu entry
-

Command line syntax

--error-file[=file]

Description

With this option the linker redirects error messages to a file. If you do not specify a filename, the error file is lmcs.elk.

Example

To write errors to errors.elk instead of stderr, enter:

lmcs --error-file=errors.elk test.o

Related information

Section 5.10, Linker Error Messages
Linker option: --error-limit

Menu entry
1. Select Linker » Diagnostics.
2. Enter a value in the Maximum number of emitted errors field.

Command line syntax

--error-limit=number

Default: 42

Description
With this option you tell the linker to only emit the specified maximum number of errors. When 0 (null) is specified, the linker emits all errors. Without this option the maximum number of errors is 42.

Related information
Section 5.10, Linker Error Messages
Linker option: --extern (-e)

Menu entry
-

Command line syntax

--extern=symbol,...
-e symbol,...

Description

With this option you force the linker to consider the given symbol as an undefined reference. The linker tries to resolve this symbol, either the symbol is defined in an object file or the linker extracts the corresponding symbol definition from a library.

This option is, for example, useful if the startup code is part of a library. Because your own application does not refer to the startup code, you can force the startup code to be extracted by specifying the symbol _START as an unresolved external.

Example

Consider the following invocation:

lmcs mylib.a

Nothing is linked and no output file will be produced, because there are no unresolved symbols when the linker searches through mylib.a.

lmcs --extern=_START mylib.a

In this case the linker searches for the symbol _START in the library and (if found) extracts the object that contains _START, the startup code. If this module contains new unresolved symbols, the linker looks again in mylib.a. This process repeats until no new unresolved symbols are found.

Related information
-

Linker option: --first-library-first

Menu entry

Command line syntax

--first-library-first

Description

When the linker processes a library it searches for symbols that are referenced by the objects and libraries processed so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the library.

By default the linker processes object files and libraries in the order in which they appear on the command line. If you specify the option --first-library-first the linker always tries to take the symbol definition from the library that appears first on the command line before scanning subsequent libraries.

This is for example useful when you are working with a newer version of a library that partially overlaps the older version. Because they do not contain exactly the same functions, you have to link them both. However, when a function is present in both libraries, you may want the linker to extract the most recent function.

Example

Consider the following example:

```
lmcs --first-library-first a.a test.o b.a
```

If the file test.o calls a function which is both present in a.a and b.a, normally the function in b.a would be extracted. With this option the linker first tries to extract the symbol from the first library a.a.

Note that routines in b.a that call other routines that are present in both a.a and b.a are now also resolved from a.a.

Related information

Linker option --no-rescan (Rescan libraries to solve unresolved externals)
Linker option: --global-type-checking

Menu entry
-

Command line syntax
--global-type-checking

Description
Use this option when you want the linker to check the types of variable and function references against their definitions, using DWARF 3 debug information.

Related information
-
Linker option: --help (-?)

Menu entry
-

Command line syntax

`--help[=item]`

`-?`

You can specify the following arguments:

- `options` Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument `options` you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

```
lmcs -?
lmcs --help
lmcs
```

To see a detailed description of the available options, enter:

```
lmcs --help=options
```

Related information
-


Linker option: --hex-format

Menu entry

1. Select Linker » Miscellaneous.
2. Add the option --hex-format to the Additional options field.

Command line syntax

--hex-format=flag,...

You can set the following flag:

+/-start-address   s/S   Emit start address record

Default: --hex-format=s

Description

With this option you can specify to emit or omit the start address record from the hex file.

Related information

Linker option --output (Output file)
Linker option: --hex-record-size

Menu entry
1. Select Linker » Miscellaneous.
2. Add the option --hex-record-size to the Additional options field.

Command line syntax

--hex-record-size=size

Default: 32

Description
With this option you can set the size (width) of the Intel Hex data records.

Related information
Linker option --output (Output file)
Linker option: --import-object

Menu entry

1. Select **Linker » Data Objects**.

   *The Data objects box shows the list of object files that are imported.*

2. To add a data object, click on the **Add** button in the **Data objects** box.

3. Type or select a binary file (including its path).

   Use the **Edit** and **Delete** button to change a filename or to remove a data object from the list.

Command line syntax

```
--import-object=file,...
```

Description

With this option the linker imports a binary *file* containing raw data and places it in a section. The section name is derived from the filename, in which dots are replaced by an underscore. So, when importing a file called *my.jpg*, a section with the name *my_jpg* is created. In your application you can refer to the created section by using linker labels.

Related information

Section 5.5, *Importing Binary Files*
Linker option: --include-directory (-I)

Menu entry
-

Command line syntax

--include-directory=path,...
-I path,...

Description

With this option you can specify the path where your LSL include files are located. A relative path will be relative to the current directory.

The order in which the linker searches for LSL include files is:

1. The pathname in the LSL file and the directory where the LSL file is located (only for #include files that are enclosed in "")
2. The path that is specified with this option.
3. The default directory $(PRODDIR)\include.lsl.

Example

Suppose that your linker script file mylsl.lsl contains the following line:

#include "myinc.inc"

You can call the linker as follows:

lmcs --include-directory=c:\proj\include --lsl-file=mylsl.lsl test.o

First the linker looks for the file myinc.inc in the directory where mylsl.lsl is located. If it does not find the file, it looks in the directory c:\proj\include (this option). Finally it looks in the directory $(PRODDIR)\include.lsl.

Related information

Linker option --lsl-file (Specify linker script file)
Linker option: --incremental (-r)

Menu entry
-

Command line syntax
--incremental
-r

Description
Normally the linker links and locates the specified object files. With this option you tell the linker only to link the specified files. The linker creates a linker output file .out. You then can link this file again with other object files until you have reached the final linker output file that is ready for locating.

In the last pass, you call the linker without this option with the final linker output file .out. The linker will now locate the file.

Example
In this example, the files test1.o, test2.o and test3.o are incrementally linked:

1. lmcs --incremental test1.o test2.o --output=test.out

   test1.o and test2.o are linked

2. lmcs --incremental test3.o test.out

   test3.o and test.out are linked, task1.out is created

3. lmcs task1.out

   task1.out is located

Related information
Section 5.4, Incremental Linking
Linker option: --keep-output-files (-k)

Menu entry

Eclipse always removes the output files when errors occurred.

Command line syntax

`--keep-output-files`

`-k`

Description

If an error occurs during linking, the resulting output file may be incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the linker removes the generated output file when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated file. For example when you know that a particular error does not result in a corrupt object file, or when you want to inspect the output file, or send it to Altium support.

Related information

Linker option `--warnings-as-errors` (Treat warnings as errors)
**Linker option: --library (-l)**

**Menu entry**

1. Select **Linker » Libraries**.

   *The Libraries box shows the list of libraries that are linked with the project.*

2. To add a library, click on the **Add** button in the **Libraries** box.

3. Type or select a library (including its path).

4. Optionally, disable the option **Link default libraries**.

   Use the **Edit** and **Delete** button to change a library name or to remove a library from the list.

**Command line syntax**

```
--library=\textit{name}
```

```
-l \textit{name}
```

**Description**

With this option you tell the linker to use system library \textit{libname.a}, where \textit{name} is a string. The linker first searches for system libraries in any directories specified with \textit{--library-directory}, then in the directories specified with the environment variable \textit{LIBMCS}, unless you used the option \textit{--ignore-default-library-path}.

**Example**

To search in the system library \textit{libc.a}:

```
lmcs test.o mylib.a --library=c
```

The linker links the file \textit{test.o} and first looks in library \textit{mylib.a} (in the current directory only), then in the system library \textit{libc.a} to resolve unresolved symbols.

**Related information**

Linker option \textit{--library-directory} (Additional search path for system libraries)
**Linker option: --library-directory (-L) / --ignore-default-library-path**

**Menu entry**

1. Select **Linker » Libraries**.

   *The Library search path box shows the directories that are added to the search path for library files.*

2. To define a new directory for the search path, click on the **Add** button in the **Library search path** box.

3. Type or select a path.

   *Use the **Edit** and **Delete** button to change a path or to remove a path from the list.*

**Command line syntax**

```
--library-directory=path,...
-L path,...
--ignore-default-library-path
-L
```

**Description**

With this option you can specify the path(s) where your system libraries, specified with the option **--library** (-l), are located. If you want to specify multiple paths, use the option **--library-directory** for each separate path.

The default path is `$(PRODDIR)\lib`.

If you specify only `-L` (without a pathname) or the long option **--ignore-default-library-path**, the linker will not search the default path and also not in the paths specified in the environment variable `LIBMCS`. So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option **--library** (-l) is:

1. The path that is specified with the option **--library-directory**.
2. The path that is specified in the environment variable `LIBMCS`.
3. The default directory `$(PRODDIR)\lib`.

**Example**

Suppose you call the linker as follows:

```
lmcs test.o --library-directory=c:\mylibs --library=c
```
First the linker looks in the directory `c:\mylibs` for library `libc.a` (this option). If it does not find the requested libraries, it looks in the directory that is set with the environment variable `LIBMCS`. Then the linker looks in the default directory `$(PRODDIR)\lib` for libraries.

**Related information**

**Linker option** `--library` (Link system library)
Linker option: --link-only

Menu entry

Command line syntax

--link-only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about unresolved references.

Related information

Control program option --create=relocatable (-cl) (Stop after linking)
Linker option: --lsl-check

Menu entry

Command line syntax

--lsl-check

Description

With this option the linker just checks the syntax of the LSL file(s) and exits. No linking or locating is performed. Use the option --lsl-file to specify the name of the Linker Script File you want to test.

Related information

Linker option --lsl-file (Linker script file)

Linker option --lsl-dump (Dump LSL info)

Section 5.7, Controlling the Linker with a Script
Linker option: --lsl-dump

Menu entry

-  

Command line syntax

```
--lsl-dump[=file]
```

Description

With this option you tell the linker to dump the LSL part of the map file in a separate file, independent of the option --map-file (generate map file). If you do not specify a filename, the file `lmcs.1df` is used.

Related information

Linker option --map-file-format (Map file formatting)
Linker option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your TriCore project in Eclipse:

1. From the File menu, select File » New » TASKING TriCore C/C++ Project.
   
   The New C/C++ Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the TriCore Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

   Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field.

Command line syntax

--lsl-file=file

-dfile

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL and contains the following types of information:

- the architecture definition describes the core’s hardware architecture.

- the memory definition describes the physical memory available in the system.

- the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file to the linker. If you do not specify this option, the linker uses a default script file. You can specify the existing file target.lsl or the name of a manually written linker script file. You can use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Linker option --lsl-check (Check LSL file(s) and exit)

Section 5.7, Controlling the Linker with a Script
Linker option: --map-file (-M)

Menu entry

1. Select Linker » Map File.
2. Enable the option Generate XML map file format (.mapxml) for map file viewer.
3. (Optional) Enable the option Generate map file.
4. Enable or disable the types of information to be included.

Command line syntax

```
--map-file [=file] [:XML]
-M [file] [:XML]
```

Default (Eclipse): XML map file is generated

Default (linker): no map file is generated

Description

With this option you tell the linker to generate a linker map file. If you do not specify a filename and you specified the option `--output`, the linker uses the same basename as the output file with the extension `.map`. If you did not specify the option `--output`, the linker uses the file `task1.map`. Eclipse names the `.map` file after the project.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files (.o) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address.

Related information

Linker option `--map-file-format` (Format map file)

Section 11.2, Linker Map File Format
Linker option: --map-file-format (-m)

Menu entry
1. Select Linker » Map File.
2. Enable the option Generate XML map file format (.mapxml) for map file viewer.
3. (Optional) Enable the option Generate map file.
4. Enable or disable the types of information to be included.

Command line syntax

```
--map-file-format=flag,...
-mflags
```

You can set the following flags:

+/-callgraph c/C Include call graph information
+/-removed d/D Include information on removed sections
+/-files f/F Include processed files information
+/-invocation i/I Include information on invocation and tools
+/-link k/K Include link result information
+/-locate l/L Include locate result information
+/-memory m/M Include memory usage information
+/-nonalloc n/N Include information of non-alloc sections
+/-overlay o/O Include overlay information
+/-statics q/Q Include module local symbols information
+/-crossref r/R Include cross references information
+/-lsl s/S Include processor and memory information
+/-rules u/U Include locate rules

Use the following options for predefined sets of flags:

```
--map-file-format=0 -m0 Link information
  Alias for -mcDfikLMNoQrSU
--map-file-format=1 -m1 Locate information
  Alias for -mCDfiKIMNoQRSU
--map-file-format=2 -m2 Most information
  Alias for -mcdfiklmNoQrSu
```

Default: --map-file-format=2
With this option you specify which information you want to include in the map file. On the command line you must use this option in combination with the option `--map-file (-M)`.

Related information

Linker option `--map-file` (Generate map file)

Section 11.2, *Linker Map File Format*
**Linker option: --misra-c-report**

**Menu entry**

-  

**Command line syntax**

`--misra-c-report [=file]`

**Description**

With this option you tell the linker to create a MISRA C Quality Assurance report. This report lists the various modules in the project with the respective MISRA C settings at the time of compilation. If you do not specify a filename, the file `basename.mcr` is used.

**Related information**

C compiler option `--misrac (MISRA C checking)`
Linker option: --new-task

Menu entry

Command line syntax

--new-task

Description

With this option the linker creates an additional task. Any options that follow only apply to the new task.

The linker processes options on the command line from left to right. To know whether a certain option belongs to a different task it uses this option. This implies that all options for a given task must be fully specified before moving on to the next.

Related information

-
Linker option: --non-romable

Menu entry
-

Command line syntax
--non-romable

Description
With this option you tell the linker that the application must not be located in ROM. The linker will locate all ROM sections, including a copy table if present, in RAM. When the application is started, the data sections are re-initialized and the BSS sections are cleared as usual.

This option is, for example, useful when you want to test the application in RAM before you put the final application in ROM. This saves you the time of flashing the application in ROM over and over again.

If you want to locate your application in RAM only, without using ROM/flash resources of the chip, for example when you run the debugger in RAM only, also specify the options --no-rom-copy and --user-provided-initialization-code or use the control program option --meminit=none.

Related information
Control program option --meminit (Initialize memory)
Linker option --no-rom-copy (Do not generate ROM copy)
Linker option --user-provided-initialization-code (Own initialization code, no standard copy table)
**Linker option: --no-rescan**

**Menu entry**

1. Select **Linker » Libraries**.
2. Disable the option **Rescan libraries to solve unresolved externals**.

**Command line syntax**

```bash
--no-rescan
```

**Description**

When the linker processes a library it searches for symbol definitions that are referenced by the objects and libraries processed so far. If the library contains a definition for an unresolved reference the linker extracts the object that contains the definition from the library. The linker processes object files and libraries in the order in which they appear on the command line.

When all objects and libraries are processed the linker checks if there are unresolved symbols left. If so, the default behavior of the linker is to rescan all libraries in the order given at the command line. The linker stops rescanning the libraries when all symbols are resolved, or when the linker could not resolve any symbol(s) during the rescan of all libraries. Notice that resolving one symbol may introduce new unresolved symbols.

With this option, you tell the linker to scan the object files and libraries only once. When the linker has not resolved all symbols after the first scan, it reports which symbols are still unresolved. This option is useful if you are building your own libraries. The libraries are most efficiently organized if the linker needs only one pass to resolve all symbols.

**Related information**

**Linker option** **--first-library-first** (Scan libraries in given order)
Linker option: --no-rom-copy (-N)

Menu entry
-

Command line syntax

--no-rom-copy

-N

Description

With this option the linker will not generate a ROM copy for data sections. A copy table is generated and contains entries to clear BSS sections. However, no entries to copy data sections from ROM to RAM are placed in the copy table.

The data sections are initialized when the application is downloaded. The data sections are not re-initialized when the application is restarted.

Related information

Linker option --non-romable (Application is not romable)

Linker option --user-provided-initialization-code (Own initialization code, no standard copy table)
Linker option: --no-warnings (-w)

Menu entry

1. Select Linker » Diagnostics.

   The Suppress warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas, of the warnings you want to suppress (for example 135,136). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings[=number,...]

-w[number,...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

- If you do not specify this option, all warnings are reported.
- If you specify this option but without numbers, all warnings are suppressed.
- If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 135 and 136, enter:

lmcs --no-warnings=135,136 test.o

Related information

Linker option --warnings-as-errors (Treat warnings as errors)
**Linker option: --optimize (-O)**

**Menu entry**

1. Select **Linker » Optimization**.
2. Select one or more of the following options:
   - Delete unreferenced sections
   - Use a ‘first-fit decreasing’ algorithm
   - Compress copy table
   - Delete duplicate code
   - Delete duplicate data

**Command line syntax**

```
--optimize=flag,...
-Oflags
```

You can set the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-delete-unreferenced-sections</td>
<td>c/C  Delete unreferenced sections from the output file</td>
</tr>
<tr>
<td>+/-first-fit-decreasing</td>
<td>l/L   Use a ‘first-fit decreasing’ algorithm to locate unrestricted sections in memory</td>
</tr>
<tr>
<td>+/-copytable-compression</td>
<td>t/T   Emit smart restrictions to reduce copy table size</td>
</tr>
<tr>
<td>+/-delete-duplicate-code</td>
<td>x/X   Delete duplicate code sections from the output file</td>
</tr>
<tr>
<td>+/-delete-duplicate-data</td>
<td>y/Y   Delete duplicate constant data from the output file</td>
</tr>
</tbody>
</table>

Use the following options for predefined sets of flags:

- `--optimize=0`  - `O0`  No optimization  
  Alias for `-OCLTXY`
- `--optimize=1`  - `O1`  Default optimization  
  Alias for `-OcLtxy`
- `--optimize=2`  - `O2`  All optimizations  
  Alias for `-Ocltxy`

Default: `--optimize=1`
Description

With this option you can control the level of optimization.

Related information

For details about each optimization see Section 5.6, *Linker Optimizations*. 
**Linker option: --option-file (-f)**

**Menu entry**

1. Select **Linker » Miscellaneous**.
2. Add the option **--option-file** to the **Additional options** field.

   *Be aware that the options in the option file are added to the linker options you have set in the other pages. Only in extraordinary cases you may want to use them in combination.*

**Command line syntax**

```
--option-file=file,...
-f file,...
```

**Description**

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the linker.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

Option files can also be generated on the fly, for example by the `make` utility. You can specify the option `--option-file` multiple times.

**Format of an option file**

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vise versa:

```
"This has a single quote ' embedded"
'This has a double quote " embedded'
'This has a double quote " and a single quote '" embedded"
```

- When a text line reaches its length limit, use a `\` to continue the line. Whitespace between quotes is preserved.

```
"This is a continuation \ line"
```

   `-> "This is a continuation line"`
It is possible to nest command line files up to 25 levels.

**Example**

Suppose the file *myoptions* contains the following lines:

```
--map-file=my.map               (generate a map file)
test.o                          (input file)
--library-directory=c:\mylibs   (additional search path for system libraries)
```

Specify the option file to the linker:

```
lmcs --option-file=myoptions
```

This is equivalent to the following command line:

```
lmcs --map-file=my.map test.o --library-directory=c:\mylibs
```

**Related information**

-
**Linker option: --output (-o)**

**Menu entry**

1. Select **Linker » Output Format**.
2. Enable one or more output formats.

   *For some output formats you can specify a number of suboptions.*

   *Eclipse always uses the project name as the basename for the output file.*

**Command line syntax**

```
--output=[filename][:format[:addr_size][,space_name]]...

-o[filename][:format[:addr_size][,space_name]]...
```

You can specify the following formats:

- ELF: ELF/DWARF
- IHEX: Intel Hex
- SREC: Motorola S-records

**Description**

By default, the linker generates an output file in ELF/DWARF format, with the name `task1.elf`.

With this option you can specify an alternative `filename`, and an alternative output `format`. The default output format is the format of the first input file.

You can use the `--output` option multiple times. This is useful to generate multiple output formats. With the first occurrence of the `--output` option you specify the basename (the filename without extension), which is used for subsequent `--output` options with no filename specified. If you do not specify a filename, or you do not specify the `--output` option at all, the linker uses the default basename `taskn`.

**IHEX and SREC formats**

If you specify the Intel Hex format or the Motorola S-records format, you can use the argument `addr_size` to specify the size of addresses in bytes (record length). For Intel Hex you can use the values: 1, 2, and 4 (default). For Motorola S-records you can specify: 2 (S1 records), 3 (S2 records, default) or 4 bytes (S3 records). Note that if you make the `addr_size` too small, the linker might give a fatal object writer error indicating an address overflow.

With the argument `space_name` you can specify the name of the address space. The name of the output file will be `filename` with the extension `.hex` or `.sre` and contains the code and data allocated in the specified space. If they exist, any other address spaces are also emitted whereas their output files are named `filename_spacename` with the extension `.hex` or `.sre`.

If you do not specify `space_name`, or you specify a non-existing space, the default address space is filled in.
Use option **--chip-output (-c)** to create Intel Hex or Motorola S-record output files for each chip defined in the LSL file (suitable for loading into a PROM-programmer).

**Example**

To create the output file `myfile.hex` of the address space named `linear`, enter:

```
lmcs test.o --output=myfile.hex:IHEX:2,linear
```

If they exist, any other address spaces are emitted as well and are named `myfile_spacename.hex`.

**Related information**

- **Linker option **--chip-output** (Generate an output file for each chip)**
- **Linker option **--hex-format** (Specify Hex file format settings)**
Linker option: --strip-debug (-S)

Menu entry
1. Select Linker » Miscellaneous.
2. Enable the option Strip symbolic debug information.

Command line syntax
--strip-debug
-S

Description
With this option you specify not to include symbolic debug information in the resulting output file.

Related information
Linker option: --user-provided-initialization-code (-i)

Menu entry
1. Select **Linker » Miscellaneous**.
2. Enable the option **Do not use standard copy table for initialization**.

Command line syntax

```
--user-provided-initialization-code
-i
```

Description

It is possible to use your own initialization code, for example, to save ROM space. With this option you tell the linker *not* to generate a copy table for initialize/clear sections. Use linker labels in your source code to access the positions of the sections when located.

If the linker detects references to the TASKING initialization code, an error is emitted: it is either the TASKING initialization routine or your own, not both.

Note that the options **--no-rom-copy** and **--non-romable**, may vary independently. The 'copytable-compression' optimization (**--optimize=t**) is automatically disabled when you enable this option.

Related information

- **Linker option --no-rom-copy** (Do not generate ROM copy)
- **Linker option --non-romable** (Application is not romable)
- **Linker option --optimize** (Specify optimization)
Linker option: --verbose (-v)

Menu entry
1. Select Linker » Miscellaneous.
2. Enable the option Show link phases during processing.

The verbose output is displayed in the Problems view and the Console view.

Command line syntax

--verbose
-v

Description

With this option you put the linker in verbose mode. The linker prints the link phases while it processes the files. The linker prints one entry for each action it executes for a task. When you use this option twice (-vv) you put the linker in extra verbose mode. In this mode the linker also prints the filenames and it shows which objects are extracted from libraries and it shows verbose information that would normally be hidden when you use the normal verbose mode or when you run without verbose. With this option you can monitor the current status of the linker.

Related information
-
Linker option: --version (-V)

Menu entry

Command line syntax

--version

-v

Description

Display version information. The linker ignores all other options or input files.

Related information

-
Linker option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number,...]

Description

When the linker detects an error or warning, it tries to continue the link process and reports other errors and warnings. When you use this option without arguments, you tell the linker to treat all warnings as errors. This means that the exit status of the linker will be non-zero after the detection of one or more linker warnings. As a consequence, the linker will not produce any output files.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information

Linker option --no-warnings (Suppress some or all warnings)
Linker option: --whole-archive

Menu entry
1. Select Linker » Miscellaneous.
2. Add the option --whole-archive to the Additional options field.

Command line syntax
--whole-archive=file

Description
This option tells the linker to directly load all object modules in a library, as if they were placed on the command line. This is different from libraries specified as input files or with the -l option, which are only used to resolve references in object files that were loaded earlier.

Example
Suppose the library myarchive.a contains the objects my1.o, my2.o and my3.o. Specifying

lmcs --whole-archive=myarchive.a

is the same as specifying

lmcs my1.o my3.o my3.o

Related information
Linker option --library (Link system library)
8.4. Control Program Options

The control program ccms facilitates the invocation of the various components of the MCS toolset from a single command line.

Options in Eclipse versus options on the command line

Eclipse invokes the compiler, assembler and linker via the control program. Therefore, it uses the syntax of the control program to pass options and files to the tools. The control program processes command line options either by itself, or, when the option is unknown to the control program, it looks whether it can pass the option to one of the other tools. However, for directly passing an option to the C compiler, assembler or linker, it is recommended to use the control program options --pass-c, --pass-assembler, --pass-linker.

See the previous sections for details on the options of the tools.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

ccms -Wc-Oac test.c
ccms --pass-c=--optimize=+coalesce,+cse test.c

When you do not specify an option, a default value may become active.
Control program option: --address-size

Menu entry

1. Select Linker » Output Format.

2. Enable the option Generate Intel Hex format file and/or Generate S-records file.

3. Specify the Size of addresses.

   Eclipse always uses the project name as the basename for the output file.

Command line syntax

--address-size=addr_size

Description

If you specify IHEX or SREC with the control option --format, you can additionally specify the record length to be emitted in the output files.

With this option you can specify the size of the addresses in bytes (record length). For Intel Hex you can use the values 1, 2 or 4 bytes (default). For Motorola-S you can specify: 2 (S1 records), 3 (S2 records) or 4 bytes (S3 records, default).

If you do not specify addr_size, the default address size is generated.

Example

To create the SREC file test.sre with S1 records, type:

ccmcs --format=SREC --address-size=2 test.c

Related information

Control program option --format (Set linker output format)

Control program option --output (Output file)
Control program option: --case-insensitive

Menu entry

1. Select Assembler » Symbols.
2. Enable the option Case insensitive identifiers.

Command line syntax

--case-insensitive

Default: case sensitive

Description

With this option you tell the assembler not to distinguish between uppercase and lowercase characters. By default the assembler considers uppercase and lowercase characters as different characters.

Example

When assembling case insensitive, the label LabelName is the same label as labelname.

ccmcs --case-insensitive test.asm

Related information

Assembler option --case-insensitive

Assembler control $CASE
Control program option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves time in developing your application because the code will not actually be compiled.

The compiler/assembler reports any warnings and/or errors.

This option is available on the command line only.

Related information

C compiler option --check (Check syntax)

Assembler option --check (Check syntax)
Control program option: --core

Menu entry
1. Expand C/C++ Build and select Processor.
2. From the Processor Selection list, select a processor or select User defined ....

Command line syntax

--core=core

You can specify the following core arguments:

- mcs1.0       MCS v1.0 core
- mcs2.0       MCS v2.0 core
- mcs3.0       MCS v3.0 core
- mcs3.1       MCS v3.1 core

Default: mcs3.1

Description

With this option you specify the core architecture for a target processor for which you create your application. If you use Eclipse or the control program, the MCS toolset derives the core from the processor you selected. When the default core (mcs3.1) is used, the macro __CORE_MCS31__ is defined in the C source file.

Note that the C compiler only supports cores mcs3.0 and mcs3.1. The assembler and linker support all cores.

With --core=mcs1.0, you tell the assembler that the assembly file contains instructions for the MCS v1.0 core.

With --core=mcs2.0, you tell the assembler that the assembly file contains instructions for the MCS v2.0 core.

With --core=mcs3.0, the compiler can generate MCS v3.0 instructions in the assembly file. The macro __CORE_MCS30__ is defined in the C source file.

With --core=mcs3.1, the compiler can generate MCS v3.1 instructions in the assembly file. The macro __CORE_MCS31__ is defined in the C source file.

Example

Select an MCS v3.0 core:

ccmcs --core=mcs3.0 test.c
Related information

Control program option \texttt{--cpu} (Select processor)
Control program option: --cpu (-C)

**Menu entry**
1. Expand C/C++ Build and select Processor.
2. From the Processor selection list, select a processor or select User defined ....

**Command line syntax**

--cpu=id | name | cpu

-Cid | name | cpu

**Description**

With this option you define the target processor for which you create your application. You can specify a full processor name, like TC27x, or a base CPU name, like tc27x or its unique id, like tc27x.

The standard list of supported processors is defined in the file processors.xml. This file defines for each processor its full name (for example, TC27x), its ID, the base CPU name (for example, tc27x) and the core settings (for example, mcs). To show a list of all supported processors you can use option --cpu-list.

The control program reads the file processors.xml. The lookup sequence for names specified to this option is as follows:

1. match with the 'id' attribute in processors.xml (case insensitive, for example tc27x)
2. if none matched, match with the 'name' attribute in processors.xml (case insensitive, for example TC27x)
3. if still none matched, match any of the base CPU names (the 'cpu' attribute in processors.xml, for example tc27x). If multiple processors exist with the same base CPU, a warning will be issued and the first one is selected.
4. if still none matched, the control program issues a fatal error.

The preferred use of the option --cpu, is to specify an ID because that is always a unique name. For example, --cpu=tc27x. The control program will lookup this processor name in the file processors.xml. The control program passes the options to the underlaying tools. For example, -D_CPU_=tx27x
-D_CPU_TC27X_ to the C compiler and assembler, or -dtc27x.lsl -D_CPU_=tc27x
-D_PROC_TC27X_ --core=mpe:mcs00 to the linker.

**Example**

To generate the file test.elf for the TC27x processor, enter:

ccmcs --cpu=tc27x test.c
Related information

Control program option `--cpu-list` (Show list of processors)

Control program option `--lsl-core` (Specify LSL core)

Control program option `--processors` (Read additional processor definitions)
Control program option: --cpu-list

Menu entry
-

Command line syntax

--cpu-list [=pattern]

Description

With this option the control program shows a list of supported processors as defined in the file processors.xml. This can be useful when you want to select a processor name or id for the --cpu option.

The pattern works similar to the UNIX grep utility. You can use it to limit the output list.

Example

To show a list of all processors, enter:

ccmcs --cpu-list

To show all processors of the mcs core, enter:

ccmcs --cpu-list=mcs

--- ~/cmcs/etc/processors.xml ---

id           name                         CPU          core
userdef16x   User defined TriCore 1.6.x   userdef16x   mcs
tc27x         TC27x                        tc27x         mcs

Related information

Control program option --cpu (Select processor)
Control program option: --create (-c)

Menu entry

Command line syntax

--create [=stage]
-c [stage]

You can specify the following stages:

- relocatable I  Stop after the files are linked to a linker object file (.out)
- mil m  Stop after C files are compiled to MIL (.mil)
- object o  Stop after the files are assembled to objects (.o)
- assembly s  Stop after C files are compiled to assembly (.src)

Default (without flags): --create=object

Description

Normally the control program generates an absolute object file of the specified output format from the file you supplied as input. With this option you tell the control program to stop after a certain number of phases.

Example

To generate the object file test.o:

ccmcs --create test.c

The control program stops after the file is assembled. It does not link nor locate the generated output.

Related information

Linker option --link-only (Link only, no locating)
Control program option: --debug-info (-g)

Menu entry

1. Select C Compiler » Debugging.

2. To generate symbolic debug information, select Default, Small set or Full.
   To disable the generation of debug information, select None.

Command line syntax

--debug-info

-g

Description

With this option you tell the control program to include debug information in the generated object file.

The control program passes the option --debug-info=d (-g2) to the C compiler and calls the assembler with --debug-info=+smart,+local (-gsl).

Related information

C compiler option --debug-info (Generate symbolic debug information)

Assembler option --debug-info (Generate symbolic debug information)
Control program option: --define (-D)

Menu entry

1. Select Assembler » Preprocessing.
   *The Defined symbols box right-below shows the symbols that are currently defined.*

2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, *demo=1*).

   Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

```plaintext
--define=macro_name[=macro_definition]
-Dmacro_name[=macro_definition]
```

Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro name (no macro definition), the macro expands as '1'.

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, use the option --define (-D) multiple times. If the command line exceeds the limit of the operating system, you can define the macros in an option file which you then must specify to the assembler with the option --option-file (-f) file.

Defining macros with this option (instead of in the assembly source) is, for example, useful to assembly conditional assembly source as shown in the example below.

The control program passes the option --define (-D) to the assembler.

Make sure you do not use a reserved keyword as a macro name, as this can lead to unexpected results.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

```c
void main( void )
{
  #if DEMO
    demo_func();   /* compile for the demo program */
  #else
    real_func();   /* compile for the real program */
  ```
You can now use a macro definition to set the DEMO flag:

```
ccmcs --define=DEMO test.c
ccmcs --define=DEMO=1 test.c
```

Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition are placed between double quotes because otherwise the spaces would indicate a new option.

```
ccmcs --define="MAX(A,B)=((A) > (B) ? (A) : (B))" test.c
```

**Related information**

- **Control program option** – `--undefine` (Remove preprocessor macro)
- **Control program option** – `--option-file` (Specify an option file)
Control program option: --dep-file

Menu entry
-

Command line syntax

`--dep-file[=file]`

Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In contrast to the option `--preprocess=+make`, the dependency information will be generated in addition to the normal output file.

By default, the information is written to a file with extension `.d` (one for every input file). When you specify a filename, all dependencies will be combined in the specified file.

Example

```
ccmcs --dep-file=test.dep -t test.c
```

The compiler compiles the file `test.c`, which results in the output file `test.src`, and generates dependency lines in the file `test.dep`.

Related information

Control program option `--preprocess=+make` (Generate dependencies for make)
Control program option: --diag

Menu entry

1. From the **Window** menu, select **Show View » Other » TASKING » Problems**.

   *The Problems view is added to the current perspective.*

2. In the Problems view right-click on a message.

   *A popup menu appears.*

3. Select **Detailed Diagnostics Info**.

   *A dialog box appears with additional information.*

Command line syntax

```bash
--diag=[format:]{all | nr,...}
```

You can set the following output formats:

- `html`: HTML output.
- `text`: ASCII text.

Default format: `text`

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: `html`, `rtf` or `text` (default). To create a file with the descriptions, you must redirect the output.

With the suboption `all`, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 103, enter:

```bash
cbcmcs --diag=103
```

This results in message 103 with explanation.

To write an explanation of all errors and warnings in HTML format to file `ccerrors.html`, use redirection and enter:

```bash
cbcmcs --diag=html:all > ccerrors.html
```
Related information
Control program option: --dry-run (-n)

Menu entry
-

Command line syntax
--dry-run
-n

Description
With this option you put the control program in verbose mode. The control program prints the invocations of the tools it would use to process the files without actually performing the steps.

Related information
Control program option --verbose (Verbose output)
Control program option: --endianness

Menu entry

1. Select Global Options.
2. Specify the Endianness: Little-endian mode or Big-endian mode.

Command line syntax

--endianness=endianness

-B
--big-endian

You can specify the following endianness:

<table>
<thead>
<tr>
<th>big</th>
<th>b</th>
<th>Big endian</th>
</tr>
</thead>
<tbody>
<tr>
<td>little</td>
<td>l</td>
<td>Little endian (default)</td>
</tr>
</tbody>
</table>

Description

With this option the control program tells the assembler and linker what the endianness is of the host CPU. By default, the assembler and linker generate code for a little-endian target (least significant byte of a word at lowest byte address). With --endianness=big the assembler and linker generate code for a big-endian target (most significant byte of a word at lowest byte address). -B is an alias for option --endianness=big.

Related information
Control program option: --error-file

Menu entry
-

Command line syntax
--error-file

Description
With this option the control program tells the assembler and linker to redirect error messages to a file.

With this option the control program tells the compiler, assembler and linker to redirect error messages to a file.

The error file will be named after the output file with extension .err (for compiler) or .ers (for assembler). For the linker, the error file is lmcs.elk.

Example
To write errors to error files instead of stderr, enter:

ccmcs --error-file -t test.c

Related information
Control Program option --warnings-as-errors (Treat warnings as errors)
Control program option: --extended-registers

Menu entry

1. Select C Compiler » Code Generation.
2. Enable the option Use extended register set.

Command line syntax

--extended-registers

Description

The extended register set extends the registers of the current MCS channel with the registers of the next MCS channel. These registers are RS0..RS7, DSTAT, GMI0 and GMI1. By default the extended register set is disabled. You can use this option to enable the extended register set.

Related information

-
Control program option: --format

Menu entry

1. Select Linker » Output Format.
2. Enable the option Generate Intel Hex format file and/or Generate S-records file.
3. Optionally, specify the Size of addresses.

_Eclipse always uses the project name as the basename for the output file._

Command line syntax

```
--format=format
```

You can specify the following formats:

<table>
<thead>
<tr>
<th>Format</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ELF</td>
<td>ELF/DWARF</td>
</tr>
<tr>
<td>IHEX</td>
<td>Intel Hex</td>
</tr>
<tr>
<td>SREC</td>
<td>Motorola S-records</td>
</tr>
</tbody>
</table>

Description

With this option you specify the output format for the resulting (absolute) object file. The default output format is ELF/DWARF, which can directly be used by the debugger.

If you choose IHEX or SREC, you can additionally specify the address size of the chosen format (option --address-size).

Example

To generate a Motorola S-record output file:

```
ccmcs --format=SREC test1.c test2.c --output=test.sre
```

Related information

Control program option --address-size (Set address size for linker IHEX/SREC files)
Control program option --output (Output file)
Linker option --chip-output (Generate an output file for each chip)
Control program option: --fp-model

Menu entry
1. Select C Compiler » Floating-Point.
2. Make a selection from the Floating-point model list.
3. If you selected Custom, enable one or more individual options.

Command line syntax

```
--fp-model=flags
```

You can set the following flags:

```
+/-contract   c/C   allow expression contraction
+/-float      f/F   treat 'double' as 'float'
+/-fastlib    l/L   allow less precise library functions
+/-nonan      n/N   allow optimizations to ignore NaN/Inf
+/-rewrite    r/R   allow expression rewriting
+/-trap       t/T   support trapping on exceptions
+/-negzero    z/Z   ignore sign of -0.0
```

Default: --fp-model=cflnrTz

Description

With this option you select the floating-point execution model.

With --fp-model=+contract you allow the compiler to contract multiple float operations into a single operation, with different rounding results. A possible example is fused multiply-add.

With --fp-model=+float you tell the compiler to treat variables and constants of type double as float. Because the float type takes less space, execution speed increases and code size decreases, both at the cost of less precision. The control program automatically selects the correct libraries.

With --fp-model=+fastlib you allow the compiler to select faster but less accurate library functions for certain floating-point operations. With --fp-model=-fastlib more precise library functions are used and the compiler defines the macro __PRECISE_LIB_FP__, which is used in math.h.
With `--fp-model=+nonan` you allow the compiler to ignore NaN or Inf input values. An example is to replace multiply by zero with zero.

With `--fp-model=+rewrite` you allow the compiler to rewrite expressions by reassociating. This might result in rounding differences and possibly different exceptions. An example is to rewrite \((a*c)+(b*c)\) as \((a+b)*c\).

With `--fp-model=+trap` operations trap on floating-point exceptions. By default the control program uses the non-trapping versions of the floating-point library (`libfp.a`). With this option you tell the control program to use the trapping versions of the floating-point library (`libfpt.a`).

If you use the trapping floating-point library, exceptional floating-point cases are intercepted and can be handled separately by an application defined exception handler. Using this library decreases the execution speed of your application.

With `--fp-model=+negzero` you allow the compiler to ignore the sign of -0.0 values. An example is to replace \((a-a)\) by zero.

**Related information**

Pragmas `STDC FP_CONTRACT`, `fp_negzero`, `fp_nonan` and `fp_rewrite` in Section 1.5, *Pragmas to Control the Compiler*. 
Control program option: --global-type-checking

Menu entry
1. Select **C Compiler » Diagnostics**.
2. Enable the option **Perform global type checking on C code**.

Command line syntax

```
--global-type-checking
```

Description

The C compiler already performs type checking within each module. Use this option when you want the linker to perform type checking between modules. The control program passes this option to both the C compiler and the linker.

Related information

-
Control program option: --help (-?)

Menu entry
-

Command line syntax

--help [=item]
-?

You can specify the following argument:

    options       Show extended option descriptions

Description
Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example
The following invocations all display a list of the available command line options:

    ccmcs -?
    ccmcs --help
    ccmcs

To see a detailed description of the available options, enter:

    ccmcs --help=options

Related information
-
Control program option: --include-directory (-I)

Menu entry
1. Select Assembler » Include Paths.
   The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.
3. Type or select a path.

   Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax

--include-directory=path,...
-I path,...

Description

With this option you can specify the path where your include files are located. A relative path will be relative to the current directory.

The control program passes this option to the compiler and the assembler.

Example

Suppose that the C source file test.c contains the following lines:

```
#include <stdio.h>
#include "myinc.h"
```

You can call the control program as follows:

```
cc87 --include-directory=myinclude test.c
```

First the compiler looks for the file stdio.h in the directory myinclude relative to the current directory. If it was not found, the compiler searches in the environment variable and then in the default include directory.

The compiler now looks for the file myinc.h in the directory where test.c is located. If the file is not there the compiler searches in the directory myinclude. If it was still not found, the compiler searches in the environment variable and then in the default include directory.

Related information

C compiler option --include-directory (Add directory to include file search path)
C compiler option --include-file (Include file at the start of a compilation)
Assembler option --include-directory (Add directory to include file search path)

Assembler option --include-file (Include file at the start of the input file)
Control program option: --iso

Menu entry
1. Select C Compiler » Language.
2. From the Comply to C standard list, select ISO C99 or ISO C90.

Command line syntax

--iso=(90 | 99)

Default: --iso=99

Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99 refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

Independent of the chosen ISO standard, the control program always links libraries with C99 support.

Example

To select the ISO C90 standard on the command line:

ccmcs --iso=90 test.c

Related information

C compiler option --iso (ISO C standard)
Control program option: --keep-output-files (-k)

Menu entry

Eclipse always removes generated output files when an error occurs.

Command line syntax

--keep-output-files

-k

Description

If an error occurs during the compilation, assembling or linking process, the resulting output file may be incomplete or incorrect. With this option you keep the generated output files when an error occurs.

By default the control program removes generated output files when an error occurs. This is useful when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt files on a subsequent invocation.

Use this option when you still want to use the generated files. For example when you know that a particular error does not result in a corrupt file, or when you want to inspect the output file, or send it to Altium support.

The control program passes this option to the compiler, assembler and linker.

Example

ccmcs --keep-output-files test.c

When an error occurs during compiling, assembling or linking, the erroneous generated output files will not be removed.

Related information

C compiler option --keep-output-files

Assembler option --keep-output-files

Linker option --keep-output-files
Control program option: --keep-temporary-files (-t)

Menu entry
1. Select Global Options.
2. Enable the option Keep temporary files.

Command line syntax
--keep-temporary-files
-t

Description
By default, the control program removes intermediate files like the .src file (result of the compiler phase) and the .o file (result of the assembler phase).

With this option you tell the control program to keep temporary files it generates during the creation of the absolute object file.

Example
ccmcs --keep-temporary-files test.c

The control program keeps all intermediate files it generates while creating the absolute object file test.elf.

Related information
Control program option: --library (-l)

Menu entry
1. Select **Linker » Libraries**.

   *The Libraries box shows the list of libraries that are linked with the project.*

2. To add a library, click on the **Add** button in the **Libraries** box.

3. Type or select a library (including its path).

4. Optionally, disable the option **Link default libraries**.

   Use the **Edit** and **Delete** button to change a library name or to remove a library from the list.

Command line syntax

```
--library=\textit{name}

-l \textit{name}
```

Description

With this option you tell the linker via the control program to use system library **lib\textit{name}.a**, where \textit{name} is a string. The linker first searches for system libraries in any directories specified with **--library-directory**, then in the directories specified with the environment variables **LIBMCS / LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1**, unless you used the option **--ignore-default-library-path**.

Example

To search in the system library **libc.a** (C library):

```
cmc c test.o mylib.a --library=c
```

The linker links the file **test.o** and first looks in library **mylib.a** (in the current directory only), then in the system library **libc.a** to resolve unresolved symbols.

Related information

Control program option **--no-default-libraries** (Do not link default libraries)

Control program option **--library-directory** (Additional search path for system libraries)

Section 5.3, *Linking with Libraries*
Control program option: --library-directory (-L) / --ignore-default-library-path

Menu entry

1. Select **Linker » Libraries**.
   
   *The Library search path box shows the directories that are added to the search path for library files.*

2. To define a new directory for the search path, click on the **Add** button in the **Library search path** box.

3. Type or select a path.

   Use the **Edit** and **Delete** button to change a path or to remove a path from the list.

Command line syntax

```
--library-directory= path,...
-L path,...
--ignore-default-library-path
-L
```

Description

With this option you can specify the path(s) where your system libraries, specified with the option --library (-l), are located. If you want to specify multiple paths, use the option --library-directory for each separate path.

The default path is $(PRODDIR)\lib\{mcs30|mcs31\}\{be\|le\}.

If you specify only -L (without a pathname) or the long option --ignore-default-library-path, the linker will not search the default path and also not in the paths specified in the environment variables LIBMCS / LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1. So, the linker ignores steps 2 and 3 as listed below.

The priority order in which the linker searches for system libraries specified with the option --library (-l) is:

1. The path that is specified with the option --library-directory.

2. The path that is specified in the environment variables LIBMCS / LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1.

3. The default directory $(PRODDIR)\lib\{mcs30|mcs31\}\{be\|le\}.

Example

Suppose you call the control program as follows:
ccmcs test.c --library-directory=c:\mylibs --library=c

First the linker looks in the directory c:\mylibs for library libc.a (this option). If it does not find the requested libraries, it looks in the directory that is set with the environment variables LIBMCS / LIBMCS2_0 / LIBMCS3_0 / LIBMCS3_1. Then the linker looks in the default directory $(PRODDIR)\lib\{mcs30|mcs31\}\{be|le\} for libraries.

Related information

Control program option --library (Link system library)

Section 5.3.1, How the Linker Searches Libraries
Control program option: --link-only

Menu entry

Command line syntax

--link-only

Description

With this option you suppress the locating phase. The linker stops after linking and informs you about unresolved references.

Related information

Control program option --create=relocatable (-cl) (Stop after linking)

Linker option --link-only (Link only, no locating)
Control program option: --list-files

Menu entry
-

Command line syntax

--list-files [=file]

Default: no list files are generated

Description

With this option you tell the assembler via the control program to generate a list file for each specified input file. A list file shows the generated object code and the relative addresses. Note that the assembler generates a relocatable object file with relative addresses.

With the optional file you can specify a name for the list file. This is only possible if you specify only one input file to the control program. If you do not specify a file name, or you specify more than one input file, the control program names the generated list file(s) after the specified input file(s) with extension .lst.

Note that object files and library files are not counted as input files.

Related information

Assembler option --list-file (Generate list file)

Assembler option --list-format (Format list file)
Control program option: --lsl-core

Menu entry

1. Expand **C/C++ Build** and select **Processor**.
2. From the **Select core** list, select a processor core.

Command line syntax

```
--lsl-core=MCS-core
```

Depending on the used processor, you can specify the following MCS cores:

- `mcs00`  
- `mcs01`  
- `mcs02`  
- `mcs03`  
- `mcs04`  
- `mcs05`  
- `mcs06`  
- `mcs07`

Default: `mcs00`

Description

With this option you can specify the LSL core architecture the code is intended for. For example, the file `tc27x.lsl` in the `include.lsl` directory, contains a description of derivative `tc27x` and the supported MCS cores.

Example

To link objects for the MCS core `mcs01`, enter:

```
ccmcs --cpu=tc27x --lsl-core=mcs01 test.asm
```

This results in the following invocation of the tools:

```
+ asmcs -D__CPU__=tc27x -D__CPU_TC27X__ -o test.o test.asm
+ lcms  -o test.elf -dtc27x.lsl --endianness=little --non-romable
        --user-provided-initialization-code -D__LINKONLY__
        -DCSA=0 --core=mpe:mcs01 --map-file test.o
```

Related information

Linker option **--core** (Specify LSL core)
Control program option: --lsl-file (-d)

Menu entry

An LSL file can be generated when you create your project in Eclipse:

1. From the File menu, select File » New » TASKING MCS C Project.
   
   The New C Project wizard appears.

2. Fill in the project settings in each dialog and click Next > until the MCS Project Settings appear.

3. Enable the option Add linker script file to the project and click Finish.

   Eclipse creates your project and the file project.lsl in the project directory.

The LSL file can be specified in the Properties dialog:

1. Select Linker » Script File.

2. Specify a LSL file in the Linker script file (.lsl) field.

Command line syntax

--lsl-file=file,...

-dfile,...

Description

A linker script file contains vital information about the core for the locating phase of the linker. A linker script file is coded in LSL and contains the following types of information:

- the architecture definition describes the core's hardware architecture.
- the memory definition describes the physical memory available in the system.
- the section layout definition describes how to locate sections in memory.

With this option you specify a linker script file via the control program to the linker. If you do not specify this option, the linker uses a default script file. You can specify the existing file target.lsl or the name of a manually written linker script file. You can use this option multiple times. The linker processes the LSL files in the order in which they appear on the command line.

Related information

Section 5.7, Controlling the Linker with a Script
Control program option: --make-target

Menu entry

Command line syntax

--make-target=name

Description

With this option you can overrule the default target name in the make dependencies generated by the options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input file, with extension .o.

Example

ccmcs --preprocess=+make --make-target=../mytarget.o test.c

The compiler generates dependency lines with the default target name ../mytarget.o instead of test.o.

Related information

Control program option --preprocess=+make (Generate dependencies for make)

Control program option --dep-file (Generate dependencies in a file)
Control program option: \texttt{--meminit}

\textbf{Menu entry}

1. Select \textbf{Global Options}.
2. Select the \textbf{Initialization mode}.

\textbf{Command line syntax}

\texttt{--meminit=mode}

You can specify the following modes:

- \texttt{cpu}: Initialization is done by a CPU
- \texttt{mcs}: Self contained initialization from ROM
- \texttt{none}: The program is loaded directly into RAM

\textbf{Description}

With this option you can specify the initialization mode for the MCS memory. Initialization by CPU is the default.

With \texttt{--meminit=cpu}, initialization of MCS memory is done by the CPU. The following applies:

- If the MCS is reset and the CPU is not reset at the same time, the MCS memory image is, or may be, incorrect.
- The start-up code of the MCS does not initialize the MCS memory.
- The user provided initialization code is the CPU initialization code.
- The control program calls the linker with the options \texttt{--link-only} and \texttt{-D__LINKONLY__}.

With \texttt{--meminit=mcs}, initialization is done by the MCS. This is the case for an MCS with its own ROM. The MCS can be reset and its memory will be re-initialized correctly. The following applies:

- The start-up code of the MCS initializes the MCS memory by copying ROM to RAM and clearing BSS sections.

With \texttt{--meminit=none}, the MCS does not initialize its memory. You can use this option when you want to debug your program with the simulator. The following applies:

- If the MCS is soft reset, the MCS global data is not re-initialized.
- The start-up code of the MCS does not initialize the MCS memory.
- The user provided initialization code is empty.
- The control program calls the linker with the options \texttt{--non-romable}, \texttt{--user-provided-initialization-code} and \texttt{--no-rom-copy}. 
The simulator clears all memory, implicitly clearing all BSS sections.

The simulator initializes RAM data sections, because initialization data is defined in RAM data sections as a consequence of the linker option --no-rom-copy.

Example

To initialize MCS memory from ROM:

```bash
ccmcs --meminit=mcs test.c
```

Related information

Control program option --address-size (Set address size for linker IHEX/SREC files)

Control program option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
Control program option: --no-default-libraries

Menu entry
1. Select **Linker » Libraries**.
2. Disable the option **Link default libraries**.

Command line syntax

```
--no-default-libraries
```

Description

By default the control program specifies the standard C libraries (C99) and run-time library to the linker. With this option you tell the control program not to specify the standard C libraries and run-time library to the linker.

In this case you must specify the libraries you want to link to the linker with the option `--library=library_name` or pass the libraries as files on the command line. The control program recognizes the option `--library` (-l) as an option for the linker and passes it as such.

Example

```
ccmcs --no-default-libraries test.c
```

The control program does not specify any libraries to the linker. In normal cases this would result in unresolved externals.

To specify your own libraries (`libc.a`) and avoid unresolved externals:

```
ccmcs --no-default-libraries --library=c test.c
```

Related information

Control program option **--library** (Link system library)

Section 5.3.1, *How the Linker Searches Libraries*
Control program option: --no-map-file

Menu entry
1. Select Linker » Map File.
2. Disable the option Generate map file.

Command line syntax

--no-map-file

Description
By default the control program tells the linker to generate a linker map file.

A linker map file is a text file that shows how the linker has mapped the sections and symbols from the various object files (.o) to the linked object file. A locate part shows the absolute position of each section. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address.

With this option you prevent the generation of a map file.

Related information

-
Control program option: --no-warnings (-w)

Menu entry
1. Select C Compiler » Diagnostics.
   
   The Suppress C compiler warnings box shows the warnings that are currently suppressed.

2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.

   Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

--no-warnings [=number[-number],...]

-w [number[-number],...]

Description

With this option you can suppresses all warning messages for the various tools or specific control program warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings of all tools are suppressed.

• If you specify this option with a number or a range, only the specified control program warnings are suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress all warnings for all tools, enter:

ccmcs test.c --no-warnings

Related information

Control program option --warnings-as-errors (Treat warnings as errors)
Control program option: --option-file (-f)

Menu entry
-

Command line syntax

--option-file=file,...
-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the control program.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vice versa:

   "This has a single quote ' embedded"

   'This has a double quote " embedded'

   'This has a double quote " and a single quote '" embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

   "This is a continuation \ line"

   -> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.
Example

Suppose the file `myoptions` contains the following lines:

```bash
--debug-info
--define=DEMO=1
test.c
```

Specify the option file to the control program:

```bash
ccmcs --option-file=myoptions
```

This is equivalent to the following command line:

```bash
ccmcs --debug-info --define=DEMO=1 test.c
```

Related information
Control program option: --output (-o)

Menu entry

Eclipse always uses the project name as the basename for the output file.

Command line syntax

```
--output=file
-o file
```

Description

By default, the control program generates a file with the same basename as the first specified input file. With this option you specify another name for the resulting absolute object file.

The default output format is ELF/DWARF, but you can specify another output format with option --format.

Example

```
ccmcs test.c prog.c
```

The control program generates an ELF/DWARF object file (default) with the name test.elf.

To generate the file result.elf:

```
ccmcs --output=result.elf test.c prog.c
```

Related information

Control program option --format (Set linker output format)

Linker option --output (Output file)

Linker option --chip-output (Generate an output file for each chip)
Control program option: --pass (-W)

Menu entry

1. Select C Compiler » Miscellaneous or Assembler » Miscellaneous or Linker » Miscellaneous.
2. Add an option to the Additional options field.

Be aware that the options in the option file are added to the options you have set in the other pages. Only in extraordinary cases you may want to use them in combination. The assembler options are preceded by \texttt{-Wa} and the linker options are preceded by \texttt{-Wl}. For the C options you have to do this manually.

Command line syntax

\begin{itemize}
\item \texttt{--pass-assembler=option} \quad \texttt{-Wa}option \quad \texttt{Pass option directly to the assembler}
\item \texttt{--pass-c=option} \quad \texttt{-Wc}option \quad \texttt{Pass option directly to the C compiler}
\item \texttt{--pass-linker=option} \quad \texttt{-Wl}option \quad \texttt{Pass option directly to the linker}
\end{itemize}

Description

With this option you tell the control program to call a tool with the specified option. The control program does not use or interpret the option itself, but specifies it directly to the tool which it calls.

Example

To pass the option \texttt{--verbose} directly to the linker, enter:

\begin{verbatim}
ccmcs --pass-linker=--verbose test.c
\end{verbatim}

Related information

-
Control program option: --preprocess (-E) / --no-preprocessing-only

Menu entry
1. Select C Compiler » Preprocessing.
2. Enable the option Store preprocessor output in <file>.pre.
3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.

Command line syntax

--preprocess [=flags]
-E [flags]
--no-preprocessing-only

You can set the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-comments</td>
<td>Keep comments</td>
</tr>
<tr>
<td>+/-includes</td>
<td>Generate a list of included source files</td>
</tr>
<tr>
<td>+/-list</td>
<td>Generate a list of macro definitions</td>
</tr>
<tr>
<td>+/-make</td>
<td>Generate dependencies for make</td>
</tr>
<tr>
<td>+/-noline</td>
<td>Strip #line source position information</td>
</tr>
</tbody>
</table>

Default: -ECILMP

Description

With this option you tell the compiler to preprocess the C source. The C compiler sends the preprocessed output to the file name.pre (where name is the name of the C source file to compile). Eclipse also compiles the C source.

On the command line, the control program stops after preprocessing. If you also want to compile the C source you can specify the option --no-preprocessing-only. In this case the control program calls the compiler twice, once with option --preprocess and once for a regular compilation.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor output is discarded.

With --preprocess=+list the compiler will generate a list of all macro definitions. The preprocessor output is discarded.
With **--preprocess=+make** the compiler will generate dependency lines that can be used in a Makefile. The information is written to a file with extension `.d`. The preprocessor output is discarded. The default target name is the basename of the input file, with the extension `.o`. With the option **--make-target** you can specify a target name which overrules the default target name.

With **--preprocess=+noline** you tell the preprocessor to strip the `#line` source position information (lines starting with `#line`). These lines are normally processed by the assembler and not needed in the preprocessed output. When you leave these lines out, the output is easier to read.

**Example**

```bash
ccmcs --preprocess=+comments,-make,-noline --no-preprocessing-only test.c
```

The compiler preprocesses the file `test.c` and sends the output to the file `test.pre`. Comments are included but no dependencies are generated and the line source position information is not stripped from the output file. Next, the control program calls the compiler, assembler and linker to create the final object file `test.elf`.

**Related information**

- **Control program option --dep-file** (Generate dependencies in a file)
- **Control program option --make-target** (Specify target name for `-Em` output)
Control program option: --processors

Menu entry

1. From the Window menu, select Preferences.
   The Preferences dialog appears.
2. Select TASKING » MCS.
3. Click the Add button to add additional processor definition files.

Command line syntax

--processors=file

Description

With this option you can specify an additional XML file with processor definitions.

The standard list of supported processors is defined in the file processors.xml. This file defines for each processor its full name (for example, TC27x), its ID, the base CPU name (for example, tc27x) and the core settings (for example, mcs).

The control program reads the specified file after the file processors.xml in the product's etc directory. Additional XML files can override processor definitions made in XML files that are read before.

Multiple --processors options are allowed.

Eclipse generates a --processors option in the makefiles for each specified XML file.

Example

Specify an additional processor definition file (suppose processors-new.xml contains a new processor MCSNEW):

ccmcs --processors=processors-new.xml --cpu=MCSNEW test.c

Related information

Control program option --cpu (Select processor)
Control program option: --signed-bitfields

Menu entry

1. Select C Compiler » Language.
2. Enable the option Treat 'int' bit-fields as signed.

Command line syntax

--signed-bitfields

Description

For bit-fields it depends on the implementation whether a plain int is treated as signed int or unsigned int. By default an int bit-field is treated as unsigned int. This offers the best performance. With this option you tell the compiler to treat int bit-fields as signed int. In this case, you can still add the keyword unsigned to treat a particular int bit-field as unsigned.

Related information

C compiler option --signed-bitfields

Section 1.1, Data Types
CONTROL PROGRAM OPTION: --STATIC

MENU ENTRY

COMMAND LINE SYNTAX

--STATIC

DESCRIPTION

This option is directly passed to the compiler.

With this option, the compiler treats external definitions at file scope (except for main) as if they were declared static. As a result, unused functions will be eliminated, and the alias checking algorithm assumes that objects with static storage cannot be referenced from functions outside the current module.

This option only makes sense when you specify all modules of an application on the command line.

EXAMPLE

ccmcs --static module1.c module2.c module3.c ...

RELATED INFORMATION

-
Control program option: --undefine (-U)

Menu entry
1. Select C Compiler » Preprocessing
   
   The Defined symbols box shows the symbols that are currently defined.

2. To remove a defined symbol, select the symbol in the Defined symbols box and click on the Delete button.

Command line syntax

```plaintext
--undefine=macro_name
-Umacro_name
```

Description

With this option you can undefine an earlier defined macro as with #undef. This option is for example useful to undefine predefined macros.

The following predefined ISO C standard macros cannot be undefined:

- `__FILE__` current source filename
- `__LINE__` current source line number (int type)
- `__TIME__` hh:mm:ss
- `__DATE__` Mmm dd yyyy
- `__STDC__` level of ANSI standard

The control program passes the option `--undefine (-U)` to the compiler.

Example

To undefine the predefined macro `__TASKING__`:

```plaintext
ccmcs --undefine=__TASKING__ test.c
```

Related information

Control program option `--define` (Define preprocessor macro)

Section 1.6, Predefined Preprocessor Macros
Control program option: --verbose (-v)

Menu entry

1. Select Global Options.
2. Enable the option Verbose mode of control program.

Command line syntax

--verbose

-v

Description

With this option you put the control program in verbose mode. The control program performs its tasks while it prints the steps it performs to stdout.

Related information

Control program option --dry-run (Verbose output and suppress execution)
Control program option: --version (-V)

Menu entry
-

Command line syntax

--version

-v

Description

Display version information. The control program ignores all other options or input files.

Related information
-


Control program option: --warnings-as-errors

Menu entry
1. Select Global Options.
2. Enable the option Treat warnings as errors.

Command line syntax

--warnings-as-errors[=number[-number],...]

Description
If one of the tools encounters an error, it stops processing the file(s). With this option you tell the tools to treat warnings as errors or treat specific control program warning messages as errors:

• If you specify this option but without numbers, all warnings are treated as errors.

• If you specify this option with a number or a range, only the specified control program warnings are treated as an error. You can specify the option --warnings-as-errors=number multiple times.

Use one of the --pass-tool options to pass this option directly to a tool when a specific warning for that tool must be treated as an error. For example, use --pass-c=--warnings-as-errors=number to treat a specific C compiler warning as an error.

Related information

Control program option --no-warnings (Suppress some or all warnings)

Control program option --pass (Pass option to tool)
8.5. Parallel Make Utility Options

When you build a project in Eclipse, Eclipse generates a makefile and uses the make utility `amk` to build all your files. However, you can also use the make utility directly from the command line to build your project.

The invocation syntax is:

```
amk [option...] [target...] [macro=def]
```

This section describes all options for the parallel make utility.

For detailed information about the parallel make utility and using makefiles see Section 6.2, Make Utility `amk`.
Parallel make utility option: --always-rebuild (-a)

Command line syntax

--always-rebuild

-a

Description

Normally the make utility rebuilds only those files that are out of date. With this option you tell the make utility to rebuild all files, without checking whether they are out of date.

Example

amk -a

Rebuilds all your files, regardless of whether they are out of date or not.

Related information

-
Parallel make utility option: --change-dir (-G)

Command line syntax

--change-dir=path

-G path

Description

Normally you must call the make utility from the directory where your makefile and other files are stored.

With the option -G you can call the make utility from within another directory. The path is the path to the directory where your makefile and other files are stored and can be absolute or relative to your current directory.

The macro SUBDIR is defined with the value of path.

Example

Suppose your makefile and other files are stored in the directory ..\myfiles. You can call the make utility, for example, as follows:

amk -G ..\myfiles

Related information

-
Parallel make utility option: --diag

Command line syntax

```
--diag=[format:] {all | nr,...}
```

You can set the following output formats:

- `html` HTML output.
- `text` ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. You can specify the following formats: `html`, `rtf` or `text` (default). To create a file with the descriptions, you must redirect the output.

With the suboption `all`, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas.

Example

To display an explanation of message number 169, enter:

```
amk --diag=169
```

This results in the following message and explanation:

```
F169: target '%s' returned exit code %d
```

An error occurred while executing one of the commands of the target, and -k option is not specified.

To write an explanation of all errors and warnings in HTML format to file `amkerrors.html`, use redirection and enter:

```
amk --diag=html:all > amkerrors.html
```

Related information
Parallel make utility option: --dry-run (-n)

Command line syntax

--dry-run

-n

Description

With this option you tell the make utility to perform a dry run. The make utility shows what it would do but does not actually perform these tasks.

This option is for example useful to quickly inspect what would happen if you call the make utility.

Example

amk -n

The make utility does not perform any tasks but displays what it would do if called without the option -n.

Related information

Parallel make utility option -s (Do not print commands before execution)
Parallel make utility option: --help (-? / -h)

Command line syntax

--help [=item]

-h

-?

You can specify the following arguments:

options Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

`amk -?`
`amk --help`

To see a detailed description of the available options, enter:

`amk --help=options`

Related information

-
Parallel make utility option: --jobs (-j) / --jobs-limit (-J)

Menu
1. From the Project menu, select Properties for
The Properties dialog appears.
2. In the left pane, select C/C++ Build.
In the right pane the C/C++ Build page appears.
3. On the Behaviour tab, select Use parallel build.
4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last case, amk will fork as many jobs in parallel as cores are available.

Command line syntax

--jobs [=number]
-j [number]

--jobs-limit [=number]
-J [number]

Description
When these options you can limit the number of parallel jobs. The default is 1. Zero means no limit. When you omit the number, amk uses the number of cores detected.

Option -J is the same as -j, except that the number of parallel jobs is limited by the number of cores detected.

Example
amk -j3
Limit the number of parallel jobs to 3.

Related information
-
Parallel make utility option: --keep-going (-k)

Command line syntax

--keep-going

-k

Description

When during the make process the make utility encounters an error, it stops rebuilding your files.

With the option -k, the make utility only stops building the target that produced the error. All other targets defined in the makefile are built.

Example

amk -k

If the make utility encounters an error, it stops building the current target but proceeds with the other targets that are defined in the makefile.

Related information

-
Parallel make utility option: --list-targets (-l)

Command line syntax

--list-targets

-l

Description

With this option, the make utility lists all "primary" targets that are out of date.

Example

amk -l
list of targets

Related information

-
Parallel make utility option: --makefile (-f)

Command line syntax

--makefile=my_makefile

-f my_makefile

Description

By default the make utility uses the file makefile to build your files.

With this option you tell the make utility to use the specified file instead of the file makefile. Multiple -f options act as if all the makefiles were concatenated in a left-to-right order.

If you use '-' instead of a makefile name it means that the information is read from stdin.

Example

amk -f mymake

The make utility uses the file mymake to build your files.

Related information

-
Parallel make utility option: --no-warnings (-w)

Command line syntax

--no-warnings [=number, ...]
-w [number, ...]

Description

With this option you can suppresses all warning messages or specific warning messages.

On the command line this option works as follows:

• If you do not specify this option, all warnings are reported.

• If you specify this option but without numbers, all warnings are suppressed.

• If you specify this option with a number, only the specified warning is suppressed. You can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 751 and 756, enter:

amk --no-warnings=751,756

Related information

Parallel make utility option --warnings-as-errors (Treat warnings as errors)
Parallel make utility option: --silent (-s)

Command line syntax

--silent

-s

Description

With this option you tell the make utility to perform its tasks without printing the commands it executes. Error messages are normally printed.

Example

amk -s

The make utility rebuilds your files but does not print the commands it executes during the make process.

Related information

Parallel make utility option -n (Perform a dry run)
Parallel make utility option: --version (-V)

Command line syntax

--version

-v

Description

Display version information. The make utility ignores all other options or input files.

Related information

-
Parallel make utility option: --warnings-as-errors

Command line syntax
--warnings-as-errors[=number,...]

Description
If the make utility encounters an error, it stops. When you use this option without arguments, you tell the make utility to treat all warnings as errors. This means that the exit status of the make utility will be non-zero after one or more warnings. As a consequence, the make utility now also stops after encountering a warning.

You can also limit this option to specific warnings by specifying a comma-separated list of warning numbers.

Related information
Parallel make utility option --no-warnings (Suppress some or all warnings)
8.6. Archiver Options

The archiver and library maintainer **armcs** is a tool to build library files and it offers the possibility to replace, extract and remove modules from an existing library.

The invocation syntax is:

```
armcs key_option [sub_option...] library [object_file]
```

This section describes all options for the archiver. Some suboptions can only be used in combination with certain key options. They are described together. Suboptions that can always be used are described separately.

For detailed information about the archiver, see Section 6.3, Archiver.

**Short and long option names**

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

**Overview of the options of the archiver utility**

The following archiver options are available:

<table>
<thead>
<tr>
<th>Description</th>
<th>Option</th>
<th>Sub-option</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main functions (key options)</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Replace or add an object module</td>
<td>-r</td>
<td>-a -b -c -u -v</td>
</tr>
<tr>
<td>Extract an object module from the library</td>
<td>-x</td>
<td>-o -v</td>
</tr>
<tr>
<td>Delete object module from library</td>
<td>-d</td>
<td>-v</td>
</tr>
<tr>
<td>Move object module to another position</td>
<td>-m</td>
<td>-a -b -v</td>
</tr>
<tr>
<td>Print a table of contents of the library</td>
<td>-t</td>
<td>-s0 -s1</td>
</tr>
<tr>
<td>Print object module to standard output</td>
<td>-p</td>
<td></td>
</tr>
<tr>
<td><strong>Sub-options</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Append or move new modules after existing module name</td>
<td>-a name</td>
<td></td>
</tr>
<tr>
<td>Append or move new modules before existing module name</td>
<td>-b name</td>
<td></td>
</tr>
<tr>
<td>Create library without notification if library does not exist</td>
<td>-c</td>
<td></td>
</tr>
<tr>
<td>Preserve last-modified date from the library</td>
<td>-o</td>
<td></td>
</tr>
<tr>
<td>Print symbols in library modules</td>
<td>-s{0</td>
<td>1}</td>
</tr>
<tr>
<td>Replace only newer modules</td>
<td>-u</td>
<td></td>
</tr>
<tr>
<td>Verbose</td>
<td>-v</td>
<td></td>
</tr>
<tr>
<td><strong>Miscellaneous</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Option</td>
<td>Sub-option</td>
</tr>
<tr>
<td>-------------------------------------------------</td>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Display options</td>
<td>-?</td>
<td></td>
</tr>
<tr>
<td>Display version header</td>
<td>-V</td>
<td></td>
</tr>
<tr>
<td>Read options from file</td>
<td>-f file</td>
<td></td>
</tr>
<tr>
<td>Suppress warnings above level $n$</td>
<td>-wn</td>
<td></td>
</tr>
</tbody>
</table>
Archiver option: --delete (-d)

Command line syntax

```plaintext
--delete [--verbose]
-d [-v]
```

**Description**

Delete the specified object modules from a library. With the suboption `--verbose (-v)` the archiver shows which files are removed.

```plaintext
--verbose -v
```

Verbose: the archiver shows which files are removed.

**Example**

```plaintext
armcs --delete mylib.a obj1.o obj2.o
```

The archiver deletes `obj1.o` and `obj2.o` from the library `mylib.a`.

```plaintext
armcs -d -v mylib.a obj1.o obj2.o
```

The archiver deletes `obj1.o` and `obj2.o` from the library `mylib.a` and displays which files are removed.

**Related information**

-
Archiver option: --dump (-p)

Command line syntax

--dump

-p

Description

Print the specified object module(s) in the library to standard output.

This option is only useful when you redirect or pipe the output to other files or tools that serve your own purposes. Normally you do not need this option.

Example

armcs --dump mylib.a obj1.o > file.o

The archiver prints the file obj1.o to standard output where it is redirected to the file file.o. The effect of this example is very similar to extracting a file from the library but in this case the 'extracted' file gets another name.

Related information
**Archiver option: --extract (-x)**

**Command line syntax**

```
--extract [--modtime] [--verbose]
-x [-o] [-v]
```

**Description**

Extract an existing module from the library.

```
--modtime  -o  Give the extracted object module the same date as the last-modified date that was recorded in the library. Without this suboption it receives the last-modified date of the moment it is extracted.
--verbose  -v  Verbose: the archiver shows which files are extracted.
```

**Example**

To extract the file `obj1.o` from the library `mylib.a`:

```
armcs --extract mylib.a obj1.o
```

If you do not specify an object module, all object modules are extracted:

```
armcs -x mylib.a
```

**Related information**

-
Archiver option: --help (-?)

Command line syntax

--help[=item]

-?

You can specify the following argument:

    options  Show extended option descriptions

Description

Displays an overview of all command line options. When you specify the argument options you can list detailed option descriptions.

Example

The following invocations all display a list of the available command line options:

    armcs -?
    armcs --help
    armcs

To see a detailed description of the available options, enter:

    armcs --help=options

Related information

-
Archiver option: --move (-m)

Command line syntax

--move [-a posname] [-b posname]

-m [-a posname] [-b posname]

Description

Move the specified object modules to another position in the library.

The ordering of members in a library can make a difference in how programs are linked if a symbol is defined in more than one member.

By default, the specified members are moved to the end of the archive. Use the suboptions -a or -b to move them to a specified place instead.

---after=posname  -a posname Move the specified object module(s) after the existing module posname.

---before=posname  -b posname Move the specified object module(s) before the existing module posname.

Example

Suppose the library mylib.a contains the following objects (see option --print):

obj1.o
obj2.o
obj3.o

To move obj1.o to the end of mylib.a:

armcs --move mylib.a obj1.o

To move obj3.o just before obj2.o:

armcs -m -b obj3.o mylib.a obj2.o

The library mylib.a after these two invocations now looks like:

obj3.o
obj2.o
obj1.o

Related information

Archiver option --print (-t) (Print library contents)
Archiver option: --option-file (-f)

Command line syntax

--option-file=\textit{file} \\
-f \textit{file}

Description

Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the archiver.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option --option-file (-f) multiple times.

If you use `-' instead of a filename it means that the options are read from stdin.

Format of an option file

• Multiple arguments on one line in the option file are allowed.

• To include whitespace in an argument, surround the argument with single or double quotes.

• If you want to use single quotes as part of the argument, surround the argument by double quotes and vice versa:

"This has a single quote ` embedded"

'This has a double quote " embedded'

'This has a double quote " and a single quote `" embedded"

• When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

"This is a continuation \ line"

-> "This is a continuation line"

• It is possible to nest command line files up to 25 levels.

Example

Suppose the file \textit{myoptions} contains the following lines:

-x mylib.a obj1.o \\
-w5
Specify the option file to the archiver:

```
armcs --option-file=myoptions
```

This is equivalent to the following command line:

```
armcs -x mylib.a obj1.o -w5
```

**Related information**

-
**Archiver option: --print (-t)**

**Command line syntax**

```bash
--print [--symbols=0|1]
-t [-s0|-s1]
```

**Description**

Print a table of contents of the library to standard output. With the suboption `-s0` the archiver displays all symbols per object file.

- `--symbols=0 -s0` Displays per object the name of the object itself and all symbols in the object.
- `--symbols=1 -s1` Displays the symbols of all object files in the library in the form `library_name:object_name:|symbol_name`

**Example**

```bash
armcs --print mylib.a
```

The archiver prints a list of all object modules in the library `mylib.a`:

```bash
armcs -t -s0 mylib.a
```

The archiver prints per object all symbols in the library.

**Related information**
Archiver option: --replace (-r)

Command line syntax

```bash
--replace [--after=posname] [--before=posname] [--create] [--newer-only] [--verbose]  
-r [-a posname] [-b posname] [-c] [-u] [-v]
```

Description

You can use the option `--replace (-r)` for several purposes:

- Adding new objects to the library
- Replacing objects in the library with the same object of a newer date
- Creating a new library

The option `--replace (-r)` normally adds a new module to the library. However, if the library already contains a module with the specified name, the existing module is replaced. If you specify a library that does not exist, the archiver creates a new library with the specified name.

If you add a module to the library without specifying the suboption `-a` or `-b`, the specified module is added at the end of the archive. Use the suboptions `-a` or `-b` to insert them after/before a specified place instead.

- `--after=posname` `-a` `posname`
  Insert the specified object module(s) after the existing module `posname`.
- `--before=posname` `-b` `posname`
  Insert the specified object module(s) before the existing module `posname`.
- `--create` `-c`
  Create a new library without checking whether it already exists. If the library already exists, it is overwritten.
- `--newer-only` `-u`
  Insert the specified object module only if it is newer than the module in the library.
- `--verbose` `-v`
  Verbose: the archiver shows which files are replaced.

The suboptions `-a` or `-b` have no effect when an object is added to the library.

Example

Suppose the library `mylib.a` contains the following object (see option `--print`):

```
obj1.o
```

To add `obj2.o` to the end of `mylib.a`:

```
armcs --replace mylib.a obj2.o
```

To insert `obj3.o` just before `obj2.o`:

```
armcs -r -b obj2.o mylib.a obj3.o
```
The library `mylib.a` after these two invocations now looks like:

```
obj1.o
obj3.o
obj2.o
```

**Creating a new library**

To *create a new library file*, add an object file and specify a library that does not yet exist:

```
armcs --replace obj1.o newlib.a
```

The archiver creates the library `newlib.a` and adds the object `obj1.o` to it.

To *create a new library file and overwrite an existing library*, add an object file and specify an existing library with the supoption `-c`:

```
armcs -r -c obj1.o mylib.a
```

The archiver overwrites the library `mylib.a` and adds the object `obj1.o` to it. The new library `mylib.a` only contains `obj1.o`.

**Related information**

*Archiver option --print (-t) (Print library contents)*
Archiver option: --version (-V)

Command line syntax

--version

-v

Description

Display version information. The archiver ignores all other options or input files.

Related information

-
Archiver option: --warning (-w)

Command line syntax

--warning=level

-w level

Description

With this suboption you tell the archiver to suppress all warnings above the specified level. The level is a number between 0 - 9.

The level of a message is printed between parentheses after the warning number. If you do not use the -w option, the default warning level is 8.

Example

To suppress warnings above level 5:

armcs --extract --warning=5 mylib.a obj1.o

Related information

-
8.7. HLL Object Dumper Options

The high level language (HLL) dumper hldumpmcs is a program to dump information about an absolute object file (.elf).

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-) character, long option names always begin with two minus (--) characters. You can abbreviate long option names as long as it forms a unique name. You can mix short and long option names on the command line.

Options can have flags or suboptions. To switch a flag 'on', use a lowercase letter or a +longflag. To switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following two invocations are equivalent:

hldumpmcs -Fdhsy test.elf
hldumpmcs --dump-format=+dump,+hllsymbols,-modules,+sections,+symbols test.elf

When you do not specify an option, a default value may become active.
HLL object dumper option: --call-graph-elf-mode

Command line syntax

--call-graph-elf-mode

Description

With this option you can force the call graph to use the ELF symbols instead of the DWARF debug info, for example when dumping from an assembly function.

Related information

Section 6.4.2, HLL Dump Output Format
HLL object dumper option: --call-graph-root

Command line syntax

--call-graph-root=function

Description

With this option you can specify the address or function name where to start the call graph. By default, the call graph starts with main().

Example

To start the call graph from printf() instead of main(), enter:

hldumpmcs --call-graph-root=printf -F3 hello.elf

The call graph looks something like this:

```
+-- 0x0000099c printf
    |       +-- 0x00000968 fputc
    |       |   +-- 0x0000042c _dbg_trap
    |       |   +-- 0x00000878 _host_write
    |   |       +-- 0x0000042c _dbg_trap
    |   |       +-- 0x0000083c _host_lseek
    |   |       |       +-- 0x0000042c _dbg_trap
    |   |       +-- 0x00000968 fputc
    |       |   +-- 0x00000698 _flsbuf
    |       |   |       +-- 0x00000878 _host_write *
    |       |   |       +-- 0x0000042c _dbg_trap
    |       |   +-- 0x00000898 _io_putchar
    |       |       +-- 0x00000478 _doprint
    |       |       +-- 0x00000898 _io_putchar *
```

Related information

Section 6.4.2, HLL Dump Output Format
HLL object dumper option: --class (-c)

Command line syntax

```
--class [=class]
-c [class]
```

You can specify one of the following classes:

- `all` a  Dump contents of all sections.
- `code` c  Dump contents of code sections.
- `data` d  Dump contents of data sections.

Default: `--class=all`

Description

With this option you can restrict the output to code or data only. This option affects all parts of the output, except the module list. The effect is listed in the following table.

<table>
<thead>
<tr>
<th>Output part</th>
<th>Effect of --class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module list</td>
<td>Not restricted</td>
</tr>
<tr>
<td>Section list</td>
<td>Only lists sections of the specified class</td>
</tr>
<tr>
<td>Section dump</td>
<td>Only dumps the contents of the sections of the specified class</td>
</tr>
<tr>
<td>HLL symbol table</td>
<td>Only lists symbols of the specified class</td>
</tr>
<tr>
<td>Assembly level symbol table</td>
<td>Only lists symbols defined in sections of the specified class</td>
</tr>
<tr>
<td>Note sections</td>
<td>Not restricted</td>
</tr>
</tbody>
</table>

By default all sections are included.

Related information

Section 6.4.2, HLL Dump Output Format
HLL object dumper option: --class (-c)

Command line syntax

```
--class [=class]
-c [class]
```

You can specify one of the following classes:

<table>
<thead>
<tr>
<th>Class</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>all</td>
<td>Dump contents of all sections.</td>
</tr>
<tr>
<td>code</td>
<td>Dump contents of code sections.</td>
</tr>
<tr>
<td>data</td>
<td>Dump contents of data sections.</td>
</tr>
</tbody>
</table>

Default: **--class=all**

Description

With this option you can restrict the output to code or data only. This option affects all parts of the output, except the module list. The effect is listed in the following table.

<table>
<thead>
<tr>
<th>Output part</th>
<th>Effect of --class</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module list</td>
<td>Not restricted</td>
</tr>
<tr>
<td>Section list</td>
<td>Only lists sections of the specified class</td>
</tr>
<tr>
<td>Section dump</td>
<td>Only dumps the contents of the sections of the specified class</td>
</tr>
<tr>
<td>HLL symbol table</td>
<td>Only lists symbols of the specified class</td>
</tr>
<tr>
<td>Assembly level symbol table</td>
<td>Only lists symbols defined in sections of the specified class</td>
</tr>
<tr>
<td>Note sections</td>
<td>Not restricted</td>
</tr>
</tbody>
</table>

By default all sections are included.

Related information

Section 6.4.2, *HLL Dump Output Format*
HLL object dumper option: --copy-table

Command line syntax

--copy-table

Description

With this option the HLL object dumper attempts to translate the specified code address to the destination address of a copy table copy command during disassembly.

Related information

-
**HLL object dumper option: --diag**

**Command line syntax**

```
--diag=[format:]{all | msg[-msg],...}
```

You can set the following output formats:

- **html**: HTML output.
- **rtf**: Rich Text Format.
- **text**: ASCII text.

Default format: text

**Description**

With this option you can ask for an extended description of error messages in the format you choose. The output is directed to stdout (normally your screen) and in the format you specify. The HLL object dumper does not process any files. You can specify the following formats: **html**, **rtf** or **text** (default). To create a file with the descriptions, you must redirect the output.

With the suboption **all**, the descriptions of all error messages are given. If you want the description of one or more selected error messages, you can specify the error message numbers, separated by commas, or you can specify a range.

**Example**

To display an explanation of message number 101, enter:

```
hldumpmcs --diag=101
```

This results in the following message and explanation:

```
F101: cannot create "<file>"
```

The output file or a temporary file could not be created. Check if you have sufficient disk space and if you have write permissions for the specified file.

To write an explanation of all errors and warnings in HTML format to file **hldumperrors.html**, use redirection and enter:

```
hldumpmcs --diag=html:all > hldumperrors.html
```

**Related information**

-
HLL object dumper option: --disassembly-intermix (-i)

Command line syntax

```
--disassembly-intermix[=flag]
-i[flag]
```

You can specify the following format flags:

```
+/single-line       s/S   Force the insert to be limited to the first preceding source line.
```

Default: `--disassembly-intermix=S`

Description

With this option the disassembly is intermixed with HLL source code. The source is searched for as described with option `--source-lookup-path`

The `+single-line` sub-option forces the insert to be limited to the first preceding source line. With the `-single-line` sub-option all source lines that belong to the address are prefixed. For example comments are thus also visible. This is the default.

Example

```
hldumpmcs --disassembly-intermix --source-lookup-path=c:\mylib\src hello.elf
```

Related information

HLL object dumper option `--source-lookup-path`
**HLL object dumper option: --disassembly-without-encoding (-r)**

**Command line syntax**

```
--disassembly-without-encoding
-r
```

**Description**

With this option the address and encoding are not part of the disassembly of a code section. This is useful when you only want the disassembly part.

**Example**

```
hldumpmcs -F2 hello.elf
```

```
------------- Section dump -------------

.sdecl '.mcstext.hello.main', CODE AT 0x3f4
.sect  '.mcstext.hello.main'
000003f4 04 00 00 30  main:  subl    r0,0x00000004
000003f8 00 03 01 a5         mrd     r5,0x000000300
000003fc 00 00 04 a5         mwri    r5,r0,0
00000400 d0 02 00 12         movl    r2,0x0000002d0
00000404 9c 09 03 e0         call    printf
00000408 04 00 00 20         addl    r0,0x00000004
0000040c 00 00 04 e0         ret
```

```
hldumpmcs -F2 --disassembly-without-encoding hello.elf
```

```
------------- Section dump -------------

.sdecl '.mcstext.hello.main', CODE AT 0x3f4
.sect  '.mcstext.hello.main'
main:  subl    r0,0x00000004
mrd     r5,0x000000300
mwri    r5,r0,0
movl    r2,0x0000002d0
call    printf
addl    r0,0x00000004
ret
```

**Related information**

-
HLL object dumper option: --dump-format (-F)

Command line syntax

--dump-format [=flag, ...]

-F[flag]...

You can specify the following format flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>+/-callgraph</td>
<td>Dump the call graph of the application.</td>
</tr>
<tr>
<td>+/-dump</td>
<td>Dump the contents of the sections in the object file. Code sections can be disassembled, data sections are dumped.</td>
</tr>
<tr>
<td>+/-hllsymbols</td>
<td>List the high level language symbols, with address, size and type.</td>
</tr>
<tr>
<td>+/-modules</td>
<td>Print a list of modules found in object file.</td>
</tr>
<tr>
<td>+/-note</td>
<td>Dump all ELF .note sections.</td>
</tr>
<tr>
<td>+/-sections</td>
<td>Print a list of sections with start address, length and type.</td>
</tr>
<tr>
<td>+/-symbols</td>
<td>List the low level symbols, with address and length (if known).</td>
</tr>
<tr>
<td>0</td>
<td>Alias for CDHMNSY (nothing)</td>
</tr>
<tr>
<td>1</td>
<td>Alias for CDhMNSY (only HLL symbols)</td>
</tr>
<tr>
<td>2</td>
<td>Alias for CdHMNSY (only section contents)</td>
</tr>
<tr>
<td>3</td>
<td>Alias for cdhmnsy (default, everything)</td>
</tr>
</tbody>
</table>

Default: --dump-format=cdhmnsy

Description

With this option you can control which parts of the dump output you want to see. By default, all parts are dumped, except for the call graph.

1. Module list
2. Section list
3. Call graph using the DWARF debug info
4. Section dump (disassembly)
5. HLL symbol table
6. Assembly level symbol table
7. Note sections

You can limit the number of sections that will be dumped with the options --sections and --section-types.
Related information

Section 6.4.2, *HLL Dump Output Format*
HLL object dumper option: --expand-symbols (-e)

Command line syntax

--expand-symbols [=flag],...

-e [flag]...

You can specify one of the following flags:

+/-basic-types  b/B  Expand arrays with basic C types.
+/-fullpath     f/F  Include the full path to the field level.
+/-gap-info     g/G  Insert gap markers where data is not consecutive.
+/-nesting-indicator  n/N  Print nesting bars.

Default (no flags): --expand-symbols=BFGN

Description

With this option you specify that all struct, union and array symbols are expanded with their fields in the HLL symbol dump.

With --expand-symbols=+basic-types, HLL struct and union symbols are listed including all fields. Array members are expanded in one array member per line regardless of the HLL type. For the fields the types and names are indented with 2 spaces.

With --expand-symbols=+fullpath, all fields of structs and unions and all members of non-basic type arrays are expanded and prefixed with their parent's names.

With --expand-symbols=+gap-info, unused memory in complex data types (structures and unions) between data objects and between code objects is shown as {gap} parts. This option is useful to optimize data memory usage. This option only works if debug information is available in the ELF file.

With --expand-symbols=+nesting-indicator, vertical bars (|) are shown to make it easier to see the expanded structs, unions and arrays.

Example

hldumpmcs -F1 hello.elf

---------- HLL symbol table ----------

Address  Size  HLL Type       Name
000000020  24  struct       _dbg_request [dbg.c]
000000038 320 static char  stdin_buf[80] [_iob.c]

hldumpmcs -e -F1 hello.elf

---------- HLL symbol table ----------
Address    Size HLL Type             Name
00000020     24 struct               _dbg_request [dbg.c]
00000020      4   int                  _errno
00000024      4   enum                 nr
00000028     16   union                u
00000028      4     struct               exit
00000028      4       int                  status
00000028      8     struct               open
00000028      4       const char         * pathname
0000002c      4       unsigned int         flags
...
00000038    320 static char          stdin_buf[80] [__iob.c]

hldumpmcs -eb -F1 hello.elf

---------- HLL symbol table ----------
Address    Size HLL Type             Name
00000020     24 struct               _dbg_request [dbg.c]
00000020      4   int                  _dbg_request._errno
00000024      4   enum                 _dbg_request.nr
00000028     16   union                _dbg_request.u
00000028      4     struct               _dbg_request.u.exit
00000028      4       int                  _dbg_request.u.exit.status
00000028      8     struct               _dbg_request.u.open
00000028      4       const char         * _dbg_request.u.open.pathname
0000002c      4       unsigned int         _dbg_request.u.open.flags
...
00000038    320 static char          stdin_buf[80] [__iob.c]

hldumpmcs -ef -F1 hello.elf

---------- HLL symbol table ----------
Address    Size HLL Type             Name
00000020     24 struct               __dbg_request [dbg.c]
00000020      4   int                  __dbg_request.__errno
00000024      4   enum                 __dbg_request.nr
00000028     16   union                __dbg_request.u
00000028      4     struct               __dbg_request.u.exit
00000028      4       int                  __dbg_request.u.exit.status
00000028      8     struct               __dbg_request.u.open
00000028      4       const char         * __dbg_request.u.open.pathname
0000002c      4       unsigned int         __dbg_request.u.open.flags
...
00000038    320 static char          stdin_buf[80] [__iob.c]

Tool Options

Page 445
hldumpmcs -eg -F1 hello.elf

---------- HLL symbol table ----------

<table>
<thead>
<tr>
<th>Address</th>
<th>Size</th>
<th>HLL Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000020</td>
<td>24</td>
<td>struct</td>
<td>_dbg_request</td>
</tr>
<tr>
<td>00000020</td>
<td>4</td>
<td>int</td>
<td>_errno</td>
</tr>
<tr>
<td>00000024</td>
<td>4</td>
<td>enum</td>
<td>nr</td>
</tr>
<tr>
<td>00000028</td>
<td>16</td>
<td>union</td>
<td>u</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>struct</td>
<td>exit</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>int</td>
<td>status</td>
</tr>
<tr>
<td>0000002c</td>
<td>12</td>
<td></td>
<td>{gap}</td>
</tr>
<tr>
<td>00000028</td>
<td>8</td>
<td>struct</td>
<td>open</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>const char</td>
<td>* pathname</td>
</tr>
<tr>
<td>0000002c</td>
<td>4</td>
<td>unsigned int</td>
<td>flags</td>
</tr>
<tr>
<td>00000030</td>
<td>8</td>
<td></td>
<td>{gap}</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000038</td>
<td>320</td>
<td>static char</td>
<td>stdin_buf[80]</td>
</tr>
</tbody>
</table>

hldumpmcs -en -F1 hello.elf

---------- HLL symbol table ----------

<table>
<thead>
<tr>
<th>Address</th>
<th>Size</th>
<th>HLL Type</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>00000020</td>
<td>24</td>
<td>struct</td>
<td>_dbg_request</td>
</tr>
<tr>
<td>00000020</td>
<td>4</td>
<td>int</td>
<td>_errno</td>
</tr>
<tr>
<td>00000024</td>
<td>4</td>
<td>enum</td>
<td>nr</td>
</tr>
<tr>
<td>00000028</td>
<td>16</td>
<td>union</td>
<td>u</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>struct</td>
<td>exit</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>int</td>
<td>status</td>
</tr>
<tr>
<td>0000002c</td>
<td>12</td>
<td></td>
<td>{gap}</td>
</tr>
<tr>
<td>00000028</td>
<td>8</td>
<td>struct</td>
<td>open</td>
</tr>
<tr>
<td>00000028</td>
<td>4</td>
<td>const char</td>
<td>* pathname</td>
</tr>
<tr>
<td>0000002c</td>
<td>4</td>
<td>unsigned int</td>
<td>flags</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>{gap}</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>00000038</td>
<td>320</td>
<td>static char</td>
<td>stdin_buf[80]</td>
</tr>
</tbody>
</table>

Related information

Section 6.4.2, HLL Dump Output Format
**HLL object dumper option: --help (-?)**

**Command line syntax**

--help

-?

**Description**

Displays an overview of all command line options.

**Example**

The following invocations all display a list of the available command line options:

hldumpmcs -?

hldumpmcs --help

hldumpmcs

**Related information**

-
HLL object dumper option: --hex (-x)

**Command line syntax**

```
--hex
-x
```

**Description**

With this option you can control the way data sections and code sections are dumped. By default, the contents of data sections are represented by directives. A new directive will be generated for each symbol. ELF labels in the section are used to determine the start of a directive. ROM sections are represented with `.word` directives, depending on the size of the data. RAM sections are represented with `.space` directives, with a size operand depending on the data size. This can be either the size specified in the ELF symbol, or the size up to the next label. Code sections are dumped as disassembly.

With option **--hex**, no directives will be generated for ROM data sections and no disassembly dump will be done for code sections. Instead ROM data sections and code sections are dumped as hexadecimal code with ASCII translation. RAM sections will be represented with only a start address and a size indicator.

**Example**

```
hldumpmcs -F2 --section=.mcsdata.hello.\$2\$str hello.elf

---------- Section dump ----------
.sdecl '.mcsdata.hello.\$2\$str', DATA AT 0x2d0
.sect '.mcsdata.hello.\$2\$str'
.word 00000048,00000065,0000006c,0000006c; H...e...l...l...
.word 0000006f,0000002c,00000020,00000025; o...,... ...%...
.word 00000073,00000021,0000000a,00000000; s...!.........

hldumpmcs -F2 --section=.mcsdata.hello.\$2\$str --hex hello.elf

---------- Section dump ----------

    section 7 (.mcsdata.hello.\$2\$str):
0000002d0 48 00 00 00 65 00 00 00 6c 00 00 00 6c 00 00 00 H...e...l...l...
0000002e0 6f 00 00 00 2c 00 00 00 20 00 00 00 25 00 00 00 o...,... ...%...
0000002f0 73 00 00 00 21 00 00 00 0a 00 00 00 00 00 00 s...!.........
```

**Related information**

Section 6.4.2, *HLL Dump Output Format*
HLL object dumper option: --option-file (-f)

Command line syntax

```bash
--option-file=file,...
-f file,...
```

Description

This option is primarily intended for command line use. Instead of typing all options on the command line, you can create an option file which contains all options and flags you want to specify. With this option you specify the option file to the HLL object dumper.

Use an option file when the command line would exceed the limits of the operating system, or just to store options and save typing.

You can specify the option `--option-file` multiple times.

Format of an option file

- Multiple arguments on one line in the option file are allowed.
- To include whitespace in an argument, surround the argument with single or double quotes.
- If you want to use single quotes as part of the argument, surround the argument by double quotes and vice versa:

  ```bash
  "This has a single quote ' embedded"
  'This has a double quote " embedded'
  'This has a double quote " and a single quote '" embedded"
  
  When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is preserved.

  "This is a continuation \ line"

  -> "This is a continuation line"
  
  It is possible to nest command line files up to 25 levels.

Example

Suppose the file `myoptions` contains the following lines:

```bash
--symbols=hll
--class=code
hello.elf
```
Specify the option file to the HLL object dumper:

hldumpmcs --option-file=myoptions

This is equivalent to the following command line:

hldumpmcs --symbols=hll --class=code hello.elf

Related information
-
HLL object dumper option: --output (-o)

Command line syntax

--output=file
-o file

Description

By default, the HLL object dumper dumps the output on stdout. With this option you specify to dump the information in the specified file.

The default output format is text, but you can specify another output format with option --output-type.

Example

hldumpmcs --output=dump.txt hello.elf

The HLL object dumper dumps the output in file dump.txt.

Related information

HLL object dumper option --output-type
HLL object dumper option: --output-type (-T)

Command line syntax

`--output-type[=type]`

`-T[type]`

You can specify one of the following types:

- **text**  **t**  Output human readable text.
- **xml**  **x**  Output XML.

Default: `--output-type=text`

Description

With this option you can specify whether the output is formatted as plain text or as XML.

Related information

HLL object dumper option `--output`
**HLL object dumper option: --sections (-s)**

**Command line syntax**

```
--sections=name,...
-s name,...
```

**Description**

With this option you can restrict the output to the specified sections only. This option affects the following parts of the output:

<table>
<thead>
<tr>
<th>Output part</th>
<th>Effect of --sections</th>
</tr>
</thead>
<tbody>
<tr>
<td>Module list</td>
<td>Not restricted</td>
</tr>
<tr>
<td>Section list</td>
<td>Only lists the specified sections</td>
</tr>
<tr>
<td>Section dump</td>
<td>Only dumps the contents of the specified sections</td>
</tr>
<tr>
<td>HLL symbol table</td>
<td>Not restricted</td>
</tr>
<tr>
<td>Assembly level symbol table</td>
<td>Only lists symbols defined in the specified sections</td>
</tr>
<tr>
<td>Note sections</td>
<td>Not restricted</td>
</tr>
</tbody>
</table>

By default all sections are included.

**Related information**

Section 6.4.2, *HLL Dump Output Format*
HLL object dumper option: --source-lookup-path (-L)

Command line syntax

```
--source-lookup-path=path
-L path
```

Description

With this option you can specify an additional path where your source files are located. If you want to specify multiple paths, use the option `--source-lookup-path` for each separate path.

The order in which the HLL object dumper will search for source files when intermixed disassembly is used, is:

1. The path obtained from the HLL debug information.
2. The path that is specified with the option `--source-lookup-path`. If multiple paths are specified, the paths will be searched for in the order in which they are given on the command line.

Example

Suppose you call the HLL object dumper as follows:

```
hldumpmcs --disassembly-intermix --source-lookup-path=c:\mylib\src hello.elf
```

First the HLL object dumper looks in the directory found in the HLL debug information of file `hello.elf` for the location of the source file(s). If it does not find the file(s), it looks in the directory `c:\mylib\src`.

Related information

HLL object dumper option `--disassembly-intermix`
HLL object dumper option: --symbols (-S)

Command line syntax

`--symbols [=type]`

`-S [type]`

You can specify one of the following types:

- `asm` (a) Display assembly symbols in code dump.
- `hll` (h) Display HLL symbols in code dump.
- `none` (n) Display plain addresses in code dump.

Default: `--symbols=asm`

Description

With this option you can control symbolic information in the disassembly and data dump. For data sections this only applies to symbols used as labels at the data addresses. Data within the data sections will never be replaced with symbols.

Only symbols that are available in the ELF or DWARF information are used. If you build an application without HLL debug information the `--symbols=hll` option will result in the same output as with `--symbols=none`. The same applies to the `--symbols=asm` option when all symbols are stripped from the ELF file.

Example

```plaintext
hldumpmcs -F2 hello.elf

---------- Section dump ----------

.sdecl '.mcstext.libc.__START', CODE AT 0x414
.sect '.mcstext.libc.__START'
00000414 28 0a 00 10 __START:  movl  r0,0x000000a28
00000418 24 0a 00 17       movl  r7,0x000000a24
0000041c 00 00 00 12       movl  r2,0x00000000
00000420 00 00 00 13       movl  r3,0x00000000
00000424 f4 03 03 e0       call  .L12
00000428 d8 08 00 e0       jmp   exit

hldumpmcs --symbols=none -F2 hello.elf

---------- Section dump ----------

.sdecl '.mcstext.libc.__START', CODE AT 0x414
.sect '.mcstext.libc.__START'
00000414 28 0a 00 10       movl  r0,0x000000a28
00000418 24 0a 00 17       movl  r7,0x000000a24
0000041c 00 00 00 12       movl  r2,0x00000000
```

---

Tool Options
Related information

Section 6.4.2, HLL Dump Output Format
HLL object dumper option: --version (-V)

Command line syntax

--version

-v

Description

Display version information. The HLL object dumper ignores all other options or input files.

Related information

-
HLL object dumper option: --xml-base-filename (-X)

Command line syntax
--xml-base-filename
-X

Description
With this option the <File name> field in the XML output only contains the filename of the object file. By default, any path name, if present, is printed as well.

Example
hldumpmcs --output-type=xml --output=hello.xml ../hello.elf
The field <File name="../hello.elf"> is used in hello.xml.

hldumpmcs --output-type=xml --output=hello.xml -X ../hello.elf
The field <File name="hello.elf"> is used in hello.xml. The path is stripped from the filename.

Related information
HLL object dumper option --output-type
Chapter 9. Influencing the Build Time

In general many settings have influence on the build time of a project. Any change in the tool settings of your project source will have more or less impact on the build time. The following sections describe several issues that can have significant influence on the build time.

9.1. Optimization Options

In general any optimization may require more work to be done by the compiler. But this does not mean that disabling all optimizations (level 0) gives the fastest compilation time. Disabling optimizations may result in more code being generated, resulting in more work for other parts of the compiler, like for example the register allocator.

9.2. Automatic Inlining

Automatic inlining is an optimization which can result in significant longer build time. The overall functions will get bigger, often making it possible to do more optimizations. But also often resulting in more registers to be in use in a function, giving the register allocation a tougher job.

9.3. Header Files

Many applications include all header files in each module, often by including them all within a single include file. Processing header files takes time. It is a good programming practice to only include the header files that are really required in a module, because:

• it is clear what interfaces are used by a module
• an incremental build after modifying a header file results in less modules required to be rebuild
• it reduces compile time

9.4. Parallel Build

The make utility amk, which is used by Eclipse, has a feature to build jobs in parallel. This means that multiple modules can be compiled in parallel. With today's multi-core processors this means that each core can be fully utilized. In practice even on single core machines the compile time decreases when using parallel jobs. On multi-core machines the build time even improves further when specifying more parallel jobs than the number of cores.

In Eclipse you can control the parallel build behavior:

1. From the Project menu, select Properties for

   The Properties dialog appears.
2. In the left pane, select **C/C++ Build**.

   *In the right pane the C/C++ Build page appears.*

3. On the Behaviour tab, select **Use parallel build**.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last case, **amk** will fork as many jobs in parallel as cores are available.
Chapter 10. Libraries

This chapter contains an overview of all library functions that you can call in your C source. This includes all functions of the standard C library (ISO C99) and some functions of the floating-point library.

Section 10.1, Library Functions, gives an overview of all library functions you can use, grouped per header file. A number of functions declared in wchar.h are parallel to functions in other header files. These are discussed together.

Section 10.2, C Library Reentrancy, gives an overview of which functions are reentrant and which are not.

C library / floating-point library / run-time library

The following libraries are included in the MCS toolset. Both Eclipse and the control program ccmc automatically select the appropriate libraries depending on the specified options.

<table>
<thead>
<tr>
<th>Libraries</th>
<th>Description</th>
</tr>
</thead>
</table>
| libc[s].a | C libraries
Optional letter:
s = single precision floating-point (control program option --fp-model=+float) |
| libfp.a   | Floating-point libraries (contains floating-point functions needed by the C compiler) |
| librt.a   | Run-time library (contains other run-time functions needed by the C compiler) |

Sources for the libraries are present in the directories lib\src, lib\src.* in the form of an executable. If you run the executable it will extract the sources in the corresponding directory.

10.1. Library Functions

The tables in the sections below list all library functions, grouped per header file in which they are declared. Some functions are not completely implemented because their implementation depends on the context where your application will run. These functions are for example all I/O related functions. Where possible, these functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment which enables you to debug your application.

Wide character support

A number of wide character functions are available as C source code, but have not been compiled with the C library. To use complete wide character functionality, you must recompile the libraries with the macro WCHAR_SUPPORT_ENABLED and keep this macro also defined when compiling your own sources. See C compiler option --define (-D). The easiest way is to adapt the makefile for the library and change the CC line to:

CC = $(PRODDIR)\bin\cmcs -DWCHAR_SUPPORT_ENABLED
10.1.1. assert.h

assert(expr)  Prints a diagnostic message if NDEBUG is not defined. (Implemented as macro)

10.1.2. complex.h

The complex number \( z \) is also written as \( x+yi \) where \( x \) (the real part) and \( y \) (the imaginary part) are real numbers of types float, double or long double. The real and imaginary part can be stored in structs or in arrays. This implementation uses arrays because structs may have different alignments.

The header file complex.h also defines the following macros for backward compatibility:

```c
complex    _Complex    /* C99 keyword */
imaginary  _Imaginary  /* C99 keyword */
```

Parallel sets of functions are defined for double, float and long double. They are respectively named function, functionf, functionl. All long type functions, though declared in complex.h, are implemented as the double type variant which nearly always meets the requirement in embedded applications.

This implementation uses the obvious implementation for complex multiplication; and a more sophisticated implementation for division and absolute value calculations which handles underflow, overflow and infinities with more care. The ISO C99 #pragma CX_LIMITED_RANGE therefore has no effect.

Trigonometric functions

- \( \text{csin} \), \( \text{csinf} \), \( \text{csinl} \)  Returns the complex sine of \( z \).
- \( \text{ccos} \), \( \text{ccosf} \), \( \text{ccosl} \)  Returns the complex cosine of \( z \).
- \( \text{ctan} \), \( \text{ctanf} \), \( \text{ctanl} \)  Returns the complex tangent of \( z \).
- \( \text{casin} \), \( \text{casinf} \), \( \text{casinl} \)  Returns the complex arc sine \( \sin^{-1}(z) \).
- \( \text{cacos} \), \( \text{cacosf} \), \( \text{ccosl} \)  Returns the complex arc cosine \( \cos^{-1}(z) \).
- \( \text{catan} \), \( \text{catanf} \), \( \text{catanl} \)  Returns the complex arc tangent \( \tan^{-1}(z) \).
- \( \text{csinh} \), \( \text{csinhf} \), \( \text{csinhl} \)  Returns the complex hyperbolic sine of \( z \).
- \( \text{ccosh} \), \( \text{ccoshf} \), \( \text{ccoshl} \)  Returns the complex hyperbolic cosine of \( z \).
- \( \text{ctanh} \), \( \text{ctanhf} \), \( \text{ctanhl} \)  Returns the complex hyperbolic tangent of \( z \).
- \( \text{casinh} \), \( \text{casinhf} \), \( \text{casinhl} \)  Returns the complex arc hyperbolic sine of \( z \).
- \( \text{cacosh} \), \( \text{cacoshf} \), \( \text{cacoshl} \)  Returns the complex arc hyperbolic cosine of \( z \).
- \( \text{catanh} \), \( \text{catanhf} \), \( \text{catanhl} \)  Returns the complex arc hyperbolic tangent of \( z \).

Exponential and logarithmic functions

- \( \text{cexp} \), \( \text{cexpf} \), \( \text{cexpl} \)  Returns the result of the complex exponential function \( e^z \).
- \( \text{clog} \), \( \text{clogf} \), \( \text{clogl} \)  Returns the complex natural logarithm.
Power and absolute-value functions

- **cabs**, **cabsf**, **cabs1**: Returns the complex absolute value of \( z \) (also known as norm, modulus or magnitude).
- **cpow**, **cpowf**, **cpowl**: Returns the complex value of \( x \) raised to the power \( y \) \( (x^y) \) where both \( x \) and \( y \) are complex numbers.
- **csqrt**, **csqrtf**, **csqrtl**: Returns the complex square root of \( z \).

Manipulation functions

- **carg**, **cargf**, **cargl**: Returns the argument of \( z \) (also known as phase angle).
- **cimag**, **cimagf**, **cimagl**: Returns the imaginary part of \( z \) as a real (respectively as a double, float, long double).
- **conj**, **conjf**, **conjl**: Returns the complex conjugate value (the sign of its imaginary part is reversed).
- **cproj**, **cprojf**, **cprojl**: Returns the value of the projection of \( z \) onto the Riemann sphere.
- **creal**, **crealf**, **creall**: Returns the real part of \( z \) as a real (respectively as a double, float, long double).

10.1.3. ctype.h and wctype.h

The header file **ctype.h** declares the following functions which take a character \( c \) as an integer type argument. The header file **wctype.h** declares parallel wide character functions which take a character \( c \) of the **wchar_t** type as argument.

<table>
<thead>
<tr>
<th>ctype.h</th>
<th>wctype.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>isalnum</td>
<td>iswalnum</td>
<td>Returns a non-zero value when ( c ) is an alphabetic character or a number ([A-Z][a-z][0-9]).</td>
</tr>
<tr>
<td>isalpha</td>
<td>iswalpha</td>
<td>Returns a non-zero value when ( c ) is an alphabetic character ([A-Z][a-z]).</td>
</tr>
<tr>
<td>isblank</td>
<td>iswblank</td>
<td>Returns a non-zero value when ( c ) is a blank character (tab, space...).</td>
</tr>
<tr>
<td>iscntrl</td>
<td>iswcntrl</td>
<td>Returns a non-zero value when ( c ) is a control character.</td>
</tr>
<tr>
<td>isdigit</td>
<td>iswdigit</td>
<td>Returns a non-zero value when ( c ) is a numeric character ([0-9]).</td>
</tr>
<tr>
<td>isgraph</td>
<td>iswgraph</td>
<td>Returns a non-zero value when ( c ) is printable, but not a space.</td>
</tr>
<tr>
<td>islower</td>
<td>iswlower</td>
<td>Returns a non-zero value when ( c ) is a lowercase character ([a-z]).</td>
</tr>
<tr>
<td>isprint</td>
<td>iswprint</td>
<td>Returns a non-zero value when ( c ) is printable, including spaces.</td>
</tr>
<tr>
<td>ispunct</td>
<td>iswpunct</td>
<td>Returns a non-zero value when ( c ) is a punctuation character (such as &quot;,', ';', '!' ).</td>
</tr>
<tr>
<td>isspace</td>
<td>iswspace</td>
<td>Returns a non-zero value when ( c ) is a space type character (space, tab, vertical tab, formfeed, linefeed, carriage return).</td>
</tr>
<tr>
<td>isupper</td>
<td>iswupper</td>
<td>Returns a non-zero value when ( c ) is an uppercase character ([A-Z]).</td>
</tr>
</tbody>
</table>
### 10.1.4. dbg.h

The header file `dbg.h` contains the debugger call interface for file system simulation. It contains low level functions. This header file is not defined in ISO C99.

- `_dbg_trap`  
  Low level function to trap debug events

- `_argcv(const char *buf, size_t size)`  
  Low level function for command line argument passing

### 10.1.5. errno.h

`int errno`  
External variable that holds implementation defined error codes.

The following error codes are defined as macros in `errno.h`:

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>EPERM 1</td>
<td>Operation not permitted</td>
</tr>
<tr>
<td>ENOENT 2</td>
<td>No such file or directory</td>
</tr>
<tr>
<td>EINTR 3</td>
<td>Interrupted system call</td>
</tr>
<tr>
<td>EIO 4</td>
<td>I/O error</td>
</tr>
<tr>
<td>EBADF 5</td>
<td>Bad file number</td>
</tr>
<tr>
<td>EAGAIN 6</td>
<td>No more processes</td>
</tr>
<tr>
<td>ENOMEM 7</td>
<td>Not enough core</td>
</tr>
<tr>
<td>EACCES 8</td>
<td>Permission denied</td>
</tr>
<tr>
<td>EFAULT 9</td>
<td>Bad address</td>
</tr>
<tr>
<td>EEEXIST 10</td>
<td>File exists</td>
</tr>
<tr>
<td>ENOTDIR 11</td>
<td>Not a directory</td>
</tr>
<tr>
<td>EISDIR 12</td>
<td>Is a directory</td>
</tr>
<tr>
<td>EINVAL 13</td>
<td>Invalid argument</td>
</tr>
</tbody>
</table>
Floating-point errors

EDOM 23  Argument too large
ERANGE 24  Result too large

Errors returned by printf/scanf

ERR_FORMAT 25  Illegal format string for printf/scanf
ERR_NOFLOAT 26  Floating-point not supported
ERR_NOLONG 27  Long not supported
ERR_NOPOINT 28  Pointers not supported

Encoding errors set by functions like fgetwc, getwc, mbtowc, etc ...

EILSEQ 29  Invalid or incomplete multibyte or wide character

Errors returned by RTOS

ECANCELED 30  Operation canceled
ENODEV 31  No such device

10.1.6. fcntl.h

The header file fcntl.h contains the function open(), which calls the low level function _open(), and definitions of flags used by the low level function _open(). This header file is not defined in ISO C99.

open  Opens a file a file for reading or writing. Calls _open.

(FSS implementation)

10.1.7. fenv.h

Contains mechanisms to control the floating-point environment.

fegetenv  Stores the current floating-point environment.
feholdexcept  Saves the current floating-point environment and installs an environment that ignores all floating-point exceptions.
fesetenv  Restores a previously saved (fegetenv or feholdexcept) floating-point environment.
TASKING VX-toolset for MCS User Guide

feupdateenv Saves the currently raised floating-point exceptions, restores a previously saved floating-point environment and finally raises the saved exceptions.

feclearexcept Clears the current exception status flags corresponding to the flags specified in the argument.

fegetexceptflag Stores the current setting of the floating-point status flags.

feraiseexcept Raises the exceptions represented in the argument. As a result, other exceptions may be raised as well.

fesetexceptflag Sets the current floating-point status flags.

fetestexcept Returns the bitwise-OR of the exception macros corresponding to the exception flags which are currently set and are specified in the argument.

For each supported exception, a macro is defined. The following exceptions are defined:

FE_DIVBYZERO    FE_INEXACT      FE_INVALID
FE_OVERFLOW     FE_UNDERFLOW    FE_ALL_EXCEPT

fegetround Returns the current rounding direction, represented as one of the values of the rounding direction macros.

fesetround Sets the current rounding directions.

For each supported rounding mode, a macro is defined. The following rounding mode macros are defined:

FE_TONEAREST    FE_UPWARD       FE_DOWNWARD     FE_TOWARDZERO

10.1.8. float.h

The header file float.h defines the characteristics of the real floating-point types float, double and long double.

float.h used to contain prototypes for the functions copysign(f), isinf(f), isfinite(f), isnan(f) and scalb(f). These functions have accordingly to the ISO C99 standard been moved to the header file math.h. See also Section 10.1.15, math.h and tgmath.h.

The following functions are only available for ISO C90:

copysignf(float f, float s) Copies the sign of the second argument s to the value of the first argument f and returns the result.

copysign(double d, double s) Copies the sign of the second argument s to the value of the first argument d and returns the result.

isinf(float f) Test the variable f on being an infinite (IEEE-754) value.

isinf(double d); Test the variable d on being an infinite (IEEE-754) value.

isfinite(float f) Test the variable f on being a finite (IEEE-754) value.

isfinite(double d) Test the variable d on being a finite (IEEE-754) value.

isnanf(float f) Test the variable f on being NaN (Not a Number, IEEE-754).
Test the variable \( d \) on being NaN (Not a Number, IEEE-754).

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>isnan</code></td>
<td>Returns ( f \times 2^p ) for integral values without computing ( 2^N ).</td>
</tr>
<tr>
<td><code>scalbf</code></td>
<td>Returns ( d \times 2^p ) for integral values without computing ( 2^N ). (See also <code>scalbn</code> in Section 10.1.15, <code>math.h</code> and <code>tgmath.h</code>)</td>
</tr>
</tbody>
</table>

### 10.1.9. inttypes.h and stdint.h

The header files `stdint.h` and `inttypes.h` provide additional declarations for integer types and have various characteristics. The `stdint.h` header file contains basic definitions of integer types of certain sizes, and corresponding sets of macros. This header file clearly refers to the corresponding sections in the ISO C99 standard.

The `inttypes.h` header file includes `stdint.h` and adds portable formatting and conversion functions. Below the conversion functions from `inttypes.h` are listed.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>imaxabs</code></td>
<td>Returns the absolute value of ( j )</td>
</tr>
<tr>
<td><code>imaxdiv</code></td>
<td>Computes ( \text{numer} / \text{denom} ) and ( \text{numer} \mod \text{denom} ). The result is stored in the <code>quot</code> and <code>rem</code> components of the <code>imaxdiv_t</code> structure type.</td>
</tr>
<tr>
<td><code>strtoimax</code></td>
<td>Convert string to maximum sized integer. (Compare <code>strtoll</code>)</td>
</tr>
<tr>
<td><code>strtoumax</code></td>
<td>Convert string to maximum sized unsigned integer. (Compare <code>strtoull</code>)</td>
</tr>
<tr>
<td><code>wcstoimax</code></td>
<td>Convert wide string to maximum sized integer. (Compare <code>wcstoll</code>)</td>
</tr>
<tr>
<td><code>wcstoumax</code></td>
<td>Convert wide string to maximum sized unsigned integer. (Compare <code>wcstoull</code>)</td>
</tr>
</tbody>
</table>

### 10.1.10. io.h

The header file `io.h` contains prototypes for low level I/O functions. This header file is not defined in ISO C99.

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>_close</code></td>
<td>Used by the functions <code>close</code> and <code>fclose</code>. (FSS implementation)</td>
</tr>
<tr>
<td><code>_lseek</code></td>
<td>Used by all file positioning functions: <code>fgetpos</code>, <code>fseek</code>, <code>fsetpos</code>, <code>ftell</code>, <code>rewind</code>. (FSS implementation)</td>
</tr>
<tr>
<td><code>_open</code></td>
<td>Used by the functions <code>fopen</code> and <code>freopen</code>. (FSS implementation)</td>
</tr>
<tr>
<td><code>_read</code></td>
<td>Reads a sequence of characters from a file. (FSS implementation)</td>
</tr>
<tr>
<td><code>_unlink</code></td>
<td>Used by the function <code>remove</code>. (FSS implementation)</td>
</tr>
<tr>
<td><code>_write</code></td>
<td>Writes a sequence of characters to a file. (FSS implementation)</td>
</tr>
</tbody>
</table>
10.1.11. iso646.h

The header file iso646.h adds tokens that can be used instead of regular operator tokens.

```c
#define and     &&
#define and_eq  &=
#define bitand  &
#define bitor   |
#define compl   ~
#define not     !
#define not_eq  !=
#define or      ||
#define or_eq   |=
#define xor     ^
#define xor_eq  ^=
```

10.1.12. limits.h

Contains the sizes of integral types, defined as macros.

10.1.13. locale.h

To keep C code reasonable portable across different languages and cultures, a number of facilities are provided in the header file locale.h.

```c
char *setlocale( int category, const char *locale )
```

The function above changes locale-specific features of the run-time library as specified by the category to change and the name of the locale.

The following categories are defined and can be used as input for this function:

- LC_ALL      0      LC_NUMERIC   3
- LC_COLLATE  1      LC_TIME      4
- LC_CTYPE    2      LC_MONETARY  5

```c
struct lconv *localeconv( void )
```

Returns a pointer to type struct lconv with values appropriate for the formatting of numeric quantities according to the rules of the current locale. The struct lconv in this header file is conforming the ISO standard.

10.1.14. malloc.h

The header file malloc.h contains prototypes for memory allocation functions. This include file is not defined in ISO C99, it is included for backwards compatibility with ISO C90. For ISO C99, the memory allocation functions are part of stdlib.h. See Section 10.1.23, stdlib.h and wchar.h.
malloc(size)         Allocates space for an object with size size.  
The allocated space is not initialized. Returns a pointer to the
allocated space.

calloc(nobj,size)    Allocates space for n objects with size size.  
The allocated space is initialized with zeros. Returns a pointer to
the allocated space.

free(*ptr)           Deallocates the memory space pointed to by ptr which should be
                     a pointer earlier returned by the malloc or calloc function.

realloc(*ptr,size)   Deallocates the old object pointed to by ptr and returns a pointer
to a new object with size size, while preserving its contents.
If the new size is smaller than the old size, some contents at the
end of the old region will be discarded. If the new size is larger than
the old size, all of the old contents are preserved and any bytes in
the new object beyond the size of the old object will have
indeterminate values.

10.1.15. math.h and tgmath.h

The header file math.h contains the prototypes for many mathematical functions. Before ISO C99, all
functions were computed using the double type (the float was automatically converted to double, prior to
calculation). In this ISO C99 version, parallel sets of functions are defined for double, float and long
double. They are respectively named function, functionf, functionl. All long type functions, though
declared in math.h, are implemented as the double type variant which nearly always meets the
requirement in embedded applications.

The header file tgmath.h contains parallel type generic math macros whose expansion depends on the
used type. tgmath.h includes math.h and the effect of expansion is that the correct math.h functions
are called. The type generic macro, if available, is listed in the second column of the tables below.

Trigonometric and hyperbolic functions

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>sin</td>
<td>sinf</td>
<td>sinl     sin</td>
</tr>
<tr>
<td>cos</td>
<td>cosf</td>
<td>cosl     cos</td>
</tr>
<tr>
<td>tan</td>
<td>tanf</td>
<td>tanl     tan</td>
</tr>
<tr>
<td>asin</td>
<td>asinf</td>
<td>asinl    asin</td>
</tr>
<tr>
<td>acos</td>
<td>acosf</td>
<td>acosl    acos</td>
</tr>
<tr>
<td>atan</td>
<td>atanf</td>
<td>atanl    atan</td>
</tr>
<tr>
<td>atan2</td>
<td>atan2f</td>
<td>atan2l   atan2</td>
</tr>
<tr>
<td>sinh</td>
<td>sinhf</td>
<td>sinhl    sinh</td>
</tr>
<tr>
<td>cosh</td>
<td>coshf</td>
<td>coshl    cosh</td>
</tr>
<tr>
<td>tanh</td>
<td>tanhf</td>
<td>tanhl    tanh</td>
</tr>
<tr>
<td>asinh</td>
<td>asinhf</td>
<td>asinhl   asinh</td>
</tr>
<tr>
<td>acosh</td>
<td>acoshf</td>
<td>acoshl   acosh</td>
</tr>
</tbody>
</table>
### Exponential and logarithmic functions

All of these functions are new in ISO C99, except for `exp`, `log` and `log10`.

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>exp</td>
<td>expf</td>
<td>Returns the result of the exponential function $e^x$.</td>
</tr>
<tr>
<td>exp2</td>
<td>exp2f</td>
<td>Returns the result of the exponential function $2^x$.</td>
</tr>
<tr>
<td>expm1</td>
<td>expm1f</td>
<td>Returns the result of the exponential function $e^{x-1}$.</td>
</tr>
<tr>
<td>log</td>
<td>logf</td>
<td>Returns the natural logarithm $\ln(x)$, $x&gt;0$.</td>
</tr>
<tr>
<td>log10</td>
<td>log10f</td>
<td>Returns the base-10 logarithm of $x$, $x&gt;0$.</td>
</tr>
<tr>
<td>log1p</td>
<td>log1pf</td>
<td>Returns the base-$e$ logarithm of $(1+x).x &lt;&gt; -1$.</td>
</tr>
<tr>
<td>log2</td>
<td>log2f</td>
<td>Returns the base-2 logarithm of $x. x&gt;0$.</td>
</tr>
<tr>
<td>ilogb</td>
<td>ilogbf</td>
<td>Returns the signed exponent of $x$ as an integer. $x&gt;0$.</td>
</tr>
<tr>
<td>logb</td>
<td>logbf</td>
<td>Returns the exponent of $x$ as a signed integer in value in floating-point notation. $x &gt; 0$.</td>
</tr>
</tbody>
</table>

### frexp, ldexp, modf, scalbn, scalbln

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>frexp</td>
<td>frexp</td>
<td>Splits a float $x$ into fraction $f$ and exponent $n$, so that: $f = 0.0$ or $0.5 \leq</td>
</tr>
<tr>
<td>ldexp</td>
<td>ldexp</td>
<td>Inverse of frexp. Returns the result of $x*2^n$. (x and n are both arguments).</td>
</tr>
<tr>
<td>modf</td>
<td>modff</td>
<td>Splits a float $x$ into fraction $f$ and integer $n$, so that: $</td>
</tr>
<tr>
<td>scalbn</td>
<td>scalbnf</td>
<td>Computes the result of $x*FLT_RADIX^n$. efficiently, not normally by computing $FLT_RADIX^n$ explicitly.</td>
</tr>
<tr>
<td>scalbln</td>
<td>scalblnf</td>
<td>Same as scalbn but with argument n as long int.</td>
</tr>
</tbody>
</table>

### Rounding functions

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ceil</td>
<td>ceilf</td>
<td>Returns the smallest integer not less than $x$, as a double.</td>
</tr>
<tr>
<td>floor</td>
<td>floorf</td>
<td>Returns the largest integer not greater than $x$, as a double.</td>
</tr>
<tr>
<td>rint</td>
<td>rintf</td>
<td>Returns the rounded integer value as an int according to the current rounding direction. See fenv.h.</td>
</tr>
<tr>
<td>lrint</td>
<td>lrintf</td>
<td>Returns the rounded integer value as a long int according to the current rounding direction. See fenv.h.</td>
</tr>
</tbody>
</table>
### Libraries

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>lrint</td>
<td>lrintf</td>
<td>Returns the rounded integer value as a <code>long long int</code> according to the current rounding direction. See <code>fenv.h</code>.</td>
</tr>
<tr>
<td>nearbyint</td>
<td>nearbyintf</td>
<td>Returns the rounded integer value as a floating-point according to the current rounding direction. See <code>fenv.h</code>.</td>
</tr>
<tr>
<td>round</td>
<td>roundf</td>
<td>Returns the nearest integer value of x as int.</td>
</tr>
<tr>
<td>lround</td>
<td>lroundf</td>
<td>Returns the nearest integer value of x as int.</td>
</tr>
<tr>
<td>llround</td>
<td>llroundf</td>
<td>Returns the nearest integer value of x as long int.</td>
</tr>
<tr>
<td>trunc</td>
<td>truncf</td>
<td>Returns the truncated integer value x.</td>
</tr>
</tbody>
</table>

#### Remainder after division

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fmod</td>
<td>fmodf</td>
<td>Returns the remainder r of x-ny. n is chosen as <code>trunc(x/y)</code>. r has the same sign as x.</td>
</tr>
<tr>
<td>remainder</td>
<td>remainderf</td>
<td>Returns the remainder r of x-ny. n is chosen as <code>trunc(x/y)</code>. r may not have the same sign as x.</td>
</tr>
<tr>
<td>remquo</td>
<td>remquof</td>
<td>Same as remainder. In addition, the argument *quo is given a specific value (see ISO).</td>
</tr>
</tbody>
</table>

#### Power and absolute-value functions

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cbrt</td>
<td>cbrtf</td>
<td>Returns the real cube root of x (<code>x^{1/3}</code>).</td>
</tr>
<tr>
<td>fabs</td>
<td>fabsf</td>
<td>Returns the absolute value of x (`</td>
</tr>
<tr>
<td>fma</td>
<td>fmaf</td>
<td>Floating-point multiply add. Returns <code>x*y+z</code>.</td>
</tr>
<tr>
<td>hypot</td>
<td>hypotf</td>
<td>Returns the square root of <code>x^2+y^2</code>.</td>
</tr>
<tr>
<td>pow</td>
<td>powf</td>
<td>Returns <code>x</code> raised to the power <code>y</code> (<code>x^y</code>).</td>
</tr>
<tr>
<td>sqrt</td>
<td>sqrtf</td>
<td>Returns the non-negative square root of <code>x</code>.</td>
</tr>
<tr>
<td></td>
<td>sqrtl</td>
<td></td>
</tr>
</tbody>
</table>

1With compiler option `--fp-model=--fastlib` more precise versions of `pow`, `powf` and `powl` are used when the arguments have no fractional part. The macro `__PRECISE_LIB_FP__` is defined. By default, less precise versions are used.

#### Manipulation functions: copysign, nan, nextafter, nexttoward

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>copysign</td>
<td>copysignf</td>
<td>Returns the value of x with the sign of y.</td>
</tr>
<tr>
<td>nan</td>
<td>nanf</td>
<td>Returns a quiet NaN, if available, with content indicated through <code>tagp</code>.</td>
</tr>
<tr>
<td>nanl</td>
<td>0</td>
<td></td>
</tr>
</tbody>
</table>
**Positive difference, maximum, minimum**

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fdim</td>
<td>fdimf, fdiml</td>
<td>Returns the positive difference between:</td>
</tr>
<tr>
<td>fmax</td>
<td>fmaxf, fmaxl</td>
<td>Returns the maximum value of their arguments.</td>
</tr>
<tr>
<td>fmin</td>
<td>fminf, fminl</td>
<td>Returns the minimum value of their arguments.</td>
</tr>
</tbody>
</table>

**Error and gamma**

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>erf</td>
<td>erff, erfl</td>
<td>Computes the error function of x.</td>
</tr>
<tr>
<td>erfc</td>
<td>erfcf, erfcl</td>
<td>Computes the complementary error function of x.</td>
</tr>
<tr>
<td>lgamma</td>
<td>lgammaf, lgammal</td>
<td>Computes the *log_e</td>
</tr>
<tr>
<td>tgamma</td>
<td>tgammaf, tgammap</td>
<td>Computes Γ(x)</td>
</tr>
</tbody>
</table>

**Comparison macros**

The next are implemented as macros. For any ordered pair of numeric values exactly one of the relationships - less, greater, and equal - is true. These macros are type generic and therefore do not have a parallel function in tgmath.h. All arguments must be expressions of real-floating type.

<table>
<thead>
<tr>
<th>math.h</th>
<th>tgmath.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>isgreater</td>
<td>–</td>
<td>Returns the value of (x) &gt; (y)</td>
</tr>
<tr>
<td>isgreaterequal</td>
<td>–</td>
<td>Returns the value of (x) &gt;= (y)</td>
</tr>
<tr>
<td>isless</td>
<td>–</td>
<td>Returns the value of (x) &lt; (y)</td>
</tr>
<tr>
<td>islessequal</td>
<td>–</td>
<td>Returns the value of (x) &lt;= (y)</td>
</tr>
<tr>
<td>islessgreater</td>
<td>–</td>
<td>Returns the value of (x) &lt; (y)</td>
</tr>
<tr>
<td>isunordered</td>
<td>–</td>
<td>Returns 1 if its arguments are unordered, 0 otherwise.</td>
</tr>
</tbody>
</table>

**Classification macros**

The next are implemented as macros. These macros are type generic and therefore do not have a parallel function in tgmath.h. All arguments must be expressions of real-floating type.
**math.h** | **tgmath.h** | **Description**
---|---|---
fpclassify | - | Returns the class of its argument: FP_INFINITE, FP_NAN, FP_NORMAL, FP_SUBNORMAL or FP_ZERO
isfinite | - | Returns a nonzero value if and only if its argument has a finite value
isinf | - | Returns a nonzero value if and only if its argument has an infinite value
isnan | - | Returns a nonzero value if and only if its argument has NaN value.
isnormal | - | Returns a nonzero value if an only if its argument has a normal value.
signbit | - | Returns a nonzero value if and only if its argument value is negative.

### 10.1.16. setjmp.h

The `setjmp` and `longjmp` in this header file implement a primitive form of non-local jumps, which may be used to handle exceptional situations. This facility is traditionally considered more portable than `signal.h`

```c
int setjmp(jmp_buf env)  
Records its caller’s environment in env and returns 0.
```

```c
void longjmp(jmp_buf env, int status)  
Restores the environment previously saved with a call to setjmp().
```

### 10.1.17. signal.h

Signals are possible asynchronous events that may require special processing. Each signal is named by a number. The following signals are defined:

- **SIGINT** 1  Receipt of an interactive attention signal
- **SIGILL** 2  Detection of an invalid function message
- **SIGFPE** 3  An erroneous arithmetic operation (for example, zero divide, overflow)
- **SIGSEGV** 4  An invalid access to storage
- **SIGTERM** 5  A termination request sent to the program
- **SIGABRT** 6  Abnormal termination, such as is initiated by the `abort` function

The next function sends the signal `sig` to the program:

```c
int raise(int sig)
```

The next function determines how subsequent signals will be handled:

```c
signalfunction *signal (int, signalfunction *);
```
The first argument specifies the signal, the second argument points to the signal-handler function or has one of the following values:

- **SIG_DFL**  Default behavior is used
- **SIG_IGN**  The signal is ignored

The function returns the previous value of `signalfunction` for the specific signal, or **SIG_ERR** if an error occurs.

### 10.1.18. stdarg.h

The facilities in this header file give you a portable way to access variable arguments lists, such as needed for `fprintf` and `vfprintf`. `va_copy` is new in ISO C99. This header file contains the following macros:

- `va_arg(va_list ap, type)`  Returns the value of the next argument in the variable argument list. Its return type has the type of the given argument `type`. A next call to this macro will return the value of the next argument.

- `va_copy(va_list dest, va_list src)`  This macro duplicates the current state of `src` in `dest`, creating a second pointer into the argument list. After this call, `va_arg()` may be used on `src` and `dest` independently.

- `va_end(va_list ap)`  This macro must be called after the arguments have been processed. It should be called before the function using the macro `va_start` is terminated.

- `va_start(va_list ap, lastarg)`  This macro initializes `ap`. After this call, each call to `va_arg()` will return the value of the next argument. In our implementation, `va_list` cannot contain any bit type variables. Also the given argument `lastarg` must be the last non-bit type argument in the list.

### 10.1.19. stdbool.h

This header file contains the following macro definitions. These names for boolean type and values are consistent with C++. You are allowed to redefine the macros below.

- `#define bool`  `_Bool`
- `#define true`  `1`
- `#define false`  `0`
- `#define __bool_true_false_are_defined`  `1`

### 10.1.20. stddef.h

This header file defines the types for common use:

- `ptrdiff_t`  Signed integer type of the result of subtracting two pointers.
- `size_t`  Unsigned integral type of the result of the `sizeof` operator.
- `wchar_t`  Integer type to represent character codes in large character sets.
Besides these types, the following macros are defined:

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>NULL</code></td>
</tr>
<tr>
<td>Expands to the null pointer constant (void *) 0 for C or 0 (zero) for C++.</td>
</tr>
<tr>
<td><code>offsetof(_type, _member)</code></td>
</tr>
<tr>
<td>Expands to an integer constant expression with type size_t that is the offset</td>
</tr>
<tr>
<td>in bytes of _member within structure type _type.</td>
</tr>
</tbody>
</table>

### 10.1.21. stdint.h

See Section 10.1.9, `inttypes.h and stdint.h`

### 10.1.22. stdio.h and wchar.h

**Types**

The header file `stdio.h` contains functions for performing input and output. A number of functions also have a parallel wide character function or macro, defined in `wchar.h`. The header file `wchar.h` also includes `stdio.h`.

In the C language, many I/O facilities are based on the concept of streams. The `stdio.h` header file defines the data type `FILE` which holds the information about a stream. A `FILE` object is created with the function `fopen`. The pointer to this object is used as an argument in many of the in this header file. The `FILE` object can contain the following information:

- the current position within the stream
- pointers to any associated buffers
- indications of for read/write errors
- end of file indication

The header file also defines type `fpos_t` as an `unsigned long`.

**Macros**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>NULL</code></td>
</tr>
<tr>
<td>Expands to the null pointer constant (void *) 0 for C or 0 (zero) for C++.</td>
</tr>
<tr>
<td><code>BUFSIZ</code></td>
</tr>
<tr>
<td>Size of the buffer used by the <code>setbuf/setvbuf</code> function: 512</td>
</tr>
<tr>
<td><code>EOF</code></td>
</tr>
<tr>
<td>End of file indicator. Expands to -1.</td>
</tr>
<tr>
<td><code>WEOF</code></td>
</tr>
<tr>
<td>End of file indicator. Expands to <code>UINT_MAX</code> (defined in <code>limits.h</code>)</td>
</tr>
<tr>
<td>NOTE: WEOF need not to be a negative number as long as its value does not</td>
</tr>
<tr>
<td>correspond to a member of the wide character set. (Defined in <code>wchar.h</code>).</td>
</tr>
<tr>
<td><code>FOPEN_MAX</code></td>
</tr>
<tr>
<td>Number of files that can be opened simultaneously: 10</td>
</tr>
<tr>
<td><code>FILENAME_MAX</code></td>
</tr>
<tr>
<td>Maximum length of a filename: 100</td>
</tr>
<tr>
<td><code>_IOFBF</code></td>
</tr>
<tr>
<td>Expand to an integer expression, suitable for use as argument to the <code>setvbuf</code> function.</td>
</tr>
</tbody>
</table>
Description

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>L_tmpnam</td>
<td>Size of the string used to hold temporary file names: 8 (tmpxxxxx)</td>
</tr>
<tr>
<td>TMP_MAX</td>
<td>Maximum number of unique temporary filenames that can be generated: 0x8000</td>
</tr>
<tr>
<td>SEEK_CUR</td>
<td>Expand to an integer expression, suitable for use as the third argument to the fseek function.</td>
</tr>
<tr>
<td>SEEK_END</td>
<td></td>
</tr>
<tr>
<td>SEEK_SET</td>
<td></td>
</tr>
<tr>
<td>stderr</td>
<td>Expressions of type &quot;pointer to FILE&quot; that point to the FILE objects associated with standard error, input and output streams.</td>
</tr>
<tr>
<td>stdin</td>
<td></td>
</tr>
<tr>
<td>stdout</td>
<td></td>
</tr>
</tbody>
</table>

### File access

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fopen(name, mode)</td>
<td>Opens a file for a given mode. Available modes are:</td>
</tr>
<tr>
<td>&quot;r&quot;</td>
<td>read; open text file for reading</td>
</tr>
<tr>
<td>&quot;w&quot;</td>
<td>write; create text file for writing; if the file already exists, its contents is discarded</td>
</tr>
<tr>
<td>&quot;a&quot;</td>
<td>append; open existing text file or create new text file for writing at end of file</td>
</tr>
<tr>
<td>&quot;r+&quot;</td>
<td>open text file for update; reading and writing</td>
</tr>
<tr>
<td>&quot;w+&quot;</td>
<td>create text file for update; previous contents if any is discarded</td>
</tr>
<tr>
<td>&quot;a+&quot;</td>
<td>append; open or create text file for update, writes at end of file</td>
</tr>
</tbody>
</table>

*FSS implementation*

| fclose(name) | Flushes the data stream and closes the specified file that was previously opened with fopen. *FSS implementation* |
| fflush(name) | If stream is an output stream, any buffered but unwritten data is written. Else, the effect is undefined. *FSS implementation* |
| freopen(name, mode, stream) | Similar to fopen, but rather than generating a new value of type FILE *, the existing value is associated with a new stream. *FSS implementation* |
| setbuf(stream, buffer) | If buffer is NULL, buffering is turned off for the stream. Otherwise, setbuf is equivalent to: (void) setvbuf(stream, buffer, _IOFBF, BUFSIZ). |
| setvbuf(stream, buffer, mode, size) | Controls buffering for the stream; this function must be called before reading or writing. Mode can have the following values: _IOFBF causes full buffering _IOLBF causes line buffering of text files _IONBF causes no buffering. If buffer is not NULL, it will be used as a buffer; otherwise a buffer will be allocated. size determines the buffer size. |
Formatted input/output

The format string of `printf` related functions can contain plain text mixed with conversion specifiers. Each conversion specifier should be preceded by a '%’ character. The conversion specifier should be built in order:

- Flags (in any order):
  - specifies left adjustment of the converted argument.
  + a number is always preceded with a sign character.
    + has higher precedence than space.
  space a negative number is preceded with a sign, positive numbers with a space.
  0 specifies padding to the field width with zeros (only for numbers).
  # specifies an alternate output form. For o, the first digit will be zero. For x or X, "0x" and "0X" will be prefixed to the number. For e, E, f, g, G, the output always contains a decimal point, trailing zeros are not removed.

- A number specifying a minimum field width. The converted argument is printed in a field with at least the length specified here. If the converted argument has fewer characters than specified, it will be padded at the left side (or at the right when the flag '−' was specified) with spaces. Padding to numeric fields will be done with zeros when the flag '0' is also specified (only when padding left). Instead of a numeric value, also '*’ may be specified, the value is then taken from the next argument, which is assumed to be of type int.

- A period. This separates the minimum field width from the precision.

- A number specifying the maximum length of a string to be printed. Or the number of digits printed after the decimal point (only for floating-point conversions). Or the minimum number of digits to be printed for an integer conversion. Instead of a numeric value, also '*' may be specified, the value is then taken from the next argument, which is assumed to be of type int.

- A length modifier 'h’, 'hh’, 'l’, 'll’, 'L’, 'j’, 'z’ or ‘t’. 'h’ indicates that the argument is to be treated as a short or unsigned short. 'hh’ indicates that the argument is to be treated as a char or unsigned char. 'l’ should be used if the argument is a long integer, 'll’ for a long long. 'L’ indicates that the argument is a long double. 'j’ indicates a pointer to intmax_t or uintmax_t, 'z’ indicates a pointer to size_t and ‘t’ indicates a pointer to ptrdiff_t.

Flags, length specifier, period, precision and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following '%’ is not in the list, the behavior is undefined:

<table>
<thead>
<tr>
<th>Character</th>
<th>Printed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>d, i</td>
<td>int, signed decimal</td>
</tr>
<tr>
<td>o</td>
<td>int, unsigned octal</td>
</tr>
<tr>
<td>x, X</td>
<td>int, unsigned hexadecimal in lowercase or uppercase respectively</td>
</tr>
<tr>
<td>u</td>
<td>int, unsigned decimal</td>
</tr>
</tbody>
</table>
### Character Printed as

<table>
<thead>
<tr>
<th>Character</th>
<th>Printed as</th>
</tr>
</thead>
<tbody>
<tr>
<td>c</td>
<td>int, single character (converted to unsigned char)</td>
</tr>
<tr>
<td>s</td>
<td>char *, the characters from the string are printed until a NULL character is found. When the given precision is met before, printing will also stop</td>
</tr>
<tr>
<td>f, F</td>
<td>double</td>
</tr>
<tr>
<td>e, E</td>
<td>double</td>
</tr>
<tr>
<td>g, G</td>
<td>double</td>
</tr>
<tr>
<td>a, A</td>
<td>double</td>
</tr>
<tr>
<td>n</td>
<td>int *, the number of characters written so far is written into the argument. This should be a pointer to an integer in default memory. No value is printed.</td>
</tr>
<tr>
<td>p</td>
<td>pointer</td>
</tr>
<tr>
<td>r, lr</td>
<td>__fract, __lfract</td>
</tr>
<tr>
<td>R, IR</td>
<td>__accum, __laccum</td>
</tr>
<tr>
<td>%</td>
<td>No argument is converted, a '%' is printed.</td>
</tr>
</tbody>
</table>

#### printf conversion characters

All arguments to the scanf related functions should be pointers to variables (in default memory) of the type which is specified in the format string.

The format string can contain:

- Blanks or tabs, which are skipped.
- Normal characters (not '%'), which should be matched exactly in the input stream.
- Conversion specifications, starting with a '%' character.

Conversion specifications should be built as follows (in order):

- A '*', meaning that no assignment is done for this field.
- A number specifying the maximum field width.
- The conversion characters d, i, n, o, u and x may be preceded by 'h' if the argument is a pointer to short rather than int, or by 'hh' if the argument is a pointer to char, or by 'l' (letter ell) if the argument is a pointer to long or by 'll' for a pointer to long long, 'j' for a pointer to intmax_t or uintmax_t, 'z' for a pointer to size_t or 't' for a pointer to ptrdiff_t. The conversion characters e, f, and g may be preceded by 'l' if the argument is a pointer to double rather than float, and by 'L' for a pointer to a long double.
- A conversion specifier. '', maximum field width and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following '%' is not in the list, the behavior is undefined.

Length specifier and length modifier are optional, the conversion character is not. The conversion character must be one of the following, if a character following '%' is not in the list, the behavior is undefined.
**Character Scanned as**

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>d</td>
<td>int, signed decimal.</td>
</tr>
<tr>
<td>i</td>
<td>int, the integer may be given octal (i.e. a leading 0 is entered) or hexadecimal (leading &quot;0x&quot; or &quot;0X&quot;), or just decimal.</td>
</tr>
<tr>
<td>o</td>
<td>int, unsigned octal.</td>
</tr>
<tr>
<td>u</td>
<td>int, unsigned decimal.</td>
</tr>
<tr>
<td>x</td>
<td>int, unsigned hexadecimal in lowercase or uppercase.</td>
</tr>
<tr>
<td>c</td>
<td>single character (converted to unsigned char).</td>
</tr>
<tr>
<td>s</td>
<td>char *, a string of non white space characters. The argument should point to an array of characters, large enough to hold the string and a terminating NULL character.</td>
</tr>
<tr>
<td>f, F</td>
<td>float</td>
</tr>
<tr>
<td>e, E</td>
<td>float</td>
</tr>
<tr>
<td>g, G</td>
<td>float</td>
</tr>
<tr>
<td>a, A</td>
<td>float</td>
</tr>
<tr>
<td>n</td>
<td>int *, the number of characters written so far is written into the argument. No scanning is done.</td>
</tr>
<tr>
<td>p</td>
<td>pointer; hexadecimal value which must be entered without 0x- prefix.</td>
</tr>
<tr>
<td>r, lr</td>
<td>__fract, __lfract</td>
</tr>
<tr>
<td>R, IR</td>
<td>__accum, __laccum</td>
</tr>
<tr>
<td>[...]</td>
<td>Matches a string of input characters from the set between the brackets. A NULL character is added to terminate the string. Specifying [...] includes the ']' character in the set of scanning characters.</td>
</tr>
<tr>
<td>[^...]</td>
<td>Matches a string of input characters not in the set between the brackets. A NULL character is added to terminate the string. Specifying [^...] includes the ']' character in the set.</td>
</tr>
<tr>
<td>%</td>
<td>Literal '%', no assignment is done.</td>
</tr>
</tbody>
</table>

**scanf conversion characters**

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>fscanf(stream, format, ...)</td>
<td>fwscanf(stream, format, ...)</td>
<td>Performs a formatted read from the given stream. Returns the number of items converted successfully. (FSS implementation)</td>
</tr>
<tr>
<td>scanf(format, ...)</td>
<td>wscanf(format, ...)</td>
<td>Performs a formatted read from stdin. Returns the number of items converted successfully. (FSS implementation)</td>
</tr>
<tr>
<td>sscanf(*s, format, ...)</td>
<td>swscanf(*s, format, ...)</td>
<td>Performs a formatted read from the string s. Returns the number of items converted successfully.</td>
</tr>
<tr>
<td>vscanf(stream, format, arg)</td>
<td>vfwscanf(stream, format, arg)</td>
<td>Same as fscanf/fwscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h)</td>
</tr>
<tr>
<td>stdio.h</td>
<td>wchar.h</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>vscanf(format, arg)</td>
<td>vwscanf(format, arg)</td>
<td>Same as sscanf/swscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h)</td>
</tr>
<tr>
<td>vsscanf(*s, format, arg)</td>
<td>vswscanf(*s, format, arg)</td>
<td>Same as scanf/wscanf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h)</td>
</tr>
<tr>
<td>fprintf(stream, format, ...)</td>
<td>fwprintf(stream, format, ...)</td>
<td>Performs a formatted write to the given stream. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td>printf(format, ...)</td>
<td>wprintf(format, ...)</td>
<td>Performs a formatted write to the stream stdout. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td>snprintf(*s, n, format, ...)</td>
<td>swprintf(*s, n, format, ...)</td>
<td>Performs a formatted write to string s. Returns EOF/WEOF on error.</td>
</tr>
<tr>
<td>vfprintf(stream, format, arg)</td>
<td>vfprintf(stream, format, arg)</td>
<td>Same as fprintf/fwprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h) (FSS implementation)</td>
</tr>
<tr>
<td>vprintf(format, arg)</td>
<td>vwprintf(format, arg)</td>
<td>Same as printf/wprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h) (FSS implementation)</td>
</tr>
<tr>
<td>vsprintf(*s, format, vswprintf(*s, arg)</td>
<td>Same as sprintf/swprintf, but extra arguments are given as variable argument list arg. (See Section 10.1.18, stdarg.h)</td>
<td></td>
</tr>
</tbody>
</table>

The C library functions printf(), fprintf(), vfprintf(), vscanf(), ... call one single function, _doprint(), that deals with the format string and arguments. The same applies to all scanf type functions, which call the function _doscan(), and also for the wprintf and wscanf type functions which call _dowprintf() and _dowscan() respectively. The C library contains three versions of these routines: int, long and long long versions. If you use floating-point the formatter function for floating-point _doflt() or _dowflt() is called. Depending on the formatting arguments you use, the correct routine is used from the library. Of course the larger the version of the routine the larger your produced code will be.

Note that when you call any of the printf/scanf routines indirectly, the arguments are not known and always the long long version with floating-point support is used from the library.

Example:

```c
#include <stdio.h>

long L;
```
void main(void)
{
    printf( "This is a long: %ld\n", L );
}

The linker extracts the long version without floating-point support from the library.

See also the description of \#pragma weak in Section 1.5, Pragmas to Control the Compiler.

**Character input/output**

<table>
<thead>
<tr>
<th>stdio.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>fgetc(stream)</code></td>
<td><code>fgetwc(stream)</code></td>
<td>Reads one character from <code>stream</code>. Returns the read character, or EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td><code>getc(stream)</code></td>
<td><code>getwc(stream)</code></td>
<td>Same as <code>fgetc/fgetwc</code> except that is implemented as a macro. (FSS implementation)</td>
</tr>
<tr>
<td><code>getchar(stdin)</code></td>
<td><code>getwchar(stdin)</code></td>
<td>Reads one character from the <code>stdin</code> stream. Returns the character read or EOF/WEOF on error. Implemented as macro. (FSS implementation)</td>
</tr>
<tr>
<td><code>fgets(*s, n, stream)</code></td>
<td><code>fgetws(*s, n, stream)</code></td>
<td>Reads at most the next <code>n-1</code> characters from the <code>stream</code> into array <code>s</code> until a newline is found. Returns <code>s</code> or NULL or EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td><code>gets(*s, n, stdin)</code></td>
<td>``</td>
<td>Reads at most the next <code>n-1</code> characters from the <code>stdin</code> stream into array <code>s</code>. A newline is ignored. Returns <code>s</code> or NULL or EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td><code>ungetc(c, stream)</code></td>
<td><code>ungetwc(c, stream)</code></td>
<td>Pushes character <code>c</code> back onto the input <code>stream</code>. Returns EOF/WEOF on error.</td>
</tr>
<tr>
<td><code>putc(c, stream)</code></td>
<td><code>putwc(c, stream)</code></td>
<td>Put character <code>c</code> onto the given <code>stream</code>. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
<tr>
<td><code>putchar(c, stdout)</code></td>
<td><code>putwchar(c, stdout)</code></td>
<td>Put character <code>c</code> onto the <code>stdout</code> stream. Returns EOF/WEOF on error. Implemented as macro. (FSS implementation)</td>
</tr>
<tr>
<td><code>fputs(*s, stream)</code></td>
<td><code>fputws(*s, stream)</code></td>
<td>Writes string <code>s</code> to the given <code>stream</code>. Returns EOF/WEOF on error. (FSS implementation)</td>
</tr>
</tbody>
</table>
**Direct input/output**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stdio.h</code></td>
</tr>
<tr>
<td><code>fread(ptr, size, nobj, stream)</code></td>
</tr>
<tr>
<td><code>fwrite(ptr, size, nobj, stream)</code></td>
</tr>
</tbody>
</table>

**Random access**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stdio.h</code></td>
</tr>
<tr>
<td><code>fseek(stream, offset, origin)</code></td>
</tr>
</tbody>
</table>

When repositioning a binary file, the new position `origin` is given by the following macros:

- SEEK_SET: 0 characters from the beginning of the file
- SEEK_CUR: 1 offset characters from the current position in the file
- SEEK_END: 2 offset characters from the end of the file

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>ftell(stream)</code></td>
</tr>
</tbody>
</table>
| `rewind(stream)` | Sets the file position indicator for the `stream` to the beginning of the file. This function is equivalent to:

```
(void) fseek(stream, 0L, SEEK_SET);
```

*(FSS implementation)* |
| `fgetpos(stream, pos)` | Stores the current value of the file position indicator for `stream` in the object pointed to by `pos`. *(FSS implementation)* |
| `fsetpos(stream, pos)` | Positions `stream` at the position recorded by `fgetpos` in `*pos`. *(FSS implementation)* |

**Operations on files**

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>stdio.h</code></td>
</tr>
<tr>
<td><code>remove(file)</code></td>
</tr>
<tr>
<td><code>rename(old, new)</code></td>
</tr>
</tbody>
</table>
**stdio.h**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>tmpfile()</code></td>
<td>Creates a temporary file of the mode &quot;wb+&quot; that will be automatically removed when closed or when the program terminates normally. Returns a file pointer.</td>
</tr>
<tr>
<td><code>tmpnam(buffer)</code></td>
<td>Creates new file names that do not conflict with other file names currently in use. The new file name is stored in a buffer which must have room for L_tmpnam characters. Returns a pointer to the temporary name. The file names are created in the current directory and all start with &quot;tmp&quot;. At most TMP_MAX unique file names can be generated.</td>
</tr>
</tbody>
</table>

**Error handling**

<table>
<thead>
<tr>
<th>Function</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>clearerr(stream)</code></td>
<td>Clears the end of file and error indicators for stream.</td>
</tr>
<tr>
<td><code>ferror(stream)</code></td>
<td>Returns a non-zero value if the error indicator for stream is set.</td>
</tr>
<tr>
<td><code>feof(stream)</code></td>
<td>Returns a non-zero value if the end of file indicator for stream is set.</td>
</tr>
<tr>
<td><code>perror(*s)</code></td>
<td>Prints s and the error message belonging to the integer errno. (See Section 10.1.5, errno.h)</td>
</tr>
</tbody>
</table>

**10.1.23. stdlib.h and wchar.h**

The header file stdlib.h contains general utility functions which fall into the following categories (Some have parallel wide character, declared in wchar.h)

- Numeric conversions
- Random number generation
- Memory management
- Environment communication
- Searching and sorting
- Integer arithmetic
- Multibyte/wide character and string conversions.

**Macros**

- `EXIT_SUCCESS` 0  
  Predefined exit codes that can be used in the `exit` function.
- `EXIT_FAILURE` 1  
- `RAND_MAX` 32767  
  Highest number that can be returned by the `rand/srand` function.
- `MB_CUR_MAX` 1  
  Maximum number of bytes in a multibyte character for the extended character set specified by the current locale (category LC_CTYPE, see Section 10.1.13, locale.h).
Numeric conversions

The following functions convert the initial portion of a string *s to a double, int, long int and long long int value respectively.

- double atof(*s)
- int atoi(*s)
- long atol(*s)
- long long atoll(*s)

The following functions convert the initial portion of the string *s to a float, double and long double value respectively. **endp will point to the first character not used by the conversion.

<table>
<thead>
<tr>
<th>stdlib.h</th>
<th>wchar.h</th>
</tr>
</thead>
<tbody>
<tr>
<td>float</td>
<td>strtof(*s,**endp)</td>
</tr>
<tr>
<td>double</td>
<td>strtod(*s,**endp)</td>
</tr>
<tr>
<td>long double</td>
<td>strtold(*s,**endp)</td>
</tr>
<tr>
<td>float</td>
<td>wcstof(*s,**endp)</td>
</tr>
<tr>
<td>double</td>
<td>wcstod(*s,**endp)</td>
</tr>
<tr>
<td>long double</td>
<td>wcstold(*s,**endp)</td>
</tr>
</tbody>
</table>

The following functions convert the initial portion of the string *s to a long, long long, unsigned long and unsigned long long respectively. Base specifies the radix. **endp will point to the first character not used by the conversion.

<table>
<thead>
<tr>
<th>stdlib.h</th>
<th>wchar.h</th>
</tr>
</thead>
<tbody>
<tr>
<td>long</td>
<td>strtol(*s,**endp,base)</td>
</tr>
<tr>
<td>long long</td>
<td>strtoll(*s,**endp,base)</td>
</tr>
<tr>
<td>unsigned long</td>
<td>strtoul(*s,**endp,base)</td>
</tr>
<tr>
<td>unsigned long long</td>
<td>strtoull(*s,**endp,base)</td>
</tr>
<tr>
<td>long</td>
<td>wcstol(*s,**endp,base)</td>
</tr>
<tr>
<td>long long</td>
<td>wcstoll(*s,**endp,base)</td>
</tr>
<tr>
<td>unsigned long</td>
<td>wcstoul(*s,**endp,base)</td>
</tr>
<tr>
<td>unsigned long long</td>
<td>wcstoull(*s,**endp,base)</td>
</tr>
</tbody>
</table>

Random number generation

- rand Returns a pseudo random integer in the range 0 to RAND_MAX.
- srand(seed) Same as rand but uses seed for a new sequence of pseudo random numbers.

Memory management

- malloc(size) Allocates space for an object with size size. The allocated space is not initialized. Returns a pointer to the allocated space.
- calloc(nobj,size) Allocates space for n objects with size size. The allocated space is initialized with zeros. Returns a pointer to the allocated space.
- free(*ptr) Deallocates the memory space pointed to by ptr which should be a pointer earlier returned by the malloc or calloc function.
realloc(*ptr, size) Deallocates the old object pointed to by *ptr and returns a pointer to a new object with size *size, while preserving its contents. If the new size is smaller than the old size, some contents at the end of the old region will be discarded. If the new size is larger than the old size, all of the old contents are preserved and any bytes in the new object beyond the size of the old object will have indeterminate values.

Environment communication

abort() Causes abnormal program termination. If the signal SIGABRT is caught, the signal handler may take over control. (See Section 10.1.17, signal.h).
atexit(*func) func points to a function that is called (without arguments) when the program normally terminates.
exit(status) Causes normal program termination. Acts as if main() returns with status as the return value. Status can also be specified with the predefined macros EXIT_SUCCESS or EXIT_FAILURE.
_exit(status) Same as exit, but not registered by the atexit function or signal handlers registered by the signal function are called.
getenv(*s) Searches an environment list for a string s. Returns a pointer to the contents of s.
NOTE: this function is not implemented because there is no OS.
system(*s) Passes the string s to the environment for execution.
NOTE: this function is not implemented because there is no OS.

Searching and sorting

bsearch(*key, *base, n, size, *cmp) This function searches in an array of n members, for the object pointed to by key. The initial base of the array is given by base. The size of each member is specified by size. The given array must be sorted in ascending order, according to the results of the function pointed to by cmp. Returns a pointer to the matching member in the array, or NULL when not found.
qsort(*base, n, size, *cmp) This function sorts an array of n members using the quick sort algorithm. The initial base of the array is given by base. The size of each member is specified by size. The array is sorted in ascending order, according to the results of the function pointed to by cmp.

Integer arithmetic

int abs(j) long labs(j) long long llabs(j) Compute the absolute value of an int, long int, and long long int j respectively.
div_t div(x,y) ldiv_t ldiv(x,y) lldiv_t lldiv(x,y) Compute x/y and x%y in a single operation. X and y have respectively type int, long int and long long int. The result is stored in the members quot and rem of struct div_t, ldiv_t and lldiv_t which have the same types.
Multibyte/wide character and string conversions

### mblen(*s, n)
Determines the number of bytes in the multi-byte character pointed to by s. At most n characters will be examined. (See also mbrlen in Section 10.1.27, wchar.h).

### mbtowc(*pwc, *s, n)
Converts the multi-byte character in s to a wide character code and stores it in pwc. At most n characters will be examined.

### wctomb(*s, wc)
Converts the wide character wc into a multi-byte representation and stores it in the string pointed to by s. At most MB_CUR_MAX characters are stored.

### mbstowcs(*pwcs, *s, n)
Converts a sequence of multi-byte characters in the string pointed to by s into a sequence of wide characters and stores at most n wide characters into the array pointed to by pwcs. (See also mbsrtowcs in Section 10.1.27, wchar.h).

### wcstombs(*s, *pwcs, n)
Converts a sequence of wide characters in the array pointed to by pwcs into multi-byte characters and stores at most n multi-byte characters into the string pointed to by s. (See also wcscrtowmb in Section 10.1.27, wchar.h).

#### 10.1.24. string.h and wchar.h

This header file provides numerous functions for manipulating strings. By convention, strings in C are arrays of characters with a terminating null character. Most functions therefore take arguments of type *char. However, many functions have also parallel wide character functions which take arguments of type *wchar_t. These functions are declared in wchar.h.

### Copying and concatenation functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memcpy(*s1, *s2, n)</td>
<td>wmemcpy(*s1, *s2, n)</td>
<td>Copies n characters from *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>memmove(*s1, *s2, n)</td>
<td>wmemmove(*s1, *s2, n)</td>
<td>Same as memcpy, but overlapping strings are handled correctly. Returns *s1.</td>
</tr>
<tr>
<td>strcpy(*s1, *s2)</td>
<td>wcsncpy(*s1, *s2)</td>
<td>Copies *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strncpy(*s1, *s2, n)</td>
<td>wcsncpy(*s1, *s2, n)</td>
<td>Copies not more than n characters from *s2 into *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strcat(*s1, *s2)</td>
<td>wcscat(*s1, *s2)</td>
<td>Appends a copy of *s2 to *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
<tr>
<td>strcat(*s1, *s2, n)</td>
<td>wcsncat(*s1, *s2, n)</td>
<td>Appends not more than n characters from *s2 to *s1 and returns *s1. If *s1 and *s2 overlap the result is undefined.</td>
</tr>
</tbody>
</table>

### Comparison functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>memcmp(*s1, *s2, n)</td>
<td>wmempcmp(*s1, *s2, n)</td>
<td>Compares the first n characters of *s1 to the first n characters of *s2. Returns &lt; 0 if *s1 &lt; *s2, 0 if *s1 == *s2, or &gt; 0 if *s1 &gt; *s2.</td>
</tr>
</tbody>
</table>
### Search functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>memchr(*s, c, n)</code></td>
<td><code>wmemchr(*s, c, n)</code></td>
<td>Checks the first <code>n</code> characters of <code>s</code> on the occurrence of character <code>c</code>. Returns a pointer to the found character.</td>
</tr>
<tr>
<td><code>strchr(*s, c)</code></td>
<td><code>wcschr(*s, c)</code></td>
<td>Returns a pointer to the first occurrence of character <code>c</code> in <code>s</code> or the null pointer if not found.</td>
</tr>
<tr>
<td><code>strrchr(*s, c)</code></td>
<td><code>wcsrchr(*s, c)</code></td>
<td>Returns a pointer to the last occurrence of character <code>c</code> in <code>s</code> or the null pointer if not found.</td>
</tr>
<tr>
<td><code>strspn(*s, *set)</code></td>
<td><code>wcsspn(*s, *set)</code></td>
<td>Searches <code>s</code> for a sequence of characters specified in <code>set</code>. Returns the length of the first sequence found.</td>
</tr>
<tr>
<td><code>strcspn(*s, *set)</code></td>
<td><code>wcsccspn(*s, *set)</code></td>
<td>Searches <code>s</code> for a sequence of characters not specified in <code>set</code>. Returns the length of the first sequence found.</td>
</tr>
<tr>
<td><code>strpbrk(*s, *set)</code></td>
<td><code>wcspbrk(*s, *set)</code></td>
<td>Same as <code>strspn/wcsspn</code> but returns a pointer to the first character in <code>s</code> that also is specified in <code>set</code>.</td>
</tr>
<tr>
<td><code>strstr(*s, *sub)</code></td>
<td><code>wcsstr(*s, *sub)</code></td>
<td>Searches for a substring <code>*sub</code> in <code>s</code>. Returns a pointer to the first occurrence of <code>*sub</code> in <code>s</code>.</td>
</tr>
<tr>
<td><code>strtok(*s, *dlm)</code></td>
<td><code>wcstok(*s, *dlm)</code></td>
<td>A sequence of calls to this function breaks the string <code>*s</code> into a sequence of tokens delimited by a character specified in <code>*dlm</code>. The token found in <code>*s</code> is terminated with a null character. Returns a pointer to the first position in <code>*s</code> of the token.</td>
</tr>
</tbody>
</table>

### Miscellaneous functions

<table>
<thead>
<tr>
<th>string.h</th>
<th>wchar.h</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>memset(*s, c, n)</code></td>
<td><code>wmemset(*s, c, n)</code></td>
<td>Fills the first <code>n</code> bytes of <code>s</code> with character <code>c</code> and returns <code>s</code>.</td>
</tr>
</tbody>
</table>
 Typically, the values for errno come from \texttt{int errno}. This function returns a pointer to the associated error message. (See also Section 10.1.5, \texttt{errno.h})

\begin{tabular}{|l|l|l|}
\hline
\textbf{string.h} & \textbf{wchar.h} & \textbf{Description} \\
\hline
\texttt{strerror} (\texttt{errno}) & & Typically, the values for errno come from \texttt{int errno}. This function returns a pointer to the associated error message. (See also Section 10.1.5, \texttt{errno.h}) \\
\hline
\texttt{strlen} (\texttt{*s}) & \texttt{wcslen} (\texttt{*s}) & Returns the length of string \texttt{*s}. \\
\hline
\end{tabular}

\section*{10.1.25. \texttt{time.h} and \texttt{wchar.h}}

The header file \texttt{time.h} provides facilities to retrieve and use the (calendar) date and time, and the process time. Time can be represented as an integer value, or can be broken-down in components. Two arithmetic data types are defined which are capable of holding the integer representation of times:

\begin{verbatim}
clock_t unsigned long long
time_t unsigned long
\end{verbatim}

The type \texttt{struct tm} below is defined according to ISO C99 with one exception: this implementation does not support leap seconds. The \texttt{struct tm} type is defines as follows:

\begin{verbatim}
struct tm
{
  int   tm_sec;       /* seconds after the minute - [0, 59] */
  int   tm_min;       /* minutes after the hour - [0, 59] */
  int   tm_hour;      /* hours since midnight - [0, 23] */
  int   tm_mday;      /* day of the month - [1, 31] */
  int   tm_mon;       /* months since January - [0, 11] */
  int   tm_year;      /* year since 1900 */
  int   tm_wday;      /* days since Sunday - [0, 6] */
  int   tm_yday;      /* days since January 1 - [0, 365] */
  int   tm_isdst;     /* Daylight Saving Time flag */
};
\end{verbatim}

\subsection*{Time manipulation}

\texttt{clock} \hspace{1cm} Returns the application's best approximation to the processor time used by the program since it was started. This low-level routine is not implemented because it strongly depends on the hardware. To determine the time in seconds, the result of \texttt{clock} should be divided by the value defined by \texttt{CLOCKS_PER_SEC}.

\texttt{difftime} (\texttt{t1}, \texttt{t0}) \hspace{1cm} Returns the difference \texttt{t1-t0} in seconds.

\texttt{mktime} (\texttt{tm} \texttt{*tp}) \hspace{1cm} Converts the broken-down time in the structure pointed to by \texttt{tp}, to a value of type \texttt{time_t}. The return value has the same encoding as the return value of the \texttt{time} function.

\texttt{time} (\texttt{*timer}) \hspace{1cm} Returns the current calendar time. This value is also assigned to \texttt{*timer}.

\subsection*{Time conversion}

\texttt{asctime} (\texttt{tm} \texttt{*tp}) \hspace{1cm} Converts the broken-down time in the structure pointed to by \texttt{tp} into a string in the form \texttt{Mon Feb 04 16:15:14 2013
\n0}. Returns a pointer to this string.
ctime(*timer) Converts the calendar time pointed to by timer to local time in the form of a string. This is equivalent to: asctime(localtime(timer))

gmtime(*timer) Converts the calendar time pointed to by timer to the broken-down time, expressed as UTC. Returns a pointer to the broken-down time.

localtime(*timer) Converts the calendar time pointed to by timer to the broken-down time, expressed as local time. Returns a pointer to the broken-down time.

**Formatted time**

The next function has a parallel function defined in wchar.h:

<table>
<thead>
<tr>
<th>time.h</th>
<th>wchar.h</th>
</tr>
</thead>
<tbody>
<tr>
<td>strftime(*s, smax, *fmt, tm *tp)</td>
<td>wcsftime(*s, smax, *fmt, tm *tp)</td>
</tr>
</tbody>
</table>

Formats date and time information from struct tm *tp into *s according to the specified format *fmt. No more than smax characters are placed into *s. The formatting of strftime is locale-specific using the LC_TIME category (see Section 10.1.13, locale.h).

You can use the next conversion specifiers:

- %a  abbreviated weekday name
- %A  full weekday name
- %b  abbreviated month name
- %B  full month name
- %c  locale-specific date and time representation (same as %a %b %e %T %Y)
- %G  last two digits of the year
- %d  day of the month (01-31)
- %D  same as %m/%d/%y
- %e  day of the month (1-31), with single digits preceded by a space
- %F  ISO 8601 date format: %Y-%m-%d
- %g  last two digits of the week based year (00-99)
- %G  week based year (0000-9999)
- %h  same as %b
- %H  hour, 24-hour clock (00-23)
- %I  hour, 12-hour clock (01-12)
- %j  day of the year (001-366)
- %m  month (01-12)
- %M  minute (00-59)
- %n  replaced by newline character
- %p  locale’s equivalent of AM or PM
- %r  locale’s 12-hour clock time; same as %I:%M:%S %p
The file unistd.h contains standard UNIX I/O functions. These functions are all implemented using file system simulation. Except for lstat and fstat which are not implemented. This header file is not defined in ISO C99.

```c
access(*name,mode)  Use file system simulation to check the permissions of a file on the host. mode specifies the type of access and is a bit pattern constructed by a logical OR of the following values:

R_OK  Checks read permission.
W_OK  Checks write permission.
X_OK  Checks execute (search) permission.
F_OK  Checks to see if the file exists.

(FSS implementation)
```

```c
chdir(*path)  Use file system simulation to change the current directory on the host to the directory indicated by path. (FSS implementation)
```

```c
close(fd)  File close function. The given file descriptor should be properly closed. This function calls _close(). (FSS implementation)
```

```c
getcwd(*buf,size)  Use file system simulation to retrieve the current directory on the host. Returns the directory name. (FSS implementation)
```

```c
lseek(fd,offset,whence)  Moves read-write file offset. Calls _lseek(). (FSS implementation)
```

```c
read(fd,*buff,cnt)  Reads a sequence of characters from a file. This function calls _read(). (FSS implementation)
```
stat(*name,*buff)  Use file system simulation to stat() a file on the host platform. (FSS implementation)

lstat(*name,*buff)  This function is identical to stat(), except in the case of a symbolic link, where the link itself is 'stat'-ed, not the file that it refers to. (Not implemented)

fstat(fd,*buff)  This function is identical to stat(), except that it uses a file descriptor instead of a name. (Not implemented)

unlink(*name)  Removes the named file, so that a subsequent attempt to open it fails. (FSS implementation)

write(fd,*buff,cnt)  Write a sequence of characters to a file. Calls _write().(FSS implementation)

10.1.27. wchar.h

Many functions in wchar.h represent the wide character variant of other functions so these are discussed together. (See Section 10.1.22, stdio.h and wchar.h, Section 10.1.23, stdlib.h and wchar.h, Section 10.1.24, string.h and wchar.h and Section 10.1.25, time.h and wchar.h).

The remaining functions are described below. They perform conversions between multi-byte characters and wide characters. In these functions, ps points to struct mbstate_t which holds the conversion state information necessary to convert between sequences of multibyte characters and wide characters:

typedef struct
{
  wchar_t wc_value;  /* wide character value solved so far */
  unsigned short n_bytes;  /* number of bytes of solved multibyte */
  unsigned short encoding;  /* encoding rule for wide character <=> multibyte conversion */
} mbstate_t;

When multibyte characters larger than 1 byte are used, this struct will be used to store the conversion information when not all the bytes of a particular multibyte character have been read from the source. In this implementation, multi-byte characters are 1 byte long (MB_CUR_MAX and MB_LEN_MAX are defined as 1) and this will never occur.

mbsinit(*ps)  Determines whether the object pointed to by ps, is an initial conversion state. Returns a non-zero value if so.

mbstowcs(*pwcs,**src,n,*ps)  Restartable version of mbstowcs. See Section 10.1.23, stdlib.h and wchar.h. The initial conversion state is specified by ps. The input sequence of multibyte characters is specified indirectly by src.

wcsrtombs(*s,**src,n,*ps)  Restartable version of wcstombs. See Section 10.1.23, stdlib.h and wchar.h. The initial conversion state is specified by ps. The input wide string is specified indirectly by src.

mbrtowc(*pwc,*s,n,*ps)  Converts a multibyte character *s to a wide character *pwc according to conversion state ps. See also mbtowc in Section 10.1.23, stdlib.h and wchar.h.
wcrtomb(*s, wc, *ps) Converts a wide character wc to a multi-byte character according to conversion state ps and stores the multi-byte character in *s.
btowc(c) Returns the wide character corresponding to character c. Returns WEOF on error.
wctob(c) Returns the multi-byte character corresponding to the wide character c. The returned multi-byte character is represented as one byte. Returns EOF on error.
mbrlen(*s, n, *ps) Inspects up to n bytes from the string *s to see if those characters represent valid multibyte characters, relative to the conversion state held in *ps.

10.1.28. wctype.h

Most functions in wctype.h represent the wide character variant of functions declared in ctype.h and are discussed in Section 10.1.3, ctype.h and wctype.h. In addition, this header file provides extensible, locale specific functions and wide character classification.

wctype(*property) Constructs a value of type wctype_t that describes a class of wide characters identified by the string *property. If property identifies a valid class of wide characters according to the LC_TYPE category (see Section 10.1.13, locale.h) of the current locale, a non-zero value is returned that can be used as an argument in the iswctype function.

iswctype(wc, desc) Tests whether the wide character wc is a member of the class represented by wctype_t desc. Returns a non-zero value if tested true.

<table>
<thead>
<tr>
<th>Function</th>
<th>Equivalent to locale specific test</th>
</tr>
</thead>
<tbody>
<tr>
<td>iswalnum(wc)</td>
<td>iswctype(wc, wctype(&quot;alnum&quot;))</td>
</tr>
<tr>
<td>iswalpha(wc)</td>
<td>iswctype(wc, wctype(&quot;alpha&quot;))</td>
</tr>
<tr>
<td>iswcntrl(wc)</td>
<td>iswctype(wc, wctype(&quot;cntrl&quot;))</td>
</tr>
<tr>
<td>iswdigit(wc)</td>
<td>iswctype(wc, wctype(&quot;digit&quot;))</td>
</tr>
<tr>
<td>iswgraph(wc)</td>
<td>iswctype(wc, wctype(&quot;graph&quot;))</td>
</tr>
<tr>
<td>iswlower(wc)</td>
<td>iswctype(wc, wctype(&quot;lower&quot;))</td>
</tr>
<tr>
<td>iswprint(wc)</td>
<td>iswctype(wc, wctype(&quot;print&quot;))</td>
</tr>
<tr>
<td>iswpunct(wc)</td>
<td>iswctype(wc, wctype(&quot;punct&quot;))</td>
</tr>
<tr>
<td>iswspace(wc)</td>
<td>iswctype(wc, wctype(&quot;space&quot;))</td>
</tr>
<tr>
<td>iswupper(wc)</td>
<td>iswctype(wc, wctype(&quot;upper&quot;))</td>
</tr>
<tr>
<td>iswdxdigit(wc)</td>
<td>iswctype(wc, wctype(&quot;xdigit&quot;))</td>
</tr>
</tbody>
</table>

wctrans(*property) Constructs a value of type wctype_t that describes a mapping between wide characters identified by the string *property. If property identifies a valid mapping of wide characters according to the LC_TYPE category (see Section 10.1.13, locale.h) of the current locale, a non-zero value is returned that can be used as an argument in the towctrans function.
towctrans(wc, desc)  Transforms wide character wc into another wide character, described by desc.

<table>
<thead>
<tr>
<th>Function</th>
<th>Equivalent to locale specific transformation</th>
</tr>
</thead>
<tbody>
<tr>
<td>towlower(wc)</td>
<td>towctrans(wc, wcstrans(&quot;tolower&quot;))</td>
</tr>
<tr>
<td>towupper(wc)</td>
<td>towctrans(wc, wcstrans(&quot;toupper&quot;))</td>
</tr>
</tbody>
</table>

### 10.2. C Library Reentrancy

Some of the functions in the C library are reentrant, others are not. The table below shows the functions in the C library, and whether they are reentrant or not. A dash means that the function is reentrant. Note that some of the functions are not reentrant because they set the global variable 'errno' (or call other functions that eventually set 'errno'). If your program does not check this variable and errno is the only reason for the function not being reentrant, these functions can be assumed reentrant as well.

The explanation of the cause why a function is not reentrant sometimes refers to a footnote because the explanation is too lengthy for the table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Not reentrant because</th>
</tr>
</thead>
<tbody>
<tr>
<td>_close</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_doflt</td>
<td>Uses I/O functions which modify iob[]. See (1).</td>
</tr>
<tr>
<td>_doprint</td>
<td>Uses indirect access to static iob[ ] array. See (1).</td>
</tr>
<tr>
<td>_doscan</td>
<td>Uses indirect access to iob[ ] and calls ungetc (access to local static ungetc[ ] buffer). See (1).</td>
</tr>
<tr>
<td>_Exit</td>
<td>See exit.</td>
</tr>
<tr>
<td>_filbuf</td>
<td>Uses iob[ ], which is not reentrant. See (1).</td>
</tr>
<tr>
<td>_flsbuf</td>
<td>Uses iob[ ]. See (1).</td>
</tr>
<tr>
<td>_getfltt</td>
<td>Uses iob[ ]. See (1).</td>
</tr>
<tr>
<td>_iob</td>
<td>Defines static iob[ ]. See (1).</td>
</tr>
<tr>
<td>_lseek</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_open</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_read</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_unlink</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>_write</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>abort</td>
<td>Calls exit</td>
</tr>
<tr>
<td>abs labs llabs</td>
<td>-</td>
</tr>
<tr>
<td>access</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>acos acosf acosl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>acosh acoshf acoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>asctime</td>
<td>asctime defines static array for broken-down time string.</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>asin asinf asinl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>asinh asinhf asinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>atan atanf atanl</td>
<td>-</td>
</tr>
<tr>
<td>atan2 atan2f atan2l</td>
<td>-</td>
</tr>
<tr>
<td>atanh atanhf atanhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>atexit</td>
<td>atexit defines static array with function pointers to execute at exit of program.</td>
</tr>
<tr>
<td>atof</td>
<td>-</td>
</tr>
<tr>
<td>atoi</td>
<td>-</td>
</tr>
<tr>
<td>atol</td>
<td>-</td>
</tr>
<tr>
<td>bsearch</td>
<td>-</td>
</tr>
<tr>
<td>btowc</td>
<td>-</td>
</tr>
<tr>
<td>cabs cabsf cabsl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cacos cacosf cacosl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cacosh cacosh cfacoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>calloc</td>
<td>calloc uses static buffer management structures. See malloc (5).</td>
</tr>
<tr>
<td>carg cargf cargl</td>
<td>-</td>
</tr>
<tr>
<td>casin casinf casinl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>casinh casinhf cfasinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>catan catanf catanl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>catanh catanhf catanhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cbrt cbrtf cbrtl</td>
<td>-</td>
</tr>
<tr>
<td>ccos ccosf ccosl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ccosh ccoshf ccoshl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ceil ceilf ceill</td>
<td>-</td>
</tr>
<tr>
<td>cexp cexpf cexpl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>chdir</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>cimag cimagf cimagl</td>
<td>-</td>
</tr>
<tr>
<td>cleanup</td>
<td>Calls fclose. See (1)</td>
</tr>
<tr>
<td>clearerr</td>
<td>Modifies iob[]. See (1)</td>
</tr>
<tr>
<td>clock</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>clog clogf clogl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>close</td>
<td>Calls _close</td>
</tr>
<tr>
<td>conj conjf conjl</td>
<td>-</td>
</tr>
<tr>
<td>copysign copysignf copysignl</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>--------------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>cos cosf cosl</td>
<td>-</td>
</tr>
<tr>
<td>cosh coshf coshl</td>
<td>cosh calls exp(), which sets errno. If errno is discarded, cosh is reentrant.</td>
</tr>
<tr>
<td>cpow cpowf cpowl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>cproj cprojf cprojl</td>
<td>-</td>
</tr>
<tr>
<td>creal crealf creall</td>
<td>-</td>
</tr>
<tr>
<td>csin csinf csinl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>csinh csinhf csinhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>csqrt csqrtf csqrtl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctan ctanf ctanl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctanh ctanhf ctanhl</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ctime</td>
<td>Calls asctime</td>
</tr>
<tr>
<td>difftime</td>
<td>-</td>
</tr>
<tr>
<td>div ldiv lldiv</td>
<td>-</td>
</tr>
<tr>
<td>erf erfl erf</td>
<td>-</td>
</tr>
<tr>
<td>erfc erfcf erfcl</td>
<td>-</td>
</tr>
<tr>
<td>exit</td>
<td>Calls fclose indirectly which uses iob[] calls functions in _atexit array. See (1). To make exit reentrant kernel support is required.</td>
</tr>
<tr>
<td>exp expf expl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>exp2 exp2f exp2l</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>expm1 expm1f expm1l</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>fabs fabsf fabsl</td>
<td>-</td>
</tr>
<tr>
<td>fclose</td>
<td>Uses values in iob[]. See (1).</td>
</tr>
<tr>
<td>fdim fdimf fdiml</td>
<td>-</td>
</tr>
<tr>
<td>feclearexcept</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fegetenv</td>
<td>- (reads PSW bits)</td>
</tr>
<tr>
<td>fegetexceptflag</td>
<td>- (reads PSW bits via calls to other functions)</td>
</tr>
<tr>
<td>fegetround</td>
<td>- (reads PSW bits)</td>
</tr>
<tr>
<td>feholdexcept</td>
<td>Reads/writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>feof</td>
<td>Uses values in iob[]. See (1).</td>
</tr>
<tr>
<td>feraiseexcept</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>ferror</td>
<td>Uses values in iob[]. See (1).</td>
</tr>
<tr>
<td>fesetenv</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fesetexceptflag</td>
<td>Writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>fesetround</td>
<td>Writes PSW bits.</td>
</tr>
<tr>
<td>fetestexcept</td>
<td>- (reads PSW bits)</td>
</tr>
</tbody>
</table>

Libraries
<table>
<thead>
<tr>
<th>Function</th>
<th>Not reentrant because</th>
</tr>
</thead>
<tbody>
<tr>
<td>feupdateenv</td>
<td>Writes PSW bits via calls to other functions.</td>
</tr>
<tr>
<td>fflush</td>
<td>Modifies iob[]. See (1).</td>
</tr>
<tr>
<td>fgetc fgetwc fgetws</td>
<td></td>
</tr>
<tr>
<td>fseek</td>
<td>Sets the variable errno and uses pointer to iob[]. See (1) / (2).</td>
</tr>
<tr>
<td>fstat</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>ftell</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>fsetpos</td>
<td>Calls fgetc. See (1).</td>
</tr>
<tr>
<td>free</td>
<td>Uses iob[] and calls malloc when file open for buffered I/O. See (1)</td>
</tr>
<tr>
<td>freopen</td>
<td>Uses iob[] and calls malloc when file open for buffered I/O. See (1)</td>
</tr>
<tr>
<td>fread</td>
<td>Uses iob[] and sets errno. See (1) / (2).</td>
</tr>
<tr>
<td>fwrite</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>fputc fputwc fputws</td>
<td></td>
</tr>
<tr>
<td>fputc getwc getwchar</td>
<td></td>
</tr>
<tr>
<td>gtime</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>getenv</td>
<td>Skeleton only.</td>
</tr>
<tr>
<td>gets getws</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>hypot</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>ilogb ilogbf ilogbl</td>
<td></td>
</tr>
<tr>
<td>imaxabs</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>imaxdiv</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>isalnum</td>
<td></td>
</tr>
<tr>
<td>iswalnum</td>
<td></td>
</tr>
<tr>
<td>isalpha</td>
<td></td>
</tr>
<tr>
<td>iswalpha</td>
<td></td>
</tr>
<tr>
<td>isascii</td>
<td></td>
</tr>
<tr>
<td>iswascci</td>
<td></td>
</tr>
<tr>
<td>iscntrl</td>
<td></td>
</tr>
<tr>
<td>iswcntrl</td>
<td></td>
</tr>
<tr>
<td>isdigit</td>
<td></td>
</tr>
<tr>
<td>iswdigit</td>
<td></td>
</tr>
<tr>
<td>isfinite</td>
<td></td>
</tr>
<tr>
<td>isgreater</td>
<td></td>
</tr>
<tr>
<td>isgreaterequal</td>
<td></td>
</tr>
<tr>
<td>isinf</td>
<td></td>
</tr>
<tr>
<td>isless</td>
<td></td>
</tr>
<tr>
<td>islessequal</td>
<td></td>
</tr>
<tr>
<td>islessgreater</td>
<td></td>
</tr>
<tr>
<td>islower</td>
<td></td>
</tr>
<tr>
<td>iswlower</td>
<td></td>
</tr>
<tr>
<td>isnan</td>
<td></td>
</tr>
<tr>
<td>isnormal</td>
<td></td>
</tr>
<tr>
<td>iswprint</td>
<td></td>
</tr>
<tr>
<td>iswprint</td>
<td></td>
</tr>
<tr>
<td>ispunct</td>
<td></td>
</tr>
<tr>
<td>iswpunct</td>
<td></td>
</tr>
<tr>
<td>isspace</td>
<td></td>
</tr>
<tr>
<td>iswspace</td>
<td></td>
</tr>
<tr>
<td>isunordered</td>
<td></td>
</tr>
<tr>
<td>isupper</td>
<td></td>
</tr>
<tr>
<td>iswupper</td>
<td></td>
</tr>
<tr>
<td>iswalnum</td>
<td></td>
</tr>
<tr>
<td>iswalpha</td>
<td></td>
</tr>
<tr>
<td>iswcntrl</td>
<td></td>
</tr>
<tr>
<td>iswctype</td>
<td></td>
</tr>
<tr>
<td>iswdigit</td>
<td></td>
</tr>
<tr>
<td>iswgraph</td>
<td></td>
</tr>
<tr>
<td>iswlower</td>
<td></td>
</tr>
<tr>
<td>iswlower</td>
<td></td>
</tr>
<tr>
<td>iswprint</td>
<td></td>
</tr>
<tr>
<td>iswpunct</td>
<td></td>
</tr>
<tr>
<td>iswpunct</td>
<td></td>
</tr>
<tr>
<td>iswaspace</td>
<td></td>
</tr>
<tr>
<td>iswaspace</td>
<td></td>
</tr>
<tr>
<td>iswupper</td>
<td></td>
</tr>
<tr>
<td>iswxdigit</td>
<td></td>
</tr>
<tr>
<td>iswxdigit</td>
<td></td>
</tr>
<tr>
<td>ldexp</td>
<td></td>
</tr>
<tr>
<td>ldexpf</td>
<td></td>
</tr>
<tr>
<td>ldexpl</td>
<td></td>
</tr>
<tr>
<td>ldexp</td>
<td></td>
</tr>
</tbody>
</table>

Sets errno. See (2).
<table>
<thead>
<tr>
<th>Function</th>
<th>Not reentrant because</th>
</tr>
</thead>
<tbody>
<tr>
<td>lgamma, lgammaf, lgammal</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>llrint, llrintf, llrintl</td>
<td>-</td>
</tr>
<tr>
<td>llround, llroundf, llroundl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>localeconv</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>localtime</td>
<td>-</td>
</tr>
<tr>
<td>log, logf, logl</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>log10, log10f, log10l</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>log1p, log1pf, log1pl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>log2, log2f, log2l</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>logb, logbf, logbl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>longjmp</td>
<td>-</td>
</tr>
<tr>
<td>lrint, lrintf, lrintl</td>
<td>-</td>
</tr>
<tr>
<td>lround, lroundf, lroundl</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>lseek</td>
<td>Calls _lseek</td>
</tr>
<tr>
<td>lstat</td>
<td>(Not implemented)</td>
</tr>
<tr>
<td>malloc</td>
<td>Needs kernel support. See (5).</td>
</tr>
<tr>
<td>mblen</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>mbrlen</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>mbrtowc</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>mbsinit</td>
<td>-</td>
</tr>
<tr>
<td>mbsrtowcs</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>mbstowcs</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>mbtowc</td>
<td>N.A., skeleton function</td>
</tr>
<tr>
<td>memchr, wmemchr</td>
<td>-</td>
</tr>
<tr>
<td>memcmp, wmemcmp</td>
<td>-</td>
</tr>
<tr>
<td>memcpy, wmemcpy</td>
<td>-</td>
</tr>
<tr>
<td>memmove, wmemmove</td>
<td>-</td>
</tr>
<tr>
<td>memset, wmemset</td>
<td>-</td>
</tr>
<tr>
<td>mktime</td>
<td>-</td>
</tr>
<tr>
<td>modf, modff, modfl</td>
<td>-</td>
</tr>
<tr>
<td>nan, nanf, nanl</td>
<td>-</td>
</tr>
<tr>
<td>nearbyint, nearbyintf</td>
<td>-</td>
</tr>
<tr>
<td>nearbyintl</td>
<td>-</td>
</tr>
<tr>
<td>nextafter, nextafterf</td>
<td>-</td>
</tr>
<tr>
<td>nextafterl</td>
<td>-</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td><code>nexttoward</code> <code>nexttowardf</code> <code>nexttowardl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>offsetof</code></td>
<td>Calls <code>_open</code></td>
</tr>
<tr>
<td><code>open</code></td>
<td></td>
</tr>
<tr>
<td><code>perror</code></td>
<td>Uses errno. See (2)</td>
</tr>
<tr>
<td><code>pow</code> <code>powf</code> <code>powl</code></td>
<td>Sets errno. See (2)</td>
</tr>
<tr>
<td><code>printf</code> <code>wprintf</code></td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td><code>putc</code> <code>putwc</code></td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td><code>putwchar</code></td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td><code>puts</code></td>
<td>Uses iob[]. See (1)</td>
</tr>
<tr>
<td><code>qsort</code></td>
<td></td>
</tr>
<tr>
<td><code>raise</code></td>
<td>Updates the signal handler table</td>
</tr>
<tr>
<td><code>rand</code></td>
<td>Uses static variable to remember latest random number. Must diverge from ISO C standard to define reentrant rand. See (4).</td>
</tr>
<tr>
<td><code>read</code></td>
<td>Calls <code>_read</code></td>
</tr>
<tr>
<td><code>realloc</code></td>
<td>See malloc (5).</td>
</tr>
<tr>
<td><code>remainder</code> <code>remainderf</code> <code>remainderl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>remove</code></td>
<td>Uses global File System Simulation buffer, <code>_dbg_request</code></td>
</tr>
<tr>
<td><code>remquo</code> <code>remquof</code> <code>remquol</code></td>
<td>-</td>
</tr>
<tr>
<td><code>rename</code></td>
<td>Uses global File System Simulation buffer, <code>_dbg_request</code></td>
</tr>
<tr>
<td><code>rewind</code></td>
<td>Eventually calls <code>_seek</code></td>
</tr>
<tr>
<td><code>rint</code> <code>rintf</code> <code>rintl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>round</code> <code>roundf</code> <code>roundl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>scalbln</code> <code>scalblnf</code> <code>scalblnl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>scalbn</code> <code>scalbnf</code> <code>scalbnl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>scanf</code> <code>wscanf</code></td>
<td>Uses iob[], calls <code>_doscan</code>. See (1).</td>
</tr>
<tr>
<td><code>setbuf</code></td>
<td>Sets iob[]. See (1).</td>
</tr>
<tr>
<td><code>setjmp</code></td>
<td>-</td>
</tr>
<tr>
<td><code>setlocale</code></td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td><code>setvbuf</code></td>
<td>Sets iob and calls malloc. See (1) / (5).</td>
</tr>
<tr>
<td><code>signal</code></td>
<td>Updates the signal handler table</td>
</tr>
<tr>
<td><code>signbit</code></td>
<td>-</td>
</tr>
<tr>
<td><code>sin</code> <code>sinf</code> <code>sinl</code></td>
<td>-</td>
</tr>
<tr>
<td><code>sinh</code> <code>sinhf</code> <code>sinhl</code></td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td><code>snprintf</code> <code>swprintf</code></td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>----------------</td>
<td>-----------------------------------------------------------</td>
</tr>
<tr>
<td>sprintf</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>sqrt sqrtf sqrtl</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>srand</td>
<td>See rand</td>
</tr>
<tr>
<td>sscanf swscanf</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>stat</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>strcat wcscat</td>
<td>-</td>
</tr>
<tr>
<td>strchr wcschr</td>
<td>-</td>
</tr>
<tr>
<td>strcmp wcscmp</td>
<td>-</td>
</tr>
<tr>
<td>strcoll wcscoll</td>
<td>-</td>
</tr>
<tr>
<td>strcpy wcscpy</td>
<td>-</td>
</tr>
<tr>
<td>strcspn wcscspn</td>
<td>-</td>
</tr>
<tr>
<td>strerror</td>
<td>-</td>
</tr>
<tr>
<td>strftime wcsftime</td>
<td>-</td>
</tr>
<tr>
<td>strlen wcslen</td>
<td>-</td>
</tr>
<tr>
<td>strncat wcsncat</td>
<td>-</td>
</tr>
<tr>
<td>strncpy wcscpy</td>
<td>-</td>
</tr>
<tr>
<td>strncpy wcscmp</td>
<td>-</td>
</tr>
<tr>
<td>strrchr wcscrp</td>
<td>-</td>
</tr>
<tr>
<td>strerror</td>
<td>-</td>
</tr>
<tr>
<td>strptime wcst ime</td>
<td>-</td>
</tr>
<tr>
<td>strtok wcstok</td>
<td>strtok saves last position in string in local static variable. This function is not reentrant by design. See (4).</td>
</tr>
<tr>
<td>strtol wcstol</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>strtol wcstold</td>
<td>-</td>
</tr>
<tr>
<td>strtoul wcstoul</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>strtoull wcstoull</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>strtoimax</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>strxfrm wcsxfrm</td>
<td>-</td>
</tr>
<tr>
<td>system</td>
<td>N.A; skeleton function</td>
</tr>
<tr>
<td>tan tanf tanh</td>
<td>Sets errno. See (2).</td>
</tr>
<tr>
<td>tanh tanhf tanhl</td>
<td>Sets errno via call to other functions.</td>
</tr>
<tr>
<td>Function</td>
<td>Not reentrant because</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>tgamma tgammaf tgammal</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>time</td>
<td>Uses static variable which defines initial start time</td>
</tr>
<tr>
<td>tmpfile</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>tmpnam</td>
<td>Uses local buffer to build filename. Function can be adapted to use user buffer. This makes the function non ISO C. See (4).</td>
</tr>
<tr>
<td>toascii</td>
<td>-</td>
</tr>
<tr>
<td>tolower</td>
<td>-</td>
</tr>
<tr>
<td>toupper</td>
<td>-</td>
</tr>
<tr>
<td>towctrans</td>
<td>-</td>
</tr>
<tr>
<td>tolower</td>
<td>-</td>
</tr>
<tr>
<td>towupper</td>
<td>-</td>
</tr>
<tr>
<td>trunc truncf truncl</td>
<td>-</td>
</tr>
<tr>
<td>ungetc ungetwc</td>
<td>Uses static buffer to hold unget characters for each file. Can be moved into iob structure. See (1).</td>
</tr>
<tr>
<td>unlink</td>
<td>Uses global File System Simulation buffer, _dbg_request</td>
</tr>
<tr>
<td>vfprintf vfwprintf</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>vfscanf vfwscanff</td>
<td>Calls _doscan</td>
</tr>
<tr>
<td>vprintf vwprintff</td>
<td>Uses iob[]. See (1).</td>
</tr>
<tr>
<td>vscanf vwscanff</td>
<td>Calls _doscan</td>
</tr>
<tr>
<td>vsprintf vswprintf</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>vsscanf vswscanff</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>wcrtomb</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>wcsrtombs</td>
<td>Sets errno.</td>
</tr>
<tr>
<td>wcstoiimax</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>wcstombs</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>wcstouimax</td>
<td>Sets errno via calls to other functions.</td>
</tr>
<tr>
<td>wctob</td>
<td>-</td>
</tr>
<tr>
<td>wcwidth</td>
<td>N.A.; skeleton function</td>
</tr>
<tr>
<td>wcwidth</td>
<td>-</td>
</tr>
<tr>
<td>wctype</td>
<td>-</td>
</tr>
<tr>
<td>write</td>
<td>Calls _write</td>
</tr>
</tbody>
</table>

**Table: C library reentrancy**

Several functions in the C library are not reentrant due to the following reasons:

- The `iob[]` structure is static. This influences all I/O functions.
• The `ungetc[]` array is static. This array holds the characters (one for each stream) when `ungetc()` is called.

• The variable `errno` is globally defined. Numerous functions read or modify `errno`.

• `_doprnt` and `_doscan` use static variables for e.g. character counting in strings.

• Some string functions use locally defined (static) buffers. This is prescribed by ANSI.

• `malloc` uses a static heap space.

The following description discusses these items in more detail. The numbers at the beginning of each paragraph relate to the number references in the table above.

(1) **iob structures**

The I/O part of the C library is not reentrant by design. This is mainly caused by the static declaration of the `iob[]` array. The functions which use elements of this array access these elements via pointers (`FILE *`).

Building a multi-process system that is created in one link-run is hard to do. The C language scoping rules for external variables make it difficult to create a private copy of the `iob[]` array. Currently, the `iob[]` array has external scope. Thus it is visible in every module involved in one link phase. If these modules comprise several tasks (processes) in a system each of which should have its private copy of `iob[]`, it is apparent that the `iob[]` declaration should be changed. This requires adaptation of the library to the multi-tasking environment. The library modules must use a process identification as an index for determining which `iob[]` array to use. Thus the library is suitable for interfacing to that kernel only.

Another approach for the `iob[]` declaration problem is to declare the array static in one of the modules which create a task. Thus there can be more than one `iob[]` array is the system without having conflicts at link time. This brings several restrictions: Only the module that holds the declaration of the static `iob[]` can use the standard file handles `stdin`, `stdout` and `stderr` (which are the first three entries in `iob[]`). Thus all I/O for these three file handles should be located in one module.

(2) **errno declaration**

Several functions in the C library set the global variable `errno`. After completion of the function the user program may consult this variable to see if some error occurred. Since most of the functions that set `errno` already have a return type (this is the reason for using `errno`) it is not possible to check successful completion via the return type.

The library routines can set `errno` to the values defined in `errno.h`. See the file `errno.h` for more information.

`errno` can be set to ERR_FORMAT by the print and scan functions in the C library if you specify illegal format strings.

`errno` will never be set to ERR_NOLONG or ERR_NOPPOINT since the C library supports long and pointer conversion routines for input and output.
errno can be set to ERANGE by the following functions: `exp()`, `strtol()`, `strtoul()` and `tan()`. These functions may produce results that are out of the valid range for the return type. If so, the result of the function will be the largest representable value for that type and `errno` is set to ERANGE.

`errno` is set to EDOM by the following functions: `acos()`, `asin()`, `log()`, `pow()` and `sqrt()`. If the arguments for these functions are out of their valid range (e.g. `sqrt(-1)`), `errno` is set to EDOM.

`errno` can be set to ERR_POS by the file positioning functions `ftell()`, `fsetpos()` and `fgetpos()`.

(3) ungetc

Currently the ungetc buffer is static. For each file entry in the `iob[]` structure array, there is one character available in the buffer to unget a character.

(4) local buffers

`tmpnam()` creates a temporary filename and returns a pointer to a local static buffer. This is according to the ANSI definition. Changing this function such that it creates the name in a user specified buffer requires another calling interface. Thus the function would be no longer portable.

`strtok()` scans through a string and remembers that the string and the position in the string for subsequent calls. This function is not reentrant by design. Making it reentrant requires support of a kernel to store the information on a per process basis.

`rand()` generates a sequence of random numbers. The function uses the value returned by a previous call to generate the next value in the sequence. This function can be made reentrant by specifying the previous random value as one of the arguments. However, then it is no longer a standard function.

(5) malloc

Malloc uses a heap space which is assigned at locate time. Thus this implementation is not reentrant. Making a reentrant malloc requires some sort of system call to obtain free memory space on a per process basis. This is not easy to solve within the current context of the library. This requires adaptation to a kernel.

This paragraph on reentrancy applies to multi-process environments only. If reentrancy is required for calling library functions from an exception handler, another approach is required. For such a situation it is of no use to allocate e.g. multiple `iob[]` structures. In such a situation several pieces of code in the library have to be declared 'atomic': this means that interrupts have to be disabled while executing an atomic piece of code.
## Chapter 11. List File Formats

This chapter describes the format of the assembler list file and the linker map file.

### 11.1. Assembler List File Format

The assembler list file is an additional output file of the assembler that contains information about the generated code. For details on how to generate a list file, see Section 4.5, *Generating a List File*.

The list file consists of a page header and a source listing.

#### Page header

The page header is repeated on every page:

```
TASKING VX-toolset for MCS: MCS assembler vx.yrz Build nnn SN 00000000
Title
ADDR CODE   CYCLES   LINE SOURCE LINE
```

The first line contains version information. The second line can contain a title which you can specify with the assembler control `$TITLE` and always contains a page number. The third line is empty and the fourth line contains the headings of the columns for the source listing.

With the assembler controls `$LIST ON/OFF`, `$PAGE`, and with the assembler option `--list-format` you can format the list file.

#### Source listing

The following is a sample part of a listing. An explanation of the different columns follows below.

```
<table>
<thead>
<tr>
<th>ADDR</th>
<th>CODE</th>
<th>CYCLES</th>
<th>LINE</th>
<th>SOURCE</th>
<th>LINE</th>
</tr>
</thead>
<tbody>
<tr>
<td>0000</td>
<td>33</td>
<td>; Module start</td>
<td>; .</td>
<td>.</td>
<td></td>
</tr>
<tr>
<td>0000</td>
<td>34</td>
<td>.sect '.mcstext.proc.channel1',code</td>
<td>.sect '.mcstext.proc.channel1'</td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000</td>
<td>35</td>
<td>.global process_channel1</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000</td>
<td>36</td>
<td>process_channel1: .type func</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0000</td>
<td>rrrr01A3</td>
<td>2 2</td>
<td>38</td>
<td>mrd R3,chan1_par0</td>
<td></td>
</tr>
<tr>
<td>0004</td>
<td>rrrr01A2</td>
<td>2 4</td>
<td>39</td>
<td>mrd R2,chan1_par1</td>
<td></td>
</tr>
<tr>
<td>0008</td>
<td></td>
<td></td>
<td>44</td>
<td>buf: .space 4</td>
<td></td>
</tr>
</tbody>
</table>
```
This column contains the memory address. The address is a hexadecimal number that represents the offset from the beginning of a relocatable section or the absolute address for an absolute section. The address only appears on lines that generate object code.

**CODE**

This is the object code generated by the assembler for this source line, displayed in hexadecimal format. The displayed code need not be the same as the generated code that is entered in the object module. The code can also be relocatable code. In this case the letter ‘r’ is printed for the relocatable code part in the listing. For lines that allocate space, the code field contains the text "RESERVED". For lines that initialize a buffer, the code field lists one value followed by the word "REPEATS".

**CYCLES**

The first number in this column is the number of instruction cycles needed to execute the instruction(s) as generated in the CODE field. The second number is the accumulated cycle count of this section.

**LINE**

This column contains the line number. This is a decimal number indicating each input line, starting from 1 and incrementing with each source line.

**SOURCE LINE**

This column contains the source text. This is a copy of the source line from the assembly source file.

For the **.SET** and **.EQU** directives the ADDR and CODE columns do not apply. The symbol value is listed instead.

### 11.2. Linker Map File Format

The linker map file is an additional output file of the linker that shows how the linker has mapped the sections and symbols from the various object files (.o) to output sections. The locate part shows the absolute position of each section. External symbols are listed per space with their absolute address, both sorted on symbol and sorted on address. For details on how to generate a map file, see Section 5.9, *Generating a Map File*.

With the linker option **--map-file-format** you can specify which parts of the map file you want to see.

In Eclipse the linker map file (`project.mapxml`) is generated in the output directory of the build configuration, usually **Debug** or **Release**. You can open the map file by double-clicking on the file name.
Each page displays a part of the map file. You can use the drop-down list or the Outline view to navigate through the different tables and you can use the following buttons.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>←</td>
<td>Back</td>
<td>Goes back one page in the history list.</td>
</tr>
<tr>
<td>→</td>
<td>Forward</td>
<td>Goes forward one page in the history list.</td>
</tr>
<tr>
<td>📚</td>
<td>Next Table</td>
<td>Shows the next table from the drop-down list.</td>
</tr>
<tr>
<td>📚</td>
<td>Previous Table</td>
<td>Shows the previous table from the drop-down list.</td>
</tr>
</tbody>
</table>

When you right-click in the view, a popup menu appears (for example, to reset the layout of a table). The meaning of the different parts is:

**Tool and Invocation**

This part of the map file contains information about the linker, its version header information, binary location and which options are used to call it.

**Used Resources**

This part of the map file shows the memory usage at memory level and space level. The largest free block of memory (Largest gap) is also shown. This part also contains an estimation of the stack usage.

Explanation of the columns:
### Memory
The names of the memory as defined in the linker script file (*.lsl).

### Code
The size of all executable sections.

### Data
The size of all non-executable sections (not including stacks, heaps, debug sections in non-alloc space).

### Reserved
The total size of reserved memories, reserved ranges, reserved special sections, stacks, heaps, alignment protections, sections located in non.alloc space (debug sections). In fact, this size is the same as the size in the Total column minus the size of all other columns.

### Free
The free memory area addressable by this core. This area is accessible for unrestricted items.

### Total
The total memory area addressable by this core.

### Space
The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed of the derivative name followed by a colon ':', the core name, another colon ':' and the space name. For example: gtm31_02:mcs00:mcs.

### Native used ...
The size of sections located in this space.

### Foreign used
The size of all sections destined for/located in other spaces, but because of overlap in spaces consume memory in this space.

### Stack Name
The name(s) of the stack(s) as defined in the linker script file (*.lsl).

### Used
An estimation of the stack usage. The linker calculates the required stack size by using information (.CALLS directives) generated by the compiler. If for example recursion is detected, the calculated stack size is inaccurate, therefore this is an estimation only. The calculated stack size is supposed to be smaller than the actual allocated stack size. If that is not the case, then a warning is given.

### Processed Files
This part of the map file shows all processed files. This also includes object files that are extracted from a library, with the symbol that led to the extraction.

### Link Result
This part of the map file shows per object file how the link phase has mapped the sections from the various object files (.o) to output sections.

<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>[in] Section</td>
<td>A section name and id from the input object file. The number between '()' uniquely identifies the section.</td>
</tr>
<tr>
<td>[in] Size</td>
<td>The size of the input section.</td>
</tr>
<tr>
<td>[out] Offset</td>
<td>The offset relative to the start of the output section.</td>
</tr>
<tr>
<td>[out] Section</td>
<td>The resulting output section name and id.</td>
</tr>
<tr>
<td>[out] Size</td>
<td>The size of the output section.</td>
</tr>
</tbody>
</table>
Module Local Symbols

This part of the map file shows a table for each local scope within an object file. Each table has three columns, 1 the symbol name, 2 the address of the symbol and 3 the space where the symbol resides in. The table is sorted on symbol name within each space.

By default this part is not shown in the map file. You have to turn this part on manually with linker option --map-file-format=+statics (module local symbols).

Cross References

This part of the map file lists all symbols defined in the object modules and for each symbol the object modules that contain a reference to the symbol are shown. Also, symbols that remain undefined are shown.

Call Graph

This part of the map file contains a schematic overview that shows how (library) functions call each other. To obtain call graph information, the assembly file must contain .CALLS directives.

The following example is a part of a call graph in the textual version of the map file (.map):

```plaintext
__START [system_stack_0:4,36; user_stack_0:0,68]
  | +-- main [system_stack_0:4,32; user_stack_0:0,68]
  |     | +-- printf [system_stack_0:4,28; user_stack_0:12,68]
  |         | +-- _doprint [system_stack_0:4,24; user_stack_0:12,56]
  |             | +-- _io_putchar [system_stack_0:4,20; user_stack_0:0,44]
  |                 | +-- fputc [system_stack_0:4,16; user_stack_0:0,44]
  |                     | +-- _flsbuf [system_stack_0:4,12; user_stack_0:16,44]
  |                         | +-- _fflush *
  |                             | +-- _host_write *
  +-- exit [system_stack_0:4,20; user_stack_0:0,48]

* _dbg_trap [system_stack_0:0,0; user_stack_0:0,0]
```

- A * after a function name indicates a caller, which calls a function which is listed separately in the call graph.
- A * in front of a function name indicates a callee. This function is referenced by a caller.
- An additional R (not shown in this example) indicates this function is part of a recursive call chain. If both a leaf and the root of a tree are marked this way, all nodes in between are in a recursive chain.
• [ ] after a function contains information about the stack usage. The first field is the name of the stack (system_stack_0 and user_stack_0 in this example), followed by the amount of stack used by the function and the amount of stack used by the function including its callees.

In the graphical version of the map file, you can click the + or - sign to expand or collapse a single node. Use the / buttons to expand/collapse all nodes in the call graph. Hover the mouse over a function (root, callee or node) to see information about the stack usage.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Root Icon" /></td>
<td>Root</td>
<td>This function is the top of the call graph. If there are interrupt handlers, there can be several roots.</td>
</tr>
<tr>
<td><img src="image" alt="Callee Icon" /></td>
<td>Callee</td>
<td>This function is referenced by several caller functions. Right-click on the function and select <strong>Expand all References</strong> to see all functions that reference this function. Select <strong>Back to Caller</strong> to return to the calling function. ◊ indicates a recursive function.</td>
</tr>
<tr>
<td><img src="image" alt="Node Icon" /></td>
<td>Node</td>
<td>A normal node (function) in the call graph.</td>
</tr>
<tr>
<td><img src="image" alt="Caller Icon" /></td>
<td>Caller</td>
<td>This function calls a function which is listed separately in the call graph. Right-click on the function and select <strong>Go to Callee</strong> to see the callee. Hover the mouse over the function to see a popup with all callees. ◊ indicates a recursive function.</td>
</tr>
</tbody>
</table>

**Overlay**

This part is empty for the MCS.
Locate Result: Sections

This part of the map file shows the absolute position of each section in the absolute object file. It is organized per address space, memory chip and group and sorted on space address. In Eclipse, right-click in the table and select Configure Columns to specify which columns you want to see. If you hover the mouse over a section, you get a popup with information about the section. If you select a range of sections, in the Fast View bar (at the bottom) you will see information about the selected range, such as the total size, how many sections are selected and how many gaps are present.

# The line number and default sort order.
Section The name and id of the section. The number between '( )' uniquely identifies the section. Sections within square brackets [ ] will be copied during initialization from ROM to the corresponding section name in RAM.
Section name
Section number
Sect. size (hex) The size of the section in minimum addressable units (hexadecimal or decimal).
Sect. size (dec)
Group Sections can be ordered in groups. These are the names of the groups as defined in the linker script file (*.lsl) with the keyword group in the section_layout definition. The name that is displayed is the name of the deepest nested group.
Start address The first address of the section in the address space.
End address The last address of the section in the address space.
Symbols in sect. The names of the external symbols that are referenced in the section. See Locate Result: Symbols below.
Defined in The names of the input modules the section is defined in. See Link Result: [in] File above.
Referenced in The names of the modules that contain a reference to the section. See Cross References above.
Address space The name of the address space.
Chip name The names of the memory chips as defined in the linker script file (*.lsl) in the memory definitions.
Chip addr The absolute offset of the section from the start of a memory chip.
Locate type:properties The locate rule type and properties. See Locate Rules below.

The following buttons are available in this part of the map file.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Configure Section Filter</td>
<td>Opens the Configure Section Filter dialog. Here you can select which sections you want to see in the map file and how.</td>
</tr>
<tr>
<td></td>
<td>Enable Highlighting</td>
<td>All sections that are marked with &quot;Highlight&quot; in the Configure Section Filter dialog will be highlighted in the table.</td>
</tr>
<tr>
<td></td>
<td>Enable Collapsing</td>
<td>All sections that are marked with &quot;Collapse&quot; in the Configure Section Filter dialog will appear collapsed in the table.</td>
</tr>
<tr>
<td></td>
<td>Only Show Matching Lines</td>
<td>All lines that are not part of the selection in the Configure Section Filter dialog will be hidden.</td>
</tr>
</tbody>
</table>
Configure Section Filter Dialog

In this dialog you can filter which sections you want to see in the map file and how. Click Add to add a new filter. Explanation of the columns and fields:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📑</td>
<td>Show Gaps</td>
<td>Also shows the gaps in the map file. Click the button again to hide the gaps.</td>
</tr>
</tbody>
</table>

**Highlight**
Marks the section as a candidate for highlighting. Turn on Enable Highlighting to see the effect.

**Color**
The highlight color.

**Collapse**
Marks the section as a candidate for collapsing. Turn on Enable Collapsing to see the effect.

**Section name**
A filter to select a section or group of sections. Wildcards are allowed. Wildcards follow the rules of regular expressions. To get help on which wildcards are supported, press Ctrl-space. Click an item in the list for help, double-click to add the wildcard.

**Start address**
The first address of the section in the address space for this filter.

**End address**
The last address of the section in the address space for this filter.

**Address space**
The name of the address space.

**Chip name**
The name of the memory chip as defined in the linker script file (*.lsl) in the memory definitions.

**Hide gaps smaller than**
If gaps are shown in the map file, here you can limit the number of gaps you want to see.

The meaning of the check boxes is the same as the corresponding buttons available in this part of the map file.

**Locate Result: Symbols**

This part of the map file lists all external symbols per address space name.

<table>
<thead>
<tr>
<th>Address</th>
<th>The absolute address of the symbol in the address space.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the symbol.</td>
</tr>
<tr>
<td>Space</td>
<td>The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed of the derivative name followed by a colon ':', the core name, another colon ':' and the space name. For example: gtm31_02:mcs00:mcs.</td>
</tr>
</tbody>
</table>

**Processor and Memory**

This part of the map file shows the processor and memory information of the linker script file.
By default this part is not shown in the map file. You have to turn this part on manually with linker option
--map-file-format=+lsl (processor and memory info). You can print this information to a separate file with
linker option --lsl-dump.

You can expand or collapse a part of the information.

## Locate Rules

This part of the map file shows the rules the linker uses to locate sections.

<table>
<thead>
<tr>
<th>Address space</th>
<th>The names of the address spaces as defined in the linker script file (*.lsl). The names are constructed of the derivative name followed by a colon ':', the core name, another colon ':' and the space name.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type</td>
<td>The rule type:</td>
</tr>
<tr>
<td></td>
<td>ordered/contiguous/clustered/unrestricted</td>
</tr>
<tr>
<td></td>
<td>Specifies how sections are grouped. By default, a group is 'unrestricted' which means that the linker has total freedom to place the sections of the group in the address space.</td>
</tr>
<tr>
<td></td>
<td>absolute</td>
</tr>
<tr>
<td></td>
<td>The section must be located at the address shown in the Properties column.</td>
</tr>
<tr>
<td></td>
<td>ranged</td>
</tr>
<tr>
<td></td>
<td>The section must be located anywhere in the address ranges shown in the Properties column; end addresses are not included in the range.</td>
</tr>
<tr>
<td></td>
<td>page</td>
</tr>
<tr>
<td></td>
<td>The sections must be located in some address range with a size not larger than shown in the Properties column; the first number is the page size, the second part is the address range restriction within the page.</td>
</tr>
<tr>
<td></td>
<td>ranged page</td>
</tr>
<tr>
<td></td>
<td>Both the ranged and the paged restriction apply. In the Properties column the range restriction is listed first, followed by the paged restriction between parenthesis.</td>
</tr>
<tr>
<td></td>
<td>ballooned</td>
</tr>
<tr>
<td></td>
<td>After locating all sections, the largest remaining gap in the space is used completely for the stack and/or heap.</td>
</tr>
<tr>
<td>Properties</td>
<td>The contents depends on the Type column.</td>
</tr>
<tr>
<td>Prio</td>
<td>The locate priority of the rule. A higher priority value gives a rule precedence over a rule with a lower priority, but only if the two rules have the same type and the same properties. The relative order of rules of different types or different properties is not affected by this priority value. You can set the priority with the priority group attribute in LSL</td>
</tr>
</tbody>
</table>
The sections to which the rule applies;
restrictions between sections are shown in this column:

< ordered
| contiguous
+ clustered

For contiguous sections, the linker uses the section order as shown here. Clustered sections can be located in any relative order.

**Removed Sections**

This part of the map file shows the sections which are removed from the output file as a result of the optimization option to delete unreferenced sections and or duplicate code or constant data (linker option `--optimize=cxy`).

<table>
<thead>
<tr>
<th>Section</th>
<th>The name of the section which has been removed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>The name of the input object file where the section is removed from.</td>
</tr>
<tr>
<td>Library</td>
<td>The name of the library where the object file is part of.</td>
</tr>
<tr>
<td>Symbol</td>
<td>The symbols that were present in the section.</td>
</tr>
<tr>
<td>Reason</td>
<td>The reason why the section has been removed. This can be because the section is unreferenced or duplicated.</td>
</tr>
</tbody>
</table>
Chapter 12. Object File Formats

This chapter describes the format of several object files.

12.1. ELF/DWARF Object Format

The TASKING VX-toolset for MCS produces objects in the ELF/DWARF 3 format.

The ELF/DWARF Object Format for the MCS toolset follows the convention as described in the *MCS Embedded Application Binary Interface* [TASKING].

For a complete description of the ELF and DWARF formats, please refer to the *Tool Interface Standard (TIS)*.

12.2. Intel Hex Record Format

Intel Hex records describe the hexadecimal object file format for 8-bit, 16-bit and 32-bit microprocessors. The hexadecimal object file is an ASCII representation of an absolute binary object file. There are six different types of records:

- Data Record (8-, 16, or 32-bit formats)
- End of File Record (8-, 16, or 32-bit formats)
- Extended Segment Address Record (16, or 32-bit formats)
- Start Segment Address Record (16, or 32-bit formats)
- Extended Linear Address Record (32-bit format only)
- Start Linear Address Record (32-bit format only)

To generate an Intel Hex output file:

1. From the *Project* menu, select *Properties*
   
   *The Properties dialog appears.*

2. In the left pane, expand *C/C++ Build* and select *Settings*.
   
   *In the right pane the Settings appear.*

3. On the Tool Settings tab, select *Linker » Output Format*.

4. Enable the option *Generate Intel Hex format file*.

5. (Optional) Specify the *Size of addresses (in bytes) for Intel Hex records*.

6. (Optional) Enable or disable the option *Emit start address record*. 
By default the linker generates records in the 32-bit format (4-byte addresses).

**General Record Format**

In the output file, the record format is:

<table>
<thead>
<tr>
<th>:</th>
<th>length</th>
<th>offset</th>
<th>type</th>
<th>content</th>
<th>checksum</th>
</tr>
</thead>
</table>

where:

- **: ** is the record header.
- **length** is the record length which specifies the number of bytes of the **content** field. This value occupies one byte (two hexadecimal digits). The linker outputs records of 255 bytes (32 hexadecimal digits) or less; that is, **length** is never greater than 0xFF.
- **offset** is the starting load offset specifying an absolute address in memory where the data is to be located when loaded by a tool. This field is two bytes long. This field is only used for Data Records. In other records this field is coded as four ASCII zero characters (‘0000’).
- **type** is the record type. This value occupies one byte (two hexadecimal digits). The record types are:

<table>
<thead>
<tr>
<th>Byte Type</th>
<th>Record Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>00</td>
<td>Data</td>
</tr>
<tr>
<td>01</td>
<td>End of file</td>
</tr>
<tr>
<td>02</td>
<td>Extended segment address (not used)</td>
</tr>
<tr>
<td>03</td>
<td>Start segment address (not used)</td>
</tr>
<tr>
<td>04</td>
<td>Extended linear address (32-bit)</td>
</tr>
<tr>
<td>05</td>
<td>Start linear address (32-bit)</td>
</tr>
</tbody>
</table>

- **content** is the information contained in the record. This depends on the record type.
- **checksum** is the record checksum. The linker computes the checksum by first adding the binary representation of the previous bytes (from length to content). The linker then computes the result of sum modulo 256 and subtracts the remainder from 256 (two’s complement). Therefore, the sum of all bytes following the header is zero.

**Extended Linear Address Record**

The Extended Linear Address Record specifies the two most significant bytes (bits 16-31) of the absolute address of the first data byte in a subsequent Data Record:

| : | 02 | 0000 | 04 | upper_address | checksum |

The 32-bit absolute address of a byte in a Data Record is calculated as:
( address + offset + index ) modulo 4G

where:

address is the base address, where the two most significant bytes are the upper_address and the two least significant bytes are zero.

offset is the 16-bit offset from the Data Record.

index is the index of the data byte within the Data Record (0 for the first byte).

Example:

:020000040000FA
| | | | | _ checksum
| | | | _ upper_address
| | | _ type
| | _ offset
| _ length

**Data Record**

The Data Record specifies the actual program code and data.

| : | length | offset | 00 | data | checksum |

The length byte specifies the number of data bytes. The linker has an option (--hex-record-size) that controls the length of the output buffer for generating Data records. The default buffer length is 32 bytes.

The offset is the 16-bit starting load offset. Together with the address specified in the Extended Address Record it specifies an absolute address in memory where the data is to be located when loaded by a tool.

Example:

:1418D8000000010080053A6040053A40C00025000004E0DB
| | | | _ data
| | | _ type
| | _ offset
| _ length

**Start Linear Address Record**

The Start Linear Address Record contains the 32-bit program execution start address.

| : | 04 | 0000 | 05 | address | checksum |

With linker option --hex-format=S you can prevent the linker from emitting this record.

Example:
End of File Record

The hexadecimal file always ends with the following end-of-file record:

:00000001FF
| | | | | checksum
| | | | type
| | | offset
| | length

12.3. Motorola S-Record Format

To generate a Motorola S-record output file:

1. From the Project menu, select Properties

   The Properties dialog appears.

2. In the left pane, expand C/C++ Build and select Settings.

   In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Output Format.

4. Enable the option Generate S-records file.

5. (Optional) Specify the Size of addresses (in bytes) for Motorola S records.

By default, the linker produces output in Motorola S-record format with three types of S-records (4-byte addresses): S0, S3 and S7. Depending on the size of addresses you can force other types of S-records. They have the following layout:

**S0 - record**

<table>
<thead>
<tr>
<th>S0</th>
<th>length</th>
<th>0000</th>
<th>comment</th>
<th>checksum</th>
</tr>
</thead>
</table>

A linker generated S-record file starts with an S0 record with the following contents:

```
070006 C6D637349
```

The S0 record is a comment record and does not contain relevant information for program execution.
where:

**S0** is a comment record and does not contain relevant information for program execution.

**length** represents the number of bytes in the record, not including the record type and length byte. This value occupies one byte (two hexadecimal digits).

**comment** contains the name of the linker.

**checksum** is the record checksum. The linker computes the checksum by first adding the binary representation of the bytes following the record type (starting with the length byte) to just before the checksum. Then the one's complement is calculated of this sum. The least significant byte of the result is the checksum. The sum of all bytes following the record type is 0xFF.

### S1 / S2 / S3 - record

This record is the program code and data record for 2-byte, 3-byte or 4-byte addresses respectively.

<table>
<thead>
<tr>
<th>S1</th>
<th>length</th>
<th>address</th>
<th>code bytes</th>
<th>checksum</th>
</tr>
</thead>
<tbody>
<tr>
<td>S2</td>
<td>length</td>
<td>address</td>
<td>code bytes</td>
<td>checksum</td>
</tr>
<tr>
<td>S3</td>
<td>length</td>
<td>address</td>
<td>code bytes</td>
<td>checksum</td>
</tr>
</tbody>
</table>

where:

**S1** is the program code and data record for 2-byte addresses.

**S2** is the program code and data record for 3-byte addresses.

**S3** is the program code and data record for 4-byte addresses (this is the default).

**length** represents the number of bytes in the record, not including the record type and length byte. This value occupies one byte (two hexadecimal digits).

**address** contains the code or data address.

**code bytes** contains the actual program code and data.

**checksum** is the record checksum. The checksum calculation is identical to S0.

Example:

```
S3190000018D800000010080053A6040053A40C000025000004E0D5
```

| | | | | checkerum |
| | | | code |
| | address |
| length |

### S7 / S8 / S9 - record

This record is the termination record for 4-byte, 3-byte or 2-byte addresses respectively.
WHERE:

- **S7** is the termination record for 4-byte addresses (this is the default). S7 is the corresponding termination record for S3 records.
- **S8** is the termination record for 3-byte addresses. S8 is the corresponding termination record for S2 records.
- **S9** is the termination record for 2-byte addresses. S9 is the corresponding termination record for S1 records.

**Length** represents the number of bytes in the record, not including the record type and length byte. This value occupies one byte (two hexadecimal digits).

**Address** contains the program start address.

**Checksum** is the record checksum. The checksum calculation is identical to S0.

Example:

```
S7 05 00 00 04 A5 2
```

```
| Address | Address | Checksum |
```

---

520
Chapter 13. Linker Script Language (LSL)

To make full use of the linker, you can write a script with information about the architecture of the target processor and locating information. The language for the script is called the Linker Script Language (LSL). This chapter first describes the structure of an LSL file. The next section contains a summary of the LSL syntax. In the remaining sections, the semantics of the Linker Script Language is explained.

The TASKING linker is a target independent linker/locator that can simultaneously link and locate all programs for all cores available on a target board. The target board may be of arbitrary complexity. A simple target board may contain one standard processor with some external memory that executes one task. A complex target board may contain multiple standard processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute a different program, and external memory may be shared by multiple cores.

LSL serves two purposes. First it enables you to specify the characteristics (that are of interest to the linker) of your specific target board and of the cores installed on the board. Second it enables you to specify how sections should be located in memory.

13.1. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.

The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into physical addresses for a given type of core. If the core supports multiple address spaces, then for each space the linker must know how to perform this conversion. In this context a physical address is an offset on a given internal or external bus. Additionally the architecture definition contains information about items such as the stack.

This specification is normally written by Altium. Altium supplies LSL files in the include.lsl directory. The architecture definition of the LSL file should not be changed by you unless you also modify the core's hardware architecture. If the LSL file describes a multi-core system an architecture definition must be available for each different type of core.

See Section 13.4, Semantics of the Architecture Definition for detailed descriptions of LSL in the architecture definition.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system. Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems apart from one or more cores. The design of such a chip is called a derivative.

Altium provides LSL descriptions of supported derivatives. When you build an ASIC or use a derivative that is not (yet) supported by the TASKING tools, you may have to write a derivative definition.
When you want to use multiple cores of the same type, you must instantiate the cores in a derivative definition, since the linker automatically instantiates only a single core for an unused architecture.


**The processor definition**

The processor definition describes an instance of a derivative. Typically the processor definition instantiates one derivative only (single-core processor). A processor that contains multiple cores having the same (homogeneous) or different (heterogeneous) architecture can also be described by instantiating multiple derivatives of the same or different types in separate processor definitions.


**The memory and bus definitions (optional)**

Memory and bus definitions are used within the context of a derivative definition to specify internal memory and on-chip buses. In the context of a board specification the memory and bus definitions are used to define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical address into an offset into an on-chip or off-chip memory device.

See Section 13.6.3, *Defining External Memory and Buses*, for more information on how to specify the external physical memory layout. *Internal* memory for a processor should be defined in the derivative definition for that processor.

**The board specification**

The processor definition and memory and bus definitions together form a board specification. LSL provides language constructs to easily describe single-core and heterogeneous or homogeneous multi-core systems. The board specification describes all characteristics of your target board's system buses, memory devices, I/O sub-systems, and cores that are of interest to the linker. Based on the information provided in the board specification the linker can for each core:

- convert a logical address to an offset within a memory device
- locate sections in physical memory
- maintain an overall view of the used and free physical memory within the whole system while locating

**The section layout definition (optional)**

The optional section layout definition enables you to exactly control where input sections are located. Features are provided such as: the ability to place sections at a given load-address or run-time address, to place sections in a given order, and to overlay code and/or data sections.

Which object files (sections) constitute the task that will run on a given core is specified on the command line when you invoke the linker. The linker will link and locate all sections of all tasks simultaneously. From the section layout definition the linker can deduce where a given section may be located in memory,
form the board specification the linker can deduce which physical memory is (still) available while locating the section.

See Section 13.8, *Semantics of the Section Layout Definition*, for more information on how to locate a section at a specific place in memory.

**Skeleton of a Linker Script File**

```plaintext
architecture architecture_name
{
    // Specification core architecture
}

derivative derivative_name
{
    // Derivative definition
}

processor processor_name
{
    // Processor definition
}

memory and/or bus definitions

section_layout space_name
{
    // section placement statements
}
```

**13.2. Syntax of the Linker Script Language**

This section describes what the LSL language looks like. An LSL document is stored as a file coded in UTF-8 with extension `.lsl`. Before processing an LSL file, the linker preprocesses it using a standard C preprocessor. Following this, the linker interprets the LSL file using a scanner and parser. Finally, the linker uses the information found in the LSL file to guide the locating process.

**13.2.1. Preprocessing**

When the linker loads an LSL file, the linker processes it with a C-style preprocessor. As such, it strips C and C++ comments. You can use the standard ISO C preprocessor directives, such as `#include`, `#define`, `#if/#else/#endif`, `#error`.

For example:

`#include "arch.lsl"`

Preprocess and include the file `arch.lsl` at this point in the LSL file.
13.2.2. Lexical Syntax

The following lexicon is used to describe the syntax of the Linker Script Language:

\[
A ::= B \quad = \quad A \text{ is defined as } B \\
A ::= B \ C \quad = \quad A \text{ is defined as } B \text{ and } C; B \text{ is followed by } C \\
A ::= B \mid C \quad = \quad A \text{ is defined as } B \text{ or } C \\
\langle B\rangle^{0\mid1} \quad = \quad \text{zero or one occurrence of } B \\
\langle B\rangle^{>0} \quad = \quad \text{zero of more occurrences of } B \\
\langle B\rangle^{>1} \quad = \quad \text{one of more occurrences of } B \\
IDENTIFIER \quad = \quad \text{a character sequence starting with } 'a'-'z', 'A'-'Z' \text{ or } '_'. \text{ Following characters may also be digits and dots } '.' \\
STRING \quad = \quad \text{sequence of characters not starting with } \backslash n, \backslash r \text{ or } \backslash t \\
DQSTRING \quad = \quad \" \ STRING \ " \ (\text{double quoted string}) \\
OCT\_NUM \quad = \quad \text{octal number, starting with a zero (06, 045)} \\
DEC\_NUM \quad = \quad \text{decimal number, not starting with a zero (14, 1024)} \\
HEX\_NUM \quad = \quad \text{hexadecimal number, starting with } '0x' \ (0x0023, 0xFF00) \\
\]

\textit{OCT\_NUM, DEC\_NUM and HEX\_NUM} \text{ can be followed by a k (kilo), M (mega), or G (giga).}

Characters in \textbf{bold} are characters that occur literally. Words in \textit{italics} are higher order terms that are defined in the same or in one of the other sections.

To write comments in LSL file, you can use the C style '/' */ */ or C++ style '/ /'.

13.2.3. Identifiers and Tags

\[
\text{arch\_name ::= IDENTIFIER} \\
\text{bus\_name ::= IDENTIFIER} \\
\text{core\_name ::= IDENTIFIER} \\
\text{derivative\_name ::= IDENTIFIER} \\
\text{file\_name ::= DQSTRING} \\
\text{group\_name ::= IDENTIFIER} \\
\text{heap\_name ::= section\_name} \\
\text{map\_name ::= IDENTIFIER} \\
\text{mem\_name ::= IDENTIFIER} \\
\text{proc\_name ::= IDENTIFIER} \\
\text{section\_name ::= DQSTRING} \\
\text{space\_name ::= IDENTIFIER} \\
\text{stack\_name ::= section\_name} \\
\text{symbol\_name ::= DQSTRING} \\
\]
A tag is an arbitrary text that can be added to a statement.

### 13.2.4. Expressions

The expressions and operators in this section work the same as in ISO C.

### 13.2.5. Built-in Functions
Every space, bus, memory, section or group you refer to, must be defined in the LSL file.

The `addressof()` and `sizeof()` functions with the `group` or `sect` argument can only be used in the right hand side of an assignment. The `sizeof()` function with the `mem` argument can be used anywhere in section layouts.

You can use the following built-in functions in expressions. All functions return a numerical value. This value is a 64-bit signed integer.

**absolute()**

```c
int absolute( expr )
```

Converts the value of `expr` to a positive integer.

```c
absolute( "labelA"-"labelB" )
```

**addressof()**

```c
int addressof( addr_id )
```

Returns the address of `addr_id`, which is a named section or group. To get the offset of the section with the name `asect`:

```c
addressof( sect: "asect")
```

This function only works in assignments.

**exists()**

```c
int exists( section_name )
```

The function returns 1 if the section `section_name` exists in one or more object file, 0 otherwise. If the section is not present in input object files, but generated from LSL, the result of this function is undefined.

To check whether the section `mysection` exists in one of the object files that is specified to the linker:

```c
exists( "mysection" )
```
**max()**

```c
int max( expr, expr )
```

Returns the value of the expression that has the largest value. To get the highest value of two symbols:

```c
max( "sym1", "sym2")
```

**min()**

```c
int min( expr, expr )
```

Returns the value of the expression that has the smallest value. To get the lowest value of two symbols:

```c
min( "sym1", "sym2")
```

**sizeof()**

```c
int sizeof( size_id )
```

Returns the size of the object (group, section or memory) the identifier refers to. To get the size of the section "asection":

```c
sizeof( sect: "asection" )
```

The `group` and `sect` arguments only work in assignments. The `mem` argument can be used anywhere in section layouts.

### 13.2.6. LSL Definitions in the Linker Script File

**definition** ::= <definition>^1

- **description** ::= <definition>

- **definition** ::= architecture_definition  
  - derivative_definition  
  - board_spec  
  - section_definition  
  - section_setup

- At least one `architecture_definition` must be present in the LSL file.

### 13.2.7. Memory and Bus Definitions

**mem_def** ::= memory mem_name <tag_attr>^01 { <mem_descr ;>^0 }

- A `mem_def` defines a memory with the `mem_name` as a unique name.

**mem_descr** ::= type = <reserved>^01 mem_type  
  - mau = expr  
  - size = expr  
  - speed = number
• A **mem_def** contains exactly one **type** statement.
• A **mem_def** contains exactly one **mau** statement (non-zero size).
• A **mem_def** contains exactly one **size** statement.
• A **mem_def** contains zero or one priority (or speed) statement (if absent, the default value is 1).
• A **mem_def** contains zero or one exec_priority statement.
• A **mem_def** contains zero or one fill statement.
• A **mem_def** contains zero or one write_unit statement.
• A **mem_def** contains at least one mapping

```plaintext
mem_type ::= rom // attrs = rx |
               ram // attrs = rw |
               nvram // attrs = rwx |
               blockram
```

```plaintext
fill_values ::= expr |
               [ expr <, expr>=0 ]
```

```plaintext
bus_def ::= bus bus_name {} <bus_descr ;>=0
```

• A **bus_def** statement defines a bus with the given **bus_name** as a unique name within a core architecture.

```plaintext
bus_descr ::= mau = expr |
              width = expr // bus width, nr |
              // of data bits |
              mapping // legal destination |
              // 'bus' only
```

• The **mau** and **width** statements appear exactly once in a **bus_descr**. The default value for **width** is the **mau** size.
• The bus width must be an integer times the bus MAU size.
• The MAU size must be non-zero.
• A bus can only have a mapping on a destination bus (through **dest = bus**:).

```plaintext
mapping ::= map <map_name>=0|1 ( map_descr <, map_descr>=0 )
```
map_descr ::= dest = destination
dest_dbits = range
dest_offset = expr
size = expr
src_dbits = range
src_offset = expr
reserved
priority = number
eexec_priority = number
tag

- A `map_descr` requires at least the `size` and `dest` statements.
- A `map_descr` contains zero or one `priority` statement (if absent, the default value is 0).
- A `map_descr` contains zero or one `exec_priority` statement.
- Each `map_descr` can occur only once.
- You can define multiple mappings from a single source.
- Overlap between source ranges or destination ranges is not allowed.
- If the `src_dbits` or `dest_dbits` statement is not present, its value defaults to the width value if the source/destination is a bus, and to the mau size otherwise.
- The `reserved` statement is allowed only in mappings defined for a memory.

destination ::= space : space_name
| bus : <proc_name | core_name :>^0^1 bus_name

- A `space_name` refers to a defined address space.
- A `proc_name` refers to a defined processor.
- A `core_name` refers to a defined core.
- A `bus_name` refers to a defined bus.
- The following mappings are allowed (source to destination)
  - space => space
  - space => bus
  - bus => bus
  - memory => bus

range ::= expr .. expr

- With address ranges, the end address is not part of the range.
13.2.8. Architecture Definition

architecture_definition ::= architecture arch_name
< ( parameter_list ) > ^0|1
< extends arch_name
< ( argument_list ) > ^0|1 > ^0|1
{ < arch_spec > ^0 } ^0|1

- An architecture_definition defines a core architecture with the given arch_name as a unique name.

- At least one space_def and at least one bus_def have to be present in an architecture_definition.

- An architecture_definition that uses the extends construct defines an architecture that inherits all elements of the architecture defined by the second arch_name. The parent architecture must be defined in the LSL file as well.

parameter_list ::= parameter < , parameter > ^0|1
parameter ::= IDENTIFIER <= expr ^0|1
argument_list ::= expr < , expr > ^0|1
arch_spec ::= bus_def
| space_def
| endianness_def

space_def ::= space space_name < tag_attr > ^0|1 { < space_descr > ^0 } ^0|1

- A space_def defines an address space with the given space_name as a unique name within an architecture.

space_descr ::= space_property ;
| section_definition //no space ref
| reserved_range

space_property ::= id = number // as used in object
| mau = expr
| align = expr
| page_size = expr < [ range ] < [ range ] > ^0|1
| page
| direction = direction
| stack_def
| heap_def
| copy_table_def
| start_address
| mapping

- A space_def contains exactly one id and one mau statement.

530
• A space_def contains at most one align statement.

• A space_def contains at most one page_size statement.

• A space_def contains at least one mapping.

\[
\text{stack_def} \quad ::= \quad \text{stack} \quad \text{stack_name} \; ( \; \text{stack_heap_descr} \; <, \; \text{stack_heap_descr} \; >^\geq 0 \; )
\]

• A stack_def defines a stack with the stack_name as a unique name.

\[
\text{heap_def} \quad ::= \quad \text{heap} \quad \text{heap_name} \; ( \; \text{stack_heap_descr} \; <, \; \text{stack_heap_descr} \; >^\geq 0 \; )
\]

• A heap_def defines a heap with the heap_name as a unique name.

\[
\text{stack_heap_descr} \quad ::= \quad \text{min_size} \; = \; \text{expr} \\
\quad \quad | \quad \text{grows} \; = \; \text{direction} \\
\quad \quad | \quad \text{align} \; = \; \text{expr} \\
\quad \quad | \quad \text{fixed} \\
\quad \quad | \quad \text{tag}
\]

• The min_size statement must be present.

• You can specify at most one align statement and one grows statement.

\[
\text{direction} \quad ::= \quad \text{low_to_high} \\
\quad \quad | \quad \text{high_to_low}
\]

• If you do not specify the grows statement, the stack and heap grow low-to-high.

\[
\text{copy_table_def} \quad ::= \quad \text{copytable} \; <\; ( \; \text{copy_table_descr} \; <, \; \text{copy_table_descr} \; >^\geq 0 \; )\; >^01
\]

• A space_def contains at most one copytable statement.

• Exactly one copy table must be defined in one of the spaces.

\[
\text{copy_table_descr} \quad ::= \quad \text{align} \; = \; \text{expr} \\
\quad \quad | \quad \text{copy_unit} \; = \; \text{expr} \\
\quad \quad | \quad \text{dest} \; <\; \text{space_name}\; >^01 \; = \; \text{space_name} \\
\quad \quad | \quad \text{page} \\
\quad \quad | \quad \text{tag}
\]

• The copy_unit is defined by the size in MAUs in which the startup code moves data.

• The dest statement is only required when the startup code initializes memory used by another processor that has no access to ROM.

• A space_name refers to a defined address space.

\[
\text{start_addr} \quad ::= \quad \text{start_address} \; ( \; \text{start_addr_descr} \; <, \; \text{start_addr_descr} \; >^\geq 0 \; )
\]
start_addr_descr ::= run_addr = expr
| symbol = symbol_name

• A symbol_name refers to the section that contains the startup code.

reserved_range ::= reserved <tag_attr>^1 expr .. expr ;

• The end address is not part of the range.

diendiness_def ::= diendiness { <endianness_type;> }^1
endianness_type ::= big
| little

13.2.9. Derivative Definition

derivative_definition ::= derivative derivative_name
< ( parameter_list ) >^1
< extends derivative_name
< ( argument_list ) >^1 >^1
{ < derivative_spec >^1 }^1

diendiness_def ::= diendiness { <endianness_type;> }^1
endianness_type ::= big
| little

• A derivative_definition defines a derivative with the given derivative_name as a unique name.

derivative_spec ::= core_def
| bus_def
| mem_def
| section_definition // no processor name
| section_setup

core_def ::= core core_name { <core_descr ;> }^1

• A core_def defines a core with the given core_name as a unique name.

• At least one core_def must be present in a derivative_definition.

core_descr ::= architecture = arch_name
< ( argument_list ) >^1
| copytable_space < core_name :>^1 space_name
| endianness = ( endianness_type
<, endianness_type >^1 )
| import core_name
| space_id_offset = number

• An arch_name refers to a defined core architecture.

• Exactly one architecture statement must be present in a core_def.

• Exactly one copytable_space statement must be present in a core_def, or in exactly one space in that core, a copytable statement must be present.
13.2.10. Processor Definition and Board Specification

```
board_spec ::= proc_def
            | bus_def
            | mem_def

proc_def ::= processor proc_name
            { proc_descr ; }

proc_descr ::= derivative = derivative_name
              ⟨ ⟨ argument_list ⟩ ⟩^0|1
```

- A `proc_def` defines a processor with the `proc_name` as a unique name.
- If you do not explicitly define a processor for a derivative in an LSL file, the linker defines a processor with the same name as that derivative.
- A `derivative_name` refers to a defined derivative.
- A `proc_def` contains exactly one `derivative` statement.

13.2.11. Section Layout Definition and Section Setup

```
section_definition ::= section_layout <space_ref>^0|1
                      ⟨ ⟨ space_layout_properties ⟩ ⟩^0|1
                      { <section_statement>^≥0 }
```

- A section definition inside a space definition does not have a `space_ref`.
- All global section definitions have a `space_ref`.

```
space_ref ::= <proc_name>^0|1 : <core_name>^0|1
            : space_name ⟨ | space_name⟩^≥0
```

- If more than one processor is present, the `proc_name` must be given for a global section layout.
- If the section layout refers to a processor that has more than one core, the `core_name` must be given in the `space_ref`.
- A `proc_name` refers to a defined processor.
- A `core_name` refers to a defined core.
- A `space_name` refers to a defined address space.

```
space_layout_properties ::= space_layout_property ⟨ , space_layout_property ⟩^≥0

space_layout_property ::= locate_direction
                         | tag
```
locate_direction ::= direction = direction

direction ::= low_to_high
            | high_to_low

• A section layout contains at most one direction statement.

• If you do not specify the direction statement, the locate direction of the section layout is low-to-high.

section_statement ::= simple_section_statement ;
                    | aggregate_section_statement

simple_section_statement ::= assignment
                        | select_section_statement
                        | special_section_statement
                        | memcopy_statement

assignment ::= symbol_name assign_op expr

assign_op ::= =
            | :=

select_section_statement ::= select <ref_tree>^0\text{--}^1 <section_name>^0\text{--}^1 <section_selections>^0\text{--}^1

• Either a section_name or at least one section_selection must be defined.

section_selections ::= ( section_selection , section_selection )^0\text{--}^0

section_selection ::= attributes = < <+|-> attribute>^0
                    | tag

• +attribute means: select all sections that have this attribute.

• -attribute means: select all sections that do not have this attribute.

special_section_statement ::= heap heap_name <stack_heap_mods>^0\text{--}^1
                           | stack stack_name <stack_heap_mods>^0\text{--}^1
                           | copytable
                           | reserved section_name <reserved_specs>^0\text{--}^1

• Special sections cannot be selected in load-time groups.

stack_heap_mods ::= ( stack_heap_mod , stack_heap_mod )^0\text{--}^0
stack_heap_mod ::= size = expr
           | tag

reserved_specs ::= ( reserved_spec <, reserved_spec >^0 )

reserved_spec ::= attributes
                  | fill_spec
                  | size = expr
                  | alloc_allowed = absolute | ranged

• If a reserved section has attributes r, rw, x, rx or rwx, and no fill pattern is defined, the section is filled with zeros. If no attributes are set, the section is created as a scratch section (attributes ws, no image).

memcopy_statement ::= memcopy section_name
                        ( memcopy_spec <, memcopy_spec >^0|1 )

memcopy_spec ::= memory = memory_reference
                  | fill_spec

• A memcopy statement must contain exactly one memory statement.

• A memcopy statement can contain at most one fill_spec.

fill_spec ::= fill = fill_values

fill_values ::= expr
                | [ expr <, expr >^0 ]

aggregate_section_statement ::= { <section_statement >^0 }
                                | group_descr
                                | if_statement
                                | section_creation_statement

group_descr ::= group <group_name >^0|1 <( group_specs >^0|1

• For every group with a name, the linker defines a label.

• No two groups for address spaces of a core can have the same group_name.

group_specs ::= group_spec <, group_spec >^0

group_spec ::= group_alignment
              | attributes
              | copy
              | nocopy
              | group_load_address
              | fill <= fill_values >^0|1
              | group_page
              | group_run_address
• The **allow-cross-references** property is only allowed for **overlay** groups.

• Sub groups inherit all properties from a parent group.

```plaintext
group_alignment ::= align = expr
attributes ::= attributes = <attribute>^1
attribute ::= r // readable sections
           | w // writable sections
           | x // executable code sections
           | i // initialized sections
           | s // scratch sections
           | b // blanked (cleared) sections
           | p // protected sections

group_load_address ::= load_addr <= load_or_run_addr^0,1

group_page ::= page <= expr^0,1
            | page_size = expr [ range ] < | [ range ]>^0,1

group_run_address ::= run_addr <= load_or_run_addr^0,1

group_type ::= clustered
             | contiguous
             | ordered
             | overlay
```

• For **non-contiguous** groups, you can only specify `group_alignment` and `attributes`.

• The **overlay** keyword also sets the **contiguous** property.

• The **clustered** property cannot be set together with **contiguous** or **ordered** on a single group.

```plaintext
load_or_run_addr ::= addr_absolute
            | addr_range < | addr_range>^0

addr_absolute ::= expr
            | memory_reference [ expr ]

addr_range ::= [ expr .. expr ]
             | memory_reference
             | memory_reference [ expr .. expr ]
```
Linker Script Language (LSL)

- The parent of a group with an `addr_range` or `page` restriction cannot be ordered, contiguous or clustered.
- The end address is not part of the range.

```plaintext
memory_reference ::= mem : <proc_name> :^0|1 mem_name </ map_name>^0|1
```
- A `proc_name` refers to a defined processor.
- A `mem_name` refers to a defined memory.
- A `map_name` refers to a defined memory mapping.

```plaintext
if_statement ::= if ( expr ) section_statement
                <else section_statement>^0|1
```

```plaintext
section_creation_statement ::= section section_name ( section_specs )
                              { <section_statement2>^0|1
```

```plaintext
section_specs ::= section_spec <, section_spec>^0|1
```

```plaintext
section_spec ::= attributes
               | fill_spec
               | size = expr
               | blocksize = expr
               | overflow = section_name
               | tag
```

```plaintext
section_statement2 ::= select_section_statement ;
                     | group_descr2
                     | { <section_statement2>^0|1
```

```plaintext
group_descr2 ::= group <group_name>^0|1
               ( group_specs2 )
               section_statement2
```

```plaintext
group_specs2 ::= group_spec2 <, group_spec2>^0|1
```

```plaintext
group_spec2 ::= group_alignment
              attributes
              | load_addr
              | tag
```

```plaintext
section_setup ::= section_setup space_ref <tag_attr>^0|1
                 { <section_setup_item>^0|1
```

```plaintext
section_setup_item ::= reserved_range
                     | stack_def ;
                     | heap_def ;
```
13.3. Expression Evaluation

Only constant expressions are allowed, including sizes, but not addresses, of sections in object files.

All expressions are evaluated with 64-bit precision integer arithmetic. The result of an expression can be absolute or relocatable. A symbol you assign is created as an absolute symbol.

13.4. Semantics of the Architecture Definition

Keywords in the architecture definition

architecture
  extends
endianness          big  little
bus
  mau
  width
  map
space
  id
  mau
  align
page_size
page
direction        low_to_high  high_to_low
stack
  min_size
  grows        low_to_high  high_to_low
  align
  fixed
heap
  min_size
  grows        low_to_high  high_to_low
  align
  fixed
copytable
  align
  copy_unit
dest
page
reserved
start_address
  run_addr
symbol
map
  map
    dest          bus  space
dest_dbits
13.4.1. Defining an Architecture

With the keyword `architecture` you define an architecture and assign a unique name to it. The name is used to refer to it at other places in the LSL file:

```
architecture name
{
    definitions
}
```

If you are defining multiple core architectures that show great resemblance, you can define the common features in a parent core architecture and extend this with a child core architecture that contains specific features. The child inherits all features of the parent. With the keyword `extends` you create a child core architecture:

```
architecture name_child_arch extends name_parent_arch
{
    definitions
}
```

A core architecture can have any number of parameters. These are identifiers which get values assigned on instantiation or extension of the architecture. You can use them in any expression within the core architecture. Parameters can have default values, which are used when the core architecture is instantiated with less arguments than there are parameters defined for it. When you extend a core architecture you can pass arguments to the parent architecture. Arguments are expressions that set the value of the parameters of the sub-architecture.

```
architecture name_child_arch (parm1, parm2=1)
    extends name_parent_arch (arguments)
{
    definitions
}
```

13.4.2. Defining Internal Buses

With the `bus` keyword you define a bus (the combination of data and corresponding address bus). The bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions in an architecture definition or derivative definition define internal buses. Some internal buses are used to communicate with the components outside the core or processor. Such buses on a processor have physical pins reserved for the number of bits specified with the `width` statements.

- The `mau` field specifies the MAU size (Minimum Addressable Unit) of the data bus. This field is required.
The `width` field specifies the width (number of address lines) of the data bus. The default value is the MAU size.

The `map` keyword specifies how this bus maps onto another bus (if so). Mappings are described in Section 13.4.4, *Mappings*.

```plaintext
bus bus_name
{
    mau = 8;
    width = 8;
    map ( map_description );
}
```

### 13.4.3. Defining Address Spaces

With the `space` keyword you define a logical address space. The space name is used to identify the address space and does not conflict with other identifiers.

- The `id` field defines how the addressing space is identified in object files. In general, each address space has a unique ID. The linker locates sections with a certain ID in the address space with the same ID. This field is required.

- The `mau` field specifies the MAU size (Minimum Addressable Unit) of the space. This field is required.

- The `align` value must be a power of two. The linker uses this value to compute the start addresses when sections are concatenated. An align value of \( n \) means that objects in the address space have to be aligned on \( n \) MAUs.

- The `page_size` field sets the page alignment and page size in MAUs for the address space. It must be a power of 2. The default value is 1. If one or more page ranges are supplied the supplied value only sets the page alignment. The ranges specify the available space in each page, as offsets to the page start, which is aligned at the page alignment.

  See also the `page` keyword in subsection Locating a group in Section 13.8.2, *Creating and Locating Groups of Sections*.

- With the optional `direction` field you can specify how all sections in this space should be located. This can be either from `low_to_high` addresses (this is the default) or from `high_to_low` addresses.

- The `map` keyword specifies how this address space maps onto an internal bus or onto another address space. Mappings are described in Section 13.4.4, *Mappings*.

### Stacks and heaps

- The `stack` keyword defines a stack in the address space and assigns a name to it. The architecture definition must contain at least one stack definition. Each stack of a core architecture must have a unique name. See also the `stack` keyword in Section 13.8.3, *Creating or Modifying Special Sections*.

The stack is described in terms of a minimum size (`min_size`) and the direction in which the stack grows (`grows`). This can be either from `low_to_high` addresses (stack grows upwards, this is the default) or from `high_to_low` addresses (stack grows downwards). The `min_size` is required.
By default, the linker tries to maximize the size of the stacks and heaps. After locating all sections, the largest remaining gap in the space is used completely for the stacks and heaps. If you specify the keyword `fixed`, you can disable this so-called 'balloon behavior'. The size is also fixed if you used a stack or heap in the software layout definition in a restricted way. For example when you override a stack with another size or select a stack in an ordered group with other sections.

Optionally you can specify an alignment for the stack with the argument `align`. This alignment must be equal or larger than the alignment that you specify for the address space itself.

- The `heap` keyword defines a heap in the address space and assigns a name to it. The definition of a heap is similar to the definition of a stack. See also the `heap` keyword in Section 13.8.3, Creating or Modifying Special Sections.

Stacks and heaps are only generated by the linker if the corresponding linker labels are referenced in the object files.

See Section 13.8, Semantics of the Section Layout Definition, for information on creating and placing stack sections.

**Copy tables**

- The `copytable` keyword defines a copy table in the address space. The content of the copy table is created by the linker and contains the start address and size of all sections that should be initialized by the startup code. You must define exactly one copy table in one of the address spaces (for a core).

  Optionally you can specify an alignment for the copy table with the argument `align`. This alignment must be equal or larger than the alignment that you specify for the address space itself. If smaller, the alignment for the address space is used.

  The `copy_unit` argument specifies the size in MAUs of information chunks that are copied. If you do not specify the copy unit, the MAU size of the address space itself is used.

  The `dest` argument specifies the destination address space that the code uses for the copy table. The linker uses this information to generate the correct addresses in the copy table. The memory into where the sections must be copied at run-time, must be accessible from this destination space.

  Sections generated for the copy table may get a page restriction with the address space’s page size, by adding the `page` argument.

**Reserved address ranges**

- The `reserved` keyword specifies to reserve a part of an address space even if not all of the range is covered by memory. See also the `reserved` keyword in Section 13.8.3, Creating or Modifying Special Sections.

**Start address**

- The `start_address` keyword specifies the start address for the position where the startup code is located. When a processor is reset, it initializes its program counter to a certain start address, sometimes called the reset vector. In the architecture definition, you must specify this start address in the correct
address space in combination with the name of the label in the application code which must be located here.

The run_addr argument specifies the start address (reset vector). If the core starts executing using an entry from a vector table, and directly jumps to the start label, you should omit this argument.

The symbol argument specifies the name of the label in the application code that should be located at the specified start address. The symbol argument is required. The linker will resolve the start symbol and use its value after locating for the start address field in IEEE-695 files and Intel Hex files. If you also specified the run_addr argument, the start symbol (label) must point to a section. The linker locates this section such that the start symbol ends up on the start address.

```c
space space_name
{
  id = 1;
  mau = 8;
  align = 8;
  page_size = 1;
  stack name (min_size = 1k, grows = low_to_high);
  reserved start_address .. end_address;
  start_address ( run_addr = 0x0000,
    symbol = "start_label" )
  map ( map_description );
}
```

### 13.4.4. Mappings

You can use a mapping when you define a space, bus or memory. With the map field you specify how addresses from the source (space, bus or memory) are translated to addresses of a destination (space, bus). The following mappings are possible:

- space => space
- space => bus
- bus => bus
- memory => bus

With a mapping you specify a range of source addresses you want to map (specified by a source offset and a size), the destination to which you want to map them (a bus or another address space), and the offset address in the destination.

- The dest argument specifies the destination. This can be a bus or another address space (only for a space to space mapping). This argument is required.
- The src_offset argument specifies the offset of the source addresses. In combination with size, this specifies the range of address that are mapped. By default the source offset is 0x0000.
- The size argument specifies the number of addresses that are mapped. This argument is required.
• The `dest_offset` argument specifies the position in the destination to which the specified range of addresses is mapped. By default the destination offset is 0x0000.

If you are mapping a bus to another bus, the number of data lines of each bus may differ. In this case you have to specify a range of source data lines you want to map (`src_dbits = begin..end`) and the range of destination data lines you want to map them to (`dest_dbits = first..last`).

• The `src_dbits` argument specifies a range of data lines of the source bus. By default all data lines are mapped.

• The `dest_dbits` argument specifies a range of data lines of the destination bus. By default, all data lines from the source bus are mapped on the data lines of the destination bus (starting with line 0).

If you define a memory and the memory mapping must not be used by default when locating sections in address spaces, you can specify the `reserved` argument. This marks all address space areas that the mapping points to as reserved. If a section has an absolute or address range restriction, the reservation is lifted and the section may be located at these locations. This feature is only useful when more than one mapping is available for a range of memory addresses, otherwise the `memory` keyword with the same name would be used.

For example:

```c
memory xrom
{
    mau = 8;
    size = 1M;
    type = rom;
    map cached (dest=bus:spe:fpi_bus, dest_offset=0x80000000, size=1M);
    map not_cached (dest=bus:spe:fpi_bus, dest_offset=0xa0000000, size=1M, reserved);
}
```

**Mapping priority**

If you define a memory you can set a locate priority on a mapping with the keywords `priority` and `exec_priority`. The values of these priorities are relative which means they add to the priority of memories. Whereas a priority set on the memory applies to all address space areas reachable through any mapping of the memory, a priority set on a mapping only applies to address space areas reachable through the mapping. The memory mapping with the highest priority is considered first when locating. To set only a priority for non-executable (data) sections, add a `priority` keyword with the desired value and an `exec_priority` set to zero. To set only a priority for executable (code) sections, simply set an `exec_priority` keyword to the desired value.

The default for a mapping `priority` is zero, while the default for `exec_priority` is the same as the specified `priority`. If you specify a value for `priority` in LSL it must be greater than zero. A value for `exec_priority` must be greater or equal to zero.

For more information about priority values see the description of the `memory priority` keyword.
memory dspram
{
  mau = 8;
  size = 112k;
  type = ram;
  map (dest=bus:mycore_1:fpi_bus, dest_offset=0xd0000000,
       size=112k, priority=8, exec_priority=0);
  map (dest=bus:sri, dest_offset=0x70000000,
       size=112k);
}

From space to space

If you map an address space to another address space (nesting), you can do this by mapping the subspace to the containing larger space. In this example a small space of 64 kB is mapped on a large space of 16 MB.

space small
{
  id = 2;
  mau = 4;
  map (src_offset = 0, dest_offset = 0,
       dest = space : large, size = 64k);
}

From space to bus

All spaces that are not mapped to another space must map to a bus in the architecture:

space large
{
  id = 1;
  mau = 4;
  map (src_offset = 0, dest_offset = 0,
       dest = bus:bus_name, size = 16M );
}

From bus to bus

The next example maps an external bus called e_bus to an internal bus called i_bus. This internal bus resides on a core called mycore. The source bus has 16 data lines whereas the destination bus has only 8 data lines. Therefore, the keywords src_dbits and dest_dbits specify which source data lines are mapped on which destination data lines.

architecture mycore
{
  bus i_bus
  {
    mau = 4;
  }
}
space i_space
{
    map (dest=bus:i_bus, size=256);
}

bus e_bus
{
    mau = 16;
    width = 16;
    map (dest = bus:mycore:i_bus, src_dbits = 0..7, dest_dbits = 0..7 )
}

It is not possible to map an internal bus to an external bus.

13.5. Semantics of the Derivative Definition

Keywords in the derivative definition

derivative
declare
extends
core
architecture
import
space_id_offset
copytable_space
bus
mau
width
map
memory
type reserved rom ram nvram blockram
mau
size
speed
priority
exec_priority
fill
write_unit
map
section_layout
section_setup
map
    dest bus space
    dest_dbits
    dest_offset
    size
13.5.1. Defining a Derivative

With the keyword `derivative` you define a derivative and assign a unique name to it. The name is used to refer to it at other places in the LSL file:

```latex
derivative name
{
  definitions
}
```

If you are defining multiple derivatives that show great resemblance, you can define the common features in a parent derivative and extend this with a child derivative that contains specific features. The child inherits all features of the parent (cores and memories). With the keyword `extends` you create a child derivative:

```latex
derivative name_child_deriv extends name_parent_deriv
{
  definitions
}
```

As with a core architecture, a derivative can have any number of parameters. These are identifiers which get values assigned on instantiation or extension of the derivative. You can use them in any expression within the derivative definition.

```latex
derivative name_child_deriv (parm1 parm2=1)
  extends name_parent_deriv (arguments)
{
  definitions
}
```

13.5.2. Instantiating Core Architectures

With the keyword `core` you instantiate a core architecture in a derivative.

- With the keyword `architecture` you tell the linker that the given core has a certain architecture. The architecture name refers to an existing architecture definition in the same LSL file.

  For example, if you have two cores (called `mycore_1` and `mycore_2`) that have the same architecture (called `mycorearch`), you must instantiate both cores as follows:

```latex
core mycore_1
{
  architecture = mycorearch;
}
```
If the architecture definition has parameters you must specify the arguments that correspond with the parameters. For example `mycorearch1` expects two parameters which are used in the architecture definition:

```plaintext
core mycore
{
    architecture = mycorearch1 (1,2);
}
```

- With the keyword `import` you can combine multiple cores with the same architecture into a single link task. The imported cores share a single symbol namespace.

- The address spaces in each imported core must have a unique ID in the link task. With the keyword `space_id_offset` you specify for each imported core that the space IDs of the imported core start at a specific offset.

- With the keyword `copytable_space` you can specify that writable sections for a core must be initialized by using the copy table of a different core.

```plaintext
core mycore_1
{
    architecture = mycorearch;
    space_id_offset = 100; // add 100 to all space IDs in
    // the architecture definition
    copytable_space = mycore:myspace; // use copytable from core mycore
}
core mycore_2
{
    architecture = mycorearch;
    space_id_offset = 200; // add 200 to all space IDs in
    // the architecture definition
    copytable_space = mycore:myspace; // use copytable from core mycore
}
core mycore
{
    architecture = mycorearch;
    import mycore_1; // add all address spaces of mycore_1 for linking
    import mycore_2; // add all address spaces of mycore_2 for linking
}
13.5.3. Defining Internal Memory and Buses

With the keyword `memory` you define physical memory that is present on the target board. The memory name is used to identify the memory and does not conflict with other identifiers. It is common to define internal memory (on-chip) in the derivative definition. External memory (off-chip memory) is usually defined in the board specification (See Section 13.6.3, Defining External Memory and Buses).

- The `type` field specifies a memory type:
  - `rom`: read-only memory - it can only be written at load-time
  - `ram`: random access volatile writable memory - writing at run-time is possible while writing at load-time has no use since the data is not retained after a power-down
  - `nvram`: non volatile ram - writing is possible both at load-time and run-time
  - `blockram`: writing is possible both at load-time and run-time. Changes are applied in RAM, so after a full device reset the data in a blockram reverts to the original state.

The optional `reserved` qualifier before the memory type, tells the linker not to locate any section in the memory by default. You can locate sections in such memories using an absolute address or range restriction (see subsection Locating a group in Section 13.8.2, Creating and Locating Groups of Sections).

- The `mau` field specifies the MAU size (Minimum Addressable Unit) of the memory. This field is required.
- The `size` field specifies the size in MAU of the memory. This field is required.
- The `priority` field specifies a locate priority for a memory. The `speed` field has the same meaning but is considered deprecated. By default, a memory has its priority set to 1. The memories with the highest priority are considered first when trying to locate a rule. Subsequently, the next highest priority memories are added if the rule was not located successfully, and so on until the lowest priority that is available is reached or the rule is located. The lowest priority value is zero. Sections with an `ordered` and/or `contiguous` restriction are not affected by the locate priority. If such sections also have a `page` restriction, the locate priority is still used to select a page.

- If an `exec_priority` is specified for a memory, the regular priority (either specified or its default value) does not apply to locate rules with only executable sections. Instead, the supplied value applies for such rules. Additionally, the `exec_priority` value is used for any executable unrestricted sections, even if they appear in an unrestricted rule together with non-executable sections.

- The `map` field specifies how this memory maps onto an (internal) bus. The mapping can have a name. Mappings are described in Section 13.4.4, Mappings.

- The optional `write_unit` field specifies the minimum write unit (MWU). This is the minimum number of MAUs required in a write action. This is useful to initialize memories that can only be written in units of two or more MAUs. If `write_unit` is not defined the minimum write unit is 0.

- The optional `fill` field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.
memory mem_name
{
  type = rom;
  mau = 8;
  write_unit = 4;
  fill = 0xaa;
  size = 64k;
  priority = 2;
  map map_name ( map_description );
}

With the bus keyword you define a bus in a derivative definition. Buses are described in Section 13.4.2, Defining Internal Buses.


Keywords in the board specification

processor
  derivative
bus
  mau
  width
  map
memory
  type reserved rom ram nvram blockram
  mau
  size
  speed
  priority
  exec_priority
  fill
  write_unit
  map

map
  dest bus space
  dest_dbits
  dest_offset
  size
  src_dbits
  src_offset
  priority
  exec_priority
  reserved
13.6.1. Defining a Processor

If you have a target board with multiple processors that have the same derivative, you need to instantiate each individual processor in a processor definition. This information tells the linker which processor has which derivative and enables the linker to distinguish between the present processors.

If you use processors that all have a unique derivative, you may omit the processor definitions. In this case the linker assumes that for each derivative definition in the LSL file there is one processor. The linker uses the derivative name also for the processor.

With the keyword `processor` you define a processor. You can freely choose the processor name. The name is used to refer to it at other places in the LSL file:

```plaintext
processor proc_name
{
    processor definition
}
```

13.6.2. Instantiating Derivatives

With the keyword `derivative` you tell the linker that the given processor has a certain derivative. The derivative name refers to an existing derivative definition in the same LSL file.

For example, if you have two processors on your target board (called `myproc_1` and `myproc_2`) that have the same derivative (called `myderiv`), you must instantiate both processors as follows:

```plaintext
processor myproc_1
{
    derivative = myderiv;
}
processor myproc_2
{
    derivative = myderiv;
}
```

If the derivative definition has parameters you must specify the arguments that correspond with the parameters. For example `myderiv1` expects two parameters which are used in the derivative definition:

```plaintext
processor myproc
{
    derivative = myderiv1 (2,4);
}
```

13.6.3. Defining External Memory and Buses

It is common to define external memory (off-chip) and external buses at the global scope (outside any enclosing definition). Internal memory (on-chip memory) is usually defined in the scope of a derivative definition.
With the keyword `memory` you define physical memory that is present on the target board. The memory name is used to identify the memory and does not conflict with other identifiers. If you define memory parts in the LSL file, only the memory defined in these parts is used for placing sections.

If no external memory is defined in the LSL file and if the linker option to allocate memory on demand is set then the linker will assume that all virtual addresses are mapped on physical memory. You can override this behavior by specifying one or more memory definitions.

```plaintext
memory  mem_name
{
    type = rom;
    mau = 8;
    write_unit = 4;
    fill = 0xaa;
    size = 64k;
    priority = 2;
    map  map_name ( map_description );
}
```

For a description of the keywords, see Section 13.5.3, *Defining Internal Memory and Buses*.

With the keyword `bus` you define a bus (the combination of data and corresponding address bus). The bus name is used to identify a bus and does not conflict with other identifiers. Bus descriptions at the global scope (outside any definition) define external buses. These are buses that are present on the target board.

```plaintext
bus  bus_name
{
    mau = 8;
    width = 8;
    map  ( map_description );
}
```

For a description of the keywords, see Section 13.4.2, *Defining Internal Buses*.

You can connect off-chip memory to any derivative: you need to map the off-chip memory to a bus and map that bus on the internal bus of the derivative you want to connect it to.

### 13.7. Semantics of the Section Setup Definition

#### Keywords in the section setup definition

```plaintext
section_setup
    stack
        min_size
        grows  low_to_high  high_to_low
        align
        fixed
        id
    heap
```
13.7.1. Setting up a Section

With the keyword `section_setup` you can define stacks, heaps and/or reserved address ranges outside their address space definition.

```
section_setup ::my_space
{
    reserved address range
    stack definition
    heap definition
}
```

See the subsections Stacks and heaps and Reserved address ranges in Section 13.4.3, Defining Address Spaces for details on the keywords `stack`, `heap` and `reserved`.

13.8. Semantics of the Section Layout Definition

Keywords in the section layout definition

```
section_layout
direction     low_to_high  high_to_low
group
    align
    attributes    + - r w x b i s p
copy
nocopy
fill
ordered
contiguous
clustered
overlay
allow_cross_references
load_addr
    mem
run_addr
    mem
page
page_size
priority
select
stack
size
```
13.8.1. Defining a Section Layout

With the keyword `section_layout` you define a section layout for exactly one address space. In the section layout you can specify how input sections are placed in the address space, relative to each other, and what the absolute run and load addresses of each section will be.

You can define one or more section definitions. Each section definition arranges the sections in one address space. You can precede the address space name with a processor name and/or core name, separated by colons. You can omit the processor name and/or the core name if only one processor is defined and/or only one core is present in the processor. A reference to a space in the only core of the only processor in the system would look like "::my_space". A reference to a space of the only core on a specific processor in the system could be "my_chip::my_space". The next example shows a section definition for sections in the `my_space` address space of the processor called `my_chip`:

```
section_layout my_chip::my_space ( locate_direction )
{
    section statements
}
```

**Locate direction**

With the optional keyword `direction` you specify whether the linker starts locating sections from `low_to_high` (default) or from `high_to_low`. In the second case the linker starts locating sections at the highest addresses in the address space but preserves the order of sections when necessary (one processor and core in this example).

```
section_layout ::my_space ( direction = high_to_low )
{
    section statements
}
```
If you do not explicitly tell the linker how to locate a section, the linker decides on the basis of the section attributes in the object file and the information in the architecture definition and memory parts where to locate the section.

13.8.2. Creating and Locating Groups of Sections

Sections are located per group. A group can contain one or more (sets of) input sections as well as other groups. Per group you can assign a mutual order to the sets of sections and locate them into a specific memory part.

\[
group (\ \text{group\_specifications})
\{
\text{section\_statements}
\}
\]

With the \textit{section\_statements} you generally select sets of sections to form the group. This is described in subsection Selecting sections for a group.

Instead of selecting sections, you can also modify special sections like stack and heap or create a reserved section. This is described in Section 13.8.3, Creating or Modifying Special Sections.

With the \textit{group\_specifications} you actually locate the sections in the group. This is described in subsection Locating a group.

Selecting sections for a group

With the keyword \texttt{select} you can select one or more sections for the group. You can select a section by name or by attributes. If you select a section by name, you can use a wildcard pattern:

* matches with all section names
? matches with a single character in the section name
\ takes the next character literally
[abc] matches with a single 'a', 'b' or 'c' character
[a-z] matches with any single character in the range 'a' to 'z'

\[
group (\ \ldots\ )
\{
\texttt{select} \ "mysection";
\texttt{select} \ "*";
\}
\]

The first \texttt{select} statement selects the section with the name "mysection". The second \texttt{select} statement selects all sections that were not selected yet.

A section is selected by the first select statement that matches, in the union of all section layouts for the address space. Global section layouts are processed in the order in which they appear in the LSL file. Internal core architecture section layouts always take precedence over global section layouts.
• The attributes field selects all sections that carry (or do not carry) the given attribute. With +attribute you select sections that have the specified attribute set. With -attribute you select sections that do not have the specified attribute set. You can specify one or more of the following attributes:

• r readable sections
• w writable sections
• x executable sections
• i initialized sections
• b sections that should be cleared at program startup
• s scratch sections (not cleared and not initialized)
• p protected sections

To select all read-only sections:

```c
group { ... }
{
    select (attributes = +r-w);
}
```

Keep in mind that all section selections are restricted to the address space of the section layout in which this group definition occurs.

• With the ref_tree field you can select a group of related sections. The relation between sections is often expressed by means of references. By selecting just the 'root' of tree, the complete tree is selected. This is for example useful to locate a group of related sections in special memory (e.g. fast memory). The (referenced) sections must meet the following conditions in order to be selected:

1. The sections are within the section layout's address space
2. The sections match the specified attributes
3. The sections have no absolute restriction (as is the case for all wildcard selections)

For example, to select the code sections referenced from foo1:

```c
group refgrp (ordered, contiguous, run_addr=mem:ext_c)
{
    select ref_tree "foo1" (attributes=+x);
}
```

If section foo1 references foo2 and foo2 references foo3, then all these sections are selected by the selection shown above.

**Locating a group**

```c
group group_name ( group Specifications )
{
```
With the `group_specifications` you actually define how the linker must locate the group. You can roughly define three things: 1) assign properties to the sections in a group like alignment and read/write attributes, 2) define the mutual order in the address space for sections in the group and 3) restrict the possible addresses for the sections in a group.

The linker creates labels that allow you to refer to the begin and end address of a group from within the application software. Labels `_lc_gb_group_name` and `_lc_ge_group_name` mark the begin and end of the group respectively, where the begin is the lowest address used within this group and the end is the highest address used. Notice that a group not necessarily occupies all memory between begin and end address. The given label refers to where the section is located at run-time (versus load-time).

1. Assign properties to the sections in a group like alignment and read/write attributes.

   These properties are assigned to all sections in the group (and subgroups) and override the attributes of the input sections.

   - The `align` field tells the linker to align all sections in the group according to the align value. The alignment of a section is first determined by its own initial alignment and the defined alignment for the address space. Alignments are never decreased, if multiple alignments apply to a section, the largest one is used.

   - The `attributes` field tells the linker to assign one or more attributes to all sections in the group. This overrules the default attributes. By default the linker uses the attributes of the input sections. You can set the `r`, `w`, or `rw` attributes and you can switch between the `b` and `s` attributes.

   - The `copy` field tells the linker to locate a read-only section in RAM and generate a ROM copy and a copy action in the copy table. This property makes the sections in the group writable which causes the linker to generate ROM copies for the sections.

   - The effect of the `nocopy` field is the opposite of the `copy` field. It prevents the linker from generating ROM copies of the selected sections.

2. Define the mutual order of the sections in the group.

   By default, a group is `unrestricted` which means that the linker has total freedom to place the sections of the group in the address space.

   - The `ordered` keyword tells the linker to locate the sections in the same order in the address space as they appear in the group (but not necessarily adjacent).

     Suppose you have an ordered group that contains the sections ‘A’, ‘B’ and ‘C’. By default the linker places the sections in the address space like ‘A’ - ‘B’ - ‘C’, where section ‘A’ gets the lowest possible address. With `direction=high_to_low` in the `section_layout` space properties, the linker places the sections in the address space like ‘C’ - ‘B’ - ‘A’, where section ‘A’ gets the highest possible address.

   - The `contiguous` keyword tells the linker to locate the sections in the group in a single address range. Within a contiguous group the input sections are located in arbitrary order, however the group
occupies one contiguous range of memory. Due to alignment of sections there can be 'alignment gaps' between the sections.

When you define a group that is both ordered and contiguous, this is called a sequential group. In a sequential group the linker places sections in the same order in the address space as they appear in the group and it occupies a contiguous range of memory.

- The clustered keyword tells the linker to locate the sections in the group in a number of contiguous blocks. It tries to keep the number of these blocks to a minimum. If enough memory is available, the group will be located as if it was specified as contiguous. Otherwise, it gets split into two or more blocks.

If a contiguous or clustered group contains alignment gaps, the linker can locate sections that are not part of the group in these gaps. To prevent this, you can use the fill keyword. If the group is located in RAM, the gaps are treated as reserved (scratch) space. If the group is located in ROM, the alignment gaps are filled with zeros by default. You can however change the fill pattern by specifying a bit pattern. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU.

- The overlay keyword tells the linker to overlay the sections in the group. The linker places all sections in the address space using a contiguous range of addresses. (Thus an overlay group is automatically also a contiguous group.) To overlay the sections, all sections in the overlay group share the same run-time address.

For each input section within the overlay the linker automatically defines two symbols. The symbol _lc_cb_section_name is defined as the load-time start address of the section. The symbol _lc_ce_section_name is defined as the load-time end address of the section. Assembly code may be used to copy the overlaid sections.

If sections in the overlay group contain references between groups, the linker reports an error. The keyword allow_cross_references tells the linker to accept cross-references. Normally, it does not make sense to have references between sections that are overlaid.

```plaintext
group ovl (overlay)
{
    group a
    {
        select "my_ovl_p1";
        select "my_ovl_p2";
    }
    group b
    {
        select "my_ovl_q1";
    }
}
```

It may be possible that one of the sections in the overlay group already has been defined in another group where it received a load-time address. In this case the linker does not overrule this load-time address and excludes the section from the overlay group.
3. Restrict the possible addresses for the sections in a group.

The load-time address specifies where the group’s elements are loaded in memory at download time. The run-time address specifies where sections are located at run-time, that is when the program is executing. If you do not explicitly restrict the address in the LSL file, the linker assigns addresses to the sections based on the restrictions relative to other sections in the LSL file and section alignments. The program is responsible for copying overlay sections at appropriate moment from its load-time location to its run-time location (this is typically done by the startup code).

- The `run_addr` keyword defines the run-time address. If the run-time location of a group is set explicitly, the given order between groups specify whether the run-time address propagates to the parent group or not. The location of the sections a group can be restricted either to a single absolute address, or to a number of address ranges (not including the end address). With an expression you can specify that the group should be located at the absolute address specified by the expression:

  ```
  group (run_addr = 0xa00f0000)
  ```

  If the group is ordered, the first section in the group is located at the specified absolute address.

  You can use the `[offset]` variant to locate the group at the given absolute offset in memory:

  ```
  group (run_addr = mem:A[0x1000])
  ```

  If the group is ordered, the first section in the group is located at the specified absolute offset in memory.

  A range can be an absolute space address range, written as `expr .. expr`, a complete memory device, written as `mem:mem_name`, or a memory address range, `mem:mem_name[expr .. expr]`

  ```
  group (run_addr = mem:my_dram)
  ```

  You can use the `|` to specify an address range of more than one physical memory device:

  ```
  group (run_addr = mem:A | mem:B)
  ```

  When used in top-level section layouts, a memory name refers to a board-level memory. You can select on-chip memory with `mem:proc_name:mem_name`. If the memory has multiple parallel mappings towards the current address space, you can select a specific named mapping in the memory by appending `/map_name` to the memory specifier. The linker then maps memory offsets only through that mapping, so the address(es) where the sections in the group are located are determined by that memory mapping.

  ```
  group (run_addr = mem:CPU1:A/cached)
  ```

- The `load_addr` keyword changes the meaning of the section selection in the group: the linker selects the load-time ROM copy of the named section(s) instead of the regular sections. Just like `run_addr` you can specify an absolute address or an address range.

  ```
  group (contiguous, load_addr)
  {
    select "mydata";  // select ROM copy of mydata:
  ```
The load-time and run-time addresses of a group cannot be set at the same time. If the load-time property is set for a group, the group (only) restricts the positioning at load-time of the group's sections. It is not possible to set the address of a group that has a not-unrestricted parent group.

The properties of the load-time and run-time start address are:

- At run-time, before using an element in an overlay group, the application copies the sections from their load location to their run-time location, but only if these two addresses are different. For non-overlay sections this happens at program start-up.

- The start addresses cannot be set to absolute values for unrestricted groups.

- For non-overlay groups that do not have an overlay parent, the load-time start address equals the run-time start address.

- For any group, if the run-time start address is not set, the linker selects an appropriate address.

- If an ordered group or sequential group has an absolute address and contains sections that have separate page restrictions (not defined in LSL), all those sections are located in a single page. In other cases, for example when an unrestricted group has an address range assigned to it, the paged sections may be located in different pages.

For overlays, the linker reserves memory at the run-time start address as large as the largest element in the overlay group.

- The page keyword tells the linker to place the group in one page. Instead of specifying a run-time address, you can specify a page and optional a page number. Page numbers start from zero. If you omit the page number, the linker chooses a page.

The page keyword refers to pages in the address space as defined in the architecture definition.

- With the page_size keyword you can override the page alignment and size set on the address space. When you set the page size to zero, the linker removes simple (auto generated) page restrictions from the selected sections. See also the page_size keyword in Section 13.4.3, Defining Address Spaces.

- With the priority keyword you can change the order in which sections are located. This is useful when some sections are considered important for good performance of the application and a small amount of fast memory is available. The value is a number for which the default is 1, so higher priorities start at 2. Sections with a higher priority are located before sections with a lower priority, unless their relative locate priority is already determined by other restrictions like run_addr and page.

```linker
group (priority=2)
{
    select "importantcode1";
    select "importantcode2";
}
```
13.8.3. Creating or Modifying Special Sections

Instead of selecting sections, you can also create a reserved section or an output section or modify special sections like a stack or a heap. Because you cannot define these sections in the input files, you must use the linker to create them.

Stack

• The keyword stack tells the linker to reserve memory for the stack. The name for the stack section refers to the stack as defined in the architecture definition. If no name was specified in the architecture definition, the default name is stack.

With the keyword size you can specify the size for the stack. If the size is not specified, the linker uses the size given by the min_size argument as defined for the stack in the architecture definition. Normally the linker automatically tries to maximize the size, unless you specified the keyword fixed.

```plaintext
group ( ... )
{
    stack "mystack" ( size = 2k );
}
```

The linker creates two labels to mark the begin and end of the stack, _lc_ub_stack_name for the begin of the stack and _lc_ue_stack_name for the end of the stack. The linker allocates space for the stack when there is a reference to either of the labels.

See also the stack keyword in Section 13.4.3, Defining Address Spaces.

Heap

• The keyword heap tells the linker to reserve a dynamic memory range for the malloc() function. Each heap section has a name. With the keyword size you can change the size for the heap. If the size is not specified, the linker uses the size given by the min_size argument as defined for the heap in the architecture definition. Normally the linker automatically tries to maximize the size, unless you specified the keyword fixed.

```plaintext
group ( ... )
{
    heap "myheap" ( size = 2k );
}
```

The linker creates two labels to mark the begin and end of the heap, _lc_ub_heap_name for the begin of the heap and _lc_ue_heap_name for the end of the heap. The linker allocates space for the heap when a reference to either of the section labels exists in one of the input object files.

Reserved section

• The keyword reserved tells the linker to create an area or section of a given size. The linker will not locate any other sections in the memory occupied by a reserved section, with some exceptions. Each reserved section has a name. With the keyword size you can specify a size for a given reserved area or section.
group ( ... )
{
    reserved "myreserved" ( size = 2k );
}

The optional fill field contains a bit pattern that the linker writes to all memory addresses that remain unoccupied during the locate process. The result of the expression, or list of expressions, is used as values to write to memory, each in MAU. The first MAU of the fill pattern is always the first MAU in the section.

By default, no sections can overlap with a reserved section. With alloc_allowed=absolute sections that are located at an absolute address due to an absolute group restriction can overlap a reserved section. The same applies for reserved sections with alloc_allowed=ranged set. Sections restricted to a fixed address range can also overlap a reserved section.

With the attributes field you can set the access type of the reserved section. The linker locates the reserved section in its space with the restrictions that follow from the used attributes, r, w or x or a valid combination of them. The allowed attributes are shown in the following table. A value between < and > in the table means this value is set automatically by the linker.

<table>
<thead>
<tr>
<th>Properties set in LSL</th>
<th>Resulting section properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>attributes</td>
<td>filled</td>
</tr>
<tr>
<td>x</td>
<td>yes</td>
</tr>
<tr>
<td>r</td>
<td>yes</td>
</tr>
<tr>
<td>r</td>
<td>no</td>
</tr>
<tr>
<td>rx</td>
<td>yes</td>
</tr>
<tr>
<td>rw</td>
<td>yes</td>
</tr>
<tr>
<td>rw</td>
<td>no</td>
</tr>
<tr>
<td>rwx</td>
<td>yes</td>
</tr>
</tbody>
</table>

If you do not specify any attributes, the linker will reserve the given number of maus, no matter what type of memory lies beneath. If you do not specify a fill pattern, no section is generated.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name for the begin of the section and _lc_ue_name for the end of the reserved section.

**Output sections**

- The keyword section tells the linker to accumulate sections obtained from object files ("input sections") into an output section of a fixed size in the locate phase. You can select the input sections with select statements. You can use groups inside output sections, but you can only set the align, attributes, copy and load_addr properties and the load_addr property cannot have an address specified.
The **fill** field contains a bit pattern that the linker writes to all unused space in the output section. When all input sections have an image (code/data) you must specify a fill pattern. If you do not specify a fill pattern, all input sections must be scratch sections. The fill pattern is aligned at the start of the output section.

As with a reserved section you can use the **attributes** field to set the access type of the output section.

```c
section "myoutput" ( size = 4k, attributes = rw,
                      fill = 0xaa )
{
    select "myinput1";
    select "myinput2";
}
```

The available room for input sections is determined by the **size**, **blocksize** and **overflow** fields. With the keyword **size** you specify the fixed size of the output section. Input sections are placed from output section start towards higher addresses (offsets). When the end of the output section is reached and one or more input sections are not yet placed, an error is emitted. If however, the **overflow** field is set to another output section, remaining sections are located as if they were selected for the overflow output section.

```c
section "tsk1_data" (size=4k, attributes=rw, fill=0,
                      overflow = "overflow_data")
{
    select ".data.tsk1.*"  
}
section "tsk2_data" (size=4k, attributes=rw, fill=0,
                      overflow = "overflow_data")
{
    select ".data.tsk2.*"  
}
section "overflow_data" (size=4k, attributes=rx,
                         fill=0)
{
}
```

With the keyword **blocksize**, the size of the output section will adapt to the size of its content. For example:

```c
group flash_area (run_addr = 0x10000)
{
    section "flash_code" (blocksize=4k, attributes=rx,
                            fill=0)
    {
```
select "*.flash";
}
}

If the content of the section is 1 mau, the size will be 4 kB, if the content is 11 kB, the section will be 12 kB, etc. If you use size in combination with blocksize, the size value is used as default (minimal) size for this section. If it is omitted, the default size will be of blocksize. It is not allowed to omit both size and blocksize from the section definition.

The linker creates two labels to mark the begin and end of the section, _lc_ub_name for the begin of the section and _lc_ue_name for the end of the output section.

When the copy property is set on an enclosing group, a ROM copy is created for the output section and the output section itself is made writable causing it to be located in RAM by default. For this to work, the output section and its input sections must be read-only and the output section must have a fill property.

Copy table

• The keyword copytable tells the linker to select a section that is used as copy table. The content of the copy table is created by the linker. It contains the start address and length of all sections that should be initialized by the startup code.

The linker creates two labels to mark the begin and end of the section, _lc_ub_table for the begin of the section and _lc_ue_table for the end of the copy table. The linker generates a copy table when a reference to either of the section labels exists in one of the input object files.

Memory copy sections

• If a memory (usually RAM) needs to be initialized by a different core than the one(s) that will use it, a copy of the contents of the memory can be placed in a section using a memcpy statement in a section_layout. All data (including code) present in the specified memory is then placed in a new section with the provided name and appropriate attributes. Unused areas in the memory are filled in the section using the supplied fill pattern or with zeros if no fill pattern is specified. If the memory contains a memory copy section the result is undefined. The actual initialization of the memory at run-time needs to be done separately, this LSL feature only directs the linker to make the data located in the memory available for initialization. Note that a memory of type ram cannot hold initialized data, use type blockram instead.

13.8.4. Creating Symbols

You can tell the linker to create symbols before locating by putting assignments in the section layout definition. Symbol names are represented by double-quoted strings. Any string is allowed, but object files may not support all characters for symbol names. You can use two different assignment operators. With the simple assignment operator '='; the symbol is created unconditionally. With the ':=' operator, the symbol is only created if it already exists as an undefined reference in an object file.

The expression that represents the value to assign to the symbol may contain references to other symbols. If such a referred symbol is a special section symbol, creation of the symbol in the left hand side of the assignment will cause creation of the special section.
13.8.5. Conditional Group Statements

Within a group, you can conditionally select sections or create special sections.

• With the if keyword you can specify a condition. The succeeding section statement is executed if the condition evaluates to TRUE (1).

• The optional else keyword is followed by a section statement which is executed in case the if-condition evaluates to FALSE (0).

```plaintext
group ( ... )
{
    if ( exists( "mysection" ) )
        select "mysection";
    else
        reserved "myreserved" ( size=2k );
}
```
Chapter 14. Debug Target Configuration Files

DTC files (Debug Target Configuration files) define all possible configurations for a debug target. A debug target can be target hardware such as an evaluation board or a simulator. The DTC files are used by Eclipse to configure the project and the debugger. The information is used by the Target Board Configuration wizard and the debug configuration. DTC files are located in the etc directory of the installed product and use .dtc as filename suffix.

Based on the DTC files, the Target Board Configuration wizard adjust the project's LSL file and creates a debug launch configuration.

14.1. Custom Board Support

When you need support for a custom board and the board requires a different configuration than those that are in the product, it is necessary to create a dedicated DTC file.

To add a custom board

1. From the etc directory of the product, make a copy of a .dtc file and put it in your project directory (in the current workspace).

   In Eclipse, the DTC file should now be visible as part of your project.

2. Edit the file and give it a name that reflects the custom board.

The Import Board Configuration wizard in Eclipse adds DTC files that are present in your current project to the list of available target boards.

Syntax of a DTC file

DTC files are XML files and use the XML Schema file dtc.xsd, also present in the etc directory of the installed product.

Inspect the DTC XML schema file dtc.xsd for a description of the allowed elements and the available attributes. Use a delivered .dtc file as a starting point for creating a custom board specification.

Basically a DTC file consists of the definition of the debug target (debugTarget element) which embodies one or more configurations (configuration element) and one or more communication methods (communicationMethod element).

DTC macros in LSL

To protect wizards/dialogs from changing the LSL file, you can protect the LSL file by adding the macro __DTC_IGNORE. This can be useful for projects that need the same LSL file, but still need to run on different target boards.

#define __DTC_IGNORE
### 14.2. Description of DTC Elements and Attributes

The following table contains a description of the DTC elements and attributes. For each element a list of allowed elements is listed and the available attributes are described.

<table>
<thead>
<tr>
<th>Element / Attribute</th>
<th>Description</th>
<th>Allowed Elements</th>
</tr>
</thead>
<tbody>
<tr>
<td>debugTarget</td>
<td>The debug target.</td>
<td>flashChips, Isl, communicationMethod, def, processor, resource, initialize</td>
</tr>
<tr>
<td>name</td>
<td>The name of the configuration.</td>
<td></td>
</tr>
<tr>
<td>manufacturer</td>
<td>The manufacturer of the debug target.</td>
<td></td>
</tr>
<tr>
<td>processor</td>
<td>Defines a processor that can be present on the debug target. Multiple processor definitions are allowed. The user should select the actual processor on the debug target.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>A descriptive name of the processor derivative.</td>
<td></td>
</tr>
<tr>
<td>cpu</td>
<td>Defines the CPU name.</td>
<td></td>
</tr>
<tr>
<td>communicationMethod</td>
<td>Defines a communication method. A communication method is the channel that is used to communicate with the target.</td>
<td>ref, resource, initialize, configuration, Isl, processor</td>
</tr>
<tr>
<td>name</td>
<td>A descriptive name of the communication method.</td>
<td></td>
</tr>
<tr>
<td>debugInstrument</td>
<td>The debug instrument DLL/Shared library file to be used for this communication method. Do not supply a path or a filename suffix.</td>
<td></td>
</tr>
<tr>
<td>gdiMethod</td>
<td>This is the method used for communication. Allowed values: rs232, tcpip, can, none</td>
<td></td>
</tr>
<tr>
<td>def</td>
<td>Defines a set of elements as a macro. The macro can be expanded using the ref element.</td>
<td>Isl, resource, initialize, def, configuration, flashMonitor</td>
</tr>
<tr>
<td>id</td>
<td>The macro name.</td>
<td></td>
</tr>
<tr>
<td>resource</td>
<td>Defines a resource definition that can be used by Eclipse, the debugger or by the debug instrument.</td>
<td></td>
</tr>
<tr>
<td>id</td>
<td>The identifier name used by the debugger or debug instrument to retrieve the value.</td>
<td></td>
</tr>
<tr>
<td>value</td>
<td>The value assigned to the resource.</td>
<td></td>
</tr>
<tr>
<td>ref</td>
<td>Reference to a macro defined with a def element. The elements contained in the def element with the same name will be expanded at the location of the ref. Multiple refs to the same def are allowed.</td>
<td></td>
</tr>
<tr>
<td>id</td>
<td>The name of the referenced macro.</td>
<td></td>
</tr>
<tr>
<td>Element / Attribute</td>
<td>Description</td>
<td>Allowed Elements</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------</td>
<td>------------------</td>
</tr>
<tr>
<td>configuration</td>
<td>Defines a configuration.</td>
<td>ref, initialize, resource, lsl, flashMonitor, processor</td>
</tr>
<tr>
<td>name</td>
<td>The descriptive name of the configuration.</td>
<td></td>
</tr>
<tr>
<td>initialize</td>
<td>This element defines an initialization expression. Each initialize element contains a resourceId attribute. If the DI requests this resource the debugger will compose a string from all initialize elements with the same resourceId. This DI can use this string to initialize registers by passing it to the debugger as an expression to be evaluated.</td>
<td>-</td>
</tr>
<tr>
<td>resourceId</td>
<td>The name of the resource to be used.</td>
<td></td>
</tr>
<tr>
<td>name</td>
<td>The name of the register to be initialized.</td>
<td></td>
</tr>
<tr>
<td>value</td>
<td>When the cstart attribute is false, this is the value to be used, otherwise, it is the default value when using this configuration. It will be used by the startup code editor to set the default register values.</td>
<td></td>
</tr>
<tr>
<td>cstart</td>
<td>A boolean value. If true the debugger should ask the C startup code editor for the value, otherwise the contents of the value attribute is used. The default value is true.</td>
<td></td>
</tr>
<tr>
<td>flashMonitor</td>
<td>This element specifies the flash programming monitor to be used for this configuration.</td>
<td>-</td>
</tr>
<tr>
<td>monitor</td>
<td>Filename of the monitor, usually an Intel Hex or S-Record file.</td>
<td></td>
</tr>
<tr>
<td>workspaceAddress</td>
<td>The address of the workspace of the flash programming monitor.</td>
<td></td>
</tr>
<tr>
<td>flashSectorBufferSize</td>
<td>Specifies the buffer size for buffering a flash sector.</td>
<td></td>
</tr>
<tr>
<td>chip</td>
<td>This element defines a flash chip. It must be used by the flash properties page to add it on request to the list of flash chips.</td>
<td>debugTarget</td>
</tr>
<tr>
<td>vendor</td>
<td>The vendor of this flash chip.</td>
<td></td>
</tr>
<tr>
<td>chip</td>
<td>The name of the chip.</td>
<td></td>
</tr>
<tr>
<td>width</td>
<td>The width of the chip in bits.</td>
<td></td>
</tr>
<tr>
<td>chips</td>
<td>The number of chips present on the board.</td>
<td></td>
</tr>
<tr>
<td>baseAddress</td>
<td>The base address of the chip.</td>
<td></td>
</tr>
<tr>
<td>chipSize</td>
<td>The size of the chip in bytes.</td>
<td></td>
</tr>
<tr>
<td>flashChips</td>
<td>Specify a list of flash chips that can be available on this debug target.</td>
<td>chip</td>
</tr>
<tr>
<td>Element / Attribute</td>
<td>Description</td>
<td>Allowed Elements</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>lsl</td>
<td>Defines LSL pieces belonging to the configuration part. The LSL text must be defined between the start and end tag of this element. All LSL texts of the active selection will be placed in the project's LSL file.</td>
<td></td>
</tr>
</tbody>
</table>


Chapter 15. CERT C Secure Coding Standard

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C programming language. The goal of these rules and recommendations is to eliminate insecure coding practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure coding standard will lead to higher-quality systems that are robust and more resistant to attack.

This chapter contains an overview of the CERT C Secure Coding Standard recommendations and rules that are supported by the TASKING VX-toolset.

For details see the CERT C Secure Coding Standard web site. For general information about CERT secure coding, see www.cert.org/secure-coding.

Identifiers

Each rule and recommendation is given a unique identifier. These identifiers consist of three parts:

- a three-letter mnemonic representing the section of the standard
- a two-digit numeric value in the range of 00-99
- the letter "C" indicates that this is a C language guideline

The three-letter mnemonic is used to group similar coding practices and to indicate to which category a coding practice belongs.

The numeric value is used to give each coding practice a unique identifier. Numeric values in the range of 00-29 are reserved for recommendations, while values in the range of 30-99 are reserved for rules.

C compiler invocation

With the C compiler option --cert you can enable one or more checks for the CERT C Secure Coding Standard recommendations/rules. With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all supported checks in the preprocessor category.

15.1. Preprocessor (PRE)

PRE01-C Use parentheses within macros around parameter names

Parenthesize all parameter names in macro definitions to avoid precedence problems.
Macro replacement lists should be parenthesized

Macro replacement lists should be parenthesized to protect any lower-precedence operators from the surrounding expression. The example below is syntactically correct, although the != operator was omitted. Enclosing the constant -1 in parenthesis will prevent the incorrect interpretation and force a compiler error:

```c
#define EOF -1 // should be (-1)
int getchar(void);
void f(void)
{
    if (getchar() EOF) // != operator omitted
    {
        /* ... */
    }
}
```

Wrap multi-statement macros in a do-while loop

When multiple statements are used in a macro, enclose them in a do-while statement, so the macro can appear safely inside if clauses or other places that expect a single statement or a statement block. Braces alone will not work in all situations, as the macro expansion is typically followed by a semicolon.

Do not conclude a single statement macro definition with a semicolon

Macro definitions consisting of a single statement should not conclude with a semicolon. If required, the semicolon should be included following the macro expansion. Inadvertently inserting a semicolon can change the control flow of the program.

15.2. Declarations and Initialization (DCL)

Declare objects with appropriate storage durations

The lifetime of an automatic object ends when the function returns, which means that a pointer to the object becomes invalid.

Declare identifiers before using them

The ISO C90 standard allows implicit typing of variables and functions. Because implicit declarations lead to less stringent type checking, they can often introduce unexpected and erroneous behavior or even security vulnerabilities. The ISO C99 standard requires type identifiers and forbids implicit function declarations. For backwards compatibility reasons, the VX-toolset C compiler assumes an implicit declaration and continues translation after issuing a warning message (W505 or W535).
DCL32-C  Guarantee that mutually visible identifiers are unique

The compiler encountered two or more identifiers that are identical in the first 31 characters. The ISO C99 standard allows a compiler to ignore characters past the first 31 in an identifier. Two distinct identifiers that are identical in the first 31 characters may lead to problems when the code is ported to a different compiler.

DCL35-C  Do not invoke a function using a type that does not match the function definition

This warning is generated when a function pointer is set to refer to a function of an incompatible type. Calling this function through the function pointer will result in undefined behavior. Example:

```c
void my_function(int a);
int main(void)
{
    int (*new_function)(int a) = my_function;
    return (*new_function)(10); /* the behavior is undefined */
}
```

### 15.3. Expressions (EXP)

EXP01-C  Do not take the size of a pointer to determine the size of the pointed-to type

The size of the object(s) allocated by malloc(), calloc() or realloc() should be a multiple of the size of the base type of the result pointer. Therefore, the sizeof expression should be applied to this base type, and not to the pointer type.

EXP12-C  Do not ignore values returned by functions

The compiler gives this warning when the result of a function call is ignored at some place, although it is not ignored for other calls to this function. This warning will not be issued when the function result is ignored for all calls, or when the result is explicitly ignored with a (void) cast.

EXP30-C  Do not depend on order of evaluation between sequence points

Between two sequence points, an object should only be modified once. Otherwise the behavior is undefined.

EXP32-C  Do not access a volatile object through a non-volatile reference

If an attempt is made to refer to an object defined with a volatile-qualified type through use of an lvalue with non-volatile-qualified type, the behavior is undefined.

EXP33-C  Do not reference uninitialized memory

Uninitialized automatic variables default to whichever value is currently stored on the stack or in the register allocated for the variable. Consequently, uninitialized memory can cause a program to behave in an unpredictable or unplanned manner and may provide an avenue for attack.
Ensure a null pointer is not dereferenced

Attempting to dereference a null pointer results in undefined behavior, typically abnormal program termination.

Call functions with the arguments intended by the API

When a function is properly declared with function prototype information, an incorrect call will be flagged by the compiler. When there is no prototype information available at the call, the compiler cannot check the number of arguments and the types of the arguments. This message is issued to warn about this situation.

Do not call offsetof() on bit-field members or invalid types

The behavior of the offsetof() macro is undefined when the member designator parameter designates a bit-field.

15.4. Integers (INT)

Ensure that unsigned integer operations do not wrap

A constant with an unsigned integer type is truncated, resulting in a wrap-around.

Do not shift a negative number of bits or more bits than exist in the operand

The shift count of the shift operation may be negative or greater than or equal to the size of the left operand. According to the C standard, the behavior of such a shift operation is undefined. Make sure the shift count is in range by adding appropriate range checks.

Evaluate integer expressions in a larger size before comparing or assigning to that size

If an integer expression is compared to, or assigned to a larger integer size, that integer expression should be evaluated in that larger size by explicitly casting one of the operands.

15.5. Floating Point (FLP)

Do not use floating point variables as loop counters

To avoid problems with limited precision and rounding, floating point variables should not be used as loop counters.

Take granularity into account when comparing floating point values

Floating point arithmetic in C is inexact, so floating point values should not be tested for exact equality or inequality.

Beware of precision loss when converting integral types to floating point

Conversion from integral types to floating point types without sufficient precision can lead to loss of precision.
15.6. Arrays (ARR)

ARR01-C  Do not apply the sizeof operator to a pointer when taking the size of an array

A function parameter declared as an array, is converted to a pointer by the compiler. Therefore, the sizeof operator applied to this parameter yields the size of a pointer, and not the size of an array.

ARR34-C  Ensure that array types in expressions are compatible

Using two or more incompatible arrays in an expression results in undefined behavior.

ARR35-C  Do not allow loops to iterate beyond the end of an array

Reading or writing of data outside the bounds of an array may lead to incorrect program behavior or execution of arbitrary code.

15.7. Characters and Strings (STR)

STR30-C  Do not attempt to modify string literals

Writing to a string literal has undefined behavior, as identical strings may be shared and/or allocated in read-only memory.

STR33-C  Size wide character strings correctly

Wide character strings may be improperly sized when they are mistaken for narrow strings or for multi-byte character strings.

STR34-C  Cast characters to unsigned types before converting to larger integer sizes

A signed character is sign-extended to a larger signed integer value. Use an explicit cast, or cast the value to an unsigned type first, to avoid unexpected sign-extension.

STR36-C  Do not specify the bound of a character array initialized with a string literal

The compiler issues this warning when the character buffer initialized by a string literal does not provide enough room for the terminating null character.

15.8. Memory Management (MEM)

MEM00-C  Allocate and free memory in the same module, at the same level of abstraction

The compiler issues this warning when the result of the call to malloc(), calloc() or realloc() is discarded, and therefore not free()d, resulting in a memory leak.

MEM08-C  Use realloc() only to resize dynamically allocated arrays

Only use realloc() to resize an array. Do not use it to transform an object to an object of a different type.
MEM30-C  Do not access freed memory

When memory is freed, its contents may remain intact and accessible because it is at the memory manager’s discretion when to reallocate or recycle the freed chunk. The data at the freed location may appear valid. However, this can change unexpectedly, leading to unintended program behavior. As a result, it is necessary to guarantee that memory is not written to or read from once it is freed.

MEM31-C  Free dynamically allocated memory exactly once

Freeing memory multiple times has similar consequences to accessing memory after it is freed. The underlying data structures that manage the heap can become corrupted. To eliminate double-free vulnerabilities, it is necessary to guarantee that dynamic memory is freed exactly once.

MEM32-C  Detect and handle memory allocation errors

The result of realloc() is assigned to the original pointer, without checking for failure. As a result, the original block of memory is lost when realloc() fails.

MEM33-C  Use the correct syntax for flexible array members

Use the ISO C99 syntax for flexible array members instead of an array member of size 1.

MEM34-C  Only free memory allocated dynamically

Freeing memory that is not allocated dynamically can lead to corruption of the heap data structures.

MEM35-C  Allocate sufficient memory for an object

The compiler issues this warning when the size of the object(s) allocated by malloc(), calloc() or realloc() is smaller than the size of an object pointed to by the result pointer. This may be caused by a sizeof expression with the wrong type or with a pointer type instead of the object type.

15.9. Environment (ENV)

ENV32-C  All atexit handlers must return normally

The compiler issues this warning when an atexit() handler is calling a function that does not return. No atexit() registered handler should terminate in any way other than by returning.

15.10. Signals (SIG)

SIG30-C  Call only asynchronous-safe functions within signal handlers

SIG32-C  Do not call longjmp() from inside a signal handler

Invoking the longjmp() function from within a signal handler can lead to undefined behavior if it results in the invocation of any non-asynchronous-safe functions, likely compromising the integrity of the program.
15.11. Miscellaneous (MSC)

MSC32-C Ensure your random number generator is properly seeded

Ensure that the random number generator is properly seeded by calling srand().
Chapter 16. MISRA C Rules

This chapter contains an overview of the supported and unsupported MISRA C rules.

16.1. MISRA C:1998

This section lists all supported and unsupported MISRA C:1998 rules.

See also Section 3.6.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory rule.

1. (R) The code shall conform to standard C, without language extensions.
2. (A) Other languages should only be used with an interface standard.
3. (A) Inline assembly is only allowed in dedicated C functions.
4. (A) Provision should be made for appropriate run-time checking.
5. (R) Only use characters and escape sequences defined by ISO C.
6. (R) Character values shall be restricted to a subset of ISO 106460-1.
7. (R) Trigraphs shall not be used.
8. (R) Multibyte characters and wide string literals shall not be used.
9. (R) Comments shall not be nested.
10. (A) Sections of code should not be “commented out”.

In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment:

• a line ends with ‘;’, or
• a line starts with ‘}’, possibly preceded by white space

11. (R) Identifiers shall not rely on significance of more than 31 characters.
12. (A) The same identifier shall not be used in multiple name spaces.
13. (A) Specific-length typedefs should be used instead of the basic types.
14. (R) Use unsigned char or signed char instead of plain char.
15. (A) Floating-point implementations should comply with a standard.
16. (R) The bit representation of floating-point numbers shall not be used. A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.
17. (R) typedef names shall not be reused.
18. (A) Numeric constants should be suffixed to indicate type. A violation is reported when the value of the constant is outside the range indicated by the suffixes, if any.
19. (R) Octal constants (other than zero) shall not be used.
20. (R) All object and function identifiers shall be declared before use.
21. (R) Identifiers shall not hide identifiers in an outer scope.
22. (A) Declarations should be at function scope where possible.
23. (A) All declarations at file scope should be static where possible.
24. (R) Identifiers shall not have both internal and external linkage.
25. (R) Identifiers with external linkage shall have exactly one definition.
26. (R) Multiple declarations for objects or functions shall be compatible.
27. (A) External objects should not be declared in more than one file.
28. (A) The register storage class specifier should not be used.
29. (R) The use of a tag shall agree with its declaration.
30. (R) All automatics shall be initialized before being used. This rule is checked using worst-case assumptions. This means that violations are reported not only for variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some execution paths.
31. (R) Braces shall be used in the initialization of arrays and structures.
32. (R) Only the first, or all enumeration constants may be initialized.
33. (R) The right hand operand of && or || shall not contain side effects.
34. (R) The operands of a logical && or || shall be primary expressions.
35. (R) Assignment operators shall not be used in Boolean expressions.
36. (A) Logical operators should not be confused with bitwise operators.
37. (R) Bitwise operations shall not be performed on signed integers.
38. (R) A shift count shall be between 0 and the operand width minus 1. This violation will only be checked when the shift count evaluates to a constant value at compile time.
39. (R) The unary minus shall not be applied to an unsigned expression.
40. (A) sizeof should not be used on expressions with side effects.
41. (A) The implementation of integer division should be documented.
42. (R) The comma operator shall only be used in a for condition.
43. (R) Don't use implicit conversions which may result in information loss.
44. (A) Redundant explicit casts should not be used.
45. (R) Type casting from any type to or from pointers shall not be used.
46. (R) The value of an expression shall be evaluation order independent. This rule is checked using worst-case assumptions. This means that a violation will be reported when a possible alias may cause the result of an expression to be evaluation order dependent.

47. (A) No dependence should be placed on operator precedence rules.

48. (A) Mixed arithmetic should use explicit casting.

49. (A) Tests of a (non-Boolean) value against 0 should be made explicit.

50. (R) F.P. variables shall not be tested for exact equality or inequality.

51. (A) Constant unsigned integer expressions should not wrap-around.

52. (R) There shall be no unreachable code.

53. (R) All non-null statements shall have a side-effect.

54. (R) A null statement shall only occur on a line by itself.

55. (A) Labels should not be used.

56. (R) The goto statement shall not be used.

57. (R) The continue statement shall not be used.

58. (R) The break statement shall not be used (except in a switch).

59. (R) An if or loop body shall always be enclosed in braces.

60. (A) All if, else if constructs should contain a final else.

61. (R) Every non-empty case clause shall be terminated with a break.

62. (R) All switch statements should contain a final default case.

63. (A) A switch expression should not represent a Boolean case.

64. (R) Every switch shall have at least one case.

65. (R) Floating-point variables shall not be used as loop counters.

66. (A) A for should only contain expressions concerning loop control. A violation is reported when the loop initialization or loop update expression modifies an object that is not referenced in the loop test.

67. (A) Iterator variables should not be modified in a for loop.

68. (R) Functions shall always be declared at file scope.

69. (R) Functions with variable number of arguments shall not be used.

70. (R) Functions shall not call themselves, either directly or indirectly. A violation will be reported for direct or indirect recursive function calls in the source file being checked. Recursion via functions in other source files, or recursion via function pointers is not detected.

71. (R) Function prototypes shall be visible at the definition and call.

72. (R) The function prototype of the declaration shall match the definition.

73. (R) Identifiers shall be given for all prototype parameters or for none.

74. (R) Parameter identifiers shall be identical for declaration/definition.

75. (R) Every function shall have an explicit return type.
76. (R) Functions with no parameters shall have a void parameter list.
77. (R) An actual parameter type shall be compatible with the prototype.
78. (R) The number of actual parameters shall match the prototype.
79. (R) The values returned by void functions shall not be used.
80. (R) Void expressions shall not be passed as function parameters.
81. (A) const should be used for reference parameters not modified.
82. (A) A function should have a single point of exit.
83. (R) Every exit point shall have a return of the declared return type.
84. (R) For void functions, return shall not have an expression.
85. (A) Function calls with no parameters should have empty parentheses.
86. (A) If a function returns error information, it should be tested.
     A violation is reported when the return value of a function is ignored.
87. (R) #include shall only be preceded by other directives or comments.
88. (R) Non-standard characters shall not occur in #include directives.
89. (R) #include shall be followed by either <filename> or "filename".
90. (R) Plain macros shall only be used for constants/qualifiers/specifiers.
91. (R) Macros shall not be #define'd and #undef'd within a block.
92. (A) #undef should not be used.
93. (A) A function should be used in preference to a function-like macro.
94. (R) A function-like macro shall not be used without all arguments.
95. (R) Macro arguments shall not contain pre-preprocessing directives.
     A violation is reported when the first token of an actual macro argument is '#'.
96. (R) Macro definitions/parameters should be enclosed in parentheses.
97. (A) Don't use undefined identifiers in pre-processing directives.
98. (R) A macro definition shall contain at most one # or ## operator.
99. (R) All uses of the #pragma directive shall be documented.
     This rule is really a documentation issue. The compiler will flag all #pragma directives
     as violations.
100. (R) defined shall only be used in one of the two standard forms.
101. (A) Pointer arithmetic should not be used.
102. (A) No more than 2 levels of pointer indirection should be used.
     A violation is reported when a pointer with three or more levels of indirection is
     declared.
103. (R) No relational operators between pointers to different objects.
     In general, checking whether two pointers point to the same object is impossible. The
     compiler will only report a violation for a relational operation with incompatible pointer
     types.
104. (R) Non-constant pointers to functions shall not be used.
105. (R) Functions assigned to the same pointer shall be of identical type.
106. (R) Automatic address may not be assigned to a longer lived object.
107. (R) The null pointer shall not be de-referenced.
   A violation is reported for every pointer dereference that is not guarded by a NULL
   pointer test.
108. (R) All struct/union members shall be fully specified.
109. (R) Overlapping variable storage shall not be used.
   A violation is reported for every union declaration.
110. (R) Unions shall not be used to access the sub-parts of larger types.
   A violation is reported for a union containing a struct member.
111. (R) Bit-fields shall have type unsigned int or signed int.
112. (R) Bit-fields of type signed int shall be at least 2 bits long.
113. (R) All struct/union members shall be named.
114. (R) Reserved and standard library names shall not be redefined.
115. (R) Standard library function names shall not be reused.
116. (R) Production libraries shall comply with the MISRA C restrictions.
117. (R) The validity of library function parameters shall be checked.
118. (R) Dynamic heap memory allocation shall not be used.
119. (R) The error indicator errno shall not be used.
120. (R) The macro offsetof shall not be used.
121. (R) <locale.h> and the setlocale function shall not be used.
122. (R) The setjmp and longjmp functions shall not be used.
123. (R) The signal handling facilities of <signal.h> shall not be used.
124. (R) The <stdio.h> library shall not be used in production code.
125. (R) The functions atof/atoi/atol shall not be used.
126. (R) The functions abort/exit/getenv/system shall not be used.
127. (R) The time handling functions of library <time.h> shall not be used.

16.2. MISRA C:2004

This section lists all supported and unsupported MISRA C:2004 rules.

See also Section 3.6.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited
way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (R) is a required rule, (A) is an advisory
rule.
**Environment**


1.2 (R) No reliance shall be placed on undefined or unspecified behavior.

1.3 (R) Multiple compilers and/or languages shall only be used if there is a common defined interface standard for object code to which the languages/compilers/assemblers conform.

1.4 (R) The compiler/linker shall be checked to ensure that 31 character significance and case sensitivity are supported for external identifiers.

1.5 (A) Floating-point implementations should comply with a defined floating-point standard.

**Language extensions**

2.1 (R) Assembly language shall be encapsulated and isolated.

2.2 (R) Source code shall only use /* ... */ style comments.

2.3 (R) The character sequence /* shall not be used within a comment.

2.4 (A) Sections of code should not be "commented out". In general, it is not possible to decide whether a piece of comment is C code that is commented out, or just some pseudo code. Instead, the following heuristics are used to detect possible C code inside a comment: - a line ends with ';', or - a line starts with '}', possibly preceded by white space

**Documentation**

3.1 (R) All usage of implementation-defined behavior shall be documented.

3.2 (R) The character set and the corresponding encoding shall be documented.

3.3 (A) The implementation of integer division in the chosen compiler should be determined, documented and taken into account.

3.4 (R) All uses of the #pragma directive shall be documented and explained. This rule is really a documentation issue. The compiler will flag all #pragma directives as violations.

3.5 (R) The implementation-defined behavior and packing of bit-fields shall be documented if being relied upon.

3.6 (R) All libraries used in production code shall be written to comply with the provisions of this document, and shall have been subject to appropriate validation.

**Character sets**

4.1 (R) Only those escape sequences that are defined in the ISO C standard shall be used.

4.2 (R) Trigraphs shall not be used.
Identifiers

5.1 (R) Identifiers (internal and external) shall not rely on the significance of more than 31 characters.
5.2 (R) Identifiers in an inner scope shall not use the same name as an identifier in an outer scope, and therefore hide that identifier.
5.3 (R) A typedef name shall be a unique identifier.
5.4 (R) A tag name shall be a unique identifier.
5.5 (A) No object or function identifier with static storage duration should be reused.
5.6 (A) No identifier in one name space should have the same spelling as an identifier in another name space, with the exception of structure and union member names.
5.7 (A) No identifier name should be reused.

Types

6.1 (R) The plain char type shall be used only for storage and use of character values.
6.2 (R) signed and unsigned char type shall be used only for the storage and use of numeric values.
6.3 (A) typedefs that indicate size and signedness should be used in place of the basic types.
6.4 (R) Bit-fields shall only be defined to be of type unsigned int or signed int.
6.5 (R) Bit-fields of type signed int shall be at least 2 bits long.

Constants

7.1 (R) Octal constants (other than zero) and octal escape sequences shall not be used.

Declarations and definitions

8.1 (R) Functions shall have prototype declarations and the prototype shall be visible at both the function definition and call.
8.2 (R) Whenever an object or function is declared or defined, its type shall be explicitly stated.
8.3 (R) For each function parameter the type given in the declaration and definition shall be identical, and the return types shall also be identical.
8.4 (R) If objects or functions are declared more than once their types shall be compatible.
8.5 (R) There shall be no definitions of objects or functions in a header file.
8.6 (R) Functions shall be declared at file scope.
8.7 (R) Objects shall be defined at block scope if they are only accessed from within a single function.
8.8 (R) An external object or function shall be declared in one and only one file.
An identifier with external linkage shall have exactly one external definition.

All declarations and definitions of objects or functions at file scope shall have internal linkage unless external linkage is required.

The static storage class specifier shall be used in definitions and declarations of objects and functions that have internal linkage.

When an array is declared with external linkage, its size shall be stated explicitly or defined implicitly by initialization.

Initialization

All automatic variables shall have been assigned a value before being used. This rule is checked using worst-case assumptions. This means that violations are reported not only for variables that are guaranteed to be uninitialized, but also for variables that are uninitialized on some execution paths.

Braces shall be used to indicate and match the structure in the non-zero initialization of arrays and structures.

In an enumerator list, the "=" construct shall not be used to explicitly initialize members other than the first, unless all items are explicitly initialized.

Arithmetic type conversions

The value of an expression of integer type shall not be implicitly converted to a different underlying type if:
   a) it is not a conversion to a wider integer type of the same signedness, or
   b) the expression is complex, or
   c) the expression is not constant and is a function argument, or
   d) the expression is not constant and is a return expression.

The value of an expression of floating type shall not be implicitly converted to a different type if:
   a) it is not a conversion to a wider floating type, or
   b) the expression is complex, or
   c) the expression is a function argument, or
   d) the expression is a return expression.

The value of a complex expression of integer type may only be cast to a type of the same signedness that is no wider than the underlying type of the expression.

The value of a complex expression of floating type may only be cast to a type that is no wider than the underlying type of the expression.

If the bitwise operators ~ and << are applied to an operand of underlying type unsigned char or unsigned short, the result shall be immediately cast to the underlying type of the operand.

A "U" suffix shall be applied to all constants of unsigned type.
Pointer type conversions

11.1 (R) Conversions shall not be performed between a pointer to a function and any type other than an integral type.

11.2 (R) Conversions shall not be performed between a pointer to object and any type other than an integral type, another pointer to object type or a pointer to void.

11.3 (A) A cast should not be performed between a pointer type and an integral type.

11.4 (A) A cast should not be performed between a pointer to object type and a different pointer to object type.

11.5 (R) A cast shall not be performed that removes any const or volatile qualification from the type addressed by a pointer.

Expressions

12.1 (A) Limited dependence should be placed on C’s operator precedence rules in expressions.

12.2 (R) The value of an expression shall be the same under any order of evaluation that the standard permits. This rule is checked using worst-case assumptions. This means that a violation will be reported when a possible alias may cause the result of an expression to be evaluation order dependent.

12.3 (R) The sizeof operator shall not be used on expressions that contain side effects.

12.4 (R) The right-hand operand of a logical && or || operator shall not contain side effects.

12.5 (R) The operands of a logical && or || shall be primary-expressions.

12.6 (A) The operands of logical operators (&&, || and !) should be effectively Boolean. Expressions that are effectively Boolean should not be used as operands to operators other than (&&, || and !).

12.7 (R) Bitwise operators shall not be applied to operands whose underlying type is signed.

12.8 (R) The right-hand operand of a shift operator shall lie between zero and one less than the width in bits of the underlying type of the left-hand operand. This violation will only be checked when the shift count evaluates to a constant value at compile time.

12.9 (R) The unary minus operator shall not be applied to an expression whose underlying type is unsigned.

12.10 (R) The comma operator shall not be used.

12.11 (A) Evaluation of constant unsigned integer expressions should not lead to wrap-around.

12.12 (R) The underlying bit representations of floating-point values shall not be used. A violation is reported when a pointer to a floating-point type is converted to a pointer to an integer type.

12.13 (A) The increment (++) and decrement (--) operators should not be mixed with other operators in an expression.

Control statement expressions

13.1 (R) Assignment operators shall not be used in expressions that yield a Boolean value.
Tests of a value against zero should be made explicit, unless the operand is effectively Boolean.

Floating-point expressions shall not be tested for equality or inequality.

The controlling expression of a for statement shall not contain any objects of floating type.

The three expressions of a for statement shall be concerned only with loop control. A violation is reported when the loop initialization or loop update expression modifies an object that is not referenced in the loop test.

Numeric variables being used within a for loop for iteration counting shall not be modified in the body of the loop.

Boolean operations whose results are invariant shall not be permitted.

Control flow

There shall be no unreachable code.

All non-null statements shall either:
  a) have at least one side effect however executed, or
  b) cause control flow to change.

Before preprocessing, a null statement shall only occur on a line by itself; it may be followed by a comment provided that the first character following the null statement is a white-space character.

The goto statement shall not be used.

The continue statement shall not be used.

For any iteration statement there shall be at most one break statement used for loop termination.

A function shall have a single point of exit at the end of the function.

The statement forming the body of a switch, while, do ... while or for statement be a compound statement.

An if (expression) construct shall be followed by a compound statement. The else keyword shall be followed by either a compound statement, or another if statement.

All if ... else if constructs shall be terminated with an else clause.

Switch statements

A switch label shall only be used when the most closely-enclosing compound statement is the body of a switch statement.

An unconditional break statement shall terminate every non-empty switch clause.

The final clause of a switch statement shall be the default clause.

A switch expression shall not represent a value that is effectively Boolean.

Every switch statement shall have at least one case clause.
Functions

16.1 (R) Functions shall not be defined with variable numbers of arguments.
16.2 (R) Functions shall not call themselves, either directly or indirectly. A violation will be reported for direct or indirect recursive function calls in the source file being checked. Recursion via functions in other source files, or recursion via function pointers is not detected.
16.3 (R) Identifiers shall be given for all of the parameters in a function prototype declaration.
16.4 (R) The identifiers used in the declaration and definition of a function shall be identical.
16.5 (R) Functions with no parameters shall be declared with parameter type void.
16.6 (R) The number of arguments passed to a function shall match the number of parameters.
16.7 (A) A pointer parameter in a function prototype should be declared as pointer to const if the pointer is not used to modify the addressed object.
16.8 (R) All exit paths from a function with non-void return type shall have an explicit return statement with an expression.
16.9 (R) A function identifier shall only be used with either a preceding &, or with a parenthesized parameter list, which may be empty.
16.10 (R) If a function returns error information, then that error information shall be tested. A violation is reported when the return value of a function is ignored.

Pointers and arrays

17.1 (R) Pointer arithmetic shall only be applied to pointers that address an array or array element.
17.2 (R) Pointer subtraction shall only be applied to pointers that address elements of the same array.
17.3 (R) >, >=, <, <= shall not be applied to pointer types except where they point to the same array. In general, checking whether two pointers point to the same object is impossible. The compiler will only report a violation for a relational operation with incompatible pointer types.
17.4 (R) Array indexing shall be the only allowed form of pointer arithmetic.
17.5 (A) The declaration of objects should contain no more than 2 levels of pointer indirection. A violation is reported when a pointer with three or more levels of indirection is declared.
17.6 (R) The address of an object with automatic storage shall not be assigned to another object that may persist after the first object has ceased to exist.

Structures and unions

18.1 (R) All structure or union types shall be complete at the end of a translation unit.
18.2 (R) An object shall not be assigned to an overlapping object.
18.3 (R) An area of memory shall not be reused for unrelated purposes.
Preprocessing directives

19.1 (A)  `#include` statements in a file should only be preceded by other preprocessor directives or comments.
19.2 (A)  Non-standard characters should not occur in header file names in `#include` directives.
19.3 (R)  The `#include` directive shall be followed by either a `<filename>` or "filename" sequence.
19.4 (R)  C macros shall only expand to a braced initializer, a constant, a parenthesized expression, a type qualifier, a storage class specifier, or a do-while-zero construct.
19.5 (R)  Macros shall not be `#define'd` or `#undef'd` within a block.
19.6 (R)  `#undef` shall not be used.
19.7 (A)  A function should be used in preference to a function-like macro.
19.8 (R)  A function-like macro shall not be invoked without all of its arguments.
19.9 (R)  Arguments to a function-like macro shall not contain tokens that look like preprocessor directives. A violation is reported when the first token of an actual macro argument is '#'.
19.10 (R)  In the definition of a function-like macro each instance of a parameter shall be enclosed in parentheses unless it is used as the operand of `#` or `##`.
19.11 (R)  All macro identifiers in preprocessor directives shall be defined before use, except in `#ifdef` and `#ifndef` preprocessor directives and the `defined()` operator.
19.12 (R)  There shall be at most one occurrence of the `#` or `##` preprocessor operators in a single macro definition.
19.13 (A)  The `#` and `##` preprocessor operators should not be used.
19.14 (R)  The `defined` preprocessor operator shall only be used in one of the two standard forms.
19.15 (R)  Precautions shall be taken in order to prevent the contents of a header file being included twice.
19.16 (R)  Preprocessing directives shall be syntactically meaningful even when excluded by the preprocessor.
19.17 (R)  All `#else`, `#elif` and `#endif` preprocessor directives shall reside in the same file as the `#if` or `#ifdef` directive to which they are related.

Standard libraries

20.1 (R)  Reserved identifiers, macros and functions in the standard library, shall not be defined, redefined or undefined.
20.2 (R)  The names of standard library macros, objects and functions shall not be reused.
20.3 (R)  The validity of values passed to library functions shall be checked.
Dynamic heap memory allocation shall not be used. (R) 20.4
The error indicator `errno` shall not be used. (R) 20.5
The macro `offsetof`, in library `<stddef.h>`, shall not be used. (R) 20.6
The `setjmp` macro and the `longjmp` function shall not be used. (R) 20.7
The signal handling facilities of `<signal.h>` shall not be used. (R) 20.8
The input/output library `<stdio.h>` shall not be used in production code. (R) 20.9
The library functions `atof`, `atoi` and `atol` from library `<stdlib.h>` shall not be used. (R) 20.10
The library functions `abort`, `exit`, `getenv` and `system` from library `<stdlib.h>` shall not be used. (R) 20.11
The time handling functions of library `<time.h>` shall not be used. (R) 20.12

Run-time failures

- 21.1 (R) Minimization of run-time failures shall be ensured by the use of at least one of:
  a) static analysis tools/techniques;
  b) dynamic analysis tools/techniques;
  c) explicit coding of checks to handle run-time faults.

16.3. MISRA C:2012

This section lists all supported and unsupported MISRA C:2012 rules.

See also Section 3.6.2, C Code Checking: MISRA C.

A number of MISRA C rules leave room for interpretation. Other rules can only be checked in a limited way. In such cases the implementation decisions and possible restrictions for these rules are listed.

x means that the rule is not supported by the TASKING C compiler. (M) is a mandatory rule, (R) is a required rule, (A) is an advisory rule.

A standard C environment

1.1 (R) The program shall contain no violations of the standard C syntax and constraints, and shall not exceed the implementation’s translation limits.

1.2 (A) Language extensions should not be used.

1.3 (R) There shall be no occurrence of undefined or critical unspecified behavior.

Unused code

2.1 (R) A project shall not contain reachable unreachable code.

2.2 (R) There shall be no dead code.

2.3 (A) A project should not contain unused type declarations.
A project should not contain unused tag declarations.
A project should not contain unused macro declarations.
A function should not contain unused label declarations.
There should be no unused parameters in functions.

Comments

The character sequences /* and // shall not be used within a comment.
Line-splicing shall not be used in // comments.

Character sets and lexical conventions

Octal and hexadecimal escape sequences shall be terminated.
Trigraphs should not be used.

Identifiers

External identifiers shall be distinct.
Identifiers declared in the same scope and name space shall be distinct.
An identifier declared in an inner scope shall not hide an identifier declared in an outer scope.
Macro identifiers shall be distinct.
Identifiers shall be distinct from macro names.
A typedef name shall be a unique identifier.
A tag name shall be a unique identifier.
Identifiers that define objects or functions with external linkage shall be unique.
Identifiers that define objects or functions with internal linkage should be unique.

Types

Bit-fields shall only be declared with an appropriate type.
Single-bit named bit-fields shall not be of a signed type.

Literals and constants

Octal constants shall not be used.
A "u" or "U" suffix shall be applied to all integer constants that are represented in an unsigned type.
The lowercase character "l" shall not be used in a literal suffix trivial.
A string literal shall not be assigned to an object unless the object's type is "pointer to const-qualified char".
Declarations and definitions

8.1 (R) Types shall be explicitly specified.
8.2 (R) Function types shall be in prototype form with named parameters.
8.3 (R) All declarations of an object or function shall use the same names and type qualifiers.
8.4 (R) A compatible declaration shall be visible when an object or function with external linkage is defined.
8.5 (R) An external object or function shall be declared once in one and only one file.
8.6 (R) An identifier with external linkage shall have exactly one external definition.
8.7 (A) Functions and objects should not be defined with external linkage if they are referenced in only one translation unit.
8.8 (R) The static storage class specifier shall be used in all declarations of objects and functions that have internal linkage.
8.9 (A) An object should be defined at block scope if its identifier only appears in a single function.
8.10 (R) An inline function shall be declared with the static storage class.
8.11 (R) When an array with external linkage is declared, its size should be explicitly specified.
8.12 (R) Within an enumerator list, the value of an implicitly-specified enumeration constant shall be unique.
8.13 (A) A pointer should point to a const-qualified type whenever possible.
8.14 (R) The restrict type qualifier shall not be used.

Initialization

9.1 (M) The value of an object with automatic storage duration shall not be read before it has been set.
9.2 (R) The initializer for an aggregate or union shall be enclosed in braces.
9.3 (R) Arrays shall not be partially initialized.
9.4 (R) An element of an object shall not be initialized more than once.
9.5 (R) Where designated initializers are used to initialize an array object the size of the array shall be specified explicitly.

The essential type model

10.1 (R) Operands shall not be of an inappropriate essential type.
10.2 (R) Expressions of essentially character type shall not be used inappropriately in addition and subtraction operations.
10.3 (R) The value of an expression shall not be assigned to an object with a narrower essential type or of a different essential type category.
10.4 (R) Both operands of an operator in which the usual arithmetic conversions are performed shall have the same essential type category.
10.5 (A) The value of an expression should not be cast to an inappropriate essential type.
10.6 (R) The value of a composite expression shall not be assigned to an object with wider essential type.
10.7 (R) If a composite expression is used as one operand of an operator in which the usual arithmetic conversions are performed then the other operand shall not have wider essential type.
10.8 (R) The value of a composite expression shall not be cast to a different essential type category or a wider essential type.

**Pointer type conversions**

11.1 (R) Conversions shall not be performed between a pointer to a function and any other type.
11.2 (R) Conversions shall not be performed between a pointer to an incomplete type and any other type.
11.3 (R) A cast shall not be performed between a pointer to object type and a pointer to a different object type.
11.4 (A) A conversion should not be performed between a pointer to object and an integer type.
11.5 (A) A conversion should not be performed from pointer to void into pointer to object.
11.6 (R) A cast shall not be performed between pointer to void and an arithmetic type.
11.7 (R) A cast shall not be performed between pointer to object and a non-integer arithmetic type.
11.8 (R) A cast shall not remove any `const` or `volatile` qualification from the type pointed to by a pointer.
11.9 (R) The macro `NULL` shall be the only permitted form of integer null pointer constant.

**Expressions**

12.1 (A) The precedence of operators within expressions should be made explicit.
12.2 (R) The right hand operand of a shift operator shall lie in the range zero to one less than the width in bits of the essential type of the left hand operand.
12.3 (A) The comma operator should not be used.
12.4 (A) Evaluation of constant expressions should not lead to unsigned integer wrap-around.

**Side effects**

13.1 (R) Initializer lists shall not contain persistent side effects.
13.2 (R) The value of an expression and its persistent side effects shall be the same under all permitted evaluation orders.
13.3 (A) A full expression containing an increment (++) or decrement (--) operator should have no other potential side effects other than that caused by the increment or decrement operator.

13.4 (A) The result of an assignment operator should not be used.

13.5 (R) The right hand operand of a logical & & or | | operator shall not contain persistent side effects.

13.6 (M) The operand of the sizeof operator shall not contain any expression which has potential side effects.

**Control statement expressions**

14.1 (R) A loop counter shall not have essentially floating type.

14.2 (R) A for loop shall be well-formed.

14.3 (R) Controlling expressions shall not be invariant.

14.4 (R) The controlling expression of an if statement and the controlling expression of an iteration-statement shall have essentially Boolean type.

**Control flow**

15.1 (A) The goto statement should not be used.

15.2 (R) The goto statement shall jump to a label declared later in the same function.

15.3 (R) Any label referenced by a goto statement shall be declared in the same block, or in any block enclosing the goto statement.

15.4 (A) There should be no more than one break or goto statement used to terminate any iteration statement.

15.5 (A) A function should have a single point of exit at the end.

15.6 (R) The body of an iteration-statement or a selection-statement shall be a compound-statement.

15.7 (R) All if ... else if constructs shall be terminated with an else statement.

**Switch statements**

16.1 (R) All switch statements shall be well-formed.

16.2 (R) A switch label shall only be used when the most closely-enclosing compound statement is the body of a switch statement.

16.3 (R) An unconditional break statement shall terminate every switch-clause.

16.4 (R) Every switch statement shall have a default label.

16.5 (R) A default label shall appear as either the first or the last switch label of a switch statement.

16.6 (R) Every switch statement shall have at least two switch-clauses.

16.7 (R) A switch-expression shall not have essentially Boolean type.
Functions

17.1 (R) The features of <stdarg.h> shall not be used.
17.2 (R) Functions shall not call themselves, either directly or indirectly.
17.3 (M) A function shall not be declared implicitly.
17.4 (M) All exit paths from a function with non-void return type shall have an explicit return statement with an expression.
17.5 (A) The function argument corresponding to a parameter declared to have an array type shall have an appropriate number of elements.
17.6 (M) The declaration of an array parameter shall not contain the static keyword between the [ ].
17.7 (R) The value returned by a function having non-void return type shall be used.
17.8 (A) A function parameter should not be modified.

Pointers and arrays

18.1 (R) A pointer resulting from arithmetic on a pointer operand shall address an element of the same array as that pointer operand.
18.2 (R) Subtraction between pointers shall only be applied to pointers that address elements of the same array.
18.3 (R) The relational operators >, >=, < and <= shall not be applied to objects of pointer type except where they point into the same object.
18.4 (A) The +, -, += and -= operators should not be applied to an expression of pointer type.
18.5 (A) Declarations should contain no more than two levels of pointer nesting.
18.6 (R) The address of an object with automatic storage shall not be copied to another object that persists after the first object has ceased to exist.
18.7 (R) Flexible array members shall not be declared.
18.8 (R) Variable-length array types shall not be used.

Overlapping storage

19.1 (M) An object shall not be assigned or copied to an overlapping object.
19.2 (A) The union keyword should not be used.

Preprocessing directives

20.1 (A) #include directives should only be preceded by preprocessor directives or comments.
20.2 (R) The ', " or \ characters and the /* or // character sequences shall not occur in a header file name.
20.3 (R) The #include directive shall be followed by either a <filename> or "filename" sequence.
20.4 (R) A macro shall not be defined with the same name as a keyword.
20.5 (A) `#undef` should not be used.
20.6 (R) Tokens that look like a preprocessing directive shall not occur within a macro argument.
20.7 (R) Expressions resulting from the expansion of macro parameters shall be enclosed in parentheses.
20.8 (R) The controlling expression of a `#if` or `#elif` preprocessing directive shall evaluate to 0 or 1.
20.9 (R) All identifiers used in the controlling expression of `#if` or `#elif` preprocessing directives shall be `#define`d before evaluation.
20.10 (A) The `#` and `##` preprocessor operators should not be used.
20.11 (R) A macro parameter immediately following a `#` operator shall not immediately be followed by a `##` operator.
20.12 (R) A macro parameter used as an operand to the `#` or `##` operators, which is itself subject to further macro replacement, shall only be used as an operand to these operators.
20.13 (R) A line whose first token is `#` shall be a valid preprocessing directive.
20.14 (R) All `#else`, `#elif` and `#endif` preprocessor directives shall reside in the same file as the `#if`, `#ifdef` or `#ifndef` directive to which they are related.

**Standard libraries**

21.1 (R) `#define` and `#undef` shall not be used on a reserved identifier or reserved macro name.
21.2 (R) A reserved identifier or macro name shall not be declared.
21.3 (R) The memory allocation and deallocation functions of `<stdlib.h>` shall not be used.
21.4 (R) The standard header file `<setjmp.h>` shall not be used.
21.5 (R) The standard header file `<signal.h>` shall not be used.
21.6 (R) The Standard Library input/output functions shall not be used.
21.7 (R) The `atof`, `atoi`, `atol` and `atoll` functions of `<stdlib.h>` shall not be used.
21.8 (R) The library functions `abort`, `exit`, `getenv` and `system` of `<stdlib.h>` shall not be used.
21.9 (R) The library functions `bsearch` and `qsort` of `<stdlib.h>` shall not be used.
21.10 (R) The Standard Library time and date functions shall not be used.
21.11 (R) The standard header file `<tgmath.h>` shall not be used.
21.12 (A) The exception handling features of `<fenv.h>` should not be used.

**Resources**

* 22.1 (R) All resources obtained dynamically by means of Standard Library functions shall be explicitly released.
A block of memory shall only be freed if it was allocated by means of a Standard Library function.

The same file shall not be open for read and write access at the same time on different streams.

There shall be no attempt to write to a stream which has been opened as read-only.

A pointer to a `FILE` object shall not be dereferenced.

The value of a pointer to a `FILE` shall not be used after the associated stream has been closed.
Chapter 17. C Implementation-defined Behavior

The TASKING VX-toolset for MCS C compiler fully supports the ISO-C standard, but some parts of the ISO-C standard are implementation-defined. This chapter describes how the implementation-defined areas and the locale-specific areas of the C language are implemented in the TASKING C compiler. Below are some remarks on the other behaviors as mentioned in the standard.

Unspecified behavior

Unspecified behavior is the use of an unspecified value, or other behavior where the ISO-C standard provides two or more possibilities and imposes no further requirements on which is chosen in any instance. Some of the unspecified behaviors are relevant to users of the TASKING VX-toolset for MCS. Some unspecified behaviors are specified in the EABI. The silicon vendor is responsible for the EABI.

Undefined behavior

Undefined behavior is behavior, upon use of a non-portable or erroneous program construct or of erroneous data, for which the ISO-C standard imposes no requirements.

Some undefined behaviors may trigger a compiler error or warning. Altium does not provide any guarantees about whether or not the compiler issues an error or warning. It is important to know whether your software contains undefined behaviors since this will make the source non-portable between compiler vendors and between other processors.

The MISRA C and CERT coding guides do not refer to undefined behaviors explicitly.

17.1. Implementation-defined Behavior

Implementation-defined behavior is unspecified behavior where each implementation documents how the choice is made.

The following sections describe the implementation-defined characteristics. The section numbers listed in parenthesis refer to the corresponding sections in the ISO-C standard. The order in this chapter is the same as used in Appendix J.3 of the ISO/IEC 9899:1999 (E) standard.

17.1.1. Translation

- How a diagnostic is identified (3.10, 5.1.1.3).
  
  The C compiler diagnostics are explained in Section 3.7, C Compiler Error Messages.

- Whether each nonempty sequence of white-space characters other than new-line is retained or replaced by one space character in translation phase 3 (5.1.1.2).

  White-space is retained.
17.1.2. Environment

- The mapping between physical source file multibyte characters and the source character set in translation phase 1 (5.1.1.2).

  Use of variable length encoded characters in the source file in comments and string literals is permitted. A one-on-one mapping is done without interpretation of multibyte characters.

- The name and type of the function called at program startup in a freestanding environment (5.1.2.1).

  The function called at program startup (in cstart.c) is called main. The prototype for main in cstart.c is:

  ```c
  extern int main( int argc, char *argv[] );
  ```

- The effect of program termination in a freestanding environment (5.1.2.1).

  Execution is halted if the program is executed under control of a debugger, otherwise the program will loop forever in function _Exit().

- An alternative manner in which the main function may be defined (5.1.2.2.1).

  You can change the definition of main by altering file cstart.c.

- The values given to the strings pointed to by the argv argument to main (5.1.2.2.1).

  The strings get their values from the arguments given in file cstart.c. The program arguments are treated case sensitive.

- What constitutes an interactive device (5.1.2.3).

  The streams stdin, stdout and stderr are treated as interactive devices. The debugger uses these streams with File System Simulation (FSS) windows to interact.

- The set of signals, their semantics, and their default handling (7.14).

  The signals are described in Section 10.1.17, signal.h.

- Signal values other than SIGFPE, SIGILL, and SIGSEGV that correspond to a computational exception (7.14.1.1).

  There are no other values that correspond to a computational exception. All signal values are described in Section 10.1.17, signal.h.

- Signals for which the equivalent of signal(sig, SIG_IGN); is executed at program startup (7.14.1.1).

  By default the implementation does not ignore any signals at program startup.
• The set of environment names and the method for altering the environment list used by the `getenv` function (7.20.4.5).

There are no implementation-defined environment names that are used by the `getenv` function. A skeleton is provided for the `getenv` function in the C library, because the embedded environment has no operating system. The `getenv` function calls the name as a `void` function.

• The manner of execution of the string by the `system` function (7.20.4.6).

A skeleton is provided for the `system()` function in the C library, because the embedded environment has no operating system. The `system()` function calls the string as a `void` function.

### 17.1.3. Identifiers

• Which additional multibyte characters may appear in identifiers and their correspondence to universal character names (6.4.2).

No additional multibyte characters are supported in an identifier.

• The number of significant initial characters in an identifier (5.2.4.1, 6.4.2).

All characters in an identifier are significant.

### 17.1.4. Characters

• The number of bits in a byte (3.6).

There are 24 bits in a byte.

• The values of the members of the execution character set (5.2.1).

Only 24-bit characters are supported. The values of the execution character set are the same as that of the source character set. The same representation value is used for each member in the characters sets except for the escape sequences.

• The unique value of the member of the execution character set produced for each of the standard alphabetic escape sequences (5.2.2).

The following table contains an overview of the escape sequences and their byte value in the execution character set.

<table>
<thead>
<tr>
<th>Escape sequence</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>\a</td>
<td>7</td>
</tr>
<tr>
<td>\b</td>
<td>8</td>
</tr>
<tr>
<td>\f</td>
<td>12</td>
</tr>
<tr>
<td>\n</td>
<td>10</td>
</tr>
<tr>
<td>\r</td>
<td>13</td>
</tr>
<tr>
<td>\t</td>
<td>9</td>
</tr>
</tbody>
</table>
**Escape sequence** | **Value**
--- | ---
\v | 11

- The value of a `char` object into which has been stored any character other than a member of the basic execution character set (6.2.5).

Any 24-bit value can be stored in a `char` object.

- Which of `signed char` or `unsigned char` has the same range, representation, and behavior as “plain” `char` (6.2.5, 6.3.1.1).

By default “plain” `char` is the same as specifying `signed char`. With C compiler option `--uchar (-u)` you can change the default to `unsigned char`.

- The mapping of members of the source character set (in character constants and string literals) to members of the execution character set (6.4.4.4, 5.1.1.2).

The mapping is one-to-one. The values of the execution character set are the same as that of the source character set. The same representation value is used for each member in the characters sets except for the escape sequences.

- The value of an integer character constant containing more than one character or containing a character or escape sequence that does not map to a single-byte execution character (6.4.4.4).

For any character constant containing more than one character, a warning is issued and the value is truncated to type `signed char`.

- The value of a wide character constant containing more than one multibyte character, or containing a multibyte character or escape sequence not represented in the extended execution character set (6.4.4.4).

A number of wide-character functions are available as C source code, but have not been compiled with the C library. To use complete wide-character functionality, you must recompile the libraries with the macro `WCHAR_SUPPORT_ENABLED` and keep this macro also defined when compiling your own sources.

- The current locale used to convert a wide character constant consisting of a single multibyte character that maps to a member of the extended execution character set into a corresponding wide character code (6.4.4.4).

By default, the “C” locale is used.

- The current locale used to convert a wide string literal into corresponding wide character codes (6.4.5).

By default, the “C” locale is used.

- The value of a string literal containing a multibyte character or escape sequence not represented in the execution character set (6.4.5).

All source characters can be represented in the execution character set.
17.1.5. Integers

- Any extended integer types that exist in the implementation (6.2.5).
  
  All types are described in Section 1.1, Data Types.

- Whether signed integer types are represented using sign and magnitude, two’s complement, or one’s complement, and whether the extraordinary value is a trap representation or an ordinary value (6.2.6.2).
  
  Signed integer types are represented in two's complement. The most significant bit is the sign bit. 1 is negative, 0 is positive.

- The rank of any extended integer type relative to another extended integer type with the same precision (6.3.1.1).
  
  All types are described in Section 1.1, Data Types.

- The result of, or the signal raised by, converting an integer to a signed integer type when the value cannot be represented in an object of that type (6.3.1.3).
  
  At compile time, when converting integer types and a value does not fit in a type, the compiler issues a warning and the value is truncated. At run-time no warning or signal is given and the value is truncated.

- The results of some bitwise operations on signed integers (6.5).
  
  The result of $E1 >> E2$ is $E1$ right shifted $E2$ bit positions. If $E1$ has a signed type and a negative value, the shift behavior is implemented as an arithmetic shift. The empty position in the most significant bit is filled with a copy of the original most significant bit.

17.1.6. Floating-Point

- The accuracy of the floating-point operations and of the library functions in `<math.h>` and `<complex.h>` that return floating-point results (5.2.4.2.2).
  
  A float has 24 significant mantissa bits and 8 exponent bits. A double or long double has 53 significant mantissa bits and 11 exponent bits. This is conform IEEE-754 for single precision and double precision floating-point. Internally the compiler uses a mantissa of 80 bits. The results of floating-point operations are rounded to the nearest IEEE-754 format.
  
  The accuracy of `sqrt` is defined unknown.

- The rounding behaviors characterized by non-standard values of `FLT_ROUNDS` (5.2.4.2.2).
  
  No non-standard values are used.

- The evaluation methods characterized by non-standard negative values of `FLT_EVAL_METHOD` (5.2.4.2.2).
  
  `FLT_EVAL_METHOD` is defined as 0. No non-standard values are used.
• The direction of rounding when an integer is converted to a floating-point number that cannot exactly represent the original value (6.3.1.4).

The round to nearest method is used. FLT_ROUNDS is ignored.

• The direction of rounding when a floating-point number is converted to a narrower floating-point number (6.3.1.5).

The round to nearest method is used. FLT_ROUNDS is ignored.

• How the nearest representable value or the larger or smaller representable value immediately adjacent to the nearest representable value is chosen for certain floating constants (6.4.4.2).

The round to nearest method is used. FLT_ROUNDS is ignored.

• Whether and how floating expressions are contracted when not disallowed by the FP_CONTRACT pragma (6.5).

Pragma FP_CONTRACT is equivalent to compiler option --fp-model=+contract. This has only effect for fused multiply-and-accumulate (FMA) operations. FMA operations are not supported by the IEEE 754-1985 standard. The result of FMA operations is only rounded once at the end of the FMA. You can disable FMAs with the compiler option --fp-model=-contract.

• The default state for the FENV_ACCESS pragma (7.6.1).

The default state of pragma FENV_ACCESS is "off". This pragma is ignored.

• Additional floating-point exceptions, rounding modes, environments, and classifications, and their macro names (7.6, 7.12).

No additional floating-point exceptions, rounding modes, environments, and classifications are defined.

• The default state for the FP_CONTRACT pragma (7.12.2).

The default state of pragma FP_CONTRACT is set by the contract flag of compiler option --fp-model. The default state is "on".

• Whether the "inexact" floating-point exception can be raised when the rounded result actually does equal the mathematical result in an IEC 60559 conformant implementation (F.9).

The "inexact" floating-point exception is not supported.

• Whether the "underflow" (and "inexact") floating-point exception can be raised when a result is tiny but not inexact in an IEC 60559 conformant implementation (F.9).

The "underflow" and "inexact" floating-point exceptions are not supported.

17.1.7. Arrays and Pointers

• The result of converting a pointer to an integer or vice versa (6.3.2.3).

All non-pointer conversions to and from a 24-bit pointer are implemented as a conversion to or from a 24-bit integer type.
• The size of the result of subtracting two pointers to elements of the same array (6.5.6).

   The size of `ptrdiff_t` is 24 bits. The difference in address location is expressed in bytes.

### 17.1.8. Hints

• The extent to which suggestions made by using the `register` storage-class specifier are effective (6.7.1).

   The compiler does not make assumptions based on the `register` storage-class specifier. So, basically this keyword is ignored, except that you cannot take the address of a `register` variable. The compiler issues an error in that case.

• The extent to which suggestions made by using the `inline` function specifier are effective (6.7.4).

   With the `inline` keyword you force the compiler to inline the specified function, regardless of the optimization strategy of the compiler itself. For more information see Section 1.7.5, *Inlining Functions: inline*.

### 17.1.9. Structures, Unions, Enumerations, and Bit-fields

• Whether a "plain" `int` bit-field is treated as a `signed` `int` bit-field or as an `unsigned` `int` bit-field (6.7.2, 6.7.2.1).

   By default an `int` bit-field is treated as `unsigned int`. This offers the best performance. With C compiler option `--signed-bitfields` you tell the compiler to treat `int` bit-fields as `signed int`. In this case, you can still add the keyword `unsigned` to treat a particular `int` bit-field as `unsigned`.

• Allowable bit-field types other than `_Bool`, `signed int`, and `unsigned int` (6.7.2.1).

   The integer types `signed char`, `unsigned char`, `signed short` and `unsigned short` as specified in Section 1.1, *Data Types*, are also allowable bit-field types.

• Whether a bit-field can straddle a storage-unit boundary (6.7.2.1).

   A bit-field cannot straddle a storage-unit boundary. If insufficient space remains, the bit-field is put into the next unit.

• The order of allocation of bit-fields within a unit (6.7.2.1).

   Allocation starts at the least significant bit up to the most significant bit. If the following bit-field fits within the same unit, it is allocated starting at the next available bit.

• The alignment of non-bit-field members of structures (6.7.2.1). This should present no problem unless binary data written by one implementation is read by another.

   The alignment of non-bit-field members of structures is the same as the alignment for data types as specified in Section 1.1, *Data Types*.

• The integer type compatible with each enumerated type (6.7.2.2).

   The compiler always uses `int` for enumeration.
17.1.10. Qualifiers

- What constitutes an access to an object that has volatile-qualified type (6.7.3).

Any reference to an object with volatile type results in an access. The order in which volatile objects are accessed is defined by the order expressed in the source code. References to non-volatile objects are scheduled in arbitrary order, within the constraints given by dependencies.

If the compiler option --language=+volatile (-Av) is set, all references to non-volatile objects result in an access before the access to a volatile object that occurs subsequently in the source file takes place. The volatile access acts as a memory barrier.

17.1.11. Preprocessing Directives

- How sequences in both forms of header names are mapped to headers or external source file names (6.4.7).

Sequences in header names are mapped to file names as is. The backslash "\" is not interpreted as an escape sequence. The backslash "\" (Windows) or forward slash "/" (Windows and UNIX) is interpreted as a standard directory separator.

- Whether the value of a character constant in a constant expression that controls conditional inclusion matches the value of the same character constant in the execution character set (6.10.1).

A character constant in a constant expression that controls conditional inclusion matches the value of the same character constant in the execution character set.

- Whether the value of a single-character character constant in a constant expression that controls conditional inclusion may have a negative value (6.10.1).

A single-character character constant in a constant expression that controls conditional inclusion may have a negative value.

- The places that are searched for an included < > delimited header, and how the places are specified or the header is identified (6.10.2).

How the compiler searches for include files is explained in Section 3.3, How the Compiler Searches Include Files.

- How the named source file is searched for in an included " " delimited header (6.10.2).

How the compiler searches for include files is explained in Section 3.3, How the Compiler Searches Include Files.

- The method by which preprocessing tokens (possibly resulting from macro expansion) in a #include directive are combined into a header name (6.10.2).

Preprocessing tokens in a #include directive are combined the same way as outside a #include directive.
• The nesting limit for #include processing (6.10.2).

There is no nesting limit for #include processing.

• Whether the # operator inserts a \ character before the \ character that begins a universal character name in a character constant or string literal (6.10.3.2).

The # operator inserts a \ character before every \ character in a character constant or string literal.

• The behavior on each recognized non-STDC #pragma directive (6.10.6).

All non-STDC pragmas are described in Section 1.5, Pragmas to Control the Compiler.

• The definitions for __DATE__ and __TIME__ when respectively, the date and time of translation are not available (6.10.8).

The date and time of translation are always available, macros __DATE__ and __TIME__ are always defined.

17.1.12. Library Functions

• Any library facilities available to a freestanding program, other than the minimal set required by clause 4 (5.1.2.1).

All library functions are described in Chapter 10, Libraries. Some functions are not completely implemented because their implementation depends on the context where your application will run. These functions are for example all I/O related functions. Where possible, these functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment which enables you to debug your application. If the application runs under control of the debugger and FSS is used, then the low-level behavior is equal to the host system's file access behavior.

In the implementation in the C library, the basic sequences of a multibyte character consist of single bytes (MB_LEN_MAX is set to 1). If you want full multibyte support, you need to change the C library. See the notes in the header files stdio.h and wchar.h for more information.

• The format of the diagnostic printed by the assert macro (7.2.1.1).

The assert() function is implemented as a macro in assert.h. The output is:

Assertion failed: (expression) file filename, line linenumber

when the parameter evaluates to zero.

• The representation of the floating-point status flags stored by the fegetexceptflag function (7.6.2.2).

Exception flags are supported and are defined in header file fenv.h:

#define FE_DIVBYZERO    (1 << 1)
#define FE_INEXACT      (1 << 2)
#define FE_INVALID      (1 << 3)


- Whether the `feraiseexcept` function raises the "inexact" floating-point exception in addition to the "overflow" or "underflow" floating-point exception (7.6.2.3).

  Function `feraiseexcept` does not raise `FE_INEXACT` if underflow or overflow is raised.

- Strings other than "C" and "" that may be passed as the second argument to the `setlocale` function (7.11.1.1).

  No other strings are predefined. A NULL pointer as the second argument returns the "C" locale. Any other string than "C" or "" can be passed as the second argument to the `setlocale` function and results in NULL.

- The types defined for `float_t` and `double_t` when the value of the `FLT_EVAL_METHOD` macro is less than 0 or greater than 2 (7.12).

  The `FLT_EVAL_METHOD` macro can only have the values 0, 1 or 2.

- Domain errors for the mathematical functions, other than those required by this International Standard (7.12.1).

  No other domain errors exist, other than those required by the standard.

- The values returned by the mathematical functions on domain errors (7.12.1).

  On domain errors (errno is set to EDOM), the mathematical functions return a value as specified in the following table.

<table>
<thead>
<tr>
<th>Math function</th>
<th>Return value on EDOM</th>
</tr>
</thead>
<tbody>
<tr>
<td>acos(</td>
<td>x</td>
</tr>
<tr>
<td>asin(</td>
<td>x</td>
</tr>
<tr>
<td>log(x &lt; 0.0)</td>
<td>-HUGE_VAL</td>
</tr>
<tr>
<td>pow(x &lt;= 0.0)</td>
<td>0.0</td>
</tr>
<tr>
<td>sqrt(x &lt; 0.0)</td>
<td>-NaN</td>
</tr>
</tbody>
</table>

- The values returned by the mathematical functions on underflow range errors, whether errno is set to the value of the macro `ERANGE` when the integer expression `math_errhandling & MATH_ERRNO` is nonzero, and whether the "underflow" floating-point exception is raised when the integer expression `math_errhandling & MATH_ERREXCEPT` is nonzero. (7.12.1).

  On underflow range errors, the mathematical functions return 0.0. `math_errhandling` is set to `MATH_ERRNO`. errno is not set to `ERANGE` on underflow range errors.
• Whether a domain error occurs or zero is returned when an \texttt{fmod} function has a second argument of zero (7.12.10.1).

Zero (0.0) is returned when an \texttt{fmod} function has a second argument of zero.

• The base-2 logarithm of the modulus used by the \texttt{remquo} functions in reducing the quotient (7.12.10.3).

The \texttt{remquo} function calculates at least 8 bits of the quotient.

• Whether the equivalent of \texttt{signal(sig, SIG_DFL);} is executed prior to the call of a signal handler, and, if not, the blocking of signals that is performed (7.14.1.1).

The equivalent of \texttt{signal(sig, SIG_DFL);} is executed prior to the call of a signal handler.

• The null pointer constant to which the macro \texttt{NULL} expands (7.17).

Macro \texttt{NULL} is defined as \texttt{(void *) 0}.

• Whether the last line of a text stream requires a terminating new-line character (7.19.2).

Both a new-line character (\texttt{\n}) and end-of-file (\texttt{EOF}) are recognized as the termination character of a line.

• Whether space characters that are written out to a text stream immediately before a new-line character appear when read in (7.19.2).

Space characters written to a stream immediately before a new-line character are preserved.

• The number of null characters that may be appended to data written to a binary stream (7.19.2).

I/O related functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment. If the application runs under control of the debugger and FSS is used, then the low-level behavior is equal to the host system's file access behavior. The library does not append any null characters. It depends on the \texttt{open()} function on the host environment what happens. You can write your own \texttt{_open()} function if necessary.

• Whether the file position indicator of an append-mode stream is initially positioned at the beginning or end of the file (7.19.3).

I/O related functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment. If the application runs under control of the debugger and FSS is used, then the low-level behavior is equal to the host system's file access behavior. Where the file position indicator of an append-mode stream is initially positioned depends on the \texttt{open()} function on the host environment. You can write your own \texttt{_open()} function if necessary.

• Whether a write on a text stream causes the associated file to be truncated beyond that point (7.19.3).

I/O related functions are implemented using file system simulation (FSS). This system can be used by the debugger to simulate an I/O environment. If the application runs under control of the debugger and FSS is used, then the low-level behavior is equal to the host system's file access behavior. Whether a write on a text stream causes the associated file to be truncated beyond that point depends on how the low-level file routines are implemented in your application.
• The characteristics of file buffering (7.19.3).

Files can be unbuffered, fully buffered or line buffered. What actually happens depends on how the low-level file routines are implemented in your application.

• Whether a zero-length file actually exists (7.19.3).

This depends on how the low-level file routines are implemented in your application.

• The rules for composing valid file names (7.19.3).

This depends on how the low-level file routines are implemented in your application.

• Whether the same file can be simultaneously open multiple times (7.19.3).

This depends on how the low-level file routines are implemented in your application.

• The nature and choice of encodings used for multibyte characters in files (7.19.3).

Use of variable length encoded characters in files in comments and string literals is permitted.

• The effect of the remove function on an open file (7.19.4.1).

This depends on how the low-level file routines are implemented in your application.

• The effect if a file with the new name exists prior to a call to the rename function (7.19.4.2).

This depends on how the low-level file routines are implemented in your application.

• Whether an open temporary file is removed upon abnormal program termination (7.19.4.3).

This depends on how the low-level file routines are implemented in your application.

• Which changes of mode are permitted (if any), and under what circumstances (7.19.5.4).

The freopen() function first calls fclose() and then calls _fopen() with the new mode.

• The style used to print an infinity or NaN, and the meaning of any n-char or n-wchar sequence printed for a NaN (7.19.6.1, 7.24.2.1).

The style used to print an infinity or NaN is inf and nan respectively (INF or NAN for the F conversion specifier). n-char or w-char sequences are not used for nan.

• The output for %p conversion in the fprintf or fwprintf function (7.19.6.1, 7.24.2.1).

The argument is treated as having type void *. The value will be printed as a hexadecimal value, similar to %x.

• The interpretation of a – character that is neither the first nor the last character, nor the second where a ^ character is the first, in the scanlist for % conversion in the fscanf or fwsanf function (7.19.6.2, 7.24.2.1).

A – character is treated as a normal character.
• The set of sequences matched by a %p conversion and the interpretation of the corresponding input item in the fscanf or fwscanf function (7.19.6.2, 7.24.2.2).

The format of %p matches the format of %x. The input for %p is a hexadecimal value, which is converted to a value with type void *.

• The value to which the macro errno is set by the fgetpos, fsetpos, or ftell functions on failure (7.19.9.1, 7.19.9.3, 7.19.9.4).

If errno is set to a value depends on how the low-level file routines are implemented in your application.

• The meaning of any n-char or n-wchar sequence in a string representing a NaN that is converted by the strtod, strtof, strtold, wcstod, wcstof, or wcstold function (7.20.1.3, 7.24.4.1.1).

An n-char or n-wchar sequence in a string representing a NaN is ignored.

• Whether or not the strtod, strtof, strtold, wcstod, wcstof, or wcstold function sets errno to ERANGE when underflow occurs (7.20.1.3, 7.24.4.1.1).

errno is set to ERANGE when underflow occurs and the value returned is 0.0.

• Whether the calloc, malloc, and realloc functions return a null pointer or a pointer to an allocated object when the size requested is zero (7.20.3).

NULL is returned when a size of zero is requested.

• Whether open streams with unwritten buffered data are flushed, open streams are closed, or temporary files are removed when the abort or _Exit function is called (7.20.4.1, 7.20.4.4).

When the abort() or _Exit() function is called, open streams with unwritten buffered data are not flushed, open streams are not closed, and temporary files are not removed.

• The termination status returned to the host environment by the abort, exit, or _Exit function (7.20.4.1, 7.20.4.3, 7.20.4.4).

exit() and _Exit() use the input value as termination status. abort() calls _Exit() with EXIT_FAILURE.

• The value returned by the system function when its argument is not a null pointer (7.20.4.6).

A skeleton is provided for the system() function in the C library, because the embedded environment has no operating system. The system() function returns the value 0.

• The local time zone and Daylight Saving Time (7.23.1).

The default time zone is UTC. Daylight Saving Time is not available (tm_isdst=-1).

• The range and precision of times representable in clock_t and time_t (7.23).

clock_t is defined as unsigned long long, time_t is defined as unsigned long. The resolution of the clock is defined by CLOCKS_PER_SEC, which is set by means of the C startup code (see the setclockpersec() function in cstart.c).
• The era for the clock function (7.23.2.1).

The clock function returns the current processor time.

• The replacement string for the %Z specifier to the strftime, andwcsftime functions in the "C" locale (7.23.3.5, 7.24.5.1).

%Z is replaced by the time zone name, by default UTC.

• Whether or when the trigonometric, hyperbolic, base-e exponential, base-e logarithmic, error, and log gamma functions raise the "inexact" floating-point exception in an IEC 60559 conformant implementation (F.9).

The "inexact" floating-point exception is not supported.

• Whether the functions in <math.h> honor the rounding direction mode in an IEC 60559 conformant implementation (F.9).

The round to nearest method is used. FLT_ROUNDS is defined as 1.

17.1.13. Architecture

• The values or expressions assigned to the macros specified in the headers <float.h>, <limits.h>, and <stdint.h> (5.2.4.2, 7.18.2, 7.18.3).

Macros in <float.h>:

<table>
<thead>
<tr>
<th>Macro &lt;float.h&gt;</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>FLT_RADIX</td>
<td>2</td>
</tr>
<tr>
<td>FLT_ROUNDS</td>
<td>1 (round to nearest)</td>
</tr>
<tr>
<td>FLT_EVAL_METHOD</td>
<td>0</td>
</tr>
<tr>
<td>FLT_MANT_DIG</td>
<td>24</td>
</tr>
<tr>
<td>FLT_DIG</td>
<td>6</td>
</tr>
<tr>
<td>FLT_EPSILON</td>
<td>1.19209290E-07F</td>
</tr>
<tr>
<td>FLT_MIN</td>
<td>1.17549435E-38F</td>
</tr>
<tr>
<td>FLT_MIN_EXP</td>
<td>-125</td>
</tr>
<tr>
<td>FLT_MIN_10_EXP</td>
<td>-37</td>
</tr>
<tr>
<td>FLT_MAX</td>
<td>3.40282347E+38F</td>
</tr>
<tr>
<td>FLT_MAX_EXP</td>
<td>+128</td>
</tr>
<tr>
<td>FLT_MAX_10_EXP</td>
<td>+38</td>
</tr>
<tr>
<td>[L]DBL_MANT_DIG</td>
<td>53</td>
</tr>
<tr>
<td>[L]DBL_DIG</td>
<td>15</td>
</tr>
<tr>
<td>[L]DBL_EPSILON</td>
<td>2.2204460492503131E-16</td>
</tr>
<tr>
<td>[L]DBL_MIN</td>
<td>2.2250738585072014E-308</td>
</tr>
</tbody>
</table>
### C Implementation-defined Behavior

<table>
<thead>
<tr>
<th>Macro <code>&lt;float.h&gt;</code></th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>[L]DBL_MIN_EXP</td>
<td>-1021</td>
</tr>
<tr>
<td>[L]DBL_MIN_10_EXP</td>
<td>-307</td>
</tr>
<tr>
<td>[L]DBL_MAX</td>
<td>1.7976931348623157E+308</td>
</tr>
<tr>
<td>[L]DBL_MAX_EXP</td>
<td>+1024</td>
</tr>
<tr>
<td>[L]DBL_MAX_10_EXP</td>
<td>+308</td>
</tr>
<tr>
<td>DECIMAL_DIG</td>
<td>17 (for double FP), 9 (for single FP)</td>
</tr>
</tbody>
</table>

Macros in `<limits.h>`:

<table>
<thead>
<tr>
<th>Macro <code>&lt;limits.h&gt;</code></th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAR_BIT</td>
<td>24</td>
</tr>
<tr>
<td>SCHAR_MIN</td>
<td>-SCHAR_MAX-1</td>
</tr>
<tr>
<td>SCHAR_MAX</td>
<td>0x7fffffff</td>
</tr>
<tr>
<td>UCHAR_MAX</td>
<td>0xffffU</td>
</tr>
<tr>
<td>CHAR_MIN</td>
<td>__CHAR_MIN (min value of 'plain' char)</td>
</tr>
<tr>
<td>CHAR_MAX</td>
<td>__CHAR_MAX (max value of 'plain' char)</td>
</tr>
<tr>
<td>MB_LEN_MAX</td>
<td>1</td>
</tr>
<tr>
<td>SHRT_MIN</td>
<td>-SHRT_MAX-1</td>
</tr>
<tr>
<td>SHRT_MAX</td>
<td>0x7fffffff</td>
</tr>
<tr>
<td>USHRT_MAX</td>
<td>0xffffU</td>
</tr>
<tr>
<td>INT_MIN</td>
<td>-INT_MAX-1</td>
</tr>
<tr>
<td>INT_MAX</td>
<td>0x7fffffff</td>
</tr>
<tr>
<td>UINT_MAX</td>
<td>0xffffU</td>
</tr>
<tr>
<td>LONG_MIN</td>
<td>-LONG_MAX-1</td>
</tr>
<tr>
<td>LONG_MAX</td>
<td>0x7fffffffffffffffL</td>
</tr>
<tr>
<td>ULONG_MAX</td>
<td>0xfffffffffffffffUL</td>
</tr>
<tr>
<td>LONGLONG_MIN</td>
<td>-LONGLONG_MAX-1</td>
</tr>
<tr>
<td>LONGLONG_MAX</td>
<td>0x7fffffffffffffffULL</td>
</tr>
<tr>
<td>ULLONGLONG_MAX</td>
<td>0xfffffffffffffffULL</td>
</tr>
</tbody>
</table>

The limit macros in `<stdint.h>` for exact-width, minimum-width and fastest-width integer types have the same ranges as char, short, int, long and long long. Furthermore the following macros are defined:

<table>
<thead>
<tr>
<th>Macro <code>&lt;stdint.h&gt;</code></th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>INTPTR_MIN</td>
<td>INT24_MIN</td>
</tr>
<tr>
<td>INTPTR_MAX</td>
<td>INT24_MAX</td>
</tr>
<tr>
<td>Macro</td>
<td>Value</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>UINTPTR_MAX</td>
<td>UINT24_MAX</td>
</tr>
<tr>
<td>INTMAX_MIN</td>
<td>INT72_MIN</td>
</tr>
<tr>
<td>INTMAX_MAX</td>
<td>INT72_MAX</td>
</tr>
<tr>
<td>UINTMAX_MAX</td>
<td>INT72_MAX</td>
</tr>
<tr>
<td>PTDIFF_MIN</td>
<td>__PTDIFF_MIN</td>
</tr>
<tr>
<td>PTDIFF_MAX</td>
<td>__PTDIFF_MAX</td>
</tr>
<tr>
<td>SIG_ATOMIC_MIN</td>
<td>INT24_MIN</td>
</tr>
<tr>
<td>SIG_ATOMIC_MAX</td>
<td>INT24_MAX</td>
</tr>
<tr>
<td>SIZE_MAX</td>
<td>__SIZE_MAX</td>
</tr>
<tr>
<td>WCHAR_MIN</td>
<td>__WCHAR_MIN</td>
</tr>
<tr>
<td>WCHAR_MAX</td>
<td>__WCHAR_MAX</td>
</tr>
<tr>
<td>WINT_MIN</td>
<td>0</td>
</tr>
<tr>
<td>WINT_MAX</td>
<td>UINT24_MAX</td>
</tr>
</tbody>
</table>

- The number, order, and encoding of bytes in any object (when not explicitly specified in this International Standard) (6.2.6.1).

  All types are described in Section 1.1, Data Types.

- The value of the result of the sizeof operator (6.5.3.4).

  The value of the size of the data types is described in Section 1.1, Data Types. Divide the size by 8 because the table lists the size of the data types in bits.

### 17.2. Locale-specific Behavior

Locale-specific behavior is behavior that depends on local conventions of nationality, culture, and language that each implementation documents.

The following items describe the locale-specific characteristics, as indicated in Appendix J.4 of the ISO/IEC 9899:1999 (E) standard.

- Additional members of the source and execution character sets beyond the basic character set (5.2.1).

  The compiler accepts all one-byte characters in the host's default character set. Use of variable length encoded characters in the source file in comments and string literals is permitted.

  In the implementation in the C library, the basic sequences of a multibyte character consist of single bytes (MB_LEN_MAX is set to 1). If you want full multibyte support, you need to change the C library. See the notes in the header files stdio.h and wchar.h for more information.
• The presence, meaning, and representation of additional multibyte characters in the execution character set beyond the basic character set (5.2.1.2).

Use of variable length encoded characters in the source file in comments and string literals is permitted.

• The shift states used for the encoding of multibyte characters (5.2.1.2).

A multibyte character must be a single byte when in the initial shift state.

• The direction of writing of successive printing characters (5.2.2).

The direction of writing depends on the application and the display device.

• The decimal-point character (7.1.1).

The default decimal-point character is a '.

• The set of printing characters (7.4, 7.25.2).

The set of printing characters are the characters for which the isprint() function returns true. Printing characters are characters in the range 32 (space) to 126.

• The set of control characters (7.4, 7.25.2).

The set of control characters are the characters for which the iscntrl() function returns true. Control characters are characters in the range 0 to 31 and 127.

• The sets of characters tested for by the isalpha, isblank, islower, ispunct, isspace, isupper, iswalpha, iswblank, iswlower, iswpunct, iswspace, or iswupper functions (7.4.1.2, 7.4.1.3, 7.4.1.7, 7.4.1.9, 7.4.1.10, 7.4.1.11, 7.25.2.1.2, 7.25.2.1.3, 7.25.2.1.7, 7.25.2.1.9, 7.25.2.1.10, 7.25.2.1.11).

The characters tested for are specified in the following table.

<table>
<thead>
<tr>
<th>Function</th>
<th>Characters tested</th>
</tr>
</thead>
<tbody>
<tr>
<td>isalpha</td>
<td>a-z, A-Z</td>
</tr>
<tr>
<td>isblank</td>
<td>' ' (space), '\t' (tab)</td>
</tr>
<tr>
<td>islower</td>
<td>a-z</td>
</tr>
<tr>
<td>ispunct</td>
<td>!, *, #, $, %, &amp;,'(,), +, -, /, :, &lt;, =, &gt;, @, [], ^, _, `, {,</td>
</tr>
<tr>
<td>isspace</td>
<td>' ' (space), '\t', '\n', '\v', '\f', '\r'</td>
</tr>
<tr>
<td>isupper</td>
<td>A-Z</td>
</tr>
</tbody>
</table>

• The native environment (7.11.1.1).

The native environment is the same as the "C" locale.

• Additional subject sequences accepted by the numeric conversion functions (7.20.1, 7.24.4.1).

No additional subject sequences are accepted.
The collation sequence of the execution character set (7.21.4.3, 7.24.4.4.2).

Only the "C" locale is supported. The `strcoll()` function is the same as the `strcmp()` function. The `wcscoll()` function is the same as the `wcscmp()` function.

The contents of the error message strings set up by the `strerror` function (7.21.6.2).

The error message strings returned by `strerror()` depend on the argument. Typically, the values for the argument come from `errno.h`. For a list of messages see Section 10.1.5, `errno.h`.

The formats for time and date (7.23.3.5, 7.24.5.1).

English names for months and days are used.

- `%c` is replaced by the following date and time representation: `%a %b %e %H:%M:%S %Y`
- `%x` is replaced by the following date representation: `%m/%d/%y`
- `%X` is replaced by the following time representation: `%H:%M:%S`

Character mappings that are supported by the `towctrans` function (7.25.1).

The character mappings supported by the `towctrans()` function are defined in `wctype.h`: `_to_lower` and `_to_upper`.

Character classifications that are supported by the `iswctype` function (7.25.1).

The character classifications supported by the `iswctype()` function are defined in `wctype.h`: `_alnum`, `_alpha`, `_cntrl`, `_digit`, `_graph`, `_lower`, `_print`, `_punct`, `_space`, `_upper`, `_xdigit` and `_blank`. 